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Animate, visualize, and interact with models in 3D

Simulink 3D Animation provides apps for linking Simulink models and MATLAB®
algorithms to 3D graphics objects. It lets you visualize and verify dynamic system
behavior in a virtual reality environment. Objects are represented in the Virtual Reality
Modeling Language (VRML), a standard 3D modeling language. You can animate a 3D
world by changing position, rotation, scale, and other object properties during desktop or
real-time simulation. You can also inject virtual sensor signals and access 3D animation
data in Simulink or MATLAB for post-processing.

Simulink 3D Animation includes viewers for rendering and interacting with virtual
scenes. With the 3D World Editor, you can author detailed scenes assembled from 3D
models exported from CAD-based or web-based sources. You can incorporate multiple 3D
scene views inside MATLAB figures and interact with these views via a force-feedback
joystick, space mouse, or other hardware device.

Key Features

+  Simulink blocks and MATLAB apps and functions for connecting models to virtual
reality worlds

* 3D World Editor for authoring 3D worlds

+  Viewers for 3D model visualization

+ Video recording and animation playback

* Visualization of real-time simulations

* Remote access to simulations via standalone viewers or web browsers

+ Interaction with 3D views via a joystick, space mouse, or other hardware device



Expected Background

Expected Background

To help you effectively read and use this guide, here is a brief description of the chapters
and a suggested reading path. Generally, you can assume that Simulink 3D Animation

software on the Apple Mac OS X platform works as described for the UNIX®*/Linux®
platforms.

The documentation assumes that you are already familiar with:

+ MATLAB product, to write scripts and functions with MATLAB code, and to use
functions with the command-line interface

*  Simulink and Stateflow charts products to create models as block diagrams and
simulate those models

* X3D or VRML,, to create or otherwise provide virtual worlds or three-dimensional
scenes to connect to Simulink or MATLAB software

Related Examples

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4
More About
. “Simulink 3D Animation Product Description” on page 1-2

1-3
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In this section...

“Virtual Reality World Models of Dynamic Systems” on page 1-4
“Set up Your Working Environment” on page 1-4

“Build a Virtual Reality World” on page 1-6

“Link to a Virtual Reality World” on page 1-7

“View Dynamic System Simulations” on page 1-8

“Share Dynamic System Simulation Visualizations” on page 1-8

Virtual Reality World Models of Dynamic Systems

The Simulink 3D Animation product is a solution for interacting with virtual reality
world models of dynamic systems over time. It extends the capabilities of your virtual
world and Simulink, Simscape Multibody, and MATLAB software into the world of
virtual reality graphics. The product provides a complete authoring, development, and
working environment for carrying out 3-D visual simulations.

To use virtual reality worlds to visualize dynamic system simulations, you perform the
following tasks:

+ “Set up Your Working Environment” on page 1-4

*  “Build a Virtual Reality World” on page 1-6

+  “Link to a Virtual Reality World” on page 1-7

* “View Dynamic System Simulations” on page 1-8

+  “Share Dynamic System Simulation Visualizations” on page 1-8
As you refine your visualization, you often perform some of these tasks iteratively.

To work through an example that illustrates the building, linking, and viewing a virtual
world, see “Build and Connect a Virtual World” on page 5-7.

Set up Your Working Environment

Install the Simulink 3D Animation software in your MATLAB environment to build
virtual reality worlds and to visualize dynamic simulations modeled in MATLAB,
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Simulink, or Simscape Multibody. If your computer does not already have a graphics
card with hardware 3-D acceleration, consider installing such a card to enhance graphics
performance.

You build and view the virtual reality world models using VRML (Virtual Reality
Modeling Language) or X3D (Xtensible 3D).

In addition to the installed editor, the 3D World Editor, you can configure your
environment to use:

* The Ligos® V-Realm Builder, which is included in the Simulink 3D Animation
software for Windows" platforms.

* Any third-party virtual world editor

* The MATLAB editor or a third-party text editor

In addition to the installed Simulink 3D Animation viewer (the default), you can use one
of these viewers to display your virtual reality worlds:

+  Simulink 3D Animation Web Viewer

* Orbisnap, on a client computer

To help decide which 3D virtual world editor and viewer to use, see “Virtual World
Editors” on page 5-2 and “Virtual World Viewers” on page 7-2.

Use joystick and space mouse input devices to provide input for dynamic simulation
visualizations.

TCP/IP Connection

The Simulink 3D Animation product uses a TCP/IP connection to a VR client for
communicating with the Simulink 3D Animation Viewer, as well for connecting to
HTML5-enabled web browser. You can verify the TCP/IP connection between the host
and client computers by using the ping command from a command-line prompt. If there
are problems, fix the TCP/IP protocol settings according to the documentation for your
operating system.

LD_LIBRARY_PATH Environment Variable for UNIX

If your system does not have the OpenGL" software properly installed when you run
the Simulink 3D Animation Viewer, you might see a MATLAB error message like the
following:

1-5
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Invalid MEX-file "matlab/toolbox/s13d/sl3d/vrsfunc._mexglx”:
libGL.so: cannot open shared object File

If you see an error like this, set the LD_LIBRARY_PATH environment variable.

If the LD_LIBRARY_PATH environment variable already exists, use a line like the
following to add the new path to the existing one:

setenv LD_LIBRARY_PATH
matlabroot/sys/opengl/1ib/<PLATFORM>:$LD_ L IBRARY_PATH

If the LD_L IBRARY_PATH environment variable does not already exist, use a line like the
following:

setenv LD_LIBRARY_PATH
matlabroot/sys/opengl/1ib/<PLATFORM>

In both cases, <PLATFORM> is the UNIX platform you are working in.

Build a Virtual Reality World

Use a virtual world editor to build a virtual reality world. A non-VRML or non-X3D CAD
model created with another tool can be a good basis for a virtual reality world to use with
Simulink 3D Animation. You can convert some CAD models to a VRML or X3D model.

You can use advanced features of the Simulink 3D Animation product such as:

*  Viewpoints, to highlight points of interest for quick browsing of a virtual reality world

+ Sensors, to input virtual reality world values to Simulink models

For more an overview of VRML and details about supported VRML features, see “Virtual
Reality Modeling Language (VRML)” on page 1-14. You can also use X3D, which
provides several extensions, including additional nodes, fields, encoding, scene access
interfaces, additional rendering control, and geospatial support. For details, see “X3D
Support” on page 1-11.

As you add nodes with the 3D World Editor on page 6-2, you can use the viewer
pane to see the virtual world that you are creating.

For a step-by-step example of building a virtual reality world with the 3D World Editor,
see “Build and Connect a Virtual World” on page 5-7.
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Link to a Virtual Reality World

To use a dynamic system simulation to drive a virtual reality world, connect the virtual
world to one of the following:

*  Simulink model
*  Simscape Multibody model
* MATLAB virtual world object

Simulink

The Simulink 3D Animation library provides blocks to connect Simulink signals with
virtual worlds. This connection lets you visualize your model as a three-dimensional
animation.

You can implement most of the software features with Simulink blocks. Once you
include these blocks in a Simulink diagram, you can select a virtual world and connect
Simulink signals to the virtual world. The software automatically scans a virtual world
for available nodes that the Simulink software can drive.

All the node properties are listed in a hierarchical tree-style viewer. You select the
degrees of freedom to control from within the Simulink interface. After you close a Block
Parameters dialog box, the Simulink software updates the block with the inputs and
outputs corresponding to selected nodes in the virtual world. After connecting these
inputs to appropriate Simulink signals, you can view the simulation with a virtual world
viewer.

The Simulink product provides communication for control and manipulation of virtual
reality objects, using Simulink 3D Animation blocks.

For details, see “Virtual World Connection to a Model” on page 3-2.
Simscape Multibody

You can use the Simulink 3D Animation product to view the behavior of a model created
with the Simscape Multibody software. First, you build a model of a machine in the
Simulink interface using Simscape Multibody blocks. Then, create a detailed picture of
your machine in a virtual world. Connect this world to the Simscape Multibody body
sensor outputs and view the behavior of the bodies in a virtual world viewer.

For details, see “Link to Simulink and Simscape Multibody Models” on page 5-62.
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MATLAB

Simulink 3D Animation software provides a flexible MATLAB interface to virtual reality
worlds. After creating MATLAB objects and associating them with a virtual world, you
can control the virtual world by using functions and methods.

From the MATLAB software, you can set positions and properties of virtual world
objects, create callbacks from graphical interfaces, and map data to virtual world objects.
You can also view the virtual world with a viewer, determine its structure, and assign
new values to all available nodes and their fields.

The software includes functions for retrieving and changing the virtual world properties
and for saving the virtual world 3D files corresponding to the actual structure of a virtual
world.

The MATLAB software provides communication for control and manipulation of virtual
reality objects using MATLAB objects.

For details about interacting between MATLAB and virtual reality worlds, see “MATLAB
Interaction”.

View Dynamic System Simulations

After you connect the virtual world to the model, use a virtual world viewer to view the
virtual world representation of the dynamic system simulation.

* In Simulink and Simscape Multibody, simulate the model that is connected to the
virtual reality world.

+ In MATLAB, use the view function to view a vrwor Id object that the MATLAB code
updates with data values.

While running a simulation, you can change the positions and properties of virtual world
objects.

For information about using virtual world viewers to navigate a virtual reality world, see
“View Dynamic System Simulations”.

Share Dynamic System Simulation Visualizations

You can share dynamic system simulation results with others by:
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Capture animation frame snapshots or record animations for video viewing. See
“Capture Frames” on page 7-53 and “Record and Play Animations”.

In addition to the single computer configuration (when MATLAB, Simulink, and

the virtual reality representations run on the same host computer), Simulink 3D
Animation software also allows a client-server configuration. In this configuration, an
Orbisnap viewer on a remote client can connect to the server host on which Simulink
3D Animation software is running. This configuration allows others to view an
animated virtual world remotely. Multiple clients can connect to one server. See
“Orbisnap Standalone Viewer”.

Use the MATLAB Compiler™ to take MATLAB files as input and generate
redistributable, standalone applications that include Simulink 3D Animation
functionality, including the Simulink 3D Animation Viewer. See “MATLAB Compiler
Support” on page 1-10

See Also

Functions
vredit | vrgetpref | vrjoystick | vrlib | vrsetpref | vrspacemouse

Blocks
VR Sink | VR Source

Related Examples

“Virtual Reality World and Dynamic System Examples” on page 1-22
“Build Virtual Reality Worlds”
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To use the MATLAB Compiler to produce standalone applications, create a MATLAB file
that uses the MATLAB interface for the Simulink 3D Animation product (for example,

creating, opening, and closing a vrwor Id object). Then use the MATLAB Compiler
product.

Standalone applications that include Simulink 3D Animation functionality have the
following limitations:

*  No Simulink software support, which results in no access to the Simulink 3D
Animation Simulink library (vrhlib).

+  No Simulink 3D Animation server, which results in no remote connection for the
Orbisnap viewer

*  No animation recording ability
*  No editing world ability
* The following Simulink 3D Animation Viewer features cannot be used in standalone
applications:
+ File > Open in Editor
* Recording menu
Simulation menu

+ Help access

Related Examples

. “Interact with Virtual Reality Worlds”
. “MATLAB Interaction”
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X3D Support

In this section...

“X3D” on page 1-11

“Relationship of X3D and VRML” on page 1-11

“X3D Support in Simulink 3D Animation” on page 1-12
“Convert a VRML File to X3D Format” on page 1-12

X3D

The X3D Xtensible 3D) ISO standard is an open standards file format and runtime
architecture for representing and communicating 3D scenes and objects. X3D has a rich
set of componentized features that you can customize. You can use X3D in applications
such as engineering and scientific visualization, CAD and architecture, medical
visualization, training and simulation, multimedia, entertainment, and education.

For information about supported X3D specification, see ISO/IEC 19775-1:2013. For
information about supported X3D encoding, see ISO/IEC 19776-1.3:201x and ISO/TEC
19776-2.3:201x.

Relationship of X3D and VRML

X3D is the successor of the VRML 97 standard (see “Virtual Reality Modeling Language
(VRML)” on page 1-14). X3D and VRML share many similar approaches, such as

their coordinate systems and the description of objects using nodes and their fields. X3D
provides several extensions, including additional nodes, fields, encoding, scene access
interfaces, additional rendering control, and geospatial support. VRML97 is still a widely
supported 3D format for tools and viewers, and is a direct subset of X3D. Many CAD tools
and 3D editors support import from and export to the X3D format.

Because many 3D virtual world tools and CAD tools have adopted X3D, Simulink 3D

Animation software provides both X3D and VRML support. VRML97 is the default
virtual world file format.
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X3D Support in Simulink 3D Animation

You can use XML encoded (. x3d files) and Classic VRML encoded (. x3dv files) X3D file
formats. X3D support is for versions from version 3.0 up to version 3.3. Support is for
X3D files that contain components that comply to the Immersive profile.

You can use Simulink blocks and MATLAB command-line interfaces to create and access
virtual worlds.

X3D Support Limitations

In the 3D World Editor, you can edit only VRML and VRML-compliant X3D files (files
that contain only X3D features that have VRMLO7 counterparts).

Simulink 3D Animation does not support X3D for Ligos V-Realm Builder.
The X3D support has these limitations:

*  No support for binary-encoded files (.x3db).

*  The Simulink 3D Animation Web Viewer supports only X3D files that contain nodes
complying to the HTML profile specified by the X3DOM developer community.

* You can use the st12virml function to import CAD models in STL format (.stl
files) to X3D format (.x3d or .x3dv files). However, other methods that Simulink
3D Animation provides for converting CAD models do not support conversion to X3D
format.

* You cannot inline X3D files (.x3d or .x3dv).

+ No support for the scene-access interface specified by ISO/IEC 19775-2:201x. To
access virtual worlds, use Simulink blocks or the MATLAB commands.

+ LineProperties node support is limited to solid lines.
* The engine ignores UNIT and additional COMPONENT statements and elements.

* A PROTO node cannot have a VRML file (.wrl) that references an X3D file (.x3d or
-X3dv).

Convert a VRML File to X3D Format

You can save VRML (.wrl) files as X3D format files. The conversion process determines
whether the X3D file is an .x3d or x3dyv file.

This example code converts a VRML file to X3D format:
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w = vrworld(“octavia_scene._wrl®);
open(w);

% save to XML encoding
save(w, "octavia_scene.x3d");

% save to VRML syntax encoding
save(w, "octavia_scene.x3dv");

Related Examples
. “Use CAD Models with the Simulink 3D Animation Product” on page 5-32

“Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4

“Virtual Reality World and Dynamic System Examples” on page 1-22

More About

. “Virtual Reality Modeling Language (VRML)” on page 1-14
. “Expected Background” on page 1-3
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In this section...

“Relationship of VRML and X3D” on page 1-14
“VRML” on page 1-14

“VRML Support” on page 1-14

“VRML Compatibility” on page 1-16

“VRML Coordinate System” on page 1-17

“VRML File Format” on page 1-18

Relationship of VRML and X3D

The X3D (Xtensible 3D) interface is the successor to the VRML (Virtual Reality Modeling
Language) interface. The X3D interface supports VRML features. X3D also provides
several extensions to VRML.

For details, see “X3D Support” on page 1-11.

VRML

You can use the Virtual Reality Modeling Language (VRML) to display three-
dimensional objects in a VRML viewer. Simulink 3D Animation supports VRML97.

VRML provides an open and flexible platform for creating interactive three-dimensional
scenes (virtual worlds). Several VRML97-enabled browsers are available on several
platforms. Also, you can choose from several VRML authoring tools. In addition,
graphical software packages (CAD, visual art, and so on) offer VRML97 import/export
features.

The Simulink 3D Animation product uses VRML97 technology for 3-D visualization.

VRML Support

The Virtual Reality Modeling Language (VRML) is an ISO standard that is open, text-
based, and uses a WWW-oriented format. You use VRML to define a virtual world that
you can display with a virtual world viewer and connect to a Simulink model.
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The Simulink 3D Animation software uses many of the advanced features defined in
the current VRML97 specification. The standard is ISO/IEC 14772-1:1997, available
from http://www.web3d.org/documents/specifications/14772/V2.0/partl/
Javascript_html. This format includes a description of 3-D scenes, sounds, internal
actions, and WWW anchors.
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The software analyzes the structure of the virtual world, determines what signals are
available, and makes them available from the MATLAB and Simulink environment.

Simulink 3D Animation software ensures that the changes made to a virtual world are
reflected in the MATLAB and Simulink interfaces. If you change the viewpoint in your
virtual world, this change occurs in the vrwor ld object properties in MATLAB and
Simulink interfaces.

The software includes functions for retrieving and changing virtual world properties.

Note: Some VRML worlds are automatically generated in VRML1.0. However, the
Simulink 3D Animation product does not support VRML1.0. Save these worlds in the
current standard for VRML, VRML97.

For PC platforms, you can convert VRML1.0 worlds to VRML97 worlds by opening the
worlds in Ligos V-Realm Builder and saving them. V-Realm Builder is shipped with the
PC version of the software. Other commercially available software programs can also
perform the VRML1.0 to VRML97 conversion.

VRML Compatibility

The Simulink 3D Animation product currently supports most features of VRML97, with
the following limitations:

*  The Simulink 3D Animation server ignores the VRML Script node, but it passes the
node to the VRML Viewer. Passing the node allows you to run VRML scripts on the
viewer side. You cannot run them on the Simulink 3D Animation server.

* In keeping with the VRML97 specification, the Simulink 3D Animation Viewer
ignores BMP files. As a result, VRML scene textures sometimes display improperly

in the Simulink 3D Animation Viewer. To display scene textures properly, replace all
BMP texture files in a VRML scene with PNG, JPG, or GIF equivalents.

For a complete list of VRML97 nodes, refer to the VRML97 specification.
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VRML Coordinate System

z

Y

MATLAB graphics coordinale syslem

Vv

VRML coordinale system

»xY
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The VRML coordinate system is different from the MATLAB and Aerospace Blockset™
coordinate systems. VRML uses the world coordinate system: the y-axis points

upward and the z-axis places objects nearer or farther from the front of the screen.
Understanding the coordinate system is important when you interact with different
coordinate systems. Simscape Multibody uses the same coordinate system as VRML.

Rotation angles — In VRML, rotation angles are defined using the right-hand rule.
Imagine your right hand holding an axis while your thumb points in the direction of the
axis toward its positive end. Your four remaining fingers point in a counterclockwise
direction. This counterclockwise direction is the positive rotation angle of an object
moving around that axis.

Child objects — In the hierarchical structure of a VRML file, specify the position and
orientation of child objects relative to the parent object. The parent object has its local
coordinate space defined by its own position and orientation. Moving the parent object
also moves the child objects relative to the parent object.

Measurement units — All lengths and distances are measured in meters, and all angles
are measured in radians.

VRML File Format

You need not have any substantial knowledge of the VRML format to use the VRML
authoring tools to create virtual worlds. However, a basic knowledge of VRML scene
description helps you create virtual worlds more effectively. A basic knowledge also
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gives you a good understanding of how you can control the virtual world elements using
Simulink 3D Animation software.

For more information, see the VRML97 Reference at http://www.web3d.org. Many
specialized VRML books can help you understand VRML concepts and create your own
virtual worlds. For more information about the VRML, refer to an appropriate third-
party VRML book.

VRML uses a hierarchical tree structure of objects (nodes) to describe a 3-D scene. Every
node in the tree represents some functionality of the scene. There are many different
types of nodes. Some of them are shape nodes (representing real 3-D objects), and some of
them are grouping nodes used for holding child nodes. Here are some example nodes:

* Box — Represents a box in a scene.

* Transform — Defines position, scale, scale orientation, rotation, translation, and
children of its subtree (grouping node).

+ Material — Corresponds to material in a scene.
* DirectionalLight— Represents lighting in a scene.
* Fog — Allows you to modify the environment optical properties.

* ProximitySensor — Brings interactivity to VRML97. This node generates events
when you enter, exit, and move within the defined region in space.

Each node contains a list of fields that hold values defining parameters for its function.

Nodes can be placed in the top level of a tree or as children of other nodes in the tree
hierarchy. When you change a value in the field of a certain node, all nodes in its subtree
are affected. This feature allows you to define relative positions inside complicated
compound objects.

You can mark every node with a specific name by using the keyword DEF in the VRML
scene code. For example, the statement DEF MyNodeName Box sets the name for this
box node to MyNodeName. You can access the fields of only those nodes that you name in
a virtual world.

In the following example of a simple VRML file, two graphical objects are modeled in
a 3-D scene. A flat box with a red ball above it represents the floor. The VRML file is a
readable text file that you can write in any text editor.

#VRML V2.0 utf8
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# This is a comment line
WorldInfo {
title "Bouncing Ball™

¥

Viewpoint {
position 0 5 30
description "Side View"

}
DEF Floor Box {

size 6 0.2 6

}
DEF Ball Transform {

translation 0100
children Shape {
appearance Appearance {
material Material {
diffuseColor 1 0 O
}

}
geometry Sphere {

}
}
}

The first line is the VRML header line. Every VRML file must start with this header line.
It indicates that the file is a VRML 2 file and that the text objects in the file are encoded
according to the UTF8 standard. You use the number sign (#) to comment VRML worlds.
A VRML viewer ignores everything on a line after the # sign is ignored, except for the
first header line.

Most of the box properties are left at their default values — distance from the center

of the coordinate system, material, color, and so on. Only the name Floor and the
dimensions are assigned to the box. To be able to control the position and other
properties of the ball, it is defined as a child node of a Transform type node. Here,

the default unit sphere is assigned a red color and a position 10 m above the floor. In
addition, the virtual world title is used by VRML viewers to distinguish between virtual
worlds. A suitable initial viewpoint is defined in the virtual world VRML file.

When displayed in a VRML viewer, you see the floor and red ball.
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Related Examples

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4
. “Virtual Reality World and Dynamic System Examples” on page 1-22
. “Add Sensors to Virtual Worlds” on page 3-25

More About

. “X3D Support” on page 1-11
. “Expected Background” on page 1-3
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In this section...

“Simulink Interface Examples” on page 1-22

“MATLAB Interface Examples” on page 1-34

Simulink Interface Examples

For all the examples that have a Simulink model, use the following procedure to run the
example and view the model:

1

In the MATLAB Command Window, enter the name of a Simulink model. For
example, enter:

vrbounce

A Simulink window opens with the block diagram for the model. By default, a virtual
world also opens in the Simulink 3D Animation Viewer or your HTML5-enabled web
browser. If you close the virtual world window, double-click the VR Sink block to
display it again.

Note: If the viewer does not open, double-click the VR Sink block in the Simulink
model. In the Simulink 3D Animation Viewer, from the Simulation menu, click
Block Parameters. A Block Parameters dialog box opens. The Open viewer
automatically check box should be selected by default. When you double-click the
VR Sink block, this selection enables the virtual world window to open.

In the Simulink window, from the Simulation menu, click Run. (Alternatively, in
the Simulink 3D Animation Viewer, from the Simulation menu, click Start.)

A simulation starts running, and the virtual world is animated using signal data
from the simulation.
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The following table lists the Simulink examples provided with the Simulink 3D

Animation product. Descriptions of the examples follow the table.

vrtkoff_trace

vrtkoff _hud

Example Simulink Coder™ |VR Sink |VR Source |Joystick  |Space
Ready Mouse
vrbounce X X
vrcrane_joystick X X
vrcrane_panel X X
vrcrane_traj X X
vrlights X X
vrmaglev X X
vrmaglev_sldrt X X
vrmanipul X X
vrmanipul_global X X
vrmembl X X
vrmorph X X
Vvr_octavia X X
Vvr_octavia_2cars X
vr_octavia_graphs X
Vvr_octavia_mirror X
Vvr_octavia_video X
vrdemo_panel X X
vrpend X X
vrplanets X X
vrtkoff X X
X
X
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Bouncing Ball Example (vrbounce)

The vrbounce example represents a ball bouncing from a floor. The ball deforms as it
hits the floor, keeping the volume of the ball constant. The deformation is achieved by
modifying the scale field of the ball.
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Portal Crane with Joystick Control (vrcrane_joystick)

The vrcrane_joystick example illustrates how a Simulink model can interact with

a virtual world. The portal crane dynamics are modeled in the Simulink interface and
visualized in virtual reality. The model uses the Joystick Input block to control the
setpoint. Joystick 3 axes control the setpoint position and button 1 starts the crane. This

example requires a standard joystick with at least three independent axes connected to
the PC.

To minimize the number of signals transferred between the Simulink model and the
virtual reality world, and to keep the model as simple and flexible as possible, only the
minimum set of moving objects properties are sent from the model to the VR Sink block.
All other values that are necessary to describe the virtual reality objects movement are
computed from this minimum set using VRMLScript in the associated virtual world 3D
file.

For details on how the crane model hierarchy and scripting logic is implemented, see the
associated commented virtual world 3D file portal_crane.wrl.

Virtual Control Panel (vrdemo_panel)

The vrdemo_panel example shows the use of sensing objects that are available in the
3D World Editor Components library. These objects combine virtual world sensors with
logic that changes their visual appearance based on user input. The sensor values can
be read into Simulink by the VR Source block. The logic is implemented using VRML
Scripts and Routes.

The control panel contains a pushbutton, switch button, toggle switch, and a 2-D
setpoint selection area. Outputs of these elements are read into a Simulink model and
subsequently displayed using standard sinks, or used as inputs of blocks that control
back some objects in the virtual world.

Pushbutton, switch button, and toggle switches have the state outputs, which are of
boolean type. Their values are displayed using the Scope.

Two outputs of the 2D setpoint area are used to achieve the following behavior. The value
of the "SetPoint_Changed" eventOut is continuously updated when the pointer is over the
sensor area. This value is triggered by the second output - "isActive" that is true only on
clicking the pointer button. Triggered value - coordinates of the active point on the sensor
plane are displayed using the XY Graph and sent back to the virtual world in two ways:
as a position of green cone marker and as text that the VR Text Output block displays on
the control panel.
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Portal Crane with Predefined Trajectory Example (vrcrane_traij)

The vrcrane_traj example is based on the vrcrane_joystick example, but instead
of interactive control, it has a predefined load trajectory. The vrcrane_traj model
illustrates a technique to create the visual impression of joining and splitting moving
objects in the virtual world.

A crane magnet attaches the load box, moves it to a different location, then releases

the box and returns to the initial position. This effect is achieved using an additional,
geometrically identical shadow object that is placed as an independent object outside of
the crane objects hierarchy. At any given time, only one of the Load or Shadow objects is
displayed, using two Switch nodes connected by the ROUTE statement.

After the crane moves the load to a new position, at the time of the load release, a
VRMLScript script assigns the new shadow object position according to the current Load
position. The Shadow object becomes visible. Because it is independent from the rest of
the crane moving parts hierarchy, it stays at its position as the crane moves away.

Lighting Example (vrlights)

The vrlights example uses light sources. In the scene, you can move Sun (modeled as
DirectionalLight) and Lamp (modeled as PointLight) objects around the Simulink
model. This movement creates the illusion of changes between day and night, and night
terrain illumination. The associated virtual world 3D file defines several viewpoints that
allow you to observe gradual changes in light from various perspectives.

Magnetic Levitation Model Example (vrmaglev)

The vrmaglev example shows the interaction between dynamic models in the Simulink

environment and virtual worlds. The Simulink model represents the HUMUSOFT®
CE 152 Magnetic Levitation educational/presentation scale model. The plant model is
controlled by a PID controller with feed-forward to cope with the nonlinearity of the
magnetic levitation system. To more easily observe and control the ball, set the virtual
world viewer to the Camera 3 viewpoint.

You can set the ball position setpoint in two ways:

+ Using a Signal Generator block

+ Clicking in the virtual reality scene at a position that you want
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To achieve a dragging effect, use the PlaneSensor attached to the ball geometry with
its output restricted to <0,1> in the vertical coordinate and processed by the VR Sensor
Reader block. The vrextin S-function provides the data connection.

For more details on how to read values from virtual worlds programmatically, see “Add
Sensors to Virtual Worlds” on page 3-25.

Magnetic Levitation Model for Simulink Desktop Real-Time Example (vrmaglev_sldrt)

In addition to the virmaglev example, the virmaglev_sldrt example works directly
with the actual CE 152 scale model hardware in real time. This model to work with

the HUMUSOFT MF 624 data acquisition board, and Simulink Coder and Simulink
Desktop Real-Time™ software. However, you can adapt this model for other targets and
acquisition boards. A digital IIR filter, from the DSP System Toolbox™ library, filters the
physical system output. You can bypass the physical system by using the built-in plant
model. Running this model in real time is an example showing the capabilities of the
Simulink product in control systems design and rapid prototyping.

After enabling the remote view in the VR Sink block dialog box, you can control the
Simulink model even from another (remote) client computer. This control can be useful
for distributing the computing power between a real-time Simulink model running on one
machine and the rendering of a virtual reality world on another machine.

To work with this model, use as powerful a machine as possible or split the computing
and rendering over two machines.

Manipulator with Space Mouse Example (vrmanipul)
The vrmanipul example illustrates the use of Simulink 3D Animation software for
virtual reality prototyping and testing the viability of designs before the implementation

phase. Also, this example illustrates the use of a space mouse input for manipulating
objects in a virtual world. You must have a space mouse input to run this example.
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The virtual reality model represents a nuclear hot chamber manipulator. It is
manipulated by a simple Simulink model containing the Space Mouse Input block. This
model uses all six degrees of freedom of the space mouse for manipulating the mechanical
arm, and uses mouse button 1 to close the grip of the manipulator jaws.

A space mouse is an input device with six degrees of freedom. It is useful for navigating
and manipulating objects in a virtual world. A space mouse is also suitable as a general
input device for Simulink models. You can use a space mouse for higher performance
applications and user comfort. Space mouse input is supported through the Space
Mouse Input block, which is included in the Simulink 3D Animation block library for the
Simulink environment.

The Space Mouse Input block can operate in three modes to cover the most typical uses of
such a device in a three-dimensional context:

* Speeds
+ Positions

*  Viewpoint coordinates
Manipulator Moving a Load with Use of Global Coordinates (vrmanipul_global)

The vrmanipul_global example illustrates the use of global coordinates in Simulink 3D
Animation models. You can use global coordinates in a model in many ways, including:

* Object tracking and manipulation
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+ Simple collision detection

+ Simulation of haptic effects

The VR Source block supports using global coordinates for objects in a virtual world. For
each Transform in the scene, the tree view in the VR Source block parameter dialog box
displays the Extensions branch. In that branch, you can select translation_abs and
rotation_abs fields. Fields with the _abs suffix contain the object's global coordinates.
The fields without the _abs suffix input their data into Simulink model object's local
coordinates (relative to their parent objects in model hierarchy).

The virtual reality model represents a nuclear hot chamber manipulator. The
manipulator moves the load from one gray cylindrical platform to another. The trajectory
for the manipulator end-effector is predefined using the Signal Builder. Each part of
manipulator arm is independently actuated using decomposed trajectory components,
with the help of VR Expander blocks (see the VR Transformations subsystem).

The VR Source block in the virtual scene tree on the left captures global coordinates of all
objects important for load manipulation:

*  Manipulator grip reference point (center of the clamp)

+ Destination reference point

+ Initial position of the load

The manipulator grip position results from complex movement of manipulator arm

parts that form hierarchical structure. Generally it is very difficult to compute global
coordinates for such objects affected by hierarchical relations in the scene. However,

Simulink 3D Animation provides an easy way to read the global coordinates of objects
affected by hierarchical relations into a Simulink model.

Based on having the global coordinates of all of the important objects, you can implement
a simple manipulator control logic.

Rotating Membrane Example (vrmemb1)

The vrmembl example is similar to the virmemb example, but in the virmembl example
the associated virtual world is driven from a Simulink model.

Geometry Morphing Example (vrmorph)

The vrmorph example illustrates how you can transfer matrix-type or variable-size
signal data between the Simulink interface and a virtual reality world. With this
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capability, you can perform massive color changes or morphing. This model morphs a
cube into an octahedron and then changes it back to a cube.

Vehicle Dynamics Visualization (vr_octavia)

The vr_octavia example illustrates the benefits of the visualization of complex
dynamic model in the virtual reality environment. It also shows the Simulink 3D
Animation 3-D offline animation recording functionality.

Vehicle Dynamics Visualization - Simulation of Multiple Objects (vr_octavia_2cars)

This example extends the vr_octavia example to show multiple-object scenario
visualizations.

The precomputed simulation data represents a standard double-lane-change maneuver
conducted in two-vehicle configurations. One configuration engages the Electronic
Stability Program control unit. The other configuration switches that control unit off. The
example sends two sets of vehicle dynamics data in parallel to the virtual reality scene,
to drive two different vehicles.

Models of the vehicles use the EXTERNPROTO mechanism. In the main virtual world
associated with the VR Sink block, you can create several identical vehicles as instances
of a common 3-D object. This approach greatly simplifies virtual world authoring. For
instance, it 1s very easy to create a third vehicle to simultaneously visualize another
simulation scenario. The octavia _scene_lchg_2cars.wrl virtual world, the code
after the definition of PROTOS illustrates an approach for easy-to-define reusable objects.

In addition to vehicle properties controlled in the vr_octavia example, vehicle
prototypes also allow you to define vehicle color and scale. These properties distinguish
individual car instances (color) and avoid unpleasant visual interaction of two nearly-
aligned 3-D objects (scale). Scaling one of the cars by a small amount, encompasses one
car into another so that their faces do not clip randomly, based on the current simulation
data in each simulation step.

To visualize vehicles side-by-side, add an offset to the position of one vehicle.
Vehicle Dynamics Visualization with Graphs (vr_octavia_graphs)

The vr_octavia_graphs example extends the vir_octavia example by showing how
to combine a virtual reality canvas in one figure with other graphical user interface
objects. In this case, the virtual world displays three graphs that update at each major
simulation time step.
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Vehicle Dynamics Visualization with Live Rear Mirror Image (vr_octavia_mirror)

The vr_octavia_mirror example extends the vr_octavia example by showing the
capability of the VR Sink block to process video stream on input. In the virtual world, a
PixelTexture texture map is defined at the point of the vehicle left rear mirror. The
example places a 2-D image from a viewpoint at the same position (looking backward).
That image is looped back into the same virtual world and projected on the rear mirror
glass, creating the impression of a live reflection. Texture images can have different
formats (corresponding to the available SFImage definitions according to the VRML97
standard). This example uses an RGB image that has the same format as the output
from the VR to Video block. In the virtual world 3D file associated with the scene, you
can define only a trivial texture (in this case, a 4x4 pixel checkerboard) that gets resized
during simulation, according to the current size of the signal on the input. See the Plane
Manipulation Using Space Mouse MATLAB Object example.

Vehicle Dynamics Visualization with Video Output Example (vr_octavia_video)

The vr_octavia_video example illustrates how to use video output from the VR To
Video block. This model performs simple operations on the video output. It requires the
Computer Vision System Toolbox™ product.
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Inverted Pendulum Example (vrpend)

The vrpend example illustrates the various ways a dynamic model in the Simulink
interface can interact with a virtual reality scene. It is the model of a two-dimensional
inverted pendulum controlled by a PID controller. What distinguishes this model from
common inverted pendulum models are the methods for setting the set point. You
visualize and interact with a virtual world by using a Trajectory Graph and VR Sink
blocks. The Trajectory Graph block allows you to track the history of the pendulum
position and change the set point in three ways:

* Mouse — Click and drag a mouse pointer in the Trajectory Graph two-dimensional
window

+ Input Signal — External Trajectory Graph input in this model (driven by a random
number generator)

* VR Sensor — Activates the input from a VRML TouchSensor

When the pointing device in the virtual world viewer moves over an active TouchSensor
area, the cursor shape changes. The triggering logic in this model is set to apply the new
set point value with a left mouse button click.

Notice the pseudoorthographic view defined in the associated virtual world 3D file. You
achieve this effect by creating a viewpoint that is located far from the object of interest
with a very narrow view defined by the FieldOfView parameter. An orthographic view
is useful for eliminating the panoramic distortion that occurs when you are using a wide-
angle lens. The disadvantage of this technique is that locating the viewpoint at a distance
makes the standard viewer navigation tricky or difficult in some navigation modes, such
as the Examine mode. If you want to navigate around the virtual pendulum bench, you
should use some other viewpoint.

Solar System Example (vrplanets)

The vrplanets example shows the dynamic representation of the first four planets of
the solar system, Moon orbiting around Earth, and Sun itself. The model uses the real
properties of the celestial bodies. Only the relative planet sizes and the distance between
the Earth and the Moon are adjusted, to provide an interesting view.

Several viewpoints are defined in the virtual world, both static and attached to an
observer on Earth. You can see that the planet bodies are not represented as perfect
spheres. Using the Sphere graphic primitive, which is rendered this way, simplified the
model. If you want to make the planets more realistic, you could use the more complex
IndexedFaceSet node type.
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Mutual gravity accelerations of the bodies are computed using Simulink matrix-type data
support.

Plane Takeoff Example (vrikoff)

The vrtkoff example represents a simplified aircraft taking off from a runway. Several
viewpoints are defined in this model, both static and attached to the plane, allowing you
to see the takeoff from various perspectives.

The model shows the technique of combining several objects imported or obtained from
different sources (CAD packages, general 3-D modelers, and so on) into a virtual reality
scene. Usually it is necessary for you to wrap such imported objects with an additional
Transform node. This wrapper allows you to set appropriately the scaling, position,
and orientation of the objects to fit in the scene. In this example, the aircraft model
from the Ligos V-Realm Builder Object Library is incorporated into the scene. The file
vrtkoff2_wrl uses the same scene with a different type of aircraft.

Plane Take-Off with Trajectory Tracing Example (vrikoff_trace)

The vrtkoff_trace is a variant of the vrtkoff example that illustrates how to trace
the trajectory of a moving object (plane) in a scene. It uses a VR Tracer block. Using a
predefined sample time, this block allows you to place markers at the current position
of an object. When the simulation stops, the markers indicate the trajectory path of the
object. This example uses an octahedron as a marker.

Plane Take-Off with HUD Text Example (vrtkoff_hud)

The vrtkoff_hud example illustrates how to display signal values as text in the virtual
world and a simple Head-Up Display (HUD). It is a variant of the vrtkoff example.

The example sends the text to a virtual world using the VR Text Output block. This
block formats the input vector using the format string defined in its mask (see sprintf
for more information) and sends the resulting string to the "string” field of the
associated Text node in the scene.

The example achieves HUD behavior (maintaining constant relative position between
the user and the Text node) by defining a ProximitySensor. This sensor senses user
position and orientation as it navigates through the scene and routes this information to
the translation and rotation of the HUD object (in this case, a Transform that contains
the Text node).
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MATLAB Interface Examples

The following table lists the MATLAB interface examples provided with the software.
Descriptions of the examples follow the table. MATLAB interface examples display
virtual worlds in your default viewer. If your default is the Simulink 3D Animation
Viewer, some buttons are unavailable. In particular, the simulation buttons for
simulation and recording are unavailable.

Example Moving Morphing Text  |Recording vrml() Space

Objects Objects Function |Mouse
Use

vrcar X

vrheat X X

vrheat_anim X X X

vrmemb X X X

vrterrain_simple X

vrtkoff _spacemouse X X

Car in the Mountains Example (vrcar)

This example illustrates the use of the Simulink 3D Animation product with the
MATLAB interface. In a step-by-step tutorial, it shows commands for navigating a
virtual car along a path through the mountains.

1 Inthe MATLAB Command Window, type

vrcar

2 A tutorial script starts running. Follow the instructions in the MATLAB Command
Window.

Heat Transfer Example (vrheat)

This example illustrates the use of the Simulink 3D Animation product with the
MATLAB interface for manipulating complex objects.

In this example, matrix-type data is transferred between the MATLAB software and

a virtual reality world. Using this feature, you can achieve massive color changes or
morphing. This is useful for representing various physical processes. Precalculated data
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of time-based temperature distribution in an L-shaped metal block is used. The data is
then sent to the virtual world. This forms an animation with relatively large changes.

This is a step-by-step example. Shown are the following features:

* Reshaping the object

+ Applying the color palette to represent distributed parameters across an object shape
* Working with VRML or X3D text objects

* Animating a scene using the MATLAB interface

* Synchronization of multiple scene properties

At the end of this example, you can preserve the virtual world object in the MATLAB
workspace, then save the resulting scene to a corresponding virtual world 3D file or carry
out other subsequent operations on it.

Heat Transfer Visualization with 2-D Animation (vrheat_anim)

This example illustrates the use of the Simulink 3D Animation C interface to create 2-D
offline animation files.

You can control the offline animation recording mechanism by setting the relevant
vrwor ld and vrfigure object properties. You should use the Simulink 3D Animation
Viewer to record animations. However, direct control of the recording is also possible.

This example uses the heat distribution data from the vrheat example to create

an animation file. You can later distribute this animation file to be independently
viewed by others. For this kind of visualization, where the static geometry represented
by an IndexedFaceSet node is colored based on the simulation of some physical
phenomenon, it is suitable to create 2-D .avi animation files. The software uses a
MATLAB VideoWriter object to record 2-D animation exactly as it appears in the
viewer figure.

There are several methods you can use to record animations. In this example, we use
the scheduled recording. When scheduled recording is active, a time frame is recorded
into the animation file with each setting of the virtual world Time property. Recording
is completed when you set the scene time at the end or outside the predefined recording
interval.

When using the Simulink 3D Animation MATLAB interface, you set the scene time as
desired. This is typically from the point of view of the simulated phenomenon equidistant
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times. This is the most important difference from recording the animations for virtual
worlds that are associated with Simulink models, where scene time corresponds directly
to the Simulink time.

The scene time can represent any independent quantity along which you want to animate
the computed solution.

This is a step-by-step example. Shown are the following features:

* Recording 2-D offline animations using the MATLAB interface
* Applying the color palette to visualize distributed parameters across an object shape
* Animating a scene

* Playing the created 2-D animation file using the system AVI player

At the end of this example, the resulting file vrheat_anim.avi remains in the working
folder for later use.

Rotating Membrane with MATLAB Graphical Interface Example (vrmemb)

The vrmemb example shows how to use a 3-D graphic object generated from the MATLAB
environment with the Simulink 3D Animation product. The membrane was generated

by the logo function and saved in the VRML format using the standard vrml function.
You can save all Handle Graphics® objects this way and use them with the Simulink 3D
Animation software as components of associated virtual worlds.

After starting the example, you see a control panel with two sliders and three check
boxes. Use the sliders to rotate and zoom the membrane while you use the check boxes to
determine the axis to rotate around.

In the virtual scene, notice the text object. It is a child of the Bi I Iboard node. You can
configure this node so that its local z-axis turns to point to the viewer at all times. This
can be useful for modeling virtual control panels and head-up displays (HUDs).

Terrain Visualization Example (vrterrain_simple)

This example illustrates converting available Digital Elevation Models into the VRML
format, for use in virtual reality scenes.

As a source of terrain data, the South San Francisco DEM model (included in the

Mapping Toolbox™ software) has been used. A simple Boeing® 747" model is included in
the scene to show the technique of creating virtual worlds from several sources on-the-fly.
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This example requires the Mapping Toolbox software from MathWorks®.
Plane Manipulation Using Space Mouse MATLAB Object

This example illustrates how to use a space mouse using the MATLAB interface. After

you start this example, a virtual world with an aircraft is displayed in the Simulink 3D
Animation Viewer. You can navigate the plane in the scene using a space mouse input

device. Press button 1 to place a marker at the current plane position.

This example requires a space mouse or compatible device.

Related Examples
. “Link to Models”
. “MATLAB Interaction”
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The Simulink 3D Animation product provides the files you need for installation on both

your host computer and client computer.

“Set the Default Editor” on page 2-2

“Set the Default Viewer” on page 2-5

“Set Simulink 3D Animation Preferences” on page 2-9
“Install V-Realm Editor on Host Computer” on page 2-20
“V-Realm Builder Help” on page 2-22

“Uninstall V-Realm Builder” on page 2-23

“Test the Viewer Installation” on page 2-24
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Set the Default Editor

In this section...

“Use Preferences to Set the Default Editor” on page 2-2
“Use MATLAB Commands to Set the Default Editor” on page 2-3

Tip: The Simulink 3D Animation product includes the 3D World Editor for editing virtual
worlds. You can use the 3D World Editor on all supported platforms for Simulink 3D
Animation. The 3D World Editor is the default editor. For a comparison of editors, see
“Virtual World Editors” on page 5-2.

You can change your environment to use another editor. You can use the MATLAB
Preferences menu or the MATLAB command line.

Use Preferences to Set the Default Editor

To determine which virtual world editor is set up as the editor in your environment:

1 From the MATLAB Toolstrip, in the Home tab, in the Environment section, select
Preferences > Simulink 3D Animation.

2 In the Simulink 3D Animation Preferences dialog box, examine the 3D World
Editor preference.
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4\ Preferences o || =] g2

————
Colors Simulink 3D Animation Preferences

Command History . :

Command Window Default Viewer: internal -
Comparson Default Editor: Built-in 3D World Editor ~
Current Folder

Editor/Debugger

Figure Copy Template WRML/X3D data types representation in MATLAB

Fonts .

Bool: logical hd
General
GUIDE Int32: double hd
Help Float: double w7
Keyboard

Toolbars Communication

Variables HTTP Port: 8123

Web
Workspace
Simulink Transport Buffer: 5
Computer Vision System Toolbox
D3P Systern Toolbox
Image Acquisition Toolbox

m

VR Port: 8124

Transport Timeout: 20

Image Processing Toolbox
Parallel Computing Toolbox
Simscape
Simulink 3D Animation
30 World Editor
Canvas
Figure
World - . o

’ oK l | Cancel | | Apply | | Help |

You can use the 3D Word Editor preference to select another editor: the V-Realm
Builder, the MATLAB editor, or a third-party virtual world editor or text editor. To use a
third-party editor, select the Custom option. In the text box that appears, enter the path
to the editor.

Use MATLAB Commands to Set the Default Editor

1 To determine which editor is installed, at the MATLAB command prompt, type:

vrgetpref("Editor"™)
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2 The default is the 3D World Editor (*BUILTIN). To change the editor, use the
vrsetpref command, specifying the editor that you want. For example, to change to
the V-Realm editor, type:
vrsetpref("Editor®, "*VREALM®)

3 To open a file in the V-Realm editor, in MATLAB navigate to a virtual world file,
right-click, and select Edit.
Note: The vredit command opens the 3D World Editor, regardless of the default
editor preference setting.

See Also

Functions

vredit | vrgetpref | vrsetpref

Related Examples

“Set Simulink 3D Animation Preferences” on page 2-9
“Install V-Realm Editor on Host Computer” on page 2-20
“Simulink 3D Animation Product Description” on page 1-2
“Set the Default Viewer” on page 2-5
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Set the Default Viewer

If you have an HTML5-enabled web browser, you can view virtual worlds with either the
default Simulink 3D Animation Viewer or your web browser. You determine the viewer
for displaying your scene using the vrsetpref and vrgetpref commands.

This procedure assumes that you are working with a PC platform.

1  When you install Simulink 3D Animation, the Simulink 3D Animation viewer is the
default viewer. If you are not sure whether the default has been changed, you can

determine your default viewer by typing:
vrgetpref
The MATLAB Command Window displays

ans =

DataTypeBool :

DataTypelnt32:

DataTypeFloat:
DefaultCanvasNavPanel :
DefaultCanvasUnits:
DefaultEditorPosition:
DefaultEditorTriad:
DefaultFigureAntialiasing:
DefaultFigureCaptureFileFormat:
DefaultFigureCaptureFileName:
DefaultFigureDeleteFcn:
DefaultFigurelLighting:
DefaultFigureMaxTextureSize:
DefaultFigureNavPanel:
DefaultFigureNavZones:
DefaultFigurePosition:
DefaultFigureRecord2DCompressMethod:
DefaultFigureRecord2DCompressQuality:
DefaultFigureRecord2DFileName:
DefaultFigureRecord2DFPS:
DefaultFigureStatusBar:
DefaultFigureTextures:
DefaultFigureToolBar:
DefaultFigureTooltips:
DefaultFigureTransparency:
DefaultFigureTriad:

"logical”
"double”
"double”
"opaque”
"normalized”
[822 123 661
"bottomleft”
“on"

“tif"
"%F_anim_%n.tif"

703]

“on®
"auto”

"halfbar*

"off"

[5 92 576 380]
"auto”

75
"%F_anim_%n.avi®
15
“on
“on®
“on®
“on®
“on®
“none”
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DefaultFigureWireframe:
DefaultViewer:
DefaultWorldRecord3DFileName:
DefaultWorldRecordMode:
DefaultWorldRecordInterval:
DefaultWorlldRemoteView:
DefaultWorldTimeSource:
Editor:
EditorPreservelLayout:
EditorSavePosition:
HttpPort:

TransportBuffer:
TransportTimeout:

VrPort:

The DefaultViewer property is set to "internal *.

"off"
"internal”
"%F _anim_%n.%e"
"manual "
[0 0]

"off"
"external”
"*BUILTIN"
"off"

“on"

8123

5

20

8124

The Simulink 3D Animation

Viewer is the default viewer for viewing virtual worlds. Any virtual worlds that you open

are displayed in the viewer.

1  For example, at the MATLAB command prompt, type

vrplanets

The Planets example is loaded and the virtual world is displayed in the Simulink 3D

Animation Viewer.
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& Planets =R B =
File View | Viewpoints | Navigation Rendering Simulation Recording  Help E
| View from top > | Fly '_4-' a2 da B o N

2 To view the virtual world through the web browser, from the MATLAB command
prompt, use the view and vrview commands.

3 Reset the Simulink 3D Animation Viewer as your default viewer by typing:

vrsetpref("DefaultViewer®, "factory™)

Alternatively, you can use the MATLAB File menu Preferences dialog box. See “Set
Simulink 3D Animation Preferences” on page 2-9.)

See Also

Functions
vrgetpref | vrsetpref
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Related Examples

“Set Simulink 3D Animation Preferences” on page 2-9
“Install V-Realm Editor on Host Computer” on page 2-20
“Test the Viewer Installation” on page 2-24

“Simulink 3D Animation Product Description” on page 1-2
“Set the Default Editor” on page 2-2



Set Simulink 3D Animation Preferences

Set Simulink 3D Animation Preferences

In this section...

“Simulink 3D Animation Preferences Dialog Box” on page 2-11
“3D World Editor Preferences Dialog Box” on page 2-12
“Canvas Preferences Dialog Box” on page 2-14

“Figure Appearance Preferences Dialog Box” on page 2-14
“Figure Rendering Preferences Dialog Box” on page 2-15
“Figure 2-D Recording Preferences Dialog Box” on page 2-17
“Figure Frame Capture Preferences” on page 2-18

“World Preferences Dialog Box” on page 2-18

The Simulink 3D Animation software opens with default preference settings. You can
change these settings so that the next time you open a Simulink 3D Animation interface,
such as the 3D World Editor, the associated preferences take effect. Use one of these
approaches:

*  From the MATLAB Toolstrip, in the Home tab, in the Environment section, select
Preferences > Simulink 3D Animation.
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A\ Preferences E\@

LUUE ATy LET

* | Simulink 30 Animation Preferences
----- Toolbars
""" Command Window Default VRML viewer. internal =
----- Command History - -
#)-Editor/Debugger | VRML Editor: ' Built-in 3D World Editor -
..... Help n g
----- ‘Web

VRML data types representation in MATLAB
----- Variable Editor

Bool: logical -
----- Workspace o : o9 -
..... GUIDE Int32: | double ]
----- Time Series Tools Float: " double =

[-Figure Copy Template

""" Compiler Communication

----- Report Generator

----- SystemTest Ll 8123
----- Bioinformatics Tools VR Port: 8124
----- Computer Vision System Toolbo: 3 Transport Buffer: 5

----- Database Toolbox
..... DSP System Toolbox Transport Timeout: 20
----- Image Acquisition
----- Image Processing

----- Instrurnent Centrol
----- System Objects

----- Simulink

----- Simscape

[BRSimulink 30 Animation

| ok || cancd || Appy || Hel

+ At the MATLAB command line, use these functions:

Tip: The preferences dialog box shows a subset of the preferences that you can set using
MATLAB functions.

2-10



Set Simulink 3D Animation Preferences

Simulink 3D Animation Preferences Dialog Box

The top dialog box is for general Simulink 3D Animation preferences.

Preference

Value

Description

Default Viewer

internal |web

Default: "internal "

Specifies which viewer is used to view a virtual
world. The default Simulink 3D Animation Viewer
is used when the preference is set to internal.
The web browser is used when this preference 1s set
to web.

Default Editor

Built-in 3D World
Editor| V-Realm
Builder | MATLAB
Editor | Custom

Specifies which virtual world editor to use. Path to
the virtual world editor. If this path is empty, the
MATLAB editor is used.

The path setting is active only if you select the
Custom option.

To open a virtual world file in a third-party editor,
do not use the vredit command. For example, to
open a virtual world in the Ligos V-Realm Builder
editor:

1 Set the default editor to V-Realm Builder. In
MATLAB, enter:

vrsetpref("Editor®, "*VREALM");

2 To open a file in the V-Realm editor, in
MATLAB navigate to a virtual world file, right-
click, and select Edit.

Note: The vredit command opens the 3D
World Editor, regardless of the default editor
preference setting.

Bool

logical | char

Default: logical

Specifies the handling of the virtual world Bool
data type for virnode/setfield and vrnode/
getfield. If set to logical, the virtual world
Bool data type is returned as a logical value. If set

2-11



2 Installation

Preference Valve Description
to char, the Bool data type is returned "on" or
Toff-.
Int32 int32 | double Specifies handling of the virtual world 1nt32
data type for vrnode/setfield and vrnode/
Default: double getfield. If set to int32, the virtual world Int32
data type is returned as " int32". If set to double,
the Int32 data type is returned as "double”.
Float "single” | Specifies the handling of the virtual world fFloat
"double* data type for vrnode/setfield and vrnode/
getfield. If set to single, the virtual world
Default: "double* Float and Color data types are returned as
"single”. If set to double, the Float and Color
data types are returned as "double”.
HTTP Port Numeric IP port number used to access the Simulink 3D
Animation server over the web via HTTP. If you
Default: 8123 change this preference, restart the MATLAB
software before the change takes effect.
VR Port Numeric IP port used for communication between the

Default: 8124

Simulink 3D Animation server and its clients. If
you change this preference, restart the MATLAB
software before the change takes effect.

Transport Buffer |Numeric Length of the transport buffer (network packet
overlay) for communication between the Simulink
Default: 5 3D Animation server and its clients.
Transport Timeout | Numeric Amount of time, in seconds, that the Simulink 3D
Animation server waits for a reply from the client.
Default: 20

If there is no response from the client, the Simulink
3D Animation server disconnects from the client.

3D World Editor Preferences Dialog Box

The Simulink 3D Animation preferences include the following preferences for the 3D
World Editor.
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Property Value Description

Position Specify the pixel location for the Specifies the default location
lower-left corner, the width, and |for the 3D World Editor. If you
the height (for example, [96 120 |select Save position on exit, the
862 960] default position changes to the

position of the 3D World Editor

Default: Depends on current used when you last exited it.
screen resolution

Triad none] top left | top right |Specifies where in the virtual

| bottom left | bottom
right | center

Default: "bottom left*

world display pane to locate a
triad of coordinate axes.

View pane mouse
behavior

navigate | select

Default: navigate

Specifies whether the mouse in the
view pane is in navigation mode

or selection mode (for highlighting
corresponding nodes in the tree
view pane).

Save position on exit

off | on

Default: on

Causes the 3D World Editor to
open in the same location where
the editor was when you last
exited it.

Preserve Layout per
Virtual Reality 3D File

off | on

Default: on

Specifies whether the 3D World
Editor starts up either with the
default virtual world display
layout or with the layout as it was
when you exited it previously. The
saved layout includes settings for
the view, viewpoints, navigation,
and rendering. Simulink 3D
Animation saves the layout in a
separate virtual world 3D file for
up to eight files.

Highlight selected
objects

off | on

Default: on

Specifies whether to highlight
virtual world objects selected in
the view pane.
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Canvas Preferences Dialog Box

The Simulink 3D Animation preferences include a Navigation panel preference. The
canvas preferences apply to the 3D World Editor, Simulink 3D Animation Viewer, and
Simulink 3D Animation Web Viewer.

Property

Value

Description

Navigation panel

none | minimized
| translucent | opaque

Default: none

Controls the appearance of the
navigation panel in the canvas.

Figure Appearance Preferences Dialog Box

The figure appearance preferences apply to the 3D World Editor and Simulink 3D
Animation Viewer. Some of these preferences also apply to Simulink 3D Animation Web

Viewer.
Property Valve Description
Toolbar on | off Specifies whether the toolbar is
displayed.
Default: on
Tooltips off | on Specifies whether tooltips are
displayed.
Default: on
Status bar off | on Specifies whether status bar is
displayed.
Default: on
Also applies to the Simulink 3D
Animation Web Viewer.
Navigation zones off | on Specifies whether navigation
zones are displayed.
Default: on
Also applies to the Simulink 3D
Animation Web Viewer.
Navigation panel none | minimized Controls the appearance of the
| translucent | opaque navigation panel in the canvas.
Default: none
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Property Valve Description

Triad none | top left | top Specifies where in the virtual
right | bottom left | world display pane to locate a
bottom right | center triad of coordinate axes.
Default: bottom left

Position Matrix with upper-right and Specifies the default location of

lower-left corner position.

Default: [6 92 576 380]

the figure window.

Figure Rendering Preferences Dialog Box

The figure rendering preferences specify how virtual worlds are displayed.

Property Value Description
Antialiasing on | off Determines whether
antialiasing is used when
Default: on rendering scene. Antialiasing
smooths textures by
interpolating values between
texture points.
Lighting off | on Specifies whether the lighting is
considered when rendering. If it
Default: on 1s off, all the objects are drawn
as if uniformly lit.
Sound off | on If a virtual world contains a
Sound node and your computer
Default: on supports sound, then you can
listen to the sound in a virtual
world.
Stereo 3D off | anaglyphactive Specifies whether to use

Default: off

stereoscopic 3D vision.

For anaglyph viewing, use
red/cyan 3D glasses. Viewing
a virtual world in this mode
causes the colors to appear as
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Property

Value

Description

almost grayscale. This approach
does not require any special
computer hardware or software.

For active stereo viewing, use
active shutter 3D glasses. This
approach preserves color effects
and produces more powerful 3D
effects. Active stereo requires a
specially configured computer
and monitor setup.

Stereo 3D Camera Offset

Numeric

Default: 0.1

Specifies the distance between
the two points of view (cameras)
that produce the 3D effect. The
higher the offset, the further
apart the cameras are, and thus
the deeper the 3D effect.

Stereo 3D Horizontal Image
Translation

Numeric value from 0 through
1, inclusive. The larger the
value, the further back the
background appears to be.

The horizontal relationship

of the two stereo images. By
default, the background image
is at zero and the foreground
image appears to pop out from

Default: O the monitor toward the person
viewing the virtual world.
Transparency off | on Specifies whether transparency
information is considered when
Default: on render]‘_ng‘
Wireframe off | on Specifies whether objects are
drawn as solids or wireframes.
Default: off
Textures off | "on" Turns texture rendering on or
off.
Default: on
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Property

Value

Description

Maximum texture size

auto | 32 <=x <=video card
limit, where X is a power of 2
(video card limit is typically
1024 or 2048)

Sets the maximum pixel size
of a texture used in rendering
vrfigure objects. The smaller
the size, the faster the texture
can render. Increasing this
value improves image quality
but decreases performance.

A value of "auto” sets the
maximum pixel size. If the
value you enter is unsuitable,
a warning can trigger. The
software then automatically
adjusts the property to the next
smaller suitable value.

Figure 2-D Recording Preferences Dialog Box

Property

Value

Description

2-D animated file name

Character vector

Default: "%F_anim_%n.avi”

Specifies the 2-D offline
animation file name. The name
can contain tokens that are
replaced by the corresponding
information when the animation
recording takes place. For
further details, see “File Name
Tokens” on page 4-15.

Recording compression
method

| auto | lossless |
codec_code

Default: auto

Specifies the compression
method for creating 2-D
animation files. The codec
code must be registered

in the system. See the
MATLAB documentation for
VideoWriter.

Recording compression
quality

Integer 0—-100.

Default: 75

Specifies the default quality of 2-
D animation file compression for
new Vrfigure objects.
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Property Valve Description
Frames per second Numeric Specifies the default frames per
second playback speed.
Default: 15

Figure Frame Capture Preferences

Default: "%f _anim %n.tif"

Property Valve Description
CaptureFileFormat tif | png Specifies file format for a
captured frame file.
Default: tif
CaptureFileName Character vector Specifies the frame capture file

name. The name can contain
tokens that are replaced by the
corresponding information when
the animation recording takes
place. For further details, see
“Define File Name Tokens” on
page 4-13.

World Preferences Dialog Box

Property

Value

Description

3-D animated file name

character vector

Default: "%f_anim_%n.%e"

3-D animation file name.

The name can contain tokens
that are replaced by the
corresponding information when
the animation recording takes
place. For details, see “Define
File Name Tokens” on page
4-13.

Recording mode

manual | scheduled

Default: manual

Animation recording mode.

Recording interval

2-18

Vector of two doubles

Default: [0 0]

Start and stop times for
scheduled animation recording.




Set Simulink 3D Animation Preferences

Property Value Description
Corresponds to the virtual world
object Time property.

Time source external | freerun Source of the time for the virtual

Default: external

world. If set to external,
time in the scene is controlled
from the MATLAB software
(by setting the Time property)
or the Simulink software
(simulation time). If set to
freerun, time in the scene
advances independently based
on the system timer.

Allowing viewing from the |off | on

Internet
Default: ofF

Remote access flag. If the
virtual world is enabled for
remote viewing, it is set to on;
otherwise, it is set to ofF.

Create or update world off | on Specify whether create world
thumbnail file when world thumbnails when you open a
is opened Default: off virtual world.

See Also

Functions

vrgetpref | vrsetpref

Related Examples
. “Set the Default Editor” on page 2-2
. “Set the Default Viewer” on page 2-5
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Install V-Realm Editor on Host Computer

2-20

Tip: The Simulink 3D Animation product includes the 3D World Editor for editing virtual
worlds. You can use the 3D World Editor on all supported platforms for Simulink 3D
Animation. The 3D World Editor is the default editor. For a comparison of editors, see
“Virtual World Editors” on page 5-2.

V-Realm Editor Installation on Windows Platforms

When you install the Simulink 3D Animation product, files are copied to your hard drive
for the Ligos V-Realm Builder, which is an optional virtual world editor available on
Windows platforms. However, the installation is not complete.

Installing the virtual world editor writes a key to the Microsoft® Windows registry,
making extra V-Realm Builder library files available for you to use. The installation
associates the Edit button in Simulink 3D Animation blocks with this editor:

From your desktop, right-click the MATLAB icon and select Run as administrator.
2 Inthe MATLAB Command Window, type

vrinstall -install

or type

vrinstall("-install™)

The MATLAB Command Window displays the following messages:

Starting editor installation...
Done.

3 Type

vrinstall

If the editor installation was successful, the MATLAB Command Window displays
this message:

Virtual World editor: installed
4 Exit MATLAB and restart MATLAB.



Install V-Realm Editor on Host Computer

5 Set the default editor to V-Realm Builder. In MATLAB, enter:

vrsetpref("Editor®, "*VREALM");

6 To open a file in the V-Realm editor, in MATLAB navigate to a virtual world file,
right-click, and select Edit.

Note: The vredit command opens the 3D World Editor, regardless of the default
editor preference setting.

See Also

Functions
vrgetpref | vrinstall | vrsetpref

Related Examples

. “Uninstall V-Realm Builder” on page 2-23
. “Test the Viewer Installation” on page 2-24
. “V-Realm Builder Help” on page 2-22
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V-Realm Builder Help

Note: You cannot access the V-Realm Builder documentation from the web. If you are

reading this page on the web, then open the MATLAB Help browser and navigate to the
V-Realm Builder documentation.

To access V-Realm Builder help from the MATLAB Help browser, click V-Realm Builder
help.

You can view the V-Realm Builder help even if you have not installed V-Realm Builder.

Related Examples

. “Install V-Realm Editor on Host Computer” on page 2-20
. “Uninstall V-Realm Builder” on page 2-23
. “Test the Viewer Installation” on page 2-24

2-22



Uninstall V-Realm Builder

Uninstall V-Realm Builder

Use the MathWorks uninstaller. Running this utility removes the Simulink 3D
Animation and Ligos V-Realm Builder software from your system. It also restores your
previous system configuration.

1 On the Windows task bar, click Start, point to MATLAB, and then click the
uninstaller.

The MathWorks uninstaller begins running.
2 Select the Simulink 3D Animation check box.

3 Follow the remaining uninstall instructions.

See Also

Functions
vrinstall

Related Examples

. “Install V-Realm Editor on Host Computer” on page 2-20
. “Uninstall V-Realm Builder” on page 2-23
. “V-Realm Builder Help” on page 2-22
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Test the Viewer Installation

2-24

In this section...

“Section Overview” on page 2-24
“Simulink Testing” on page 2-24
“MATLAB Testing” on page 2-29

Section Overview

The Simulink 3D Animation product includes several Simulink models with the
associated virtual worlds. These models are examples of what you can do with this
software. You can use one of these examples to test the installation of the virtual world
viewer.

Simulink Testing

Before you can run this example, install the MATLAB, Simulink, and Simulink 3D
Animation products as follows:

1 Inthe MATLAB Command Window, type

vrpend

A Simulink window opens with the model for an inverted pendulum. This model,
which you can view in three dimensions with the software, has an interactive set
point and trajectory graph.



Test the Viewer Installation

#ﬁ vrpend EI@

File Edit View Display Diagram Simulation Analysis Code Tools Help

157} = y P
-8 S @2 40Pk @ » (D | ~
vrpend

® |[Pa|vrpend »
&y - -
IE' | Marker ¥Z Pendulum XYZ ¥ Pendulum.translation
— | Pendulim X2 Marker XYZ 3D angle 1 - Folet rptation
5 &1
Coordinates 20 #{ 20 angle
tre SEbSvstam 3D angle 2| — - Pole rotation
ActiveVariantBlodk="" m—
,‘mf:fmm P Markeriranslstion
v VR Sink
. FID
Pasition
4 2Z-dimensional
Position Force
Controller Angle
Pendulum 20 m - @
FID Random Trajectory
Number Graph
Z-dimens ional
Angle
Controller

The Simulink 3D Animation Viewer opens with a 3-D model of the pendulum.
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File View Recording  Help L]

P

gal
Pseudo orthographic view vl Examine ']J Ll | B = | addq | . | | o] | » .

Pseudo orthographic view

2 In the Simulink 3D Animation Viewer, from the Simulation menu, click Run. A
Trajectory Graph window opens, and a simulation starts running.
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-} Trajectory Graph O
Trajectory Graph
1O T T T
St J
e
= @ .
>
51 p
-0 ! ! L
-10 -5 0 5 10
X Axis

3 In the Simulink 3D Animation Viewer, point to a position on the blue surface and
left-click.

The pendulum set point, represented by the green cone, moves to a new location.
Next, the path is drawn on the trajectory graph, and then the pendulum itself moves
to the new location.

In the Simulink 3D Animation Viewer, you see the animated movement of the
pendulum. Use the viewer controls to navigate through the virtual world, change
the viewpoints, and move the set point. For more information about using the
Simulink 3D Animation Viewer controls, see “Simulink 3D Animation Viewer” on

page 7-5.
4  In the Simulink window, double-click the Trajectory Graph block.

The Block Parameters: Trajectory Graph dialog box opens.
5 From the Stipend mode list, choose Mouse, then click OK.
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E! Block Parameters: Trajectory Graph

2=

— Trajectory scope. [mask)]

Trajectory scope using MATLAE graph window. Enter plotting ranges.

—Parameter
HmiF:
|10
WeME:
J1o
y-mir:
|10
JEDS
J1o
Sample time:
Joz

Setpoint mode I WH zenzar

Input signal
VR sensar

[ Ok | Cancel | Help | Bpply

You can now use the trajectory graph as a 2-D input device to set the position of the

pendulum.

Move the mouse pointer into the graph area and click.

The set point (red circle) for the pendulum position moves to a new location.

In the Simulink window, from the Simulation menu, click Stop.

The trajectory for the pendulum is displayed in the graph as a blue line.
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Sl=IE

Trajectory Graph
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L=

TS 5 0 5 10

8 Close the Simulink 3D Animation Viewer and close the Simulink window.

You can try other examples in “Simulink Interface Examples” on page 1-22, or you can
start working on your own projects.

MATLAB Testing

This model, which can be viewed in three dimensions with the software, has a MATLAB
interface to control the figure in a virtual world viewer window.

Additional examples are listed in the table “MATLAB Interface Examples” on page 1-34.
1 In the MATLAB window, type
vrmemb

The MATLAB interface displays the following messages:

View the published version of this example to learn more about
vrmemb.m™.

The Simulink 3D Animation Viewer opens with a 3-D model.
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B VRML MATLAB Membrane felle =
File View Viewpoints Mavigation Rendering Simulation Recording Help L]
Original view v Bamine v J P |4 D d | e

Pos:[-193.40 -265.15 220.48] Dir:[0.48 0.67 -0.56]

2 Use the viewer controls to move within the virtual world, or use the example dialog
box to rotate the membrane. Sometimes the Simulink 3D Animation example dialog
box is hidden behind the viewer window.

Sicix
= Ratation <] | o

[
¥z Zaom ﬂ |>|

See Also

Functions
vrinstall
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Related Examples

. “Set the Default Editor” on page 2-2
. “Set the Default Viewer” on page 2-5

“Set Simulink 3D Animation Preferences” on page 2-9

“Install V-Realm Editor on Host Computer” on page 2-20
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Simulink Interface

The Simulink 3D Animation product works with both the MATLAB and the Simulink
products. However, the Simulink interface is the preferred way of working with the
software. It is more straightforward to use and all the features are easily accessible

through a graphical interface.

“Virtual World Connection to a Model” on page 3-2

“Open a Viewer Window” on page 3-11

“Display Virtual World and Start Simulation” on page 3-12
“View Virtual World on Host Computer” on page 3-15

“View Virtual World Remotely” on page 3-19

“Add Sensors to Virtual Worlds” on page 3-25

“Modify Remote Virtual World Via Sensor Events” on page 3-26
“Read Sensor Values” on page 3-27

“VR Source Block Input to Simulink Models” on page 3-29
“Interact with Generated Code” on page 3-30
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Virtual World Connection to a Model

3-2

In this section...

“Add a Simulink 3D Animation Block” on page 3-2
“Change the Virtual World Associated with a Simulink Block” on page 3-8

Add a Simulink 3D Animation Block

To visualize a dynamic system simulation, connect a Simulink block diagram to a virtual
world. The example in this section explains how to display a simulated virtual world on a
host computer. This approach is the recommended way to view associated virtual worlds

on the host computer.

Simulating a Simulink model generates signal data for a dynamic system. By connecting
the Simulink model to a virtual world, you can use this data to control and animate the
virtual world.

After you create a virtual world and a Simulink model, you can connect the two with
Simulink 3D Animation blocks. The example in this procedure simulates a plane taking
off and lets you view it in a virtual world.

Note The examples in this topic are based on the Simulink 3D Animation default viewer.

1 Inthe MATLAB Command Window, type

vrtut2

A Simulink model opens without a Simulink 3D Animation block that connects the
model to a virtual world.



Virtual World Connection to a Model
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From the Simulation menu, select Mode > Normal, then click Simulation > Run.

Observe the results of the simulation in the scope windows.
In the MATLAB Command Window, type

vrlib

The Simulink 3D Animation library opens.

From the Library window, drag and drop the VR Sink block to the Simulink
diagram. The VR Sink block writes data from the Simulink model to the virtual
world. You can then close the Library: vrlib window.

Now you are ready to select a virtual world for the visualization of your simulation.

A simple virtual world with a runway and a plane is in the virtual world 3D file
vrtkoff.wrl, located in the vrdemos folder.

In the Simulink model, double-click the block labeled VR Sink.

The Parameters: VR Sink dialog box opens.
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) Parameters: ¥R Sink =] 3

~WR Sink

‘Writes Simulink values ko virbual world node fields, Fields to be written are marked by
checkboxes in the tree view, Every marked field corresponds to an input port of the block,

—World propertie: ~VRML Tree

5 fil
ource file [V Show node bypes v Show field types

Browse |
P Mo world loaded

| 3 Mo world Filename specified,

Wiew | Mew | Reload

~Outpuk

[~ Open YRML Viewer automatically

[~ allows viewing From the Internet

Description:

~Block propertie:

Sample time (-1 for inherit):

jo.1

[ show video cutput port

‘Wideo output signal dimensions:

Set up and preview videa output

Apply |

6 In the Description text box, enter a brief description of the model. This description
appears on the list of available worlds served by the Simulink 3D Animation server.
For example, type
VR Plane taking off

7 At the Source File text box, click the Browse button. The Select World dialog box
opens. Find the folder matlabroot\toolbox\sl3d\sl3ddemos. Select the file
vrtkoff.wrl and click Open.

8 Select the Open Viewer automatically parameter.

9 In the Parameters: VR Sink dialog box, click Apply.

A virtualscene tree appears on the right side, showing the structure of the associated
virtual reality scene.

10 On the left of the Plane (Transform) node, click the + square.
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11

The Plane Transform tree expands. Now you can see what characteristics of the
plane can be driven from the Simulink interface. This model computes the position

and the pitch of the plane.

In the Plane (Transform) tree, select the translation and rotation fields.

The selected fields are marked with checks. These fields represent the position
(translation) and the pitch (rotation) of the plane.

) Parameters: ¥R Sink o =] e}
VR Sink
Wites Simulink values to virual world node fields, Fields to be writken are marked by
checkbaxes in the tree view. Every marked Field corresponds o an input port af the block.
~World propertie ~WRML Tree
RS s [¥ show node types  [v Show Figld types
vrthkoff, vl Browise | -
[+~ ® {MavigationInfo) ;I
Wiew | Edit | Reload | {Background)
(Directionallight)
~Output {Directionallight)
(TransForm)
[~ Open YRML Wiewer automatically (TransFarm)
(Wiewpoint)
v Allow viewing Frorm the Internet Cameral (TransForm)
Plane (Transform)
Description: X addChidren {MFMode)
IVR Plane Take-0ff - ¥ removeChildren (MPAMode)
D center (SFYec3f)
-~ [#] rotation (SFRotation)
At pr.opertus _ . D scale (SFYec3f)
Sample time (-1 for iherit): [ scaleCrientation (SFRatation)
Jo.1 rans
~[] bboxCerter (SFYecF)
™ Show video output port [ bboxsize (sFveca)
Video output signal dimensions: - B children (MFNode) b
[~ ® (Shape)
I [#- b Block {Transform)
Set up and preview) video output B ¢ (Shape) LI
[e]4 Cancel Help | Apply |

12 Click OK.

In the Simulink diagram, the VR Sink block is updated with two inputs.

Flane. mtation

Flane tmnslkation

WH Sink

3-5



3 Simulink Interface
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14

3-6

The first input is Plane rotation. Define the rotation with a four-element vector. The
first three numbers define the axis of rotation. In this example, it is [1 0 0] for the
x-axis (see the Pitch Axis of Rotation block in the model). The pitch of the plane is
expressed by the rotation about the x-axis. The last number is the rotation angle
around the x-axis, in radians.

In the Simulink model, connect the line going to the Scope block labeled Display
Pitch to the Plane rotation input.

The second input is Plane translation. This input describes the position of the plane
in the virtual world. This position consists of three coordinates, x, y, z. The connected
vector must have three values. In this example, the runway is in the x-z plane (see
the VR Signal Expander block). The y-axis defines the altitude of the plane.

In the Simulink model, connect the line going to the Scope block labeled Display
Position to the Plane translation input.

After you connect the signals and remove the Scope blocks, your model looks similar
to the figure shown.

|| vrtut2

5

Takeoff Lift qdot —D‘
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.—bssw L é/_/_,—-—"
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Ground ! Lift HeZe
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@ » Fx Pitch Axds of Rotation
Fic L P j— 9 _" Pland rotaticn
Plane translation

by

Flane Weight Ground %::
Compersation | VR
3
Uw —D- VR Signal Expander
@ N A »lu
2
o= |V ssefrfS]
Filot Input

Equstions of Mation
{Body Axes)

Note Virtual world degrees of freedom have different requested input vector

sizes depending on the associated virtual world field types. If the vector size of

the connected signal does not match the associated virtual world field size, an
Incorrect input vector size error is reported when you start the simulation.
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15

16

Double-click the VR Sink block in the Simulink model. Select the View button. A
viewer window containing the virtual world of the plane opens.

Bl VR Plane Take-Off [ ==
File View Viewpoints MNavigati Renderi Simulati Recording  Help L]
[Airpor‘t vIFI},r ']JP|,§,9|QTQ_|.||3|’.

Note: When you next open the model, the associated virtual scene opens
automatically. This behavior occurs even if the Simulink 3D Animation block
associated with the virtual scene is in a subsystem of the model.

In the Simulink 3D Animation Viewer, from the Simulation menu, click Run to run
the simulation.

A plane, moving right to left, starts down the runway and takes off into the air.
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3-8

Bl VR Plane Take-Off [ ==
File View Viewpoints Mavigati Renderi Simulati Recording  Help L]
[Airpor‘t vIFI},r ']JP|,§,9|QTQ_|.||3|’.

Change the Virtual World Associated with a Simulink Block

You can associate a different virtual world with a Simulink model or connect different
signals.

After you associate a virtual world with a Simulink model, you can select another virtual
world or change signals connected to the virtual world. This procedure assumes that you
have connected the vrtut2 Simulink model with a virtual world. See “Add a Simulink
3D Animation Block” on page 3-2.

1  Double-click the VR Sink block in the model. The viewer opens.

2 Select the Simulation menu Block Parameters option. The Parameters: VR Sink
dialog box opens.

3 At the Source File text box, click the Browse button. The Select World dialog box
opens. Find the folder matlabroot\toolbox\sl3d\sl3ddemos. Select the file
vrtkoff2._wrl, and click Open.

4 In the Parameters: VR Sink dialog box, click Apply.



Virtual World Connection to a Model

A virtual scene tree appears on the right side. The Simulink software associates a
new virtual world with the model.

5 On the left of the Plane (Transform) node, click the + square.

The Plane Transform tree expands. Now you can see what characteristics of the
plane you can drive from the Simulink interface. This model computes the position.

6 Inthe Plane Transform tree, select the translation field check box. Clear the
rotation field check box. Click OK.

The VR Sink block is updated and changes to just one input, the Plane translation.
The Virtual Reality block is ready to use with the new parameters defined.

7 Verify that the correct output is connected to your VR Sink block. The output from
the VR Signal Expander is connected to the single input.
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8 In the Simulink 3D Animation Viewer, from the Simulation menu, run the
simulation again and observe the simulation.

See Also

Functions
vredit | vrjoystick | vrlib | vrspacemouse

Blocks
Joystick Input | Space Mouse Input | VR Sink | VR Source | VR Text Output
| VR To Video | VR Tracer
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Related Examples

“Add Sensors to Virtual Worlds” on page 3-25

“VR Source Block Input to Simulink Models” on page 3-29
“Interact with Generated Code” on page 3-30

“Link to Models”

“Interact with Virtual Reality Worlds”



Open a Viewer Window

Open a Viewer Window

When you simulate a model that contains a VR Sink block, your default viewer opens and
displays the virtual scene. For more information on setting your default viewer, see “Set
the Default Viewer” on page 2-5.

Multiple instances of the viewer can exist on your screen. A viewer appears each time
you select the File menu New Window option in the Simulink 3D Animation Viewer.
This feature is useful if you want to view one scene from many different viewpoints at the
same time.

If you close the viewer window, you can reopen it. In the Simulink model window, double-
click the VR Sink block.

See Also

Functions
vredit | vrgetpref | vrsetpref

Related Examples
. “Set the Default Viewer” on page 2-5

. “View Dynamic System Simulations”
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Display Virtual World and Start Simulation

3-12

This example explains how to display a simulated virtual world using the Simulink 3D
Animation Viewer on your host computer. The Simulink 3D Animation Viewer is the
default and recommended method for viewing virtual worlds. A Simulink window opens
with the model of a simple automobile. Automobile trajectory (vehicle position and angle)
is viewed in virtual reality:

1 Inthe MATLAB Command Window, type

vrtutl

A Simulink window opens with the model of an automobile.

[P vrtutl
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A virtual world viewer also opens with a 3-D model of the virtual world associated
with the model.



Display Virtual World and Start Simulation

n‘u’R Car in the Mountains EI@
File View Viewpoints Mavigation Rendering Simulation Recording Help L]
:Viewl-Obser\.rer v::Examine v¢JP|,§,9|Q+ Q_|.||ﬁ| » .

Pos:[20.00 &.00 50.00] Dir:[0.00 -0.20 -0.98]

2 In the Simulink 3D Animation Viewer, from the Simulation menu, click Run.

The simulation starts. In the Simulink 3D Animation Viewer, a car moves along the
mountain road.

3 Use the Simulink 3D Animation Viewer controls to move the camera within this
virtual world while the simulation is running. For more information on the Simulink
3D Animation Viewer controls, see “Simulink 3D Animation Viewer” on page
7-5.

4 In the Simulink 3D Animation Viewer, from the Simulation menu, click Stop.

See Also

Functions
vredit | vrgetpref | vrsetpref

Blocks
VR Sink | VR Source
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Related Examples

“Set the Default Viewer” on page 2-5

“View Dynamic System Simulations”

“View Virtual World on Host Computer” on page 3-15
“View Virtual World Remotely” on page 3-19



View Virtual World on Host Computer

View Virtual World on Host Computer

Normally, you view a virtual world by double-clicking the VR Sink in the Simulink
model. The virtual world opens in the Simulink 3D Animation Viewer or your HTML5-
enabled web browser, depending on your DefaultViewer setting. For more information
on setting your default viewer, see “Set the Default Viewer” on page 2-5.

Alternatively, you can view a virtual world in your web browser by selecting an open
virtual world from a list in your web browser. You can display the HTML page that
contains this list by connecting to the Simulink 3D Animation host. The host is the
computer on which the Simulink 3D Animation software is running. You do not need an
HTML5-enabled web browser to display this page.

A virtual world appears on this list in your web browser only if the vrworld
Description property contains a string. If this property is empty for a virtual world,
that world is not accessible from the remote host. The simplest way to set a world
description is to define the virtual world 3D file WorldInfo node and fill in the title
field for that node. You can set up the WorldInfo node to look like the following:

WorldInfo { title
"My First World"
info [ "Author: XY" ]
}

The vrworld object uses the title string in the virtual world 3D file for the
Description property of the virworld object. You can change this property with the
Simulink 3D Animation MATLAB interface (vrworld/set).

The following procedure describes how to connect to the Simulink 3D Animation host:

1 At the MATLAB command prompt, type

vrbounce

The VR Bouncing Ball example is loaded and becomes active.
2 Open your HTML5-enabled web browser. In the address line of the browser, type

http://localhost:8123

Note To connect to the main HTML page from a client computer, type http://
hostname:8123, where hostname is the name of the computer on which the
Simulink 3D Animation software is running.
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The following page is loaded and becomes active.

The main HTML page for the Simulink 3D Animation product lists the currently
available (active) virtual worlds. In this example, the VR Bouncing Ball virtual world
appears as a link.

/& Simulink 3D Animatien - Windows Internet Explorer E@
@Q - |g, http://localhost&123/index.html - ‘ ‘f| x ‘ ‘ Bing 2~
File Edit View Favorites Tools Help % @yConvert + [BF]Select

57 Favorites 5% @] Generating HTML Qutput ... & Web Slice Gallery = Suggested Sites *

»

l@S\muIiﬂkEDAnimation | fa - v [ @ v Pagev Safety~ Tools~ @~
Simulink 3D Animation
Worlds currently available: + Developed by:
+« VR Bouncing Ball « Humusoft
Powered by:
« MATLAB ‘x
®
« VRMIL 97 ...
€ Local intranet | Protected Mode: Off g v H100% -

3 Click VR Bouncing Ball.

The VR Bouncing Ball virtual world appears in your web browser.
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/} simulink 3D Animation - Microsoft Internet Explorer provided by The Mathworks, I... ] [E3

JFiIe Edit Wiew Faworites Tools  Help | i
J Address Iﬂj http:fi127.0.0.1:8123fworlds/ 3 index. html j
=

[~
|ﬂj Applet com.mathworks, toolbox, wr . client, AppYR. notir ’_ ’_ ’_ ’_ ’_ |\J Local inkranet S

From the main HTML page, select one of the listed worlds or click the reload link to
update the status of the virtual worlds supported by the software. This page does not
require the VRML or X3D capabilities from the browser; it is a standard HTML page.
Nevertheless, when you click one of the virtual world links in the list, the browser must
be HTML5-enabled to display the virtual world correctly and to communicate with the
Simulink 3D Animation product.

Related Examples
. “Display Virtual World and Start Simulation” on page 3-12
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. “Set the Default Viewer” on page 2-5
. “View Dynamic System Simulations”

. “View Virtual World Remotely” on page 3-19
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View Virtual World Remotely

The Simulink 3D Animation software allows you to simulate a process on a host
computer while running the visualization of the process on a client computer. You view
the virtual world on the client computer using a web browser. This client computer is
connected to the host computer through a network using the TCP/IP protocol. This means
that you need to know the name or IP address of the host computer you want to access
from the client computer.

Viewing a virtual world on a client computer is useful for remote computing, presentation
of the results over the web, or in situations where it is desirable to distribute computing
and graphical power.

This example explains how to display a simulated virtual world on a client computer.
In this case, the client computer is a PC platform with a Simulink 3D Animation Web
Viewer. For a similar example using the Orbisnap viewer, see “View Virtual Worlds
Remotely with Orbisnap” on page 8-17).

In the following example, a Simulink window opens with the model of a simple
automobile. The automobile trajectory (vehicle position and angle) is viewed in virtual
reality:

1  On the host computer, in the MATLAB Command Window, type

vrtutl

A Simulink window opens with the model of an automobile.
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Double-click the VR Sink block. This block is in the right part of the model window.

A virtual world viewer also opens with a 3-D model of the virtual world associated

with the model.

In the virtual world viewer, select the Simulation menu Block Parameters option.

A VR Sink block parameters dialog box opens.



View Virtual World Remote|y

«): Parameters: ¥R Sink =10/ x|

VR Sink

ittes Simulink values to virtual world node fields. Fields to be written are marked by
checkboxes in the tree viewe. Every marked field corresponcds to an input port of the block

~World propettie: —YRML Tree
S file:

oures ¥ Show node types ¥ Show field types

Ivrmount.wrl Erowse |

RooT =
) ) Diorlcinfo)
iz | [l | fscad | [Marvigationlnfo)
Wil (Wiewwpoird

ot ( paird)

(DirectionslLight)
[Background)

Autornobile (Transform)

X addChildren (MFMode)

X removeChildren (MFMode)
[ center (sFvecsn -
rotation (SFRatation)

O scale (5Fvecsn

D saleCrientation (SFRotation)

translation (SFvec3f)

O bboxcerter (SFvecst)

[ bhoxsize (SFvecit B
| _>lJ

Ok | Cancel | Help | Apply |

.
L]
»
P Camera_car (Transform)
v Cpen YREML Viewer automatically :
»

[ Allowe wiesnving fram the Internet

Description:

IVR Car in the Mourtains

rBlock properti

Sample time (-1 for inherit):

0.2

Select the Allow viewing from the Internet check box.

Note This option allows any computer connected to the network to view your model.
Do not select this box when you want your model to be private or confidential.

Click OK.

On the client computer, open your HTML5-enabled web browser. In the Address
line, enter the address and Simulink 3D Animation port number for the host
computer running the Simulink software. For example, if the IP address of the host
computer is 192.168.0.1, enter

http://192.168.0.1:8123
To determine your IP address on a Windows system, type cmd, and enter ipconfig.

To determine your IP address on a UNIX system, type the command

ifconfig device_name
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Click OK. An IP Configuration dialog box opens with a list of your IP, mask, and
gateway addresses.

Alternatively, for Windows platforms, you can open a DOS shell and type ipconfig.

The web browser displays the main Simulink 3D Animation HTML page. Only one
virtual world is in the list because you have only one Simulink model open.

/€ simulink 3D Animation - Windows Internet Explorer E@
Bing o ~|

% @ Convert v [ Select

G = [E] rp17128.191095123 ndex e - e ] x|

File Edit View Favorites Tools Help

7;3 Favorites 325 | Generating HTML Output ... @& Web Slice Gallery + Suggested Sites *

@SlmulmkEDAmmatmn - B -=2 m v Page~ Safety~ Tools~ -@v 7

Simulink 3D Animation
Worlds currently available: + Developed by:
s VR Car in the Mountains « Humusoft
Powered by:
o MATLAB ‘\
_®—
« VRML 97 ...
€ Local intranet | Protected Mode: Off 4 v R0% -

7 Click VR Car in the Mountains.

The web browser displays a 3-D model of the virtual world associated with the
model.
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/) simulink 3D Animation - Microsoft Internet Explorer provided by The Mathworks, I... [lju=] [E3

JFiIe Edit  Wiew Fawvorites  Tools  Help |f,"
J Address I@ http:filocalhost: 8123 worlds/4/indesx. html j

|@ Applet com.mathworks, toolbox, wr . client, AppYR. notir ’_ ’_ ’_ ’_ ’_ |g Local inkranet S

On the host computer, in the Simulink window, from the Simulation menu, click
Run.

On the client computer, the animation of the scene reflects the process simulated in
the Simulink diagram on the host computer.

You can tune communication between the host and the client computer by setting
the Sample time and Transport buffer size parameters.

Use the web browser controls to move within this virtual world while the simulation
is running.
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10 On the host computer, in the Simulink window, from the Simulation menu, click
Stop. On the client computer, close the web browser window.

Related Examples

. “Display Virtual World and Start Simulation” on page 3-12
. “Set the Default Viewer” on page 2-5

. “View Dynamic System Simulations”

. “View Virtual World on Host Computer” on page 3-15

3-24



Add Sensors to Virtual Worlds

Add Sensors to Virtual Worlds

This section describes how to interface a Simulink block diagram to sensors in a virtual
reality scene. It also describes how to input signals programmatically from the virtual
world into a simulation model.

Virtual reality scenes can contain sensors, nodes able to generate events and output
values depending on time, navigation, and actions and distance changes in the scene.
These nodes add interactivity to the virtual world. You can use Simulink 3D Animation
functions to read sensor field values into simulation models and control simulation based
on the user interaction with the virtual scene.

You can define the following sensors in the scene:

Sensors Description

CylinderSensor Maps pointer motion (for example, a mouse) into a rotation on
an invisible cylinder that is aligned with the y-axis of the local
coordinate system.

PlaneSensor Maps pointing device motion into two-dimensional translation in a
plane parallel to the z=0 plane of the local coordinate system.

ProximitySensor Generates events when the viewer enters, exits, and moves within
a region in space (defined by a box).

SphereSensor Maps pointing device motion into spherical rotation about the
origin of the local coordinate system.

TimeSensor Generates events as time passes.

TouchSensor Tracks the location and state of the pointing device and detects
when you point at geometry contained by the TouchSensor node
parent group.

VisibilitySensor Detects visibility changes of a rectangular box as you navigate the
world.
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Modify Remote Virtual World Via Sensor Events

3-26

Interactive mode allows clients to modify a remote virtual world via events from sensor

nodes defined in the virtual world. Interactive mode is useful when a virtual world
includes a sensor.

Interactive mode is disabled by default on clients. You can enable (or later disable)

interactive mode on a client via context menu in the Web Viewer or by pressing the I key
shortcut.

You can disable interactive mode for a particular virtual world on the host computer. For
details, see the ClientUpdates property, using vrwor ld/get or vrworld/set.

Related Examples

. “Modify Remote Virtual World Via Sensor Events” on page 3-26
. “Read Sensor Values” on page 3-27

“Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4
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Read Sensor Values

To read a value of a readable field (either exposedField or eventOut), first
synchronize that field with the vrnode/sync method. After synchronization, each time
the field changes in the scene, the field value updates on the host. You can then read the
value of the field with the vrnode/getFfield method or directly access the field value
using the dot notation.

Reading Sensor Values Example

The virtual scene for the Magnetic Levitation Model example, maglev.wrl, contains a
PlaneSensor (with the DEF name "Grab_Sensor ™). The PlaneSensor is attached to the
ball geometry to register your attempts to move the ball up or down when grabbing it
using the mouse. The example uses the sensor fields minPosition and maxPosition to
restrict movement in other directions. You can use the output of the sensor translation
field as the new setpoint for the ball position controller. You can read the sensor output
value into a MATLAB variable setpoint with the following:

% create the vrworld object and open the world
wh = vrworld("maglev.wrl®);
open(wh);

% get the node handle
nh = vrnode(wh, "Grab_Sensor®);

% synchronize the translation field
sync(nh, "translation®, "on");

% 3 alternative ways to read the synchronized field value

setpoint = getfield(nh, "translation®);
setpoint = nh.translation;
setpoint = wh.Grab_Sensor.translation;

To use the setpoint value in a Simulink model, you can write an S-function or a MATLAB
Function block that reads the sensor output periodically. For an example of such an S-
function:

1  Right-click the VR Sensor Reader block of Magnetic Levitation Model (vrmaglev)
model and select Mask > Look Under Mask.

The virmaglev/VR Sensor Reader model displays. This model contains the
vrextin block, which is an S-function block. The vrextin S-function synchronizes
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the sensor field in the setup method and periodically reads its value in the
mdlUpdate method.

2 To examine the S-function parameters, right-click vrextin and select S-Function
Parameters.

The parameters defined in the mask supply the sample time, virtual world, and the
node/field to read.

Note the following about the vrextin S-function:

+ Instead of setting its own block outputs, the vrextin S-function sets the value of the
adjacent Constant block value_holder. This setting makes the VR Sensor Reader
block compatible with Simulink Coder code generation so that the model can run on
Simulink Coder targets.

* The signal loop between user action (grabbing the ball to a desired position using a
mouse) closes through the associated Simulink model virmaglev.Grabbing the ball
to a new position works only when the model is running and when the model sets the
blue selection method switch to the virtual reality sensor signal path. To experience
the behavior of the PlaneSensor using the virtual scene only, save the maglev.wrl
file under a new name and remove the comment symbol (#) to enable the last line of
this file. This action activates direct routing of sensor output to a ball translation. You
can then experiment with the newly created scene instead of the original maglev.wrl
world.

ROUTE Grab_Sensor.translation_changed TO Ball.translation

* You can use this method to input information from all node fields of the type
exposedField or eventOut, not only a Sensor eventOut field. See VRML Data
Class Types on page 5-27 for more information about virtual world data class
types.

+ For fields of class exposedField, you can use an alternate name using
the field name with the suffix, changed. For example, translation and
translation_changed are alternate names for requesting the translation field
value of the Grab_Sensor node.

Related Examples
. “Add Sensors to Virtual Worlds” on page 3-25
. “Modify Remote Virtual World Via Sensor Events” on page 3-26

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4
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VR Source Block Input to Simulink Models

The VR Source reads values from virtual world fields specified in the Block Parameters
dialog box and inputs their values.

Use the VR Source block to provide interactivity between a user navigating the virtual
world and the Simulink model. The VR Source block registers user interactions with the
virtual world and passes to the model values that can affect the simulation of the model.
For example, you can specify setpoints in the virtual world, so that user can specify

the location of a virtual world object interactively. The simulation then responds to the
changed location of the object. The VR Source block can read into the model events from
the virtual world, such as time ticks or outputs from scripts. The VR Source block can
also read into the model static information about the virtual world (for example, the size
of a box defined in the virtual world 3D file).

For an example of how to use the VR Sink block, see Magnetic Levitation Model.

Related Examples
. “Virtual World Connection to a Model” on page 3-2

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4
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Interact with Generated Code

You can have a virtual world that you create the Simulink 3D Animation product
interact with code generated by the Simulink Coder product and compiled with a third-

party C/C++ compiler in the Simulink Desktop Real-Time environment. To do so, use the
Simulink External mode.

Related Examples

“Virtual World Connection to a Model” on page 3-2
. “Link Simulink Models”
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Although using the Simulink 3D Animation software with the Simulink interface is the
preferred way of working with the Simulink 3D Animation software, you can also use the
MATLAB interface. Enter commands directly in the MATLAB Command Window or use

scripts to control virtual worlds.

“Create vrworld Object for a Virtual World” on page 4-2
“Open a Virtual World with MATLAB” on page 4-4
“Interact with a Virtual World with MATLAB” on page 4-6
“Close and Delete a vrworld Object” on page 4-10
“Animation Recording” on page 4-11

“Define File Name Tokens” on page 4-13

“File Name Tokens” on page 4-15

“Manual 3-D Recording with MATLAB” on page 4-17
“Manual 2-D AVI Recording with MATLAB” on page 4-20
“Scheduled 3-D Recording with MATLAB” on page 4-23
“Scheduled 2-D AVI Recording with MATLAB” on page 4-26
“Record Animations for Unconnected Virtual Worlds” on page 4-29
“Play Animation Files” on page 4-32
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Create vrworld Object for a Virtual World

4-2

To connect MATLAB to a virtual world and to interact with that virtual world through
the MATLAB command-line interface, create virwor ld and vrnode objects. A virtual
world 3D file defines a virtual world.

Note The Simulink interface and the MATLAB interface share virtual world objects. This
sharing of objects enables you to use the MATLAB interface to change the properties of
vrwor Id objects originally created by Simulink with Simulink 3D Animation blocks.

After you create a virtual world, you can create a virwor Id object. This procedure uses
the virtual world vrmount.wrl as an example.



Create vrworld Object for a Virtual World

1  Open MATLAB. In the MATLAB Command Window, type

myworld = vrworld("vrmount.wrl*®)

The MATLAB Command Window displays output like

myworld =
vrworld object: 1-by-1

VR Car in the Mountains
(matlabroot/toolbox/sl3d/vrdemos/vrmount.wrl)

2 Type

vrwhos

The MATLAB Command Window displays the messages

Closed, associated with
"C:matlabroot\toolbox\sl3d\sl3ddemos\vrmount.wrl".
Visible for local viewers.

No clients are logged on.

The vrworld object mywor 1d is associated with the virtual world virmount.wrl. You
can think of the variable myworld as a handle to the vrworld object stored in the
MATLAB workspace.

Your next step is to open a virtual world using the vrworld object. See “Open a Virtual
World with MATLAB” on page 4-4.

See Also

Functions
vrworld

Related Examples

. “Open a Virtual World with MATLAB” on page 4-4

. “Interact with a Virtual World with MATLAB” on page 4-6
. “Close and Delete a vrworld Object” on page 4-10

. “MATLAB Interaction”
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Open a Virtual World with MATLAB

4-4

Open a virtual world to view the virtual world in a virtual world viewer, scan its
structure, and change virtual world properties from the MATLAB Command Window.

After you create a vrwor Id object, you can open the virtual world by using the vrworld
object associated with that virtual world. This procedure uses the vrwor ld object
mywor Id associated with the virtual world virmount.wrl as an example:

1 Inthe MATLAB Command Window, type

open(myworlid);

The MATLAB Command Window opens the virtual world virmount._wrl.
2 Type

set(myworld, "Description®, *My first virtual world®");

The Description property is changed to My First virtual world. This
description displays in all Simulink 3D Animation object listings, in the title bar of
the Simulink 3D Animation Viewer, and in the list of virtual worlds on the Simulink

3D Animation HTML page.
3 Display the virtual world virmount.wrl. Type

view(myworld)

The viewer that is set as the default viewer displays the virtual scene. The default
viewer is typically the Simulink 3D Animation Viewer unless you have a different
viewer set.

Alternatively, you can display the virtual world in an HTML5-enabled web browser.

1 Repeat steps 1 and 2 of the preceding procedure.
2 Open a web browser. In the Address box, type

http://localhost:8123

The browser displays the Simulink 3D Animation HTML page with a link to My
first virtual world. The number 8123 is the default Simulink 3D Animation port
number. If you set a different port number on your system, enter that number in
place of 8123 and restart MATLAB. For more information on the Simulink 3D
Animation HTML page, see “View Virtual World on Host Computer” on page 3-15.



Open a Virtual World with MATLAB

3 If the web browser has the VRML or X3D plug-in installed, in the browser window,
click My first virtual world.

4 Your default HTML5-enabled web browser displays the virtual world virmount.wrl.

Note If your web browser is not HTML5-enabled, clicking a virtual world link such

as My first virtual world results in a broken link message. The browser cannot
display the virtual world.

For more information on changing your default viewer, see “Set the Default Viewer” on
page 2-5.

See Also

Functions
vrworld

Related Examples

. “Create vrworld Object for a Virtual World” on page 4-2

. “Interact with a Virtual World with MATLAB” on page 4-6
. “Close and Delete a vrworld Object” on page 4-10

. “MATLAB Interaction”
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Interact with a Virtual World with MATLAB

In the life cycle of a virwor 1d object you can set new values for all the available virtual
world nodes and their fields using vrnode object methods. This way, you can change
and control the degrees of freedom for the virtual world from within the MATLAB
environment.

An object of type vrworld contains nodes named in the virtual world 3D file using the
DEF statement. These nodes are of type virnode. For more information, see vrworld
and vrnode functions.

After you open a vrwor Id object, you can get a list of available nodes in the virtual
world. This procedure uses the virworld object mywor ld and the virtual world
vrmount.wrl as an example. To create the myworld, see “Create vrworld Object for a
Virtual World” on page 4-2.

1 Inthe MATLAB Command Window, type

nodes(myworld);

The MATLAB Command Window displays a list of the virnode objects and their
fields that are accessible from the Simulink 3D Animation software.

Tunnel (Transform) [My first virtual world]
Road (Shape) [My first virtual world]

Bridge (Shape) [My First virtual world]

River (Shape) [My first virtual world]

ElevApp (Appearance) [My first virtual world]
Canal (Shape) [My first virtual world]

Wood (Group) [My First virtual world]

Treel (Group) [My Ffirst virtual world]

Wheel (Shape) [My First virtual world]
Automobile (Transform) [My first virtual world]
VPfollow (Viewpoint) [My Ffirst virtual world]
Camera_car (Transform) [My Ffirst virtual world]
Viewl (Viewpoint) [My first virtual world]

2 Type
mynodes = get(myworld, “Nodes™)

The MATLAB software creates an array of vrnode objects corresponding to the
virtual world nodes and displays
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mynodes =
vrnode object: 13-by-1

Tunnel (Transform) [My first virtual world]
Road (Shape) [My first virtual world]

Bridge (Shape) [My Ffirst virtual world]

River (Shape) [My first virtual world]

ElevApp (Appearance) [My first virtual world]
Canal (Shape) [My first virtual world]

Wood (Group) [My First virtual world]

Treel (Group) [My Ffirst virtual world]

Wheel (Shape) [My first virtual world]
Automobile (Transform) [My first virtual world]
VPfollow (Viewpoint) [My first virtual world]
Camera_car (Transform) [My first virtual world]
Viewl (Viewpoint) [My first virtual world]

Type
whos

The MATLAB Command Window displays the messages

Name Size Bytes Class
ans 1x1 132 wvrfigure object
mynodes 13x1 3564 vrnode object
mywor 1d 1x1 132 vrworld object

Now you can get node characteristics and set new values for certain node properties.
For example, you can change the position of the automobile by using Automobile,
which is the fourth node in the virtual world.

Access the fields of the Automobi le node by typing

Ffields(myworld._Automobile)

or

Ffields(mynodes(10));

The MATLAB Command Window displays information like the following table.

Field Access Type Sync
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addChildren eventln MFNode off
removeChildren eventln MFNode off
children exposedField MFNode off
center exposedField SFVec3f off
rotation exposedField SFRotation off
scale exposedField SFVec3f off
scaleOrientation exposedField SFRotation off
translation exposedField SFVec3f off
bboxCenter field SFVec3f off
bboxSize field SFVec3f off

The Automobi le node is of type Transform. This node allows you to change its
position by changing its translation field values. From the list, you can see that
translation requires three values, representing the [x y z] coordinates of the
object.

5 Type
view(myworld)

Your default viewer opens and displays the virtual world virmount.wrl.

6 Move the MATLAB window and the browser window side by side so you can view
both at the same time. In the MATLAB Command Window, type

mywor ld.Automobile._translation = [15 0.25 20];

The MATLAB sets a new position for the Automobi le node. You can observe that
the car is repositioned in the virtual world browser window.

You can change the node fields listed by using the function vrnode/setfield.

Note The dot notation is the preferred method for accessing nodes.

See Also

Functions
vrworld
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Related Examples

“Create vrworld Object for a Virtual World” on page 4-2
“Open a Virtual World with MATLAB” on page 4-4

“Close and Delete a vrworld Object” on page 4-10
. “MATLAB Interaction”
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Close and Delete a vrworld Object

After you are finished with a session, close all open virtual worlds and remove them from
memory:

1 Inthe MATLAB Command Window, type

close(myworld);
delete(myworld);

The virtual world representation of the vrwor Id object myworld is removed from
memory. All possible connections to the viewer and browser are closed and the
virtual world name is removed from the list of available worlds.

Note Closing and deleting a virtual world does not delete the vrwor ld object handle
mywor Id from the MATLAB workspace.

See Also

Functions
vrworld

Related Examples

. “Create vrworld Object for a Virtual World” on page 4-2

. “Open a Virtual World with MATLAB” on page 4-4

. “Interact with a Virtual World with MATLAB” on page 4-6
“MATLAB Interaction”
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Animation Recording

In this section...

“Recording Formats” on page 4-11

“Manual and Scheduled Animation Recording” on page 4-12

The Simulink 3D Animation software enables you to record animations of virtual

scenes that the Simulink or MATLAB product controls. You can record simulations
through either the Simulink 3D Animation Viewer (described in “Simulink 3D Animation
Viewer” on page 7-5) or the MATLAB interface. You can then play back these

animations offline, in other words, independent of the MATLAB, Simulink, or Simulink
3D Animation products. You can generate such files for presentations, to distribute
simulation results, or to generate archives.

Note If you are working with virtual scenes controlled from MATLAB, you can record
virtual scenes through the MATLAB interface. Optimally, use the Simulink 3D
Animation Viewer to record animations of virtual worlds associated with Simulink
models. This method ensures that all necessary virtual world and vrfigure properties
are properly set to record simulations. For details, see “Record Offline Animations” on
page 7-41.

Recording Formats
You can save the virtual world offline animation data in the following formats:

+  3-D virtual world file — The Simulink 3D Animation software traces object
movements and saves that data into a virtual world 3D file using VRML97 standard
interpolators. You can then view these files with the Simulink 3D Animation Viewer.
3-D VRML files typically use much less disk space than Audio Video Interleave (AVI)
files. If you make any navigation movements in the Simulink 3D Animation Viewer
while recording the animation, the Simulink 3D Animation software does not save
any of these movements.

Note If you distribute virtual world 3D animation files, be sure to distribute all the
inlined object and texture files referenced in the original virtual world 3D world file.

*  2-D Audio Video Interleave (AVI) file — The Simulink 3D Animation software
writes animation data into an .avi file. The Simulink 3D Animation software uses
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vrfigure objects to record 2-D animation files. The recorded 2-D animation reflects
exactly what you see in the viewer window. It includes any navigation movements you
make during the recording.

Note While recording 2-D .avi animation data, always ensure that the Simulink
3D Animation Viewer is the topmost window and fully visible. Graphics acceleration
limitations can prevent the proper recording of 2-D animation otherwise.

Manual and Scheduled Animation Recording

You can use MATLAB to either manually record an animation or schedule a preset time
interval for recording. For details, see:

+ “Manual 3-D Recording with MATLAB” on page 4-17

+ “Manual 2-D AVI Recording with MATLAB” on page 4-20

+ “Scheduled 3-D Recording with MATLAB” on page 4-23

* “Scheduled 2-D AVI Recording with MATLAB” on page 4-26

See Also

Functions
vrplay | vrview

Related Examples
. “Record and Play Animations”
. “Define File Name Tokens” on page 4-13

. “Capture Frames”

More About
. “File Name Tokens” on page 4-15
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Define File Name Tokens

In this section...

“Default File Name Format” on page 4-13
“Uses for File Name Tokens” on page 4-13

Default File Name Format

By default, the Simulink 3D Animation Viewer records simulations or captures virtual
scene frames in a file named with the following format:

%F_anim_%n.%e

This format creates a unique file name each time you capture a frame or record the
animation. The file name uses the %, %n, and %e tokens.

The %T token is replaced with the name of the virtual world associated with the model.
The %n token is a number that increments each time that you record a simulation

for the same virtual world. For example, if the name of the virtual world file is
vrplanets.vrml and you record a simulation for the first time, the animation file is
vrplanets_anim_1.wrl. If you record the simulation a second time, the animation
file name is virplanets_anim_2._wrl. In the case of frame captures, capturing another
frame of the scene increments the number.

The %e token represents the virtual world 3D file extension (.wrl, .x3d, or .x3dv) as
the extension of the virtual world that drives the animation. By default, the %e token
uses the file extension of the virtual world 3D file that drives the animation. The VR Sink
and VR Source block Source file parameter specifies the file extension of the virtual
world. You can specify a different extension. However, if the file extension in the Source
file parameter is . x3d or .x3dv, you cannot set %e token to .wrl (VRML).

Uses for File Name Tokens

You can use several tokens to customize the automated generation of frame capture or
animation files. To use these tokens to create varying frame capture or animation file
names, you can:

*  Create files whose root names are the same as the root names of the virtual world.
This option is useful if you use different virtual worlds for one model.
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+ Create files in directories relative to the virtual world location. This option is useful if
you want to ensure that the virtual world file and frame capture or animation file are
in the same folder.

*  Create rolling numbered file names such that subsequent frame captures or runs
of the model simulation create incrementally numbered file names. This approach
is useful if you expect to create files of different parts of the model simulation. This
feature allows you to capture a frame or run a Simulink model multiple times, but
create a unique file each time.

* Create multiple file names with time or date stamps, with a unique file created each
time.

See “File Name Tokens” on page 4-15 for a summary of the file name tokens.

Related Examples

. “Record and Play Animations”
. “Capture Frames”
More About

. “File Name Tokens” on page 4-15
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File Name Tokens

The software supports various file naming formats using file tokens. By default, the
Viewer captures virtual scene frames or records simulations in a file named with the
following format: %f_anim_%n.%e. This format creates a unique file name each time you
capture a frame or record the animation.

The following tokens are the same for frame capture (. tif or .png) or animation (.wrl,
-x3d, -x3dv, and .avi) files.

Token

Description

%n

The current incremental number replaces this token in the file name string.
Each subsequent frame capture or run of the simulation increments the
number. For example, the format %f _anim_%n.wrl saves the animation to
vrplanets_anim_1.wrl on the first run, vrplanets_anim_2.wrl on the
second run, and so forth.

%T

The virtual world file name replaces this token in the file name string.
For example, the format %f_anim_%D.wrl saves the animation to
vrplanets_anim_29._wrl.

%e

The virtual world file name replaces this token represents with the virtual
world 3D file extension (-wrl, .x3d, or .x3dv). By default, the %e token
uses the file extension of the virtual world 3D file that drives the animation.
The VR Sink and VR Source block Source file parameter specifies the file
extension of the virtual world.

You can specify a different extension. However, if the file extension in the
Source file parameter is .x3d or .x3dv, you cannot set %e token to .wrl
(VRML).

%d

The full path to the virtual world 3D file replaces this token in the file

name string and creates files in directories relative to the virtual world file
location. For example, the format %d/animdir/%f _anim_%n.avi saves

the animation in the animdir subfolder of the folder containing the virtual
world 3D file. If animdir subfolder does not exist, the software creates the
animdir subfolder. This token is most helpful if you want to ensure that the
virtual world file and animation file are in the same folder.

%Y

The current four-digit year replaces this token in the file name string.
For example, the format %f_anim_%Y .wrl saves the animation to
vrplanets_anim_2015.wrl for the year 2015.
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Token

Description

%M

The current month replaces this token in the file name string. For
example, the format %f_anim_%M.wrl saves the animation to
vrplanets_anim_4.wrl for a start record time in April.

%D

The current day in the month replaces this token in the file name string.
For example, the format %Ff_anim_%D.wrl saves the animation to
vrplanets_anim_29.wrl for the 29th day of the month.

%h

The current hour replaces this token in the file name string. For
example, the format %f_anim_%h.wrl saves the animation to
vrplanets_anim_14._wrl for any time between 14:00 and 15:00.

%m

The current minute replaces this token in the file name string. For
example, the format %f_anim_%h%m.wrl saves the animation to
vrplanets_anim_1434 _wrl for a start record time of 14:34.

Y%s

The current second replaces this token in the file name string. For
example, the format %f_anim_%h%m%s.wrl saves the animation to
vrplanets_anim_150430.wr1 for a start record time of 15:04:30.

Related Examples
. “Define File Name Tokens” on page 4-13

. “Record and Play Animations”

. “Capture Frames”
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Manual 3-D Recording with MATLAB

This topic describes how to record a 3-D animation manually using the MATLAB
interface for a virtual world that is associated with a Simulink model. In this example,
the timing of the animation file derives from the simulation time. One second of the
recorded animation time corresponds to one second of Simulink time. You create and
record the animation file by interactively starting and stopping the recording from the
MATLAB Command Window.

This procedure uses the vrplanets example. It describes how to create a virtual world
3D animation file name with the default name format.

1

Run the Simulink model for vrplanets. In the MATLAB window, type

vrplanets

The Simulink model appears. Also by default, the Simulink 3D Animation Viewer for
that model is loaded and becomes active. If the viewer does not appear, double-click
the Simulink® 3D Animation block in the Simulink model.

To work with the virtual world associated with vrplanets from the MATLAB
interface, retrieve the virtual world handle. Use the vrwhos command. Type

vrwhos

If the result shows that only one vrworld object is in the workspace, assign its
handle directly to a variable. Type

myworld = vrwho;

If multiple virtual worlds are listed, select which of these virtual worlds you want to
manipulate. To select the virtual world, you can use indexing or a selection method
using a string comparison of virtual world descriptions. For the indexing method,
type

worlds = vrwho;
myworld = worlds(l);
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For the string comparison method, type

worlds = vrwho;
myworld =
worlds(strcmp("Planets”,get(worlds, "Description®)));

To have the Simulink 3D Animation software manually record the animation, set the
RecordMode property to manual. Type

set(myworld, "RecordMode” , "manual *) ;

Direct the Simulink 3D Animation software to record the animation to a virtual
world 3D format file. Type

set(myworld, "Record3D", "on");

Run the Simulink model. From the Simulation menu, select Mode > Normal, then
click Simulation > Run. Alternatively, if you are using the Simulink 3D Animation
default viewer, you can run the Simulink model with one of the following from the
viewer.

*  From the menu bar, select the Simulation menu Start option to start or stop the
simulation.

From the toolbar, click Start/pause/continue simulation to start the
simulation.

From the keyboard, press Ctrl+T to start the simulation.
As the simulation runs, start recording the animation by setting the virtual world
Recording property. Type

set(myworld, "Recording”®,"on");

This setting turns on the recording state.

When you want to stop the recording operation, type:
set(myworld, "Recording”, "off");

The Simulink 3D Animation software stops recording the animation. The Simulink
3D Animation software creates the file virplanets_anim_1._wrl in the current
working folder. If the simulation stops before you stop recording, the recording
operation stops and creates the animation file.

Stop the simulation. You can use one of the following from the viewer.
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+  From the menu bar, select the Simulation menu Stop option to stop the
simulation.

From the toolbar, click Stop simulation to stop the simulation.

*  From the keyboard, press Ctrl+T to stop the simulation.
You do not need to stop the recording manually before stopping the simulation. If

you do not manually stop the recording, the recording operation does not stop and
create the animation file when the simulation stops.

9 Close and delete the objects if you do not want to continue using them.

Related Examples

. “Record and Play Animations”

. “Manual 2-D AVI Recording with MATLAB” on page 4-20

. “Scheduled 3-D Recording with MATLAB” on page 4-23

. “Scheduled 2-D AVI Recording with MATLAB” on page 4-26

. “Record Animations for Unconnected Virtual Worlds” on page 4-29

. “Play Animation Files” on page 4-32

More About
. “File Name Tokens” on page 4-15
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Manual 2-D AVI Recording with MATLAB

This topic describes how to record a 2-D animation manually using the MATLAB
interface for a virtual world that is associated with a Simulink model. In this example,
the timing of the animation file derives from the simulation time. One second of the
recorded animation time corresponds to one second of Simulink time. You create and
record the animation file by interactively starting and stopping the recording from the
MATLAB Command Window.

4-20

This procedure uses the vrplanets example. It describes how to create an .avi
animation file name with the default name format.

1

Run the Simulink model for vrplanets. In the MATLAB window, type

vrplanets

The Simulink model appears. Also by default, the Simulink 3D Animation Viewer for
that model is loaded and becomes active. If the viewer does not appear, double-click
the Simulink® 3D Animation block in the Simulink model.

To work with the virtual world associated with vrplanets from the MATLAB
interface, retrieve the virtual world handle. Use the vrwhos command. Type
vrwhos

If the result indicates that only one vrwor ld object is in the workspace, assign its

handle directly to a variable. Type

myworld = vrwho;

If multiple virtual worlds are listed, select which of these virtual worlds you want to
manipulate. To select the virtual world, you can use indexing or a selection method
using a string comparison of virtual world descriptions. For the indexing method,

type

worlds = vrwho;
myworld = worlds(l);

For the string comparison method, type

worlds = vrwho;
myworld =
worlds(strcmp("Planets”,get(worlds, "Description®)));
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10

If the description string is unique, mywor Id is assigned the correct virtual world.

To retrieve the handle to the currently displayed the Simulink 3D Animation Viewer
figure, type

f=get(myworld, "Figures”)

To have the software manually record the animation, set the RecordMode property
to manual. Type

set(myworld, "RecordMode” , "manual *) ;

Direct the Simulink 3D Animation software to record the animation as a .avi
format file. Type

set(Ff, "Record2D","on");

Disable the navigation panel. The navigation panel appears at the bottom of the
virtual scene view. You can turn off this panel for a cleaner view of the virtual scene.
Type

set(f, "NavPanel ", "none*);

Run the Simulink model. From the Simulation menu, select Mode > Normal, then
click Simulation > Run. Alternatively, if you are using the Simulink 3D Animation
default viewer, you can run the Simulink model with one of the following from the
viewer:

*  From the menu bar, select the Simulation menu Start option to start or stop the
simulation.

*  From the toolbar, click Start/pause/continue simulation to start the
simulation.

*  From the keyboard, press Ctrl+T to start the simulation.

As the simulation runs, start recording the animation by setting the virtual world
Recording property. Type

set(myworld, "Recording”,"on");

This setting turns on the recording state.

To stop the recording operation, type:

set(myworld, "Recording”, "off");
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11

12

13

The Simulink 3D Animation software stops recording the animation. The Simulink
3D Animation software creates the file virplanets_anim_1_avi in the current
working folder. If the simulation stops before you stop recording, the recording
operation stops and creates the animation file.

Stop the simulation. You can use one of the following from the viewer.
From the menu bar, select the Simulation menu Stop option to stop the
simulation.
From the toolbar, click Stop simulation to stop the simulation.

*  From the keyboard, press Ctrl+T to stop the simulation.

You do not need to stop the simulation manually. If you do not manually stop the

recording, the recording operation does not stop and create the animation file until
the simulation stops.

If you want to enable the Navigation Panel again, type

set(fF, "NavPanel ", "halfbar");

Close and delete the objects if you do not want to continue using them.

Related Examples

“Record and Play Animations”

“Manual 3-D Recording with MATLAB” on page 4-17

“Scheduled 3-D Recording with MATLAB” on page 4-23
“Scheduled 2-D AVI Recording with MATLAB” on page 4-26
“Record Animations for Unconnected Virtual Worlds” on page 4-29

“Play Animation Files” on page 4-32

More About

“File Name Tokens” on page 4-15
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Scheduled 3-D Recording with MATLAB

This topic describes how to schedule the recording of a 3-D animation using the MATLAB
interface for a virtual world that is associated with a Simulink model. You control the
animation file recording by presetting a time interval. The Simulink 3D Animation
software records the animation during this interval in the simulation. In this example,
the timing of the recorded animation file derives from the simulation time. One second of
the recorded animation time corresponds to one second of Simulink time.

This procedure uses the vrplanets example. It describes how to create a virtual world
3D animation file name with the default name format.

1

Run the Simulink model for vrplanets. In the MATLAB window, type

vrplanets

The Simulink model is displayed. Also by default, the Simulink 3D Animation
Viewer for that model is loaded and becomes active. If the viewer is not displayed,
double-click the Simulink® 3D Animation block in the Simulink model.

To work with the virtual world associated with vrplanets from the MATLAB
interface, retrieve the virtual world handle. Use the vrwhos command. Type
vrwhos

If the result indicates that only one vrworld object is in the workspace, assign its

handle directly to a variable. Type

myworld = vrwho;

If multiple virtual worlds are listed, select which of these virtual worlds you want to
manipulate. To select the virtual world, you can use indexing or a selection method
using a string comparison of virtual world descriptions. For the indexing method,

type

worlds = vrwho;
myworld = worlds(l);

For the string comparison method, type
worlds = vrwho;

myworld =
worlds(strcmp("Planets”,get(worlds, "Description®)));
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Direct the Simulink 3D Animation software to record the animation on a schedule by
setting the RecordMode property to scheduled. Type

set(myworld, "RecordMode” , "scheduled®);

Direct the Simulink 3D Animation software to record the animation in a virtual
world 3D format file.

set(myworld, "Record3D", "on");

Select the start and stop times during which you want to record the animation. For
example, enter 5 as the start time and 15 as the stop time.

set(myworld, "RecordInterval®,[5 15]);

Ensure that the recording start time value is not earlier than the start time of the
Simulink model; the recording operation cannot start in this instance. If the stop
time exceeds the stop time of the Simulink model, or if it is an out of bounds value
such as a negative number, the recording operation stops when the simulation stops.
The recording can be slow.

Run the Simulink model. From the Simulation menu, select Mode > Normal, then
click Simulation > Run. Alternatively, if you are using the Simulink 3D Animation
default viewer, you can run the Simulink model with one of the following from the
viewer.

From the menu bar, select the Simulation menu Start option to start the
simulation.

*  From the toolbar, click Start/pause/continue simulation to start the
simulation.

*  From the keyboard, press Ctrl+T to start the simulation.

The simulation runs. The Simulink 3D Animation software starts recording when
the simulation time reaches the specified start time. The software creates the file
vrplanets_anim_N.wrl in the current working folder when finished, where N is
either 1 or more, depending on how many file iterations you have.

When you are done, stop the simulation. You can use one of the following from the

viewer.

*  From the menu bar, select the Simulation menu Stop option to stop the
simulation.

*  From the toolbar, click Stop simulation to stop the simulation.
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+  From the keyboard, press Ctrl+T to stop the simulation.

9 Close and delete the objects if you do not want to continue using them.

Related Examples

. “Record and Play Animations”

. “Manual 3-D Recording with MATLAB” on page 4-17

. “Manual 2-D AVI Recording with MATLAB” on page 4-20

. “Scheduled 2-D AVI Recording with MATLAB” on page 4-26

. “Record Animations for Unconnected Virtual Worlds” on page 4-29

. “Play Animation Files” on page 4-32

More About
. “File Name Tokens” on page 4-15
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Scheduled 2-D AVI Recording with MATLAB

This topic describes how to schedule the recording of a 2-D animation using the MATLAB
interface for a virtual world that is associated with a Simulink model. You control the
animation file recording by presetting a time interval. The Simulink 3D Animation
software records the animation during this interval in the simulation. In this example,
the timing of the recorded animation file derives from the simulation time. One second of
the recorded animation time corresponds to one second of Simulink time.

4-26

This procedure uses the vrplanets example. It describes how to create an .avi
animation file name with the default name format.

1

Run the Simulink model for vrplanets. In the MATLAB window, type

vrplanets

The Simulink model is displayed. Also by default, the Simulink 3D Animation
Viewer for that model is loaded and becomes active. If the viewer is not displayed,
double-click the Simulink® 3D Animation block in the Simulink model.

To work with the virtual world associated with vrplanets from the MATLAB
interface, retrieve the virtual world handle. Use the vrwhos command. Type

vrwhos

If the result indicates that only one vrwor ld object is in the workspace, assign its
handle directly to a variable. Type

myworld = vrwho;

If multiple virtual worlds are listed, select which of these virtual worlds you want to
manipulate. To select the virtual world, you can use indexing or a selection method
using a string comparison of virtual world descriptions. For the indexing method,
type

worlds = vrwho;
myworld = worlds(l);

For the string comparison method, type
worlds = vrwho;

myworld =
worlds(strcmp("Planets” ,get(worlds, "Description®)));
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To retrieve the handle to the currently displayed Simulink 3D Animation Viewer
figure, type

f=get(myworld, "Figures®)

To have the Simulink 3D Animation software manually record the animation, set the
RecordMode property to manual. Type

set(myworld, "RecordMode” , "scheduled®);

Direct the Simulink 3D Animation software to record the animation as an .avi
format file. Type

set(f, "Record2D","on");

Select the start and stop times during which you want to record the animation. For

example, enter 5 as the start time and 15 as the stop time.

set(myworld, "RecordInterval " ,[5 15]);

Ensure that the recording start time value is not earlier than the start time of the
Simulink model; the recording operation cannot start in this instance. If the stop
time exceeds the stop time of the Simulink model, or if it is an out of bounds value
such as a negative number, the recording operation stops when the simulation stops.
The recording can be slow.

Disable the Navigation Panel. The Navigation Panel appears at the bottom of the
virtual scene view. You can turn off this panel for a cleaner view of the virtual scene.
Type

set(fF, "NavPanel ", "none*);

Ensure that the virtual reality figure window is the topmost window.

Run the Simulink model. From the Simulation menu, select Mode > Normal, then
click Simulation > Run. Alternatively, if you are using the Simulink 3D Animation
default viewer, you can run the Simulink model with one of the following from the
viewer:

From the menu bar, select the Simulation menu Start option to start the
simulation.

From the toolbar, click Start/pause/continue simulation to start the
simulation.

*  From the keyboard, press Ctrl+T to start the simulation.
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The simulation runs. The Simulink 3D Animation software starts recording when
the simulation time reaches the specified start time. The software creates the file
vrplanets_anim_N.avi in the current working folder when finished, where N is
either 1 or more, depending on how many file iterations you have.

10 When you are done, stop the simulation. You can use one of the following from the
viewer:
From the menu bar, select the Simulation menu Stop option to stop the
simulation.
From the toolbar, click Stop simulation to stop the simulation.
*  From the keyboard, press Ctrl+T to stop the simulation.

11 If you want to enable the navigation panel again, type

set(F, "NavPanel ", "halfbar®);

12 Close and delete the objects if you do not want to continue using them.

Related Examples

. “Record and Play Animations”

. “Manual 3-D Recording with MATLAB” on page 4-17

. “Manual 2-D AVI Recording with MATLAB” on page 4-20

. “Scheduled 3-D Recording with MATLAB” on page 4-23

. “Record Animations for Unconnected Virtual Worlds” on page 4-29

. “Play Animation Files” on page 4-32

More About

. “File Name Tokens” on page 4-15
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Record Animations for Unconnected Virtual Worlds

This topic describes how to record animation files programmatically for virtual worlds
that are not associated with Simulink models (in other words, from the MATLAB
interface). In this instance, you must specify the relationship between the events that
change the virtual world state and the time in the animation file. This requirement

is different from virtual worlds associated with Simulink models. Virtual worlds

that are controlled completely from the MATLAB interface have no default, intuitive
interpretation of time relation between MATLAB environment models and virtual
scenes.

Note Many engineering time-dependent problems are modeled and solved in MATLAB.
For those problems that have meaningful visual representation, you can create virtual
reality models and animate their solutions. In addition, the offline animation time can
represent any independent variable along which you can observe and visualize a model
solution. Using offline animation files can bring the communication of such engineering
problem resolutions to new levels. The Simulink 3D Animation example vrheat (heat
transfer visualization) is an example of a time-dependent problem modeled and solved
in MATLAB. Its modified version, vrheat anim, shows the use of the programming
technique described in this topic.

To record animation files for virtual worlds that are not associated with Simulink

models, note the following guidelines, which require a strong understanding of the

advanced Simulink 3D Animation software.

* Retrieve the virwor ld object handle of the virtual scene that you want to record.

* To record 2-D animations,

1 Retrieve the corresponding vrfigure object. For 2-D animations, the Simulink

3D Animation software records exactly what you see in the viewer window.
Because 2-D animations record exactly what you see in the Simulink 3D

Animation Viewer window, the properties that control 2-D file recording belong to
vrfigure objects.

2 Set the Record2D vrfigure property.

3 To override default filenames for animation files, set the vrfigure
Record2DFi leName property.

* To create 3-D animation files,
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1 Retrieve the corresponding vrworld object.
2 Set the Record3D vrworld property.

3 To override default filenames for animation files, set the vrworld
Record3DFi leName property.

+ Set the RecordMode vrwor ld object property to manual or scheduled. For optimal
results, select scheduled.

+ If you select scheduled for RecordMode, be sure to set the virworld
RecordInterval property to a desired time interval.

* To specify that the virtual world time source is an external one, set the vrworld
property TimeSource to external. This setting ensures that the MATLAB software
controls the virtual world scene time. Type

set(virtual_world, "TimeSource®, "external™)

+ To specify time values at which you want to save animation frames, iteratively set the
vrwor ld Time property. For a smoother animation, set the time at equal intervals,
for example, every five seconds. Use a sequence like this one:

set(virtual_world, "Time",time_value)

For example, to set the Time property for virwor Id, w, with values increasing by 10,
enter

set(w,"Time",10);
set(w,"Time",20);
set(w,"Time",30);
set(w,"Time",40);
set(w, "Time",50);
set(w,"Time",60);
set(w,"Time",70);
set(w,"Time",80);
set(w,"Time",90);
set(w, "Time",100);
set(w,"Time",110);
set(w,"Time",120);
set(w,"Time",130);
set(w, "Time",140);

If you select a start time of 60 and a stop time of 120 (as described in “Scheduled 3-D
Recording with MATLAB” on page 4-23), the Simulink 3D Animation software starts
recording at 60 and stops at 120.
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Because of the repetitive nature of the time interval setting, set the Time property in
a loop from within a script or program.

+ After you set the vrworld Time property, set the virtual scene object properties as
necessary. Set these properties to values that correspond to the given time frame to
achieve the desired animation effect.

* In each time frame, issue the vrdrawnow command for scene changes. This command
renders and updates the scene.

The following code fragment contains a typical loop that iteratively sets the Time
property, changes a virtual scene object property, and calls vrdrawnow to render the
scene:

for time=StartTime:Step:StopTime
% advance the time in the virtual scene
set(myworld, "Time" ,time);
% here we change node properties
mywor ld.Car.translation = [ time*speed 0 0 ];
% render the changed position
vrdrawnow;

end

If you set the Time property at or outside the end boundary of RecordInterval, the
Simulink 3D Animation software stops recording. You can then view the resulting
animation file.

For a complete example of how to perform this kind of animation recording, refer to the
Simulink 3D Animation vrheat_anim example.

Related Examples

. “Record and Play Animations”

. “Manual 3-D Recording with MATLAB” on page 4-17

. “Manual 2-D AVI Recording with MATLAB” on page 4-20

. “Scheduled 3-D Recording with MATLAB” on page 4-23

. “Scheduled 2-D AVI Recording with MATLAB” on page 4-26
. “Play Animation Files” on page 4-32

More About
. “File Name Tokens” on page 4-15
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Play Animation Files

In this section...

“Play Virtual World Animation Files” on page 4-32
“Play AVI Animation Files” on page 4-33

Play Virtual World Animation Files

You can view virtual world animation files using one of these approaches:
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Open the 3D Animation Player from the MATLAB Toolstrip.

To open the 3D Animation Player from the MATLAB Toolstrip, in the Apps tab, in
the Simulation Graphics and Reporting section, click 3D Animation Player.
Select or specify a virtual world 3D animation file.

From the operating system, locate and double-click the VRML animation file

Double-click the virtual world 3D file. An HTML5-enabled web browser opens with
the animation running. To view the resulting animation file, you must have an
HTML5-enabled web browser installed on your system.

Use vrplay(filename), where Filename is the name of your virtual world 3D file.
This command opens the 3D Animation Player and your file. Using the player, you
can control the playback of your file.

For example, play the animation file based on the vr_octavia example by running
vrplay(“octavia_scene_anim.wrl®).

vrplay works only with VRML animation files created using the Simulink 3D
Animation recording functionality.

In the Current Folder pane of MATLAB, double-click the animation file and from
the context menu, select Run.

At the MATLAB command line, use vrview.

A fourth option is to use the MATLAB command vrview. For example, enter:

w=vrview("vrplanets_anim_1.wrl");
set(w, "TimeSource”, "freerun®);
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The vrview command displays the default Simulink 3D Animation Viewer for the
animation file. Setting the TimeSource property of the set method to "freerun*”
directs the viewer to advance its time independent of the MATLAB software.

To stop the animation, type:

set(w, "TimeSource", "external ") ;

To close the viewer and delete the world, get the handle of the vrfigure object and close
it, as follows:

f=get(w, "Figures®)
close(T);
delete(w);

Or, to close all vrfigure objects and delete the world, type

vrclose
delete(w);

Play AVI Animation Files

To view an AVI animation file, use one of these approaches:

* Double-click the AVI animation file. The program associated with .avi files in your

system (for example, Windows Media® Player Media Player) opens for the .avi file. If
your -avi file is not yet running, start it now from the application. The animation file
runs.

+ Use the MATLAB VideoReader function.

See Also

Functions
vrplay | vrview

Related Examples

. “Record and Play Animations”
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Build Virtual Reality Worlds

The Simulink 3D Animation product includes tools that you can use to edit and create
virtual worlds. A basic understanding of these tools and how to use them will help you to

get started quickly.

“Virtual World Editors” on page 5-2

“Build and Connect a Virtual World” on page 5-7

“Virtual World Data Types” on page 5-25

“Simulink 3D Animation Textures” on page 5-30

“Add Sound to a Virtual World” on page 5-31

“Use CAD Models with the Simulink 3D Animation Product” on page 5-32
“Import STL and Physical Modeling XML Files” on page 5-34
“Import VRML Models from CAD Tools” on page 5-36

“Import VRML Models from CATIA Software” on page 5-45
“Modify the CAD Model Virtual World” on page 5-52

“Import Visual Representations of Robot Models” on page 5-55
“Link to Simulink and Simscape Multibody Models” on page 5-62
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Virtual World Editors
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Editors for Virtual Worlds

The primary way to create a virtual world is with a 3-D editing tool. These tools allow
you to create complex virtual worlds without a deep understanding of the VRML or X3D
language. These 3-D editing tools offer the power and versatility for creating many types
of practical and technical models. For example, you can import 3-D objects from some
CAD packages to make the authoring process easier and more efficient.

There is more than one way to create a virtual world defined with VRML or X3D code.
You can use a virtual world editor to create a virtual world without knowing anything
about the VRML or X3D language. Or you can use a text editor to write code directly.

The Simulink 3D Animation product includes the 3D World Editor for editing virtual
worlds. You can use the 3D World Editor on all supported platforms for Simulink 3D
Animation. The 3D World Editor is the default editor. For a comparison of editors, see
“Virtual World Editors” on page 5-2.

As you create a virtual world, you can use different editors for different phases of the
process. Choose the editor that best meets your needs.

Some people prefer to create simple virtual worlds using MATLAB Editor or other text
editor.

For Windows platforms, you can also use Ligos V-Realm Builder software to create and
edit code. For information on using V-Realm Builder software with the Simulink 3D
Animation product, see “Ligos V-Realm Builder” on page 5-6.

“Text Editors” on page 5-3.
For details about specifying an editor, see “Set the Default Editor” on page 2-2.

For a description of the benefits and limitations of different types of editors, see the next
section.

+ “Text Editors” on page 5-3

* “General 3-D Editors” on page 5-3

* “Native VRML and X3D Editors” on page 5-4
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+ “3D World Editor” on page 5-4
Text Editors

A virtual world 3D file uses a standard text format that you can read with any text
editor. Reading the code in a text editor is useful for debugging and for directly changing
the code, and for automated processing of the code. If you use the correct syntax, you can
use the MATLAB Editor or any common text editor to create virtual worlds.

Consider using a text editor to work on a virtual world when you want to:

+ Create a simple virtual world.

*  Debug syntax and formatting errors in a virtual world 3D file. Corrupted files do not
open in most 3-D tools.

* Learn about VRML and X3D syntax by using VRML and X3D syntax highlighting in
the MATLAB Editor. For details, see “VRML and X3D Syntax Highlighting” on page
5-3.

* Perform global search editing operations across one or more virtual world 3D files.

*  Combine several virtual world models. Combining models can involve temporary
model inconsistencies, which most 3-D tools cannot handle.

VRML and X3D Syntax Highlighting
You can display VRML, X3DV, and X3D syntax highlighting in the MATLAB Editor.

To set MATLAB Editor properties for VRML and syntax highlighting (for example, the
color for highlighting comments or not using the smart indentation feature):

1 In MATLAB, select Preferences > Editor/Debugger > Language.

2 In the Editor/Debugger Language Preferences dialog box, set the Language field to
VRML/X3DV.

3 Change the highlighting properties that you want.
For X3D syntax highlighting, set Language to XML/HTML.

General 3-D Editors
General 3-D editors, such as 3D Studio, SolidWorks®, or Autodesk® Maya, do not use

VRML or X3D as their native format. They export their formats to VRML or X3D. These
tools have many features and are relatively easy to use.
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General 3-D editing tools target specific types of work. For example, they can target
visual art, animation, games, or technical applications. They offer different working
environments depending on the application area for which they are designed. Some of
these general 3-D editing tools are powerful, expensive, and complex to learn, but others
are relatively inexpensive and can satisfy your specific needs.

The graphical user interfaces for many of the commercial general 3-D editors use
features typical of the native VRML or X3D editing tools. For example, in addition to
displaying 3-D scenes in various ways, they offer hierarchical tree styles, providing an
overview of the model structure and a shortcut to nodes.

Native VRML and X3D Editors

Native VRML and X3D editors use those languages as their native format. Native
VRML editors support features that are unique to the VRML and X3D format, such as
interpolators and sensors.

The Simulink 3D Animation software includes two native VRML and X3D editors:
+ “3D World Editor” on page 6-2, which works on all platforms supported for
Simulink 3D Animation product

* The “Ligos V-Realm Builder” on page 5-6, which works on Windows platforms
only

3D World Editor

The 3D World Editor is installed as part of the Simulink 3D Animation installation. It is
the default virtual world editor.

The 3D World Editor is a native VRML and X3D authoring tool that provides an
interface to the syntax of those languages. The editor supports VRML97 types and
language elements. For details on limitations, see “VRML Support” on page 1-14and
“X3D Support” on page 1-11.

The 3D World Editor interface provides three panes.
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@% 3D World Editor - Hy/Documents/MATLAB/vr_bounce.wrl =N E=h=
File Edit ViewPane Tree MNodes Help

DECEHEE EENEEN DE0E|E-RFH|e

» ROOT i .
tH- ®  (WorldInfo)
H- *  (MavigaticnInfo)
- ®  (Viewpoint)
-~ P Beckg (Background)
- ® (Shape)
B appearance (SFNode)
[=- ® (Appearance)
: testureTransform (SFMeode)
texture (SFMNode)
E ® material (SFMode)

- ®  (Material)

A ambientIntensity (5FFloat): 1

& diffuseColor (SFColer): 0 1] 0.8
i emissiveCelor (5FCeler): 0 0 0 A——
-8 chininess (SFFloat): 0.2
B f-pecuorColor (SFColon: 0.0 0]
o transparency (SFFloat): 0
= ® geometry (SFMNode)

- ® (IndexedFaceSet) [_.
i b Ball (Transform)

specularColor (SFColor)

Value | Comment

)

L C5 pa B3

Apply Cancel

0 o 0

»

| ROOT/ (Shape)/appearance (SFNode)/ (Appearance)/material (SFNode)/ (Material)/specularColor (SFColor)

Tree structure pane — View the hierarchy for the virtual world that you are editing.
The 3D World Editor lists the nodes and their properties according to their respective
node types. You can change the nesting levels of certain nodes to modify the virtual
world. In the tree viewer, give the nodes unique names.

Virtual world display pane — Observe the virtual world as you create it. The 3D
World Editor renders inlined objects (grouped objects). It uses the same renderer
as the Simulink 3D Animation viewer. Using the same renderer for the editor and

the viewer provides consistent navigation and display throughout the development
process.

Object property edit pane — Change values for node items.
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For details, see “Build and Connect a Virtual World” on page 5-7 and “3D World
Editor” on page 6-2.

Ligos V-Realm Builder
The Ligos V-Realm Builder interface is available only for Windows operating systems.

The V-Realm Builder application is a flexible, graphically oriented tool for 3-D editing. It
provides similar functionality as the 3D World Editor.

The V-Realm Builder offers these features that the 3D World Editor does not:

*  Manipulators — for dragging objects in the 3—D world

+ Keyframe animation — animation involving interpolated linear movements
Compared to the 3D World Editor, the V-Realm Editor interface:

*  Supports only VRML, not X3D

* Provides dialog boxes for editing properties, which can be less streamlined than the
3D World Editor object properties edit pane

* Does not always render virtual worlds the same way as the viewer
*  Does not support rendering inlined objects

For more information about the V-Realm Editor, see “V-Realm Builder Help” on page
2-22.

See Also

Functions
vredit | vrgetpref | vrsetpref

Related Examples

. “Set the Default Editor” on page 2-2

. “3D World Editor” on page 6-2

. “Basic Editing” on page 6-12

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4
. “Install Third-Party Editors and Viewers”
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Build and Connect a Virtual World

In this section...

“Introduction” on page 5-7

“Define the Problem” on page 5-7

“Add a Simulink 3D Animation Block” on page 5-9
“Open a New Virtual World” on page 5-10

“Add Nodes” on page 5-11

“Link to a Simulink Model” on page 5-20

Introduction

The example in this section shows you how to create a simple virtual world using the 3D
World Editor. The example does not show everything that you can do with the editor.
However, the example does show you how to perform some basic tasks to get started.

This example assumes that you have set your default editor to be the 3D World Editor.
For details, see “Set the Default Editor” on page 2-2.

This example describes the steps to build a simplified version of the virtual world that
you see if you enter this command in the MATLAB command window:

edit(vrworld("vrdeform.wrl™))

Define the Problem

Suppose that you want to simulate and visualize in virtual reality the deformation of

a sphere. In your virtual world, you want to have two boxes representing rigid plates
(B1, B2) and an elastic sphere (S) between them. All three of the objects are center-
aligned along the x-axis. The boxes B1 and B2 move toward S with identical velocities,
but they move in opposite directions. As they reach the sphere S, they start to deform it
by reducing its x dimension and stretching both its y and z dimensions.

Here 1s how this virtual world looks:
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&% vrtuts

File View Viewpoints Mavigation Rendering Simulation Recording Help k]

| Fiy rdMP rolddg B @ »

No Viewpoint T=25.30 Fhy Pos:[0.00 0.00 10.00] Dir:[0.00 0.00 -1.00]

The following table lists the positions and dimensions of the objects that you create for
this example.

Object Center Position Dimensions
B1 [3 0 0] [0.3 1 1]
B2 [-3 0 0] [0.3 1 1]
S [0 0 0] r=0.9

The Simulink 3D Animation product includes the tutorial model vrtut3. This simplified
model simulates the deformation of an elastic sphere. After collision with the rigid blocks,
the sphere's x dimension decreases by a factor from 1 to 0.4, and the y and z dimensions
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expand to keep the volume of the deformed sphere-ellipsoid constant. Additional blocks
in the model supply the correctly sized vectors to the Simulink 3D Animation block.
The simulation stops when the sphere is deformed to 0.4 times its original size in the x
direction.

Your first task is to open a Simulink model and add a Simulink 3D Animation block to
your model.

Add a Simulink 3D Animation Block

This procedure uses the Simulink model vrtut3 to show how to add a Simulink 3D
Animation block to your model. The model generates the values for the position of B1,

the position of B2, and the dimensions of S (as described in “Define the Problem” on page
5-7).

1 Open the Tutorial #3. example.

a At the top of the page that opens, select Open this Example.
b Save thevrtut3 file to your MATLAB working folder.

2 In MATLAB, change the current folder to your MATLAB working folder.
In the MATLAB Command Window, type:

vrtut3

A Simulink window opens with a model that contains Simulink 3D Animation
VR Signal Expander blocks, but no VR Sink block to write data from the model
to Simulink 3D Animation. Instead, this model uses Scope blocks to monitor
temporarily the relevant signals.

5-9



5 Build Virtual Reo|ity Worlds
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4  From the MATLAB Command Window, type

vrlib

The Simulink 3D Animation library opens.

5 From the Library window, drag and drop the VR Sink block to the Simulink
diagram. You can then close the Library Browser window.

Your next task is to create a virtual world that you will associate with the VR Sink block.
See “Open a New Virtual World” on page 5-10.

Open a New Virtual World

You must create a virtual world to connect to a Simulink model for visualizing signals.

This procedure opens a new virtual world, in which you add nodes for visualizing the
signals of the model vrtut3. The connection between the virtual world and the Simulink
model requires that the model includes a VR Sink block, as described in “Add a Simulink
3D Animation Block” on page 5-9.

1  Start the 3D World Editor with an empty virtual world. From the MATLAB
Toolstrip, in the Apps tab, in the Simulation Graphics and Reporting section,
click 3D World Editor.

The 3D World Editor displays:
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* In the left pane, a virtual scene tree with only a ROOT node
* In the right pane, an empty virtual world
In the bottom pane, an empty pane for editing objects

2 You can save the virtual world at any point. Save the virtual world as vrtut3._.wrl
in the same working folder where your vrtut3 file resides. Do not close the 3D
World Editor.

Your next two tasks create a virtual world to use with the vrtut3 model:

+ “Add Nodes” on page 5-11
+  “Build and Connect a Virtual World” on page 5-7

Add Nodes

Create Boxes

Defining virtual world objects involves defining a hierarchy of nodes. This example
shows how to define Transform nodes under the ROOT node, with each Transform node
including a hierarchy of children, Shape, Appearance, Geometry, and specific shape
(in this case, a Box) nodes.

1 In the tree in the left pane, click ROOT (the topmost item).
2 Add a Transform node, using the following sequence of menu selections.

& 30 World Editor - H:/Documents/MATLAB/vrtut3.wri* =3 |
File Edit ViewPane Tree Help x

NECCHEBER ¥ A »|  Appearance
[« g Insert From... 3 Bindable
Inline VRML File... Cemmon
Wrap By 3 Geometry
Anchor
Billboard

USE Group
ROUTE Interpolator

Light Collision

Sensor Group
PROTO/EXTERNPROTQ Instance Transform
PROTO Declaration

EXTERMPROTO Declaration

Inline
LoD
Switch

3 This Transform node is for the B1 box. To name the Transform node:
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a Right-click the Transform node.

b Select the Edit Name menu item.

¢ Inthe edit box to the left of the Transform node, type B1.
4 Add a Shape node:

a Expand the B1 Transform node.
b Select the children node.

¢ Add a Shape node, using the following sequence of menu selections:

4*® 30 World Editor - Hi/Documents/MATLAB/vrtut3.wrl” =N o=
| e N B e Help 5
NERECCHER|9 A »  Appearance v
» ROOT Insert From... ¥ Bindable »
= b BL (Transform) Inline VRML File... Common v Audio Clip

B+ center (SFVec3f):0 0 0 Wrap By N Geometry » Seript

-+ rotation (SFRotation): 0 = Gom D Shape %

of scale (SFVec3):1 1 1 -

- scaleOrientation (SFRof|  ROUTE 'DiETRlEED K ot

o translation (SFVec3f):0 0 0 Light 3 World Info

B bboxCenter (SFVec3f):0 0 0 Sensor [

PROTQ/EXTERNPROTO Instance
PROTO Declaration
EXTERNPROTO Declaraticn

~ B bboxSize (SFVec3f): -1 -1 -1
.

5 Add an Appearance node for the Shape node:

a Under the Shape node, select the appearance (SFNode) node.

b Add an Appearance node, using the following sequence of menu selections.
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&® 30 World Editor - H:/Documents/MATLAB /vrtut3.wil* [E=nE=R===

File Edit ViewPane Tree Help L
El=gs] | - ¥ earance b

NECCcHE R Add App

Appearance I
% roor | InsetFrom..  »  Bindable 3 Calor

=P Bl (Transform) Inline VRML File... Common » Font Style
o center (SFVec3f):0 0 0
4B+ rotation (SFRotation): 0
o scale (SFVec3f)i1 1 1

Wrap By 3 Geometry e Image Texture
USE Group r Material

+-~B scaleOrientation (SFRot ROUTE Interpolator 4 Movie Texture
- translation (SFVec3f):0 0 0 Light 4 Pixel Texture
- B bboxCenter (SFVec3):0 0 0 Sensor 3 Texture Transform

- B bboxSize (SFVec3f): 1 -1 1
= ® children (MFNode)
B ® (Shape)
e

PROTO/EXTERNPROTO Instance
PROTQ Declaration
EXTERNPROTO Declaration
* geometry (SFNode)

Add a Material node to the Appearance node:

a Expand the (Appearance) node and select the material (SFNode) node.

b Add a Material node, using the following sequence of menu selections.

¢® 3D World Editor - H:/Documents/MATLAB/vrtut3.wrl* = |
File Edit ViewPane Tree Help o
NECCHER |9 A +|  Appearance v Appearance

5 b Bl (Transfarm) Insert From... M Bindable b Color

B center (SFVec3f):0 0 0 Inline VRML File... Common » Font Style

B rotation (SFRotation): 0 Wrap By d EammE b Image Texture
o scale (SFVec3f)i1 1 1 e Group N Matrcal
+-+f scaleOrientation (SFRot UsE %

o translation (SFVec3f): 0 ROUTE Interpolator D Movie Texture
B bboxCenter (SFVec3):0 0 0 Light 4 Pixel Texture

- B bboxSize (SFVec3f): -1-1-1
= ® children (MFNode)
B * (Shape)
5 appearance (SFNode]
=~ ® (Appearance)
- # textureTransform (SFNode),
* texture (SFNode)

Sensor
PROTO/EXTERNPROTO Instance
PROTQ Declaration
EXTERNPROTO Declaration

Texture Transform

m

geometry (SFNode) -
q i v

Add a Box node to the geometry node:

a Select the geometry(SFNode) node of the (Shape) node.

b Add a Box node, using the following sequence of menu selections.
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©*® 30 World Editor - H:/Documents/MATLAB/vrtut3.wrl™
File Edit ViewPane Tree

MR CHBER| Add 4 Appearance

DRW— Insert From... 3 Bindable

= b Bl (Transform) Inline VRML File... Common
B> center (SFVec3f):0 0 0 Wrap By o Geometry
B> rotation (SFRotation): 0 Group

B scale (SFVec3n:1 1 1 =
T Interpolator
Light

Sensor

& scaleOrientation (SFRot
+§ translation (SFVec3f):0 0 0
E bboxCenter (SFVec3f):0 0 0
B bboxSize (SFVec3f): -1 -1 -1
* children (MFNode)
= & (Shape)

= ® appearance (SFNode)

PROTO Declaration
EXTERNPROTO Declaration
“i-* (Appearance)
* textureTransform (SFNode)
* texture (SFNode)
i+ material (SFNode)

With all the nodes expanded, the 3D World Editor now displays a box in the virtual

world display pane.

&% 3D World Editor - H:/Documents/MATLAB/vitut3.wil*
File Edit ViewPane Tree Nodes Help
NESCHEBR| 928
» ROOT
= b Bl (Transform)
B center (SFVec3):0 0 0
& rotation (SFRotation): 0 0 1 0
B scale (SFVec3fi1 11
B scaleDrientation (SFRotation): 0 0 1 0
B transiation (SFVec3f):0 0 0
B bboxCenter (SFVec3f):0 0 0
B bboxSize (SFVec3f): -1 -1 -1
* children (MFNode)
=- * (Shape)

= ® appearance (SFNode)

= ® (Appearance)
* textureTransform (SFNode)
* texture (SFNode)
& ® material (SFNode)
= ® geometry (SFNode)
B

X OEos 8-H+E @

PROTQ/EXTERNPROTO Instance

3 Box

3 Cone

» Cylinder

3 Elevation Grid

Extrusion
Indexed Face Set
Indexed Line Set

Sphere
Text
Coordinate
Normal
Point Set
Texture Coordinate

8 Make the box smaller by editing its Size property:
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a Select the size property of the Box node.

In the object properties edit pane at the bottom of the 3D World Editor, enter
0.3 in the first column, and 1 in the second and third columns.

¢ Click Apply.

The box becomes smaller.

«*® 3D World Editor - H:/Documents/MATLAB fwrtut3.wrl*

(E=3) F=h =
File Edit ViewPane Tree MNodes Help
NEECHER | 2 1 lmiEni=NEEE @
b ROOT
=~ b Bl (Transform)
B center (SFVec3f):0 0 0
-8 rotation (SFRotation): 0 0 1 0
4B scale (SFVec3f):1 11
i-+8 scaleOrientation (SFRotation): 0 0 1 0
4B+ translation (SF¥ec3f): 0 0 0
- B bboxCenter (SFVec3f):0 0 0
B bboxSize (SFVec3f): -1-1-1
- ® children (MFNode)
2 e (Shape)
-1 ® appearance (SFNode)
- ® (Appearance)
i ® textureTransform (SFMNode)
to @ texture (SFMode)
A material (SFNode)
=1 ® geometry (SFNode)
- (Box)
o size (SFVec3f: 0.3 1

€ [0 »

9 Move the box to the right by changing the translation(SFVec3f) property of the

B1(Transform) node. In the object properties edit pane, set the first column to 3
and leave the second and third columns set to O.
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«*® 30 World Editor - H:/Documents/MATLAB fvrtut3.wrl*

[E=3 B =
File Edit ViewPane Tree Nodes Help A
AEEEETEEE EEOBD®E B== @
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=k B BL (Transform)
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i rotation (SFRotation):0 0 1 0
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10 Add a second box that is similar to the first box.

a Under the ROOT node, add a Transform node (see step 2) and name it B2 (see
step 3).

b Copy the Shape node. Under the B1 Transform node, right-click the Shape
node in the B1 Transform node and select the Copy menu item.

¢ Paste the copied Shape node into the B2 Transform node. Under the B2

Transform node), right-click the children node and select the Paste Node >
Paste menu item.

With the B1 node collapsed and the B2 node expanded, the 3D World Editor
looks like the following graphic.
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&*® 2D World Editor - H:/Documents/MATLAB/vrtut3 wrl™

= [ =] =
File Edit Tree Nodes Help )
DERSCHEE |92 # X EBEE @
¥ ROOT

- b BL (Transform)
=- b B2 (Transform)
B center (SFVec3f: 0 0 0
B rotation (SFRotation): 0 0 1 0
& scale (SFVec3f):1 1 1
8 scaleOrientation (SFRotation):0 0 1 0
B translation (SFVec30):0 0 0
B bboxCenter (SFVec3f):0 0 0
B bboxSize (SFVec3f): -1 -1 -1
£+ @ children (MFNode)
B ¢ (Shape)
S~ * appearance (SFNode)
2~ (Appearance)
£ & material (SFNode)
= (Material)
B ambientIntensity (SFFloat): 0.2
B diffuseColor (SFColor:0.8 08 08
& emissiveColor (SFColor): 0 0 0
+f chininess (SFFloat): 0.2
i specularColor (SFColor): 0 0 0
& transparency (SFFloat): 0
® texdure (SFNode)
* tedureTransform (SFhode)
= * geometry (SFNode)
2o [(Box)
B size (SFVec3f): 03 1 1

Move the box that you created to the left by changing the translation property of

the B2(Transform) node. In the object properties edit pane, set the first column
to -3 and leave the second and third columns set to O.

«*® 3D World Editor - H:/Documents/MATLAB/vrtut3.wrl*
File Edit ViewPane Tree MNodes Help

WEEEELEEIE
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Oso®A|= =+ )

b ROOT
@~ P Bl (Transform)
=- B B2 (Transform)
4B+ center (SFVec3f):0 0 0
&+ rotation (SFRotation): 0 01 0
B scale (SFVec3f1 1 1
-+ scaleOrientation (SFRotation): 0 01 0
B+ translstion (SFVec3f): -3 0 0
§ bboxCenter (SFVec3f):0 0 0
§ bboxSize (SFVecdf):-1-1-1
=k children (MFNode)
= & (Shape)
= * appearance (SFNode)
4 ®  (Appearance)
= ® geometry (SFNode)
= & (Box)
B size (SFVec3f): 0.3 1
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Create a Sphere

Your next task is to add a sphere between the two boxes. This section assumes that you
have completed the tasks described in “Add Nodes” on page 5-11.

1 To make it easier to focus the tree structure pane on the nodes that you want to
add, collapse the B1(Transform) and B2(Transform) nodes.

2 In the tree in the left pane, click ROOT node.

Add a Sphere node. The 3D World Editor includes a library of objects for building a
virtual world, including a Sphere object.

Add a Sphere library object using the following sequence of menu selections.

&® 3D World Editor - H:/Documents/MATLAB/vitut3-junk.wrl =N Eem )|

File Edit ViewPane Tree Help o
DECCHEBE R Add yIIBOME[E -+ | e
» ROOT Insert From... ¥ Component Library...

& P B (Transform) Inline VRML File... Material Library...
=P B2 (Transform) Wrap By » Texture Library..
B center (SFVec3f):0 0 0
-+ rotation (SFRotation): 0 UsE 4 Otheylocstor
B scale (SFVec3f111 ROUTE
-+ scaleDrientation (SFRotation):0 0 1 0
-~ transiation (SFVec3f): 0 0 0
- B bboxCenter (SFVec3f):0 0 0
B bboxSize (SFVec3fy -1-1-1
=+ # children (MFNode)
Bl ® (Transform)
-4 center (SFVec3f):0 0 0
B rotation (SFRotation):0 0 1 0
o scale (SFVec3):1 1 1
- scaleOrientation (SFRotation):0 0 1 0
4B+ translation (SFVec3f): -3 0 0

LB hknvCanber QEVer3000 0 0

From the list of Component Library folders, select the Shapes folder, and then select
the Sphere.wrl file.

4 Select the Transform node and name it S.

With the S Transform node fully expanded and the other Transform nodes
collapsed, the 3D World Editor looks like the following graphic.
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<# 3D World Editor - H:/Documents/MATLAB/vrtut3-junkwil* =0 =N |
File Edit ViewPane Tree Nodes Help

NMESCHER 95X EBX|OE0H|E-++H| @
=¥ B2 (Transform) B

-l center (SFVec3f): 0 0 0
-+ rotation (SFRotation):0 0 1 0
oo scale (SFVec3fil 11
-4 scaleOrientation (SFRotation):0 0 1 0
b translation (SFVec3f): 0 0 0
- B bboxCenter (SFVec3f:0 0 0
B bboxSize ($FVec3f:-1-1-1
5 children (MFNode)
Bl # (Shape)
£ appearance (SFNode)
{ B+ (Appearance) o
i | ® textureTransform (SFNode) |
- # texture (SFNode)
B * material (SFNode)
B¢ (Material)
& ambientintensity (SFFI
i+ diffuseColor (SFColor)
- +B emissiveColor (SFColo
i+ shininess (SFFloat): 02
++B specularColor (SFColo
H t-+ transparency (SFFloat)
£ * geometry (SFNode)
S+ (Sphere) <

5 To make the sphere blue, under the Material node, select the di ffuseColor
property. In the object properties edit pane, change the first column value to 0.2,
the second column to 1, and the third column to 1.

4% 3D World Editor - H:/Documents/MATLAB/urtut3-junk wrl* =3 ch ==
File Edit ViewPane Tree MNodes Help M
SEEEEEEIE " =EIEREEE @

= F S{lransform]
i center (SFVec3f:0 0 0
-4+ rotation [SFRotation): 0 0 1 0
o scale (SFVec3fi1 1 1
-4 scaleOrientation (SFRotation): 0 0 1 0
- translation (SFVec3f):0 0 0
B bboxCenter (SFVec3f):0 0 0
B bboxSize (SFVec3f: -1-1-1
* children (MFNode)
E1-® (Shape)
B # appearance (SFNode)
i O e (Appesrance)
: i # tedtureTransform (SFNode)
e texture (SFNode)
5 ® material (SFNode)
E-e (Material)
i+ ambientintensity (SFFI
.+ diffuseColor (SFColor)
-+ emissiveColor (SFColo
i+ shininess (SFFloat): 0.2
i+ specularColor (SFColo
| i<k transparency (SFFloat)
£ # geometry (SFNode)
e (Sphere)
- § radius (SFFloat): 1 -

« m v

6 Save the virtual world file.

Your next task is to connect the model outputs to the Simulink 3D Animation block in
your Simulink model. See “Link to a Simulink Model” on page 5-20.
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5-20

Link to a Simulink Model

After you create a virtual world and a Simulink model with a VR Sink block, define
the associations between the model signals and the virtual world. This procedure uses
the model vrtut3 as an example. It assumes that you have opened the model and
that you have added a VR Sink block, and that you have created a virtual world called
vrtut3.wrl. See the tutorial starting with “Add a Simulink 3D Animation Block” on
page 5-9.

1

In the Simulink model window, double-click the VR Sink block.

The Parameters: VR Sink dialog box opens.

Next to the Source file edit box, click Browse.

The Open dialog box opens.
Select vrtut3.wrl, and then click Open.

In the Output pane, select the Open Viewer automatically check box.

This check box specifies that a viewer for the virtual world starts when you run the
model.

In the Description field, type vrtut3.
Click Apply in the Parameters: VR Sink dialog box.

In the tree structure pane, select the B1 translation, B2 translation, and S scale
check boxes as the nodes you want to connect to your model signals. Click OK to
close the dialog box.

The VR Sink block appears with corresponding inputs.

Delete the three Scope blocks (B1 Translation, B2 Translation, and S scale)
and their associated input signal lines.

Connect the input lines from the VR Signal Expander, VR Signal Expanderl,
and S Scaling in XYZ blocks to the appropriate ports in the VR Sink block.
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10

11

12

|Pafvrtut3 »
Ay =
N —  » BZ.translatien
BfVeooly 81X Pastion e
VR Signal Expander .
VR Sirk
Lb N %
il ———
VR Signal Expander!
B1 Thickness /2
min ‘@ >
S Deformation in X Conversion >
H Fastion to Scale
;
Initial S Radius ki
) Volume
Siop Condiion YZ Deformation S Scaling
inXvZ
XD

Double-click the VR Sink block.

The viewer appears.

Select the Simulation menu Block Parameters option. Your default viewer opens
and displays the virtual world. For more information on changing your default
viewer, see “Set the Default Viewer” on page 2-5.

In the Parameters: VR Sink dialog box, click the View button.
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¢ vrtut3 =N B =

File View Viewpoints Mavigation Rendering Simulation Recording Help k.

+ | Fly ~JdM LD d g B e » W

|No Viewpoint |T=25.30 |Fiy |Pos:(0.00 0.00 10.00] Dir:[0.00 0.00 -1.00]

13 In the Simulink window, from the Simulation menu, click Run.

In your default viewer, you see a 3-D animation of the scene. Using the viewer
controls, you can observe the action from various points.

When the width of the sphere is reduced to 0.4 of its original size, the simulation
stops running.
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N ol

File Wiew Yiewpoinks Mavigakion Rendering  Simulation  Recording  Help

| I sl o dae |

Mo viewpoink T=25.30 Fly Pos:[0.00 0,00 10,007 Cir:[0.00 0,00 -1.0

This example shows you how to create and use a simple virtual reality model. Using the
same method, you can create more complex models for solving the particular problems
that you face.

See Also

Functions
vredit | vrgetpref | vrjoystick | vrlib | vrsetpref | vrspacemouse

Blocks
VR Sink | VR Source
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Related Examples
. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4

. “Virtual Reality World and Dynamic System Examples” on page 1-22
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Virtual World Data Types

In this section...

“Field Data Types” on page 5-25
“Virtual World Data Class Types” on page 5-27

Nodes use VRML and X3D virtual world data types to define objects and the types of
data that can appear in the node fields and events.

This section explains these field data types and data class types.

Field Data Types

The Simulink 3D Animation product provides an interface between the MATLAB and
Simulink environment and virtual reality scenes. With this interface, you can set and
get the scene node field values. Working with these values requires that you understand
the relationship between virtual world data types and the corresponding MATLAB data
types. The following table illustrates the virtual world data types and how they are
converted to and from MATLAB types.

For a detailed description of the VRML fields, refer to the VRML97 Standard.

You can use MATLAB commands to read and save X3D files and to associate X3D files
with Simulink models. For additional information about X3D support in Simulink 3D
Animation, see “X3D Support” on page 1-11.

For information about the supported X3D specification, see ISO/IEC 19775-1:2013. For
information about supported X3D encoding, see ISO/IEC 19776-1.3:201x and ISO/IEC
19776-2.3:201x.

VRML Type Description Simulink 3D Animation Type

SFBool Boolean value true or false. logical

SFFloat 32-bit, floating-point value. single

SFInt32 32-bit, signed-integer value. int32

SFTime Absolute or relative time value. |double

SFVec2f Vector of two floating-point Single array (1-by-2)
values that you usually use for
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VRML Type Description Simulink 3D Animation Type
2-D coordinates. For example,
texture coordinates.
SFVec3f Vector of three floating-point Single array (1-by-3)
values that you usually use for
3-D coordinates.
SFColor Vector of three floating-point Single array (1-by-3)
values you use for RGB color
specification.
SFRotation Vector of four floating-point Single array (1-by-4)
values you use for specifying
rotation coordinates (x, y, 2)
of an axis plus rotation angle
around that axis.
SFImage Two-dimensional array uint8 array (n-by-m-by-3)
represented by a sequence of
floating-point numbers.
SFString String in UTF-8 encoding. char
Compatible with ASCII,
allowing you to use Unicode®
characters.
SFNode Container for a node. vrnode
MFFloat Array of SFFloat values. Single array (n-by-1)
MFINnt32 Array of SFInt32 values. int32 array (n-by-1)
MFVec2f Array of SFVec2f values. Single array (n-by-2)
MFVec3Ff Array of SFvec3F values. Single array (n-by-3)
MFColor Array of SFColor values. Single array (n-by-3)
MFRotation Array of SFRotation values. Single array (n-by-4)
MFString Array of SFString values. char array (n-by-1)
MFNode Array of SFNode values. vrnode

The Simulink 3D Animation software can work with various MATLAB data types,
converting them if necessary:
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* The inputs for the setFfield function (and its dot notation form) and VR Sink and VR
Source blocks, accept all meaningful data types on input. Both convert the data types
into natural virtual world types as necessary. The data types include logicals, signed
and unsigned integers, singles, and doubles.

* The getfield function and its dot notation form return their natural data types
according to the table above.

To ensure backward compatibility with existing models and applications, use the
Simulink 3D Animation vrsetpref function to define the data type support. Their

names are as follows:

Property

Description

DataTypeBool

Specifies the boolean data type for virnode/setfield and
vrnode/getfield. Valid values are "logical " and "char”.
If set to "logical ", the virtual world boolean data type is
returned as a logical value. If set to "char”, the virtual world
boolean data type is returned "on" or "off".

DataTypelnt32

Specifies the Int32 data type for vrnode/setfield and
vrnode/getfield. Valid values are "int32" and "double”. If
set to "iInt32", the virtual world Int32 data type is returned as
int32. If set to "double”, the virtual world int32 data type is
returned as "double”.

DataTypeFloat

Specifies the Float data type for vrnode/setfield and
vrnode/getfield. Valid values are "single” and "double”. If
set to "single”, the virtual world float and color data types
(the types of most virtual world fields) are returned as "single”.
If set to "double™”, the virtual world float and color data
types are returned as "double”.

Virtual World Data Class Types

A node can contain four classes of data: Field, exposedField, eventln, and
eventOut. These classes define the behavior of the nodes, how nodes are stored in
memory, and how they can interact with other nodes and external objects.

VRML Data Class

Description

eventln

An event that the node can be receive
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VRML Data Class Description

eventOut An event that the node can send

field A private node member, holding node data
exposedField A public node member, holding node data
eventin

Usually, eventln events correspond to a field in the node. Node fields are not accessible
from outside the node. The only way you can change them is by having a corresponding
eventlin.

Some nodes have eventln events that do not correspond to any field of that node,

but provide additional functionality for it. For example, the Transform node has an
addChildren eventin. When this event is received, the child nodes that are passed are
added to the list of children of a given transform.

You use this class type for fields that are exposed to other objects.
eventOut

This event is sent whenever the value of a corresponding node field that allows sending
events changes its value.

You use this class type for fields that have this functionality.
field

A field can be set to a particular value in the virtual world 3D file. Generally, the field is
private to the node and its value can be changed only if its node receives a corresponding
eventln. It is important to understand that the field itself cannot be changed by other
nodes or via the external authoring interface.

You use this class type for fields that are not exposed and do not have the eventOut
functionality.

exposedField

This powerful data class serves many purposes. You use this class type for fields

that have both eventln and eventOut functionality. The alternative name of the
corresponding eventln is always the field name with a set_ prefix. The name of the
eventOut is always the field name with a _changed suffix.



Virtual World Data Types

The exposedField class defines how the corresponding eventln and eventOut
behave. For all exposedField classes, when an event occurs, the field value is changed,
with a corresponding change to the scene appearance, and an eventOut is sent with the
new field value. These changes allow the chaining of events through many nodes.

The exposedField class is accessible to scripts, whereas the Field class is not.

More About

. “Virtual Reality Modeling Language (VRML)” on page 1-14
. “X3D Support” on page 1-11

. “Simulink 3D Animation Textures” on page 5-30
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Simulink 3D Animation Textures

The following are texture file recommendations for Simulink 3D Animation models:

*  Where possible, scale source texture files to a size equal to a power of 2 in both
dimensions. Doing so ensures optimal performance for the Simulink 3D Animation
viewer. If you do not scale the files, the Simulink 3D Animation viewer can attempt to
descale the image or create textures with undesired resolutions.

+ Use source texture files whose size and detail are no more than what you need for
your application.

*  Where possible, use the Portable Network Graphics (PNG) format as the static
texture format. You can also use the GIF and JPG graphic formats.

*  For movie textures, use the MPEG format. For optimal performance, be sure to scale
source texture files to a size equal to the power of 2 in both dimensions.

More About

. “Virtual Reality Modeling Language (VRML)” on page 1-14
. “X3D Support” on page 1-11
. “Virtual World Data Types” on page 5-25
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Add Sound to a Virtual World

To add sound to a virtual world, use a Sound node. You can include an AudioClip
node in a Sound node. For an AudioClip node, use a mono or stereo WAV file in
uncompressed PCM format.

To listen to the sound, use a computer that supports sound. For details, see “Listen to
Sound in a Virtual World” on page 7-61.

Note: A stereo sound source retains its channel separation during playback. Simulink

3D Animation attenuates the sound based on the distance of the viewer from the sound
location. The relative position of the viewer to the sound location and the viewer direction
in the virtual world do not affect the stereo channels. There is no impact even if the
Sound node has the spatialize field set to true.

The following code adds to a virtual world a sound that switches on and off based on a
logical signal.

DEF SoundSwitch Switch {
choice [
DEF MySound Sound {
source DEF CraneNoise AudioClip {
url "sound/crane_run.wav"'
loop TRUE
}
}
1
}

Related Examples
. “Listen to Sound in a Virtual World” on page 7-61
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Use CAD Models with the Simulink 3D Animation Product

5-32

In this section...

“Use of CAD Designs” on page 5-32
“Import CAD Designs” on page 5-32
“Integrate the Imported Model Virtual World” on page 5-33

Note: These topics assumes that the reader has a moderate knowledge of the Simulink

3D Animation product. For VRML-specific information, such as the description of nodes
and their fields, refer to the VRML97 standard.

Use of CAD Designs

When you work with models of dynamic systems, often it is helpful to visualize them

in a three-dimensional virtual reality environment. If most of the 3D designs in your
organization are created using CAD tools, convert these designs into forms that you can
be use with:

*  Simulink models

*  Simscape Multibody models

* MATLAB models

To adapt existing CAD designs for visualization using the Simulink 3D Animation
software:

* Import CAD designs

+ Integrate the virtual world created from the imported CAD model into the Simulink
3D Animation environment.

Import CAD Designs

You can use the following techniques to import CAD designs for use in the Simulink 3D
Animation product:

+ Import STL and Physical Modeling file directly
*  Import VRML models from CAD tools



Use CAD Models with the Simulink 3D Animation Product

Import VRML models from CATIA" software

Integrate the Imported Model Virtual World

After you import the CAD model, use the Simulink 3D Animation software to modify
the resulting virtual world so that you can use it effectively. Also, create associations
between the virtual world and Simulink and Simscape Multibody models.

See Also

Functions
stl2vrml | vrcadcleanup | vrphysmod

Related Examples
“Import STL and Physical Modeling XML Files” on page 5-34
“Import VRML Models from CAD Tools” on page 5-36
“Import VRML Models from CATIA Software” on page 5-45
“Modify the CAD Model Virtual World” on page 5-52
“Link to Simulink and Simscape Multibody Models” on page 5-62
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Import STL and Physical Modeling XML Files

CAD models frequently use STL (STereoLithography) format files or Physical Modeling
XML files.

You can use the 3D World Editor to import STL and Physical Modeling XML files directly
into a VRML virtual scene. You can integrate content from those files into a virtual
world, converting the structure into VRML.

Note: You cannot use the 3D World Editor to import STL and Physical Modeling XML
files directly into an X3D virtual scene.

To import an STL or Physical Modeling XML file:
1 In the 3D World Editor, select the Root node or an MFNode node (usually the
children node of a Transform or Group node).

2 From the Nodes > Import From menu item, select either STL File or Physical
Modeling XML File.

Tip: Alternatively, you can right-click the Root node or an MFNode node and use the
Import From menu item. To insert the new node in the middle of a node list, after
the selected node, use the Nodes > Import From menu path.

Note: To import a Physical Modeling XML file, the target folder must be writable.

Alternatively, you can use the st12vrml function.

Results

Importing an STL file creates a Transform node containing a Shape node with
IndexedFaceSet geometry that represents the original STL shape. The new
Transform is create in one of these locations:

+ At the main level of the scene hierarchy (at the end of the file)
* As a child of a selected grouping node
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Importing a Physical Modeling XML file creates an individual VRML file for each STL
file that the XML file references. The created VRML files are stored in the folder where
the edited VRML file is located.

In the edited VRML file, the newly created Transform contains hierarchical structure
Transforms that correspond to the structure of objects described in the XML file.
Individual VRML shape files in this structure are referenced using Inline nodes.

Note: When importing a Physical Modeling XML file into a new, unsaved VRML model,
children VRML files are created in the current working folder. If you save the file into a
different folder, move the referenced VRML files to the new location.

Related Examples

. “Use CAD Models with the Simulink 3D Animation Product” on page 5-32
. “Import VRML Models from CAD Tools” on page 5-36

. “Import VRML Models from CATIA Software” on page 5-45

. “Modify the CAD Model Virtual World” on page 5-52

. “Link to Simulink and Simscape Multibody Models” on page 5-62
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Import VRML Models from CAD Tools

5-36

In this section...

“VRML Format Type” on page 5-36

“Level of Detail Considerations” on page 5-37
“Units Used in Exported Files” on page 5-37
“Coordinate System Used” on page 5-38

“Assembly Hierarchy” on page 5-38

Note: You cannot use the Simulink 3D Animation to import CAD tool VRML models to
X3D files in Simulink 3D Animation.

To import VRML models from CAD tools, convert your product assembly model into the
VRML format used by the Simulink 3D Animation software. Most CAD tools have VRML
export filters. If the export filter is not directly available in the CAD tool, you can use
conversion utilities available from third parties.

When exporting CAD models into the VRML format, you can set several options to
customize the output. You can set options that are specific to the export filters or are
general CAD file properties. Consult your CAD system documentation for specific details
on how to set these properties. Some of the most typical and useful CAD file properties
are:

* VRML Format Type

* Level of Detail Considerations

*  Units Used in Exported Files

*  Coordinate System Used

* Assembly Hierarchy

VRML Format Type

Graphic tools use two major versions of the VRML format used by CAD tools:

+ VRML1, which is an older format
+ VRML97 (also known as VRMLZ2), which is a newer format
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The Simulink 3D Animation software supports VRML97, so select VRML97 as the export
format.

If your CAD tool allows only VRML1 export, use the Ligos V-Realm Builder application,
which is supplied with the Simulink 3D Animation software, to convert models from
VRML1 to VRML97. Simply open a VRMLI1 file and resave it in V-Realm. The file is
saved in the VRML97 format.

Note: In this documentation, “VRML” refers to the VRML97 standard.

Level of Detail Considerations

Usually CAD models are parametric models that use proprietary object rendering
methods to handle various contexts. During model export, the internal parametric
model of the assembly is tessellated. In this process, the model surface is divided into
triangular meshes, represented by the IndexedFaceSet nodes. Before tesselation, set
the granularity of the mesh so that it is suitable for further use. Modifying the polygon
count later is not practical. The resolution independent information of the object shape
and structure is lost and cannot be reconstructed based on the tessellated model.

For effective rendering of moving parts, keep virtual world models as simple as possible,
with minimal visible model degradation. Find the appropriate compromise between these
two requirements.

Computers and graphic accelerators have a range of performance levels, so there is no
firm recommendation for the number of polygons or triangles suitable for use. To assess
the complexity of a model, you can display the resulting virtual world 3D file in the
Simulink 3D Animation viewer and observe the viewer response to navigation. If you
can navigate the virtual world without any significant delays, the model is suitable for
further work. If you connect the virtual world to a Simulink model, you have access to
more precise measures of suitability. For example, you can find, the number of frames
rendered per second during simulation.

Units Used in Exported Files

VRML and X3D length units are meters. To scale exported parts correctly in the virtual
world, export the parts using meters. If the exported objects are small or large, consider
creating your virtual world in some other scale. In this case, export the objects using
units other than meters.
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Virtual reality viewers measure using dimensions that are comparable to the dimensions
of people, to achieve the immersion effect of virtual reality. Viewers assume that you
prepared the scene so that it can be walked through or examined by a virtual visitor to
the scene (an avatar). The physical dimensions of the avatar are used in calculations for
purposes like collision detection, near-object clipping, or terrain following. To customize
avatar dimensions and other navigation-specific parameters such as default navigation
speed), use the NavigationInfo node. The Simulink 3D Animation viewer enables
effective navigation in the virtual world, including scaled scenes. For example, you can
use the viewer to inspect miniature objects or to visualize a large-scale aircraft operation
in space.

Coordinate System Used

VRML and X3D use a Cartesian coordinate system with axes defined so that:

* +x points right

* +y points up

* +z points out of the screen

To avoid transforming object axes into the virtual world system later on, whenever
possible, export CAD models using an identical coordinate system. If your CAD tool uses

a different coordinate system and does not allow you to change it for the exported objects,
note the system differences. Then implement axes transformations in your model later.

For example, if you export a vehicle model so that it points towards the +x axis on a road
in the virtual world:

*  Make the road also point towards the +x direction.
+  Use the x coordinate for the model of vehicle dynamics.

*  Make a note of the orientation of the parts in the coordinate system.

When the CAD tool allows you to animate parts and assemblies, reset their positions to
the initial state before the export.

Assembly Hierarchy

The export of assembly of parts varies based on the structure of the model, which usually
comes in two forms:
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All parts are independent from each other, or objects in the scene are independent
from each other at the same level of the scene hierarchy. The exported virtual world
3D file has a flat structure, with all part coordinates defined in global coordinates.

Parts follow a hierarchy defined in the CAD tool. The exported virtual world 3D file
uses this hierarchy via the Transform-children mechanism, to create a nested
structure. In this case, part coordinates are usually defined in the local coordinate
system of the parent of the part.

For example, you can export a robot with the following object hierarchy. The
coordinates of each part are defined in the local coordinate system of the parent:

rotating support — arm — wrist — hand — tool

When the rotating support moves, all other parts are designed to move with it.

The hierarchy of the virtual world 3D file must correspond to the coordinates used in the
dynamic model of the assembly as follows:

If all parts in the Simulink or Simscape Multibody model are defined in global
coordinates, use a flat virtual world structure.

If all parts in the Simulink or Simscape Multibody model follow hierarchical
relationships, use a nested virtual world structure.

To illustrate these two cases, imagine a rotating pendulum. As the gray arm rotates
about the vertical axis, the orange pendulum swings about the z axis in local coordinates
of the rotating gray arm.
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VR Rotating Inverted Pendulum - | Ellﬂ

File View Viewpoints Mavigafion Rendering Simulton  Recording  Help >

I cld M s 2dal e Bm@] > =

[ camer= 1

Camera 1 T=0.00 Fly Pos:[-6.57 0.64 3.37] Dir:[0.91 -0.22 -0.36]

If the pendulum dynamics model uses global coordinates for all moving parts, the virtual
world model has a flat structure.

» ROOT

P Stand (Transform)

P Parts_Rotste_Y (Transform)
ez 3 Parts_Swing {Transform)
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Here is the code for the flat structure.

#VBML V2.0 utfs

DEF Stand Transform

children

W -3 dh A e W R

P
= o

DEF Parts_Rotate Y Transform

iy
Ra

children

=
(%]

=
o

["Pendulumsxis-1.wrl"™]

[ i
[P S Ry N T}

DEF Parts Swing Transform

[
(=]

children

[
=

R
Ra

["arm001-1.wrl"™]

SR S R )
LRI S 1)

If the pendulum dynamics model uses local coordinates for moving parts, the
corresponding virtual world model has a nested structure.
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b RoOT
E| P} Stand (Transform)
Bl b chidren (MFNode)
* [Inling)
"E" url {MFString): [stand-1.wrl]
- Parts_Rotate_Y (Transform)
+f» rotstion (SFRotstion): 0 1 0 O
E P children (MFNode)
E| ® (Inline)
"E'* url (MFString}: [Pendulumfdis- Lowr]
=y 3 Parts_Swing {Transform)
El ® children {MFNode)
=B {Inline}
"E'* url (MFString}: [arm001-1.wrl]

Here is the code for the nested structure.

5-42



Import VRML Models from CAD Tools

#VRML V2.0 ucfsg

DEF Stand Transform
children

# Static parts of mechanism

url ["stand-1.wrl"]

wom o1 oon e W R

10 # Parts that rotate along ¥ axis

11 DEF Parts Rotate Y Transform

12 # Initial rotation defined along the Y axis
13 $# to facilitate using VR Expander block

14 r

15
16
17
18 Fe

13

20 # Parts that rotate along Z axis

21 DEF Parts Swing Transform
22 #
23 $# to facilitate using
24 r 0010

25
26 Inline

27 url ["arm001-1.wrl™]
28

29

30

31

32

33

34

# Initial rotation defined along the Z axis

VR Expander block

Some third-party tools allow you to export each part of the assembly into separate
virtual world 3D files. All parts are then referenced in one main file using the Inline
mechanism. Referencing in this manner is the recommended way to work with
assemblies, as the main file is small and easy to understand and modify.

See Also

Functions
stl2vrml | vrcadcleanup | vrphysmod
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Related Examples
“Use CAD Models with the Simulink 3D Animation Product” on page 5-32
“Import STL and Physical Modeling XML Files” on page 5-34
“Import VRML Models from CATIA Software” on page 5-45
“Modify the CAD Model Virtual World” on page 5-52
“Link to Simulink and Simscape Multibody Models” on page 5-62
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Import VRML Models from CATIA Software

In this section...

“CATIA Coordinate Systems” on page 5-45

“Settings That Affect the VRML Output” on page 5-46

“Level of Detail” on page 5-46

“VRML Export Filter Settings” on page 5-46

“VRML Models Exported from the CATIA Environment” on page 5-47
“Adjusting Resulting VRML Files” on page 5-50

You can use CAD designs created in the CATIA product to create Simulink 3D Animation
virtual reality scenes. CATIA models are hierarchical trees comprised of products that
contain parts.

To export CATIA parts or products to the VRML format, in the CATIA dialog box, select
File > Save as and select VRML in the Save as type list.

Note: You cannot use the Simulink 3D Animation to import CATIA models to X3D files
in Simulink 3D Animation.

When exporting products, the CATIA software creates one compound VRML file that
contains all the parts of the product.

To export each part of the assembly hierarchy into a separate VRML file, in the CATIA
environment:

1  Save each part individually to a separate virtual world 3D file.

2 Create the main model virtual world 3D file manually, with Inline references to
the part files.

CATIA Coordinate Systems

The CATIA software also exports background color and viewpoints. The software exports
individual parts without these properties.
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By default, the CATIA software uses right-handed Cartesian coordinate system identical
to the MATLAB coordinate system (“VRML Coordinate System” on page 1-17). Account
for the coordinate system when you export objects from the CATIA environment into
virtual worlds. Also account for the coordinate system when you manipulate exported
objects using the Simulink 3D Animation software.

You can also define a different coordinate system. Within the current geometrical set,
create an axis system. Doing so sets this new system as a reference system that you
can use to export the VRML virtual world. Consider creating such an axis system so
that it corresponds to the virtual world coordinate system. This approach makes all the
coordinates and orientations of objects compatible with other objects you combine into
virtual worlds.

Settings That Affect the VRML Output

In the CATIA environment, the properties that affect the VRML output are available in
two options dialog boxes:

+ Display Performances dialog box
* VRML Compatibility dialog box

Level of Detail

The level of detail of the exported VRML file (accuracy of the tessellation mesh of objects)
corresponds to the setting of CATIA general visualization mesh. In the CATIA menu,
select Tools > Options > General > Display > Performances. In the resulting dialog
box, select the 3D Accuracy options to control the visualization mesh detail.

Use the proportional method of tessellation (arcs are substituted by line segments based
on their relative, not absolute, accuracy). This method works for models regardless their
dimensions. For maximum accuracy of the exported virtual world model, set the slider at
the rightmost position. If the resulting file is too complex to be handled effectively with
VRML rendering tools, experiment with this accuracy setting. Find the setting that gives
you the smallest possible virtual world model that is visually acceptable.

VRML Export Filter Settings

The CATIA software enables you to tune some VRML export options. You can use these
Tools > Options > General > Compatibility > VRML options:
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+  Select VRML97 as the export format

The Simulink 3D Animation software uses VRML97 standard format.

+  Select the Save normals check box

This option affects whether to export explicit face normals definitions.

+ Clear the Save edges check box

Clear this check box for optimum performance. Selecting this check box directs the
CATIA software to export object edges (in the form of IndexedLineSets).

+ Select the appropriate Save textures check boxes to the desired settings

In particular, if you want to save textures, select the Save textures in external
files option. This option generates external JPG files for object textures.

+ Select the VRML model background color

This option applies only to exporting products.

VRML Models Exported from the CATIA Environment

The CATIA software exports CATProducts and their CATParts as VRML transforms.
The structure of these transforms corresponds to the CATIA model hierarchy. In
addition to transforms that represent physical elements, the CATIA software creates
several transforms and groups in the VRML file. The transforms and groups represent
relationships between objects and other model properties defined in the CATIA
environment.

Some of these additional nodes can be empty. Many CATIA model properties do not have
equivalents in the VRML language. Each part transform contains a hierarchy of nested
transforms, groups, and shapes that correspond to the part internal structure. Some of
these elements have synthetic DEF names (for example, 0161DC70). Usually, work with
the main transforms that represent each part.

The following contains the VRML model of a cylinder assembly consisting of four parts:
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20ene Tree I viEWPDint ¢ 0.017439 —0.001734
B po=ition —0. —-0.
torldinfo : orientation  0.707107 0.707107 0
'"_ MavigationInfo fieldOfView 0471225
(- Background description "Bottomn View"
[--<¥- Viewpoint
i By ink [l Transform {
du::xﬁz::t scale 0.001 0.001 0.001
T children [
"1 Yigtpoink = Transform {
<& Wigpoink children [
-<¥- Yigwpoint '{ransfnrm i
d vigwpoint Transform {
<k Migpoink 1
=4 Transform Transform {
e x
El@" children Transform -
EIQ TransForm %ruup 1
=@l children children [
-4 Transform 1
-4 Transform ¥
-4 Transform }]
-4 Transform ]
-] Group T

The left tree view illustrates the overall structure of the model.

1 The CATIA software saves the general model information in the WorldInfo,
Navigationlnfo, and Background nodes.

2 The software exports the default CATIA viewpoints (it does not export user-defined
viewpoints).

Following this section, common to all products exported to VRML, is a top-level
transform node representing the CATProduct.

In the CATIA software, Product CylinderAssembly1 consists of four parts:

* CrankAssemblyl

*  CylinderSleevel

* PistonAssemblyl

* CrankshaftAssemblyl
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The export does not preserve the CATProduct and CATPart names. You can identify
these objects in the VRML file in the tree view and in the text mode. In the figure, the
contents of the part transforms are collapsed so that only the top-level objects are visible
for clarity. After four transforms representing CATParts, the export adds an empty
Group node at the place where CATIA Constraints are defined. You can delete such
empty nodes from the VRML model.

The conversion scales contents of the CATProduct down by a factor of 1000 (conversion of
units from millimeters to meters).

When you have VRML files created with the CATIA software, consider the following
known features for further use with the Simulink 3D Animation software:

+  Object - Exporting to VRML does not preserve CATProduct and CATPart names.
The CATIA environment only creates synthetic VRML DEF names for subparts,
materials, and object coordinate fields. These synthetic names change between two or
more consecutive export operations.

To work with the Simulink 3D Animation software, provide meaningful DEF names
for the objects that you want to control from the MATLAB /Simulink environment.

+ The CATIA software saves all vertex coordinates for a part in one VRML coordinate
field, which resides in the first exported IndexedFaceSet for the part. This field is
referenced from several subparts throughout the file with the USE directive.

Preserve this reference. Do not delete or rename the original Coordinate field DEF
name.

+ The VRML file stores only one material per part. If the part consists of several
subparts in VRML, their material also uses the USE reference to the material of the
first subpart.

+ Textures are supported

+ LOD (exporting parts in several levels of detail for more efficient visualization) is not
supported

* The CATIA software exports models in millimeters, VRML units are meters.

Scale resulting objects to visualize them effectively.
+ The VRML file does not save user-defined CATIA viewpoints.

+ The conversion scales the main Transform representing the CATIA product by a
factor of 0.001 (conversion from millimeters to meters). The scaling occurs regardless
of the units used in the CATIA document
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Adjusting Resulting VRML Files

To use the exported VRML models with the Simulink 3D Animation software, adjust
exported VRML files. You can perform these adjustments manually, as described in this
topic, or use the vrcadcleanup and vrphysmod functions to perform some of these

tasks.

+ Adding DEF Names to Part Transforms.

In the VRML file, assign a unique name for each VRML object. Add the DEF
Object_Name statement to each part Transform line.

This example shows a VRML file that has DEF names added to the cylinder assembly.

Scene Tree

H-[E Worldinfo
-4 MavigationInfo
#-** EBackground
#-<F- Yigwpoint
<8 Yiewpaint
F#-<F- Yigwpoint
F#-<F- Yigwpoint
<8 Yiewpaint
F#-<F- Yigwpoint
<8 Yiewpaint
F#-<F- Yigwpoint

=@ children
ElQ TransfForm Cylinderfssembly 1
=@ children

0 Transform Crankassembly 1
0 Transform Cylindersleevel
0 Transform Pistonfssembly 1
-4 Transform CrankshaftAssembly1
-- GEroup

=

BH O BH H H O

Viewpoint {

po=ition —0.017439 —0.001734 -0.7&
orientation 0707107 0.707107 0.000001
fieldOiView 0.471225

deszcription "Bottom Wiew"

Transform {
z=cale
children [

LEF Cylinderissemblyl Transform {
children [
DEF Crankisszemblvyl Transform {

0.001 0.001 0.001

I
LEF CylinderSlesvel Transform {
I
DEF PistoniAszszemblyl Transform {

I
DEF Crankshaftissemblvl Tran=form {

1
Group 4

children [

Do not adjust parts in the scene that you do not want to control from the MATLAB

environment.
* Scaling of VRML Objects.
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To convert CATProduct size from millimeters to meters (VRML default units), the
CATIA software wraps the transform corresponding to the CATProduct with an
additional transform. In this transform, the scale field is defined. The preceding
example illustrates this size conversion.

If you have a small object, or an object that you must place into an overall virtual
world, adjust this scale.

If you leave the VRML object scale in the default state, the local part coordinates
are still in millimeters. Remember this fact when controlling these parts from the
MATLAB or Simulink environment. If your MATLAB or Simulink model units are
meters, scale each part individually to achieve correct results. Delete the scale field
from the top-level transform, and adding it to each individual part transform. For
example:

Transform {
children [
DEF CylinderAssemblyl Transform {
children [
DEF CrankAssemblyl Transform {
scale 0.001 0.001 0.001

See Also

Functions
stl2vrml | vrcadcleanup

Related Examples

“Use CAD Models with the Simulink 3D Animation Product” on page 5-32
“Import STL and Physical Modeling XML Files” on page 5-34

“Import VRML Models from CAD Tools” on page 5-36

“Modify the CAD Model Virtual World” on page 5-52

“Link to Simulink and Simscape Multibody Models” on page 5-62
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Modify the CAD Model Virtual World

5-52

In this section...

“Wrap Shape Objects with Transforms” on page 5-52
“Add DEF Names” on page 5-52
“Additional Virtual World Modifications” on page 5-53

You can use the 3D World Editor or other editor to modify the results of CAD tool export
filters manually. For example, you can compose the converted model into an urban

or manufacturing environment, or add objects such as viewpoints, backgrounds, and
lights before using them in Simulink 3D Animation virtual worlds. Typically, adjusting
exported files manually in an editor involves several modifications.

Wrap Shape Obijects with Transforms

CAD tools export parts into VRML or X3D as individual shapes using various object
types such as Shape or Inline nodes. To control part positions and orientations,
wrap each such Shape or Inline node with a node that allows for the changing of
these properties. This wrapping node is the Transform node, which transforms the
coordinates of its children. For instance, after wrapping with a Transform node, an
Inline node has syntax similar to this syntax:

Transform {
children [
Inline {
url ["robot_arml.wrl']
}

}

To set the initial location of the entire assembly in the virtual world, consider wrapping
all parts of the assembly with an additional Transform node.

Add DEF Names

CAD export filters often export objects with no names or with synthetic nondescriptive
names. To make export objects accessible in MATLAB, give each virtual world object a
unique name in the virtual world 3D file. For example, name the object by adding a DEF



Modify the CAD Model Virtual World

Object_Name statement to the Transform line. After adding the DEF Object_Name,
the Robot_Arml definition in the main virtual world 3D file has the syntax similar to
this syntax:

DEF Robot_Arml Transform {
children [
Inline {
url ["robot_arml.wrl']
}

}

The Simulink 3D Animation functions and in the user interface (such as the descriptions
of inputs to the VR Sink block) use these object names. To help you manage the
orientation in the object hierarchy, give the parts descriptive names.

Note: Sometimes it is necessary to correct bugs introduced in the file by the CAD tool
export filter. As the VRML and X3D format is a text-based format codified by an ISO®
standard, these bugs are relatively easy to identify and correct. If problems occur when
you are using exported VRML or X3D files in the Simulink 3D Animation software,
consult MathWorks technical support.

Additional Virtual World Modifications

To work with the virtual world effectively, you can make additional modifications to
the scene file using a virtual world editor. Make these changes on an ongoing basis, in
parallel with developing and using the dynamic model.

* Add the WorldInfo node with a scene title. Simulink 3D Animation software uses
the title as the virtual world description.

* Add the NavigationInfo node defining the scene default navigation speed and
avatar size that ensures correct display of the object from near and far distances.

+ Add the Background node defining a color backdrop that simulates the ground and
sky, and optional background textures, such as panoramas for the scene.

* Add several viewpoints to be able to observe the object conveniently from different
positions. The viewpoints can be static or moving. Define a static viewpoint as
an independent object at the top level of the scene hierarchy. To create a moving
viewpoint, attached a viewpoint to objects that move in the scene during simulation.
Such viewpoints are defined as siblings of moving objects in the scene hierarchy. For
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an example of a viewpoint moving with the object, see the viewpoint Ride on the
Plane in the Simulink 3D Animation vrtkoff.wrl example.

Illuminate a scene by adding lights to it. Although virtual world viewers always
have a headlight available, consider defining lights in the scene so that it looks the
same for everyone. The most useful type of light to illuminate a whole scene is the
DirectionalLight node. To illuminate objects from several directions, consider
using a combination of several such lights.

Add scene surroundings. This step is not crucial for the visualization of interactions
between parts in a machine assembly, but is important for the visualization of
simulations. For example, for aircraft and vehicle dynamics the position of one object
relative to the scene in which it operates is important. Adding scene surroundings
provides context.

For example, to visualize vehicle dynamics, place a virtual car on a virtual road.
Make both objects to scale (the length units in the car and road models must match).
Place the car in an appropriate position relative to the road. Set proper car scaling,
placement, and orientation in the scene by defining corresponding fields of the
Transform node main object (see “Wrap Shape Objects with Transforms” on page
5-52).

For an example of a complete scene definition, see the octavia_scene.wrl file that is
part of the Simulink 3D Animation vr_octavia example.

Related Examples

“Use CAD Models with the Simulink 3D Animation Product” on page 5-32
“Import STL and Physical Modeling XML Files” on page 5-34

“Import VRML Models from CAD Tools” on page 5-36

“Import VRML Models from CATIA Software” on page 5-45

“Link to Simulink and Simscape Multibody Models” on page 5-62
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Import Visual Representations of Robot Models

In this section...

“Import a DAE File” on page 5-55

“Import a URDF File” on page 5-57

“Import an SDF File” on page 5-58

“Define Viewpoint to Make Imported Model Visible” on page 5-61

“Limitations” on page 5-61

You can import into a virtual world in Simulink 3D Animation robot and robot
environment 3-D models that are defined using unified robot description format (.urdf)
or simulation description format (.sdf) . The URDF file format is an XML file format
that defines various model (typically robot) properties. When you import from a URDF
file, only the visual representation of the model is imported. This representation typically
refers to model component shape files, defined as STL or COLLADA™ DAE files.

You can import visual properties of the objects present in the URDF or SDF files into
corresponding hierarchical structure of Transform nodes containing IndexedFaceSet
objects with textures.

URDF and SDF files use COLLADA DAE and STL formats to define visual properties of
scene objects.

To import visual representation of robots, in the 3D World Editor select Nodes > Import

From. Then select STL File, Physical Modeling XML File, URDF File, SDF File, or
COLLADA File. From the MATLAB command line, you can use the vrimport function
to import .urdf, .dae, .stl, and .sdf files into a virtual world.

Import a DAE File

The URDF and SDF import supports a subset of the COLLADA DAE 3D file format
(objects that are typically present in URDF and SDF files: geometric shape objects with
textures).

This example imports a COLLADA DAE file, fox.dae, into a scene with predefined grid,
gray background and viewpoint. The fox head is a sphere with 1 m radius, placed at the
origin and looking in the direction of VRML +z-axis.

The fox.dae is shipped with the Simulink 3D Animation software. The path is
matlabroot/toolbox/s13d/s13ddemos/fox.dae.
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5 Build Virtual Reality Worlds

From the MATLAB Toolstrip, in the Apps tab, in the Simulation Graphics and

Reporting section, click 3D World Editor.

1

In the 3D World Editor, select File > New from Template.

2
3

In the file dialog box, select the Grids folder and then select the XZGri

virtual world file.

4 Save the virtual world in the current folder. Select File > Save as and name the

virtual world file fox_dae.wrl.

Import the DAE model. Select Nodes > Import From > COLLADA File. Select the

fox.dae file.
6 Open the COLLAD

5

A_Fox_Transform node and set the scale field to 3 for each

dimension.

* (Background)

b XZ_Grid

» ROOT
G- @ Grid_101:101 (EXTERNPROTQ)

(Grid_101x101)

* (Transform)

(Transform)

B center (SFVec3f: 0 0 0

=R b COLLADA fox_Transform

-+ scaleQrientation (SFRotation): 0 0 1 0

-+ rotation (SFRotation):0 0 1 0

-+ translation (SFVec3f):0 0 0

- B bboxCenter (SFVec3f):0 0 0

-~ 0 bboxSize (SFVec3f): -1 -1 -1
- ® children (MFNode)

B scale (SFVec3f):3 3 3

scale (SFVec3f)

Value | Comment
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Import a URDF File

In this example, the Fox.urdf file refers to fox.dae file. The URDF file transforms the
original DAE model so that the fox is translated to the position [4 1 0] and rotated so that
it points to the VRML +x-axis direction.

The Ffox.urdf is shipped with the Simulink 3D Animation software. The path is
matlabroot/toolbox/s13d/sl3ddemos/fox.urdf.

1  From the MATLAB Toolstrip, in the Apps tab, in the Simulation Graphics and
Reporting section, click 3D World Editor.
2 Inthe 3D World Editor, select File > New from Template.

3 In the file dialog box, select the Grids folder and then select the XZGrid.wrl
virtual world file.

4 Save the virtual world in the current folder. Select File > Save as and name the
virtual world file fox_urdf.wrl.

5 Import the URDF model. Select Nodes > Import From > URDF File. Select the
fox.urdf file.

6 Open the URDF_visual_Transform node and set the scale field to 3 for each
dimension.
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* (Background)

b XZ_Grid

(Grid_101:101)

* (Transform)

(Transform)

B+ center (SFVec3f):0 0 0

-~ scaleQrientation (SFRotation):0 01 0

+§* translation (SFVec3f:0 0 0
- | bboxCenter (SFVec3f):0 0 0

- B bboxSize (SFVec3f): -1 -1 -1

+§* rotation (SFRotation):0 0 1 0
F children (MFNode)

-+ scale (SFVec3f:3 3 2

Ei- b URDF_visual_Transform

scale (SFVec3f)

Value | Comment

Cancel

Apply

[3

3

ile

Import an SDF F

SDF is an XML format that describes objects and environments for robot simulators,
visualization, and control, originally developed as part of the Gazebo robot simulator. The

folder in which the model . sdT file is located defines the SDF model name. This example

shows how to import a simple arm link mechanism.

The example assumes that you have

Download the simple_arm model folder (including all its contents) from this Gazebo

model site: http://models.gazebosim.org/simple_arm/. To download all the folder

contents, download and unpack the model . tar.gz file.
2 From the MATLAB Toolstrip, in the Apps tab, in the Simulation Graphics and

1

tor.

i

Reporting section, click 3D World Ed

In the 3D World Editor
In the file dialog box

virtual world file.

ile > New from Template.

select F
select the Gr

b

3
4

wrl

ids folder and then select the XZGr i

’
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Lance

Apply

i3

5 Save the virtual world in the current folder. Select File > Save as and name the

Import the SDF model. Select Nodes > Import From > SDF File. In the

le arm.wrl.

virtual world file simp

6

le_arm folder, select the model . sdf file.

7 Open the SDF

simp

le_arm_Transform node and set the scale field to 3 for each

simp

dimension.

(Grid_101:101)

Transform (Transform)

e_arm_

pl

that make it easier to manipulate models. Each rotational joint in the SDF model

is represented with a Transform node with the name starting with axis
nodes have rotation axes defined so that the model elements move consistently if you

8 The import process creates in the model hierarchy some special Transform nodes
set the rotation angle to a different value.

(Background)

B b XZ_Grid
-+ scaleOrientation (SFRotation):0 01 0

“E” rotation (SFRotation):0 0 1 0
-+ translation (SFVec3f): 0 0 0

- B bboxCenter (SFVec3f):0 0 0
- B bboxSize (SFVec3f): -1 -1 -1
-k children (MFNode)

-+ scale (SFVec3f):3 3 3

-~ center (SFVec3f):0 0 0

P SDF sim

@ Grid_101:101 (EXTERNPROTO)

*  (Transform)

» ROOT

)

scale (SFVec3f)
Value | Comment




1on

int node, then the
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_pan_join

shoulder_pan

arm_shoulder
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join

Change the rotation angle of a rotational joint node. For example, expand the

children node, then the
children, and finally, the axis
field, set the fourth element to 1.
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Apply

i

s_xxX Transform node rotation

If you associate this virtual world with a VR Sink block in a Simulink model,

you can use the VR Signal Expander block to set only the rotation angle (the fourth

element of the rotation vector) of the ax
the first three elements of the vector unchanged. This approach preserves robot

consistency with the way model authors defined movement of robot parts.

Tip

rotation (SFRotation)
Value | Comment
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Define Viewpoint to Make Imported Model Visible

When you import a model, often it does not appear in the initial view of the virtual world.
If necessary, create a viewpoint to make the imported model visible when the virtual
world opens. If the imported model is not visible:

In the 3D World Editor, select the ROOT node.

Select Nodes > Add > Bindable > Viewpoint.

To observe the imported model, navigate to a suitable location in the scene.

AW N —

Populate viewpoint properties with current camera settings. In the tree hierarchy
pane, right-click the viewpoint and select Copy values from current camera.

5 Save the virtual world.

Limitations

URDF import transforms robot hierarchy of links and joints into a VRML or X3D
hierarchy of transforms. It imports only visualization properties from each link. Joints
are represented by transforms that preserve rotation axes of the original revolute joints
and axis alignment of prismatic joints.

SDF import transforms the hierarchy of SDF model objects into VRML or X3D hierarchy
of transforms the same way as URDF import. It supports a subset of SDF format objects
and is limited to visual objects under the Model element hierarchy. Supported Geometry
elements are geometric primitives and meshes.

See Also

Functions
sth2vrml | vrimport

Related Examples

. “Use CAD Models with the Simulink 3D Animation Product” on page 5-32
. “Import STL and Physical Modeling XML Files” on page 5-34

. “Import VRML Models from CAD Tools” on page 5-36

. “Modify the CAD Model Virtual World” on page 5-52

. “Link to Simulink and Simscape Multibody Models” on page 5-62
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In this section...

“Link the Virtual World to a Simulink Model” on page 5-62
“Initial Conditions” on page 5-64

“VR Placeholder and VR Signal Expander Blocks” on page 5-65
“Link to Simscape Multibody Models” on page 5-65

“Link to a MATLAB Model” on page 5-67

To establish a live data connection between the model and the virtual world, create
associations between dynamic model object quantities and corresponding virtual world
object properties. For example, create associations with virtual world object properties
such as position and rotations.

Although Simscape Multibody and Simulink are common platform for modeling
mechanical systems, also you can use the Simulink 3D Animation product for the
visualization of models implemented in MATLAB.

Link the Virtual World to a Simulink Model

You associate Simulink model signals to virtual world object properties through the VR
Sink block from the Simulink 3D Animation block library, vrilib.

To associate a Simulink signal to a virtual object property:

From the vrlib library, insert a VR Sink block into your Simulink model.

2 To define the virtual world, use the VR Sink block parameters dialog box. Enter the
name of the virtual world 3D file in Source file, or click Browse to select the file
interactively. To load the selected virtual reality scene, click Apply.

3  For smooth visualization of the movement, you can change the block Sample time.
For example, to update the virtual world 25 times per simulation second, set the
Sample time to 0.04. Be careful when using the inherited sample time for the VR
Sink block. Depending on the solver used, using inherited sample time can result in
nonequidistant (in simulation time) updating of the virtual world. Nonequidistant
updating gives a false impression of system dynamics to the person viewing the
virtual world.
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4 In Virtual World Tree, expand the main object Transform branch. In the scene
object hierarchy, locate all parts you want to control from Simulink according to
their names as given in “Add DEF Names” on page 5-52. Named Transform nodes
represent each part. Select the check box next to the rotation and position fields of
the Transform node. You can select other properties of virtual world objects, such as
color, but rotations and positions are the ones most frequently controlled.

5 Click OK. For each selected field, the VR Sink block creates an input port. Increase
the VR Sink block size as appropriate to accommodate the number of input ports.

After you associate the VR Sink block with a virtual world, you can double-click it to open
the Simulink 3D Animation viewer. Block parameters are available through the menu
Simulation > Block Properties in the viewer.

VR Sink inputs take signals of the type corresponding to their virtual world
representation. Position inputs are of type SFVec3f, which is the position represented
in [X y z] coordinates. Rotation inputs are of type SFRotation, the four-element
vector defining rotation as [axis angle], using the coordinate system described in
“Coordinate System Used” on page 5-38, where the angle value is in radians.

Match the coordinate system used by the Simulink model to that of the virtual world. If
the two coordinate systems are not identical, transform an axis.

Usually, object positions are available in the form required by virtual world (Cartesian
coordinates). Often, object rotations are defined using the rotation matrix representation.
To convert such rotations into the VRML format, use the Rotation Matrix to VRML
Rotation block.

Object positions and rotations are treated differently depending on the virtual world
hierarchy:

* To define all parts in a Simulink model in global coordinates, when the virtual world
has a flat structure of independent objects, use these positions and rotations.

Object positions Send to VR Sink all positions in global coordinates.

Object rotations Send to VR Sink all rotations in global coordinates, with the
center of rotation defined as the coordinate system origin. If
the default center of rotation of Transform objects is [0 O
0], you do not need to define the center for each part in the
virtual world 3D file.

* When all parts in Simulink model follow hierarchical relations, and the virtual world
has a nested structure, use these positions and rotations.
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Object positions

Send to VR Sink all positions in local coordinates relative
to their parents or predecessors in the object hierarchy. For
example, send the robot tool position relative to the robot
hand.

Object rotations

Send to VR Sink all rotations in local coordinates relative
to their parents or predecessors in the object hierarchy. For
example, send the robot tool rotation relative to the robot
hand.

Match the positions of joints between objects visually by
oinciding the centers of rotation in the virtual world and in
the Simulink model. Coincide the center of rotation because
when joints between parts are not positioned in the origin ([0
0 0]) of the coordinate system of the parent.

To define a center of rotation different from the default
value, [0 O 0], define the center field of the child
Transform node in the virtual world 3D file. For example,
define the robot tool center of rotation to coincide with the
joint connecting the hand and the tool in the hand local
coordinates.

In a hierarchical scene structure, when the parts are connected by revolving joints, it
is easy to define the relative rotations between parts. The joint axis directly defines
the virtual world rotation axis, so you can construct the [axis angle] four-element

rotation vector.

Initial Conditions

A Simulink model initial conditions must correspond to the initial object positions and
rotations defined in the virtual world. Otherwise, the object controlled from Simulink
jumps from the position defined in the VRML file to the position dictated by Simulink for
the simulation. To compensate for this offset, use one of these approaches:

* In the virtual world 3D file, define another level of nested Transform around the

controlled object.

* In the Simulink mode, add the object initial position to the model calculations before
sending to the VR Sink block.
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Align the Simulink model initial conditions with the virtual world object positions,
Maintain the correct position of the object relative to the surrounding scene. You can
adjust the position of the surroundings of the object. For example, move the road position
so that the car at position [0 O 0] stays on the road, without the wheels sinking or
floating above the road.

VR Placeholder and VR Signal Expander Blocks

The VR Sink block accepts only inputs that define fully qualified field values. Dynamic
models that describe the system behavior in only one dimension still require full 3D
positions for all controlled objects for their virtual reality visualization.

To simplify the modeling in such cases, you can use the VR Placeholder and VR
Expander blocks of the Simulink 3D Animation library.

The VR Placeholder block sends out a special value that is interpreted as unspecified
by the VR Sink block. When this placeholder value appears on a VR Sink input, as a
single value or as vector element, the appropriate value in the virtual world remains
unchanged.

The VR Signal Expander block creates a vector of predefined length, using some values
from the input ports and filling the rest with placeholder signal values.

To control the position of a virtual object in a one-dimensional dynamic model, use the
VR Signal Expander block with the controlled dimension as its input. For its output, use
a three-component vector in the VR Sink block. The remaining vector elements are filled
with placeholder signals.

Use of the VR Signal Expander block is also a possibility when defining rotations. When
the axis of rotation is defined in the virtual world 3D file, you can send to the VR Sink
block a virtual world rotation value. Use a value consisting of three placeholder signals
and the computed angle. This rotation value forms a valid four-element [axis angle]
vector.

Link to Simscape Multibody Models

You can use the Simulink 3D Animation product to view the behavior of a model created
with the Simscape Multibody software.

1  Build a model of a machine in the Simulink interface using Simscape Multibody
blocks.
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2 Create a detailed visual representation of your machine in a virtual world.
3 Connect the virtual world to the Simscape Multibody body sensor outputs.

4 View the behavior of the bodies in a virtual world viewer.

You can use the Simscape Multibody software for 3D visualizations using the Simulink
3D Animation product. In addition to the features that Simscape Multibody product
offers for modeling mechanical assemblies, the following features simplify the
visualization of Simscape Multibody models in virtual reality:

+  Simscape Multibody and virtual world coordinate systems are identical.

* In the Simscape Multibody software, you can work with both global and local object
coordinates. This flexibility makes it easy to adapt the model to the structure of the
virtual world exported from the CAD tool.

The Simscape Multibody product also offers a convenient way of importing CAD
assembly designs into Simscape Multibody machines through the Simscape Multibody
Link interface. Alternatively, when you export a CAD assembly to the virtual world
format, you can add virtual reality visualization to such assemblies.

The Simulink 3D Animation software includes the following functions for working with
Simscape Multibody files: vircadcleanup, vrphysmod, and stl2vrml.

Depending on the virtual world hierarchy, you can use one of two approaches to help
visualize Simscape Multibody machines:

* When the virtual world has a flat structure of independent objects, you can obtain
the positions and rotations of machine parts using Body Sensor blocks. Connect the
Body Sensor block to appropriate coordinate systems attached to the bodies. Define
positions and rotations using global coordinates. Usually, you can connect the sensor
to a body coordinate system with origin at [0 O 0] and with an initial rotation
matrix defined as the identity matrix, [1 O O; O 1 0, 0 O 1], in the global
coordinate.

*  When the virtual world has a hierarchical structure of nested objects, you can obtain
the body positions and rotations. Use a Body Sensor block with its output set to
use local body coordinates. In special cases, such as when two bodies are connected
through a revolving joint, you can get the angle between the objects using a Joint
Sensor block.
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Link to a MATLAB Model

To help you to interact with virtual worlds, the Simulink 3D Animation product offers
a set of MATLAB functions and constructs referred to collectively as its “MATLAB
interface.” Circumstances when this MATLAB functionality is appropriate for use with
CAD-based designs include:

+  Using customized GUIs to visualize static objects and their relations in a virtual
environment, such as in interactive machine assembly instructions.

*  Visualizing 3D information based on an independent quantity (not necessarily time).

+ Using MATLAB interface functions in Simulink model callbacks.

* Visualizing systems whose dynamic models are available as MATLAB code.

+ Visualizing systems where massive object changes, such as deformations, take place.
In this case, send dynamically sized matrix-type data from the dynamic models to
virtual worlds, which is not possible using just Simulink signals.

For information on setting object properties using the MATLAB interface, see “MATLAB
Interaction”.

Related Examples

. “Use CAD Models with the Simulink 3D Animation Product” on page 5-32
. “Import STL and Physical Modeling XML Files” on page 5-34

. “Import VRML Models from CAD Tools” on page 5-36

. “Import VRML Models from CATIA Software” on page 5-45

. “Modify the CAD Model Virtual World” on page 5-52

. “MATLAB Interaction”
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Using the 3D World Editor

+ “3D World Editor” on page 6-2

* “Open the 3D World Editor” on page 6-5

+ “3D World Editor Panes” on page 6-8

+ “Create a Virtual World” on page 6-10

+  “Basic Editing” on page 6-12

+ “Reduce Number of Polygons for Shapes” on page 6-24

* “Virtual World Navigation in 3D World Editor” on page 6-25
+ “3D World Editor Library” on page 6-29
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3D World Editor
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In this section...

“Supported Platforms” on page 6-2

“Use with Other Editors” on page 6-2

“VRML and X3D Support” on page 6-2

“Nodes, Library Objects, and Templates” on page 6-3

The 3D World Editor is a native VRML and X3D editor.

For an example that shows how to see the 3D World Editor to create a virtual world, see
“Build and Connect a Virtual World” on page 5-7.

Supported Platforms

The 3D World Editor works on all supported platforms for the Simulink 3D Animation
product. For details, see http://www.mathworks.com/products/3d-animation/
requirements._html.

The 3D World Editor is installed as part of the Simulink 3D Animation installation. It is
the default virtual world editor.

Use with Other Editors

As you create a virtual world, you can use a different editor for individual phases of the
process.

Choose an editor that best meets your needs. For a description of the benefits and
limitations of different types of editors, see “Virtual World Editors” on page 5-2.

VRML and X3D Support
The file formats for the 3D World Editor are VRML and X3D.

The 3D World Editor supports all VRML97 types and language elements, except as
noted.

For general VRML limitations relating to the Simulink 3D Animation software as a
whole, see “VRML Compatibility” on page 1-16.


http://www.mathworks.com/products/3d-animation/related.html
http://www.mathworks.com/products/3d-animation/related.html

3D World Editor

For general X3D limitations relating to the Simulink 3D Animation software as a whole,
see “X3D Support” on page 1-11.

PixelTexture Nodes

You cannot create or edit PixelTexture node image contents. Existing PixelTexture
node image contents are fully preserved

Nodes, Library Obijects, and Templates

Use the 3D World Editor to specify VRML or X3D to create 3-D virtual worlds that you
can connect to a Simulink model.

Use the 3D World Editor to:

* To create a virtual world, assemble nodes. You can add nodes that specify many
aspects of a virtual world, such as:
+ Appearance (for example, font style, color, and material)
+ Navigation information (for example, navigation mode and headlights)
Geometry (for example, boxes, text, and elevation grids)
Groups (for example, transforms)
+ Interpolators
Light
Sensors
+ Select objects from a set of supplied libraries or from custom libraries for:
Components (for example, geometric objects, backgrounds, aircraft, vehicles,
landscapes, and architecture)
+ Materials
+ Textures

+ Use a supplied template as a starting point for a virtual world.
Template Virtual World 3D Files

The 3D World Editor includes template virtual world 3D files that you can use as a
starting point for creating virtual reality worlds. Some examples of templates are the
Earth, road, sea, and terrain virtual world templates.
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To access templates, use one of the following approaches:
+ Select File > New From Template.

Select the New File From Template button =
A template file name displayed in the 3D World Editor always starts with Template:.

To adapt the template world for your application, edit the file. To save your changes, use
the File > Save As option. You cannot overwrite an existing template file.

You can create your own template files. Store them in a different folder than the folder
used for template files provided with Simulink 3D Animation.

In virtual worlds that you create, you can reference nodes, such as texture files, that
appear in the template files provided with Simulink 3D Animation.

See Also

Functions
vredit | vrgetpref | vrsetpref

Related Examples

. “Basic Editing” on page 6-12

. “Set the Default Editor” on page 2-2

. “Open the 3D World Editor” on page 6-5

. “Create a Virtual World” on page 6-10

. “Reduce Number of Polygons for Shapes” on page 6-24

. “Virtual World Navigation in 3D World Editor” on page 6-25
. “Virtual World Navigation in 3D World Editor” on page 6-25

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4

More About
. “3D World Editor Panes” on page 6-8
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Open the 3D World Editor

In this section...
“3D World Editor Is the Default Editor” on page 6-5
“Open an Empty Virtual World” on page 6-5

“Open a Saved Virtual World” on page 6-6
“Preferences for 3D World Editor Startup” on page 6-6

3D World Editor Is the Default Editor

When you install the Simulink 3D Animation product, the 3D World Editor is configured
to be the default editor. For details about changing the default editor, see “Set the
Default Editor” on page 2-2).

Note: You can also use the V-Realm Editor. For more information, see “V-Realm Builder
Help” on page 2-22.

Open an Empty Virtual World

Use one of these approaches to open an empty virtual world in the 3D World Editor.

* From the MATLAB Toolstrip, in the Apps tab, in the Simulation Graphics and
Reporting section, click 3D World Editor.

+ If the 3D World Editor is your default virtual world editor, open an empty virtual
world from the MATLAB command line using the edit command.

edit(vrworld(" "))

* Regardless of Default Editor preference setting, you can use the vredit command,
without arguments.

*  From within the 3D World Editor, select either File > Newor File > New From
Template. If there is already a file open in the 3D World Editor, these options open
a new instance of the editor. Use multiple instances of the editor to work on multiple
virtual worlds at the same time and to copy and paste from one virtual world to
another.
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Open a Saved Virtual World

Use one of these approaches to open a saved virtual world.

From the MATLAB Current Folder panel, right-click a virtual world 3D file and from
the context menu, select Edit

If 3D World Editor is your default virtual world editor, start it from the MATLAB
command line using the edit command. For example:
edit(vrworld("myVRMLFile.wrl™))

Regardless of what your default virtual world editor is, from the MATLAB command
line, use the vredit command with the name of the virtual world 3D file. For
example:

vredit("membrane._.wrl®)

From within the 3D World Editor, select File > Open. If a file is already open in the
3D World Editor, this option opens a new instance of the editor.

Preferences for 3D World Editor Startup

The Simulink 3D Animation Preferences > 3D World Editor pane includes the
following options for specifying the startup position:

For the default location, select Position. Then specify the pixel location for the lower-
left corner, the width, and the height (for example, [96 120 862 960]).

To open the 3D World Editor in the same location where you exited it, select Save
position on exit.

You can specify whether the editor starts up with the default virtual world display layout

or with the layout as it was when you exited it previously. The saved layout includes
settings for the view, viewpoints, navigation, and rendering. Simulink 3D Animation
saves the layout in a separate virtual world 3D file for up to eight files.

By default, the virtual world opens with the layout saved at exit. To have the virtual

world open using the default layout, clear the Preferences > Simulink 3D Animation

> 3D World Editor > Preserve Layout per Virtual Reality 3D File check box.

See Also

Functions
vredit | vrgetpref | vrsetpref
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Related Examples

. “3D World Editor” on page 6-2

. “Basic Editing” on page 6-12

. “Set the Default Editor” on page 2-2

. “Set Simulink 3D Animation Preferences” on page 2-9

. “Create a Virtual World” on page 6-10

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4
More About

. “3D World Editor Panes” on page 6-8
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3D World Editor Panes

The 3D World Editor provides three panes:

«* 30 World Editor - H:/Documents/MATLAB/vr_bounce.wrl
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Tree structure pane — View the hierarchy for the virtual world that you are editing.
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Use the tree structure pane interactively to create graphical virtual world elements
and to view of all the virtual world structure elements present in the virtual world.
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These structure elements are called nodes. The 3D World Editor lists the nodes and their
properties according to their respective virtual world node types. In the tree viewer, you
give the nodes unique names.

Use the virtual world display pane to display a graphical representation of a 3-D
scene.

Use the object properties edit pane to edit a selected property or add a comment to a
selected node or property.

Tree Structure Pane Icons

The Tree structure pane displays icons to help you visually distinguish node field types.

Node Field Type 3D World Editor Icon
field .

eventln +E

eventOut B

exposedField N

ROUTE

USE e
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Create a Virtual World

There are several tasks involved in creating a virtual world. You can use the 3D World
Editor throughout the process of building a virtual world, and you can perform activities
in many different ways.

For a step-by-step tutorial about building a virtual world using the 3D World Editor, see
“Build and Connect a Virtual World” on page 5-7.

In general, the following is a common workflow for creating a virtual world using the 3D
World Editor. This example workflow includes optional tasks and a small subset of the
types of tasks that you can perform. For more information, see “Basic Editing” on page
6-12.

1 Open a new virtual world 3D file.
2 Under the ROOT node, optionally add:

+ A WorldInfo node to document the virtual world.

+ A NavigationInfo node to define overall navigation characteristics of the
virtual world, such as the Avatar size.

3 Under the ROOT node, add a Transform node in the virtual world for each object
that you want to share properties with other object in that same Transform node.

4 Under the Transform node, include nodes in a hierarchy, such as:

children
Shape
appearance

Appearance

material
Material

texture
textureTransform

Geometry
Box

5 Use the object properties edit pane to change default property values to create the
effects that you want.

6 To define aspects, such as textures, for virtual world objects, insert 3D World Editor
library objects.

Give a DEF name to each object that you create, so that you can access them using
Simulink 3D Animation.
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* You can use Orbisnap to view library objects to determine which objects you want
to insert into the virtual world.

7 In the virtual world display pane, use the context menu to specify display
characteristics, such as:
*  View characteristics (for example, zooming and a navigation panel)
+  Viewpoints
Navigation characteristics (for example, methods (such as fly or walk) and speed)
*  Rendering techniques (for example, antialiasing, lighting, and transparency)

8 Save or export the virtual world 3D file.

See Also

Functions
vredit | vrgetpref | vrsetpref

Related Examples

. “Open the 3D World Editor” on page 6-5

. “Virtual Reality World and Dynamic System Examples” on page 1-22
. “Create vrworld Object for a Virtual World” on page 4-2
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6-12

In this section...

“Add Objects” on page 6-12

“Copy and Paste a Node” on page 6-13

“Edit Object Properties” on page 6-14

“Document a Virtual World Using Comments” on page 6-16
“Display Event Fields” on page 6-16

“Expand and Collapse Nodes” on page 6-17

“Highlight Nodes and Virtual World Objects” on page 6-17
“Wrap Nodes as Children of Another Node” on page 6-19
“Remove Nodes” on page 6-20

“Save and Export Virtual World 3D Files” on page 6-21
“Edit VRML and X3D Scripts” on page 6-21

For information about opening a file in the editor, see “Open the 3D World Editor” on
page 6-5.

For a step-by-step tutorial, see “Build and Connect a Virtual World” on page 5-7.

Add Obijects

Add virtual world objects (for example, the wing of an airplane) by adding nodes in the
tree structure pane. The hierarchy of nodes controls the scope to which node properties

apply.

Note: Nodes must have unique names to work in the Simulink 3D Animation product.

Approaches for Adding Objects

Use one of these approaches to add a node.

Approach Procedure
Use the Nodes menu 1 In the tree structure pane, select the parent node
for the object that you want to add.




Basic Editing

Approach

Procedure

2 Select Nodes > Add.

3 To add the node that you want, select appropriate
submenus.

Use a context menu for a
node

1 In the tree structure pane, right-click the parent
node for the object that you want to add.

2 To add the node that you want, select the Add Node
menu, and then select appropriate submenus.

Insert an object from a
library

For Material, Texture, and children nodes, select the
Insert From menu option (from either the Nodes menu
or from the context menu for a node).

For information about library objects, see “3D World
Editor Library” on page 6-29.

Add an inlined virtual world
3D file

For a ROOT or children node, from the Nodes menu or
the context menu for the node, select the Inline Virtual
Reality 3D File menu item.

You can inline VRML files (.wrl) files, but not X3D files
(-x3d or .x3dv).

The node that you add gets added to different locations in the hierarchy, depending on
the node that you select to begin adding a node.

node).

ROOT node (for example, a Transform

Selected Node Location of Added Node
ROOT At the bottom of the hierarchy
Node at the next level down from the Above the selected node

A children node

Under the children node (as a child node
of the selected node)

Copy and Paste a Node

You can copy a node below a top-level Transform node and paste that copied node to be
a child of another node, including the ROOT node.
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You can paste the copied node as either an explicit text copy (Paste) or as a referenced
copy (Paste As Reference).

* An explicit text copy allows you to edit properties of that node, independently from
the original node that you copied.

+ A referenced copy node appears with the term USE. Referenced copies streamline the
tree structure pane display. Edits that you make to the original (referenced) node
are applied to the copied node, ensuring that the two nodes remain exact copies of
each other.

To copy and paste a node:

1 In the tree structure pane, select the node that you want to copy.

2 Copy the node, using one of these techniques:

+  Select Edit > Copy.
Right-click the node and select Copy.
3 Under the appropriate node, paste the copied node.

+ Paste the node using one of the following techniques:

+ Select the Edit > Paste or the Paste As Reference menu item.

* Right-click the parent node and select Paste Node, and then select Paste or
Paste As Reference.

Copy and Paste Between Virtual Worlds

In the same editing session, you can copy nodes from a virtual world in one virtual world
3D file to another virtual world in a different file. After you copy the nodes from one
virtual world, select File > Open to open the second file where you want to paste the
nodes.

Edit Object Properties

To define the characteristics of an object, in the tree structure pane, select the
appropriate property. At the bottom of the 3D World Editor, use the object properties
edit pane to change property values. Then click Apply.

The tree structure pane shows the current property values, which reflect your edits.



Basic Editing

When you enter a numeric field value in the 3D World Editor, you can use MATLAB
expressions and MATLAB variables. For example, to convert an angle from degrees to
radians, enter a MATLAB expression such as 25*pi/180.

Set Viewpoint Values Using Camera Position

You can use the current camera position to specify interactively a viewpoint in the 3D
World Editor.

1 Navigate to the position in the scene where you want the viewpoint.
2 In the tree structure pane, right-click a Viewpoint node.

3 Select Copy values from current camera.
Specify a URL

For objects that have a URL field, to specify a URL, select the node and use one of these
approaches.

+ In the property edit box for the URL, enter the URL.

* Select the 0 on the left side of the property edit box and click the Select File URL
button. Navigate to the file.
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Document a Virtual World Using Comments
To document a virtual world, in the object property edit pane, use the Comments tab
for nodes and properties. Comments can help others understand the design of a virtual

world.

Comments do not appear in the virtual world. They appear in the virtual world 3D file,
next to the given node or property, on lines that begin with #.

Display Event Fields

You can display eventln and eventOut fields in the 3D World Editor tree pane. Either

click the Show Events button ® or select Tree > Show Events.

You can perform an IS mapping for events in a PROTO declaration.
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Expand and Collapse Nodes

To expand a node in the tree structure pane, click the plus (+) sign to the left of the
node. To collapse a node, click the minus (—) sign to the left of the node.

To expand or collapse all nodes in one step, select Tree > Expand All or Tree >
Collapse All.

To expand subtrees within a node:

1 In the tree structure pane, right-click a node.

2 From the context menu, select Expand Subtree.
Alternative approaches for expanding the subtree for a node are:
+ Select Tree > Expand Subtree.

Click the * button.
Hide Default Values

To simplify the tree view, you can hide default values. Select Tree > Hide Default
Values. To display default values, clear the Hide Default Values option.

Highlight Nodes and Virtual World Obijects

To select and highlight virtual world objects using the mouse pointer in the 3D World
Editor view pane, use the select mode. Use that mode to highlight a node that defines a
virtual world object or to highlight a virtual world object that a node defines. In the 3D
World Editor display pane, the selected virtual world object is highlighted with an orange
outline. For example:

1 Open the vrtkoff virtual world and select File > Open in editor.

2 In the 3D World Editor toolbar, click the k button.

Tip: Alternatively, you can select the View Pane > Select menu item.

When the cursor hovers over a selectable object in the view pane, the cursor shape
changes to a hand symbol.
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3 In the virtual world display pane, click the tail of the plane.

-

ROOT

i3 Marker (PROTO)
- & (WorldInfo)
(MavigationInfo)
(Background)

(Transform)
(Transform)
(Viewpoint)

B W= = I = = = W B = W = |

i

W W s e e e e

[

The corresponding Shape node in the tree structure pane is highlighted.

4 In the tree structure pane, click in the Tower (Transform) node, select the bottom
Shape node. The floors of the tower are highlighted.

B * children (MFNode)

[ * (Shape)
- ®  (Shape)
- b Block (Transform)
[ (Shape)
- ®  (Shape)
[_]..

- P Terminal (Transform)
- ® addChildren (MFNode)

* removeChildren (MFMNode)
B scale (SFVec3f: 0005  0f
-+ translation (SFVec3f): -30 11
=} ’ children (MFMode)

---} (Transform)

ERE (Transform)
- & addChildren (MFNot
removeChildren (MF
children (MFMNode)

L
£ P Lighthouse (Transfor%

* addChildren (MFMode)
* removeChildren (MFMNode)
B scale (SFVec3f): 001 0.0

(Directionallight)
(Directionallight)

Cameral (Transform)
Plane (Transform)
B scale (SFVec3f): 0.5
children (MFMode)
*  (Viewpoint)
E- W (Transform)
=~ ® (Transform)
£ 8 children (MFNode)
[~ * (Transform)
- *  (Transform)

-~

m
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Tip: If you select a node in the tree structure pane but do not see anything
highlighted in the virtual world display pane, adjust the viewing angle to make the
highlighted object visible.

To return to navigation mode, in the 3D World Editor toolbar, click the ¥ putton.

Tip: Alternatively, you can select the View Pane > Navigate menu item.

You can use Shift-click to select multiple objects in the tree structure pane or view pane.

If you do not want objects to be highlighted when you pick them, in the display
pane right-click and clear the Rendering > Highlight Selected Objects option.
Alternatively, you can use the F4 key.

Note: Compound virtual world objects, such as objects defined using Inline and PROTO
nodes, are selected and highlighted as a whole. You cannot select individual components
of these objects.

Selection and Highlighting Preferences

By default, the cursor in view pane navigates in the virtual world. To have the mouse
cursor in the view pane behave in select mode by default, set the Simulink 3D Animation
3D World Editor preference View pane mouse behavior preference to select. As an
alternative, use the Defaul tEditorMouseBehavior parameter with the vrsetpref
command.

By default, virtual world objects are highlighted when you select them using select mode.
To have the default behavior for selected virtual world objects be to not highlight the
objects, set the Simulink 3D Animation 3D World Editor preference Highlight selected

objects preference to OFF. As an alternative, use the DefaultEditorHighlighting
parameter with the vrsetpref command.

Wrap Nodes as Children of Another Node

To wrap contiguous nodes as children of another node:
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6 Using the 3D World Editor

1  Select the nodes. You can use the Shift key to select contiguous nodes, and the
CTRL key to select discontiguous nodes.

2 Right-click the selected nodes and from the context menu, select Wrap By.

As an alternative, on the 3D World Editor menu bar, select Nodes > Wrap By.

3 From the list of nodes, select the node in which you want to wrap the selected nodes.

b ROOT

[ ®  (WorldInfo)

(- *  (MavigationInfa)

(- * (Background)

(- ®  (Transform)

=2 WM embrane (Transform)

g: : W'EP[%Y 4 Anchor

@ b Dirlight (Directi Delete Billboard

- P PointLight (PointLight] Collision
Group

Transform

LOD
Switch

Remove Nodes

To delete one or more nodes, select the nodes and use one of these methods:

*  On the toolbar, click the red X button.
* Click the Delete button.

* Select Edit > Delete.

* Right-click the node and select Delete.

From the Edit menu, you can also delete a specific child node or all the children nodes of
a selected parent node, without deleting the parent node.

To cut a node and save it to the clipboard, select the node and use one of these
techniques:

*  On the toolbar, click the scissors button.
+ Select Edit > Cut.
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+ Right-click the node and select Cut.

Save and Export Virtual World 3D Files

You can save your virtual world files as virtual world using the File > Save or File >
Save As menu items.

If you use the Save option, the 3D World Editor renames the previous version of the file
by appending .bak after the .wrl, .x3dv, or .x3d extension.

If you use the Save As option, the 3D World Editor saves the file using the new name
that you specify. The file is saved in a form that the Simulink 3D Animation Viewer
and 3D World Editor support (for example, the saved file preserves links to the library
texture files).

Use the File > Export menu item to export a virtual world 3D file for use:

* With other VRML or X3D tools
*  On different computers

* In previous versions of the Simulink 3D Animation (previously the Virtual Reality
Toolbox) product (for VRML files)

Note: You cannot save an X3D file (.x3d or .x3dv) file as a VRML (.wrl) file.

For exported files, the 3D World Editor copies referenced inlined virtual world 3D files
and texture files to the <Filename>_Files folder. It modifies the corresponding URLs
for those files, so that they point to the <Fi lename>_Ffiles folder.

Edit VRML and X3D Scripts

To add a VRML or X3D Script node:

1 Inthe Tree structure pane, select the ROOT node.

2 Select the appropriate type of script, using the Node > Add > Common > Script
menu.

To add Script interface elements:
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1 Right-click a Script node.
2 Select the appropriate Add Interface Item menu option.

The following is an example of a Script node in the Tree structure pane.

= W Sl (Script)
-+ direction (SFVec3f)
[+ ® atollMatenal (SFMode)
- B ground (MFCalor)
- B sky (MFColor)
- url (MFString): [vrmlscript  function direction(value) {  y = value[l]: //ifthesunis
-~ B directOutput (SFBool): FALSE
-~ B mustEvaluate (5FBool): FALSE

For a url node, click the node and either specify the path to a JavaScript® file or enter
the URL code in the Object property edit pane.

- P Scl (Script)
-4 direction (SFVec3f)
atollMaterial (SFMode)
- B ground (MFCalor)
B sky (MFCalor)
g url (MFString): [vrmiscript:  function directionfvalue) {  y = value[l]:  //if the sun is below th
- B directOutput (SFBool): FALSE
o B mustEvaluate (SFBool): FALSE
" ROUTE Sun (DirectienalLight).direction (SFVec3f) TO Scl (Script).direction (SFVec3f)

- ROUTE 5¢l (Script).sky (MFCelor) TO Bekg (Background).skyCelor (MFColor) Nl
* BOIITE €1 (Cerint) arnun A AFC aladt TA Relen MRarkaraindl araon Al (AEC nlar 1

4

url (MFString)

Value | Comment
vERBRXER

vrmlscript:
function directionivalue) {

¥ = walue[1l;

/7 if the sun is below the horizon, make the sky and ocean dark
if (y >0 1] y < -1)
{

s = new SFColox(0, 0, 0);

sky[0] = s;

sky[l] = s;

skyl[2] = s;

ground[0]

ground[1]
1

// otherwise set sky and ccean lightness according to sun position
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See Also

Functions
vredit | vrgetpref | vrsetpref

Related Examples

. “3D World Editor Library” on page 6-29

. “Set the Default Editor” on page 2-2

. “Open the 3D World Editor” on page 6-5

. “Create a Virtual World” on page 6-10

. “Reduce Number of Polygons for Shapes” on page 6-24

. “3D World Editor Library” on page 6-29

. “Virtual World Navigation in 3D World Editor” on page 6-25

. “Build Virtual Worlds to Visualize Dynamic Simulations” on page 1-4

More About
. “3D World Editor Panes” on page 6-8
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Reduce Number of Polygons for Shapes

6-24

For a node that is, or includes, an IndexedFaceSet node, you can improve rendering
speed by reducing the number of polygons in the IndexedFaceSet. Choose the polygon
reduction factor that produces your desired balance of rendering performance and
quality.

To reduce the number of polygons:

1

4

Right-click an IndexedFaceSet node, or a node that includes one or more
IndexedFaceSet nodes.

Select Optimize Child Geometries.

In the Geometries Optimization Preview dialog box, use the slider or enter a value in
the Polygon reduction factor field to set the polygon reduction factor. A value of O
performs the maximum reduction, and a value of 1 performs no reduction.

Click OK.

Related Examples

“Basic Editing” on page 6-12
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Virtual World Navigation in 3D World Editor

In this section...

“Specify Virtual World Rendering” on page 6-25
“Basic Navigation” on page 6-25

“Coordinate Axes Triad” on page 6-25

“View Panes” on page 6-26

“Pivot Point” on page 6-28

Specify Virtual World Rendering

You can control the rendering used in the virtual world display pane of the 3D World
Editor. Right-click in the virtual world display pane and set rendering options, such as
antialiasing, lighting, and transparency.

Basic Navigation
Use the virtual world display pane to visualize the virtual world as you create it.

To control navigation, right-click anywhere in the pane and select the appropriate
navigation options. You can control aspects such as methods (for example, fly or walk)
and speed.

To save these navigation settings in a virtual world file, define the navigation properties
in a NavigationInfo node.

To navigate in the virtual world, left-click in the pane. The cursor changes to a white
cross hair. Moving the cursor changes the orientation of the virtual world.

Coordinate Axes Triad

To help you visualize changes in the orientation (coordinate axes) of nodes in a virtual
world, the 3D World Editor virtual world display pane includes a triad of red, green,
and blue arrows. These arrows are always parallel with global X, y, and z coordinate
axes. As you navigate in a virtual world, the triad display changes to reflect changes in
orientation.
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ROOT

- b Bl (Transform)
-~ b B2 (Transform)
a4

&--F--F- v

To hide the triad for a virtual world, or to change the location of the triad in the virtual
world display pane, right-click in the pane and select the appropriate option from the
View > Triad menu.

To change the default location or visibility of the triad:

1  From the MATLAB Toolstrip, in the Home tab, in the Environment section, select
Preferences.

2 In the Preferences dialog box left pane, select Simulink 3D Animation > 3D
World Editor > Triad.

View Panes

You can view the virtual world in one pane, two horizontal panes, two vertical panes, or
four panes.

For example, if you select View Pane > Grid View, the 3D World Editor displays four
view panes:



Virtual World Navigation in 3D World Editor

[Er T e =B e B e T e W= e = B e W = W e R e O e =

LR N A b A A 2 A T T )

- Octavia (EXTERNPROTO)

(WorldInfo)
(Navigationlnfo)
(Background)
(DirectionalLight)
(DirectionalLight)
(Directionallight)

Car_1 (Octavia)

Car_2 (Octavia)
FlyingCamera (Viewpoint)
RoadSystem (Transform)
Surrounding_Objects (Transform)
Startline (Transform)
(Viewpuoint)

(Viewpoint)

(Viewpoint)

You can also use toolbar buttons to set view panes:

Oeos|

When the grid view panes are open and you change the view pane option, the editor
displays the following view panes from the grid view.

Horizontal Split Left two panes
Vertical Split Top two panes
Single View Top left pane

To change the relative size of a pane, select one of the gray borders for a view pane and
drag the cursor.

To delete a pane when there are multiple panes, click the dot in the border between view
panes.

You can control the navigation of each pane independently. For example, you can set

viewpoints, manipulate the triad, and specify rendering techniques independently for
each pane. The navigation panel in the active pane is blue. For example:
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Pivot Point

In Examine mode, you can use a pivot point for rotating a virtual world around a point,
using a mouse.

The default pivot point is 0,0,0 (world coordinates). To set a new pivot point, hold
CRTL and double-click the spot where you want the pivot point.

See Also

Functions
vredit | vrgetpref | vrsetpref

Related Examples
. “3D World Editor” on page 6-2

. “Set Simulink 3D Animation Preferences” on page 2-9

More About
. “3D World Editor Panes” on page 6-8
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3D World Editor Library

In this section...

“3D World Editor Library Objects” on page 6-29
“Add a Library Object” on page 6-30

“Guidelines for Using Custom Objects” on page 6-30

3D World Editor Library Objects

The 3D World Editor includes a library of virtual world objects, which you can insert into
a virtual world. The library consists of component, texture, and material objects. These
library objects supplement the default empty nodes available via the Nodes menu or the
Insert From context menu item. The library objects are predefined with specific nodes
and property settings to represent common virtual world effects.

Examples of component objects in the library include:

+  Aircraft

* Vehicles

*  Backgrounds
+ Shapes

Examples of texture objects are:

* Surface of Earth

*  Surface of the moon

+ Water

+ Surfaces of building materials

Examples of material objects are:

*  Colored plastics
+ Colored metals
+ Sand

After you add a library object to a virtual world, you can modify its nodes and properties.
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Add a Library Object
To add a 3D World Editor library object to a virtual world:

1  Select the parent node under which you want to insert the library object.

2 Use one of these techniques to access the library objects:

Select the Nodes > Insert From menu item.

* Right-click the parent node and select the Insert From menu item.

The set of objects displayed depends on the parent node that you select. For
example, if you select a child node under a Transform node, you can choose among
Component sublibrary objects. To add a material object, select an Appearance

or Material node or material field. To add a texture library object, select an
Appearance node or texture field.

3 To find the object that you want to insert, follow the folder paths.

You can also insert objects from other locations, using the Insert From > Other
Location menu item.

+ The first Transform node of the file that you select from another location is inserted
in place into the tree view of the virtual world that you are editing.

+ If you want to insert a whole virtual world 3D file into the virtual world that you are
editing, use the Nodes > Inline Virtual Reality 3D file menu option.

Before you add a custom library object from a location other than from the 3D World
Editor object library, see “Guidelines for Using Custom Objects” on page 6-30.

Guidelines for Using Custom Objects

If you use a VRML or X3D object from a source other than from the 3D World Editor
object library, the object must comply with these rules.
* A component object must be in a file that contains at least one Transform node.

+ A material object must be a file whose only content is a fully qualified Material
node.

* A texture object must be in either:

A _png, -Jpg, or -giT graphics file for use in the URL field of an ImageTexture
node.



3D World Editor Library

+ A file whose only content is a fully qualified ImageTexture node.

If you create VRML or X3D objects to use with the 3D World Editor, create your own
folder for storing the custom objects. Avoid using the 3D World Editor library folder. Use
your own folder so that you can:

+ Edit the custom library object in the library folder; the 3D World Editor library
folders are generally read-only.

+  Update to a future version of the Simulink 3D Animation product without
compatibility issues relating to mixing custom objects with the 3D World Editor
objects.

Related Examples
. “Basic Editing” on page 6-12
. “3D World Editor” on page 6-2
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Viewing Virtual Worlds

“Virtual World Viewers” on page 7-2

“Simulink 3D Animation Viewer” on page 7-5

“Open the Simulink 3D Animation Viewer” on page 7-10
“Simulate with the Simulink 3D Animation Viewer” on page 7-12
“Specify Rendering Techniques” on page 7-13

“Navigate Using the Simulink 3D Animation Viewer” on page 7-22
“Viewpoints” on page 7-32

“Define and Reset Viewpoints” on page 7-33

“Navigate Through Viewpoints” on page 7-37

“Record Offline Animations” on page 7-41

“Play Animations with Simulink 3D Animation Viewer” on page 7-49
“Configure Frame Capture Parameters” on page 7-51

“Capture Frames” on page 7-53

“Simulink 3D Animation Web Viewer” on page 7-54

“Open the Web Viewer” on page 7-56

“Navigate Using the Web Viewer” on page 7-58

“Listen to Sound in a Virtual World” on page 7-61

“View a Virtual World in Stereoscopic Vision” on page 7-63

“Active Stereoscopic Vision Configuration” on page 7-65
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Virtual

World Viewers

In this section...

“Host and Remote Viewing” on page 7-2

“Comparison of Viewers” on page 7-2

After you create a virtual world in VRML or X3D (see “Build Virtual Reality Worlds”),
you can visualize that virtual world with a virtual world viewer or HTML5-enabled web
browser.

The Simulink 3D Animation product includes three viewers.

*  Simulink 3D Animation Viewer (the default viewer)
+  Simulink 3D Animation Web Viewer

*  Orbisnap viewer

To determine which viewer to use, see “Comparison of Viewers” on page 7-2.

Host and Remote Viewing

You can view a virtual world on your host computer, with either the Simulink 3D
Animation Viewer, Orbisnap, or a web browser. For web browser support, Simulink 3D
Animation provides the Simulink 3D Animation Web Viewer.

In most configurations, you do not need to install a viewer on a client computer because
you can perform all the tasks on a host computer. However, if you have large models that
consume considerable computational resources, you can use a client computer to run and
view the virtual world.

To view a virtual world on a client computer, which does not need to have Simulink 3D
Animation installed, you can use the Web Viewer, or Orbisnap. For remote viewing, use
the Web Viewer or Orbisnap.

Comparison of Viewers

Feature Simulink 3D Animation |Simulink 3D AnimationWeb |Orbisnap
Viewer Viewer
Platforms Windows, Macintosh, |[Windows, Macintosh, and | Windows, Macintosh,

and Linux Linux and Linux
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Feature Simulink 3D Animation |Simulink 3D AnimationWeb |Orbisnap
Viewer Viewer
Web browser HTML5-enabled web
browser
Installation Installed with product |Host interface installed |Separate installation

with product

Simulink 3D Yes
Animation required

Remote viewing Yes Yes

Viewpoint creation Yes

Animation start/stop |Yes Starts automatically

Simulation start/stop |Yes

Sound Yes Yes
Stereoscopic viewing |Yes Yes
See Also
Functions

vrgetpref | vrsetpref

Related Examples

. “Set the Default Viewer” on page 2-5

. “Set Simulink 3D Animation Preferences” on page 2-9

. “Open the Simulink 3D Animation Viewer” on page 7-10

. “Specify Rendering Techniques” on page 7-13

. “Navigate Using the Simulink 3D Animation Viewer” on page 7-22
. “Define and Reset Viewpoints” on page 7-33

. “Navigate Through Viewpoints” on page 7-37

. “Simulate with the Simulink 3D Animation Viewer” on page 7-12
. “Record Offline Animations” on page 7-41

. “Capture Frames” on page 7-53

. “Play Animations with Simulink 3D Animation Viewer” on page 7-49
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. “Install Third-Party Editors and Viewers”

More About

. “Simulink 3D Animation Viewer” on page 7-5
. “Viewpoints” on page 7-32
. “Simulink 3D Animation Web Viewer” on page 7-54
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Simulink 3D Animation Viewer

In this section...
“What You Can Do with the Viewer” on page 7-5
“Viewer Uses MATLAB Figures” on page 7-7

“Set Viewer Appearance Preferences” on page 7-8

What You Can Do with the Viewer

This section provides an overview of the features and controls of the viewer.

This section uses the vrpend, vrplanets, and vrtutl examples to illustrate the viewer
features:
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Select a Simulink 3D Animation example and type the example name in the
MATLAB Command Window. For example:

vrpend

The Simulink model is displayed. By default, the Simulink 3D Animation viewer for
that model is loaded and becomes active. If the viewer is not displayed, double-click
the VR Sink block in the Simulink model.

Inspect the viewer window.

The Simulink 3D Animation viewer displays the virtual scene. The top of the viewer
contains a menu bar and toolbar. By default, the Simulink 3D Animation viewer
displays the virtual scene with a navigation panel at the bottom. These three areas
of the viewer give you alternate ways to work with the virtual scene.



Simulink 3D Animation Viewer

File View Viewpoints Mavigation Rendering Simulation Recording Help k]
Pseude crthegraphic view VI Examine "IJ e | ) | d q | . | | o | [ .

|Pseudo orthographic view [T=0.00 |Examine |Pas:[-180.00 100.00 180.00] Dir:[0.66 -0.35 -0.88]

Note The Simulink 3D Animation viewer settings are saved when you save your
model file.

Viewer Uses MATLAB Figures

The Simulink 3D Animation software contains a viewer as the default method for
viewing virtual worlds. You can use this viewer on any supported operating system. This
viewer uses MATLAB figures. It provides several capabilities, including:
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Treat the viewer window like a MATLAB figure. This ability enables you to perform
MATLAB figure actions such as dock the viewer window in the MATLAB window. For
example:

I =] E3

Daock: Planets

| »

To display a context menu that contains the viewer commands, right-click in the
viewer window. For example:

File ]
View L
Viewpoinks k
I I
Rendering Speed b waAmine
Straighten Up w Fly
Undo Mowve i

v Camera Bound ko Viewpaoint

Combine multiple virtual reality viewer figures in several tiles of a MATLAB figure.

Set Viewer Appearance Preferences

You can configure the appearance of the viewer using Simulink 3D Animation
preferences. For details, see “Figure Appearance Preferences Dialog Box” on page 2-14.

See Also

Functions
vrgetpref | vrsetpref

Related Examples

“Open the Simulink 3D Animation Viewer” on page 7-10

“Set Simulink 3D Animation Preferences” on page 2-9
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More About

. “Virtual World Viewers” on page 7-2
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Open the Simulink 3D Animation Viewer

7-10

In this section...

“Open from the VR Sink Block” on page 7-10
“Open from the Command Line” on page 7-10

Open from the VR Sink Block

You can open the Simulink 3D Animation Viewer by double-clicking a VR Sink block in
the Simulink Editor.

You can configure a VR Sink block to automatically open the Simulink 3D Animation
Viewer.

1 In the Simulink Editor, double-click the VR Sink block to open the Simulink 3D
Animation Viewer.

2 From the Simulink 3D Animation Viewer Simulation menu, select Block
parameters.

3 Select Open Viewer automatically.
4 Click OK.

Open from the Command Line

Use vrview. For example, to open the vrbounce virtual world in the Simulink 3D
Animation Viewer, use vrview("vrbounce").

See Also

Functions
vrgetpref | vrsetpref

Related Examples
“Set the Default Viewer” on page 2-5

“Set Simulink 3D Animation Preferences” on page 2-9



Open the Simulink 3D Animation Viewer

More About

. “Virtual World Viewers” on page 7-2
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Simulate with the Simulink 3D Animation Viewer

You can start and stop simulations of the virtual world from the Simulink 3D Animation
viewer through the menu bar, toolbar, or keyboard.

From the menu bar, select the Simulation menu Start or Stop option.

From the toolbar, click Start/pause/continue simulation or Stop simulation.

From the keyboard, press Ctrl+T to toggle between starting or stopping the
simulation.

Note The Ctrl+T operation is available only if you started the viewer from a Simulink
model. If you start the viewer through the MATLAB interface, no Simulink model is
associated with the viewer. You cannot start and stop the simulation in this case.

Related Examples

“Open the Simulink 3D Animation Viewer” on page 7-10
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Specify Rendering Techniques

You can change the rendering of the scene through the controls on the navigation panel
or options on the rendering menu. The vrpend and vrplanets examples are used to
show the viewer functionality.

You can turn the antialiasing of the scene on or off. Antialiasing applies to the textures
of a world. Antialiasing is a technique that attempts to smooth the appearance of
jagged lines. These jagged lines are the result of a printer or monitor not having enough
resolution to represent a line smoothly. When Antialiasing is on, the jagged lines are
surrounded by shades of gray or color. Therefore, the lines appear smoother rather than
jagged.

The following figure depicts the vrplanets example View on Earth viewpoint with
Antialiasing on. To display the effects of antialiasing better, turn Headlight on. You
can turn antialiasing on or off to observe the differences.

B proness =
File View Viewpeoints Mavigation Rendering Simulation Recording Help L
View on Earth »lly Az da M BE &> E
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You can turn the camera headlight and the lighting of the scene on or off. When
Headlight is off, the camera does not emit light. Therefore, the scene can appear dark.
For example, the following figure depicts the vrpend example with Headlight on.

File View \Viewpoints Mavigation Rendering Simulation Recording Help k]
Pseudo orthographic view vl Examine ']J | | Y Dl d q | . | | ﬁ| » .

|Pseudn orthographic view 1 Examine Pos:[-180.00 100.00 180.00] Dir:[0.656 -0.36 -0.65]

The scene looks darker when Headlight is set to off.
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u Inverted Pendulum

File VWiew Viewpoints Mavigation Rendering Simulation Recording Help
F
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|Pos:(-180.00 100.00 180.00] Dir:[0.66 -0.36 -0.66]

Pzeudo orthographic view T=0.00 Examing

Note It is helpful to define enough lighting within the virtual scene so that it is lit
regardless of the Headlight setting.

When Lighting is off, the virtual world appears as if lit in all directions. The Simulink
3D Animation viewer does not compute and render all the lighting effects at the surfaces
of the objects. Shadows disappear and the scene loses some of its 3-D quality. The

following is the vrpend example with Lighting off.
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File VWiew Viewpoints Mavigation Rendering Simulation Recording Help El
Pseudo orthegraphic view VI Examine ']J ot | 15 ) | d q | . | | 5] | » .

|Pseudo orthographic view |T=0.00 |Examine |Pos:[-180.00 100.00 180.00] Dir:[0.66 -0.35 -0.66]

If Transparency is off, transparent objects are rendered as solid objects.
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. Inverted Pendulum EIE

File View Viewpeoints Mavigation Rendering Simulation Recording Help k]
’Pseudoorthographicview vl Examine v]qJ i | & . | d- q | . | | ﬁ | b .

|Pseudo orthographic view [T=0.00 |Examine |Pos:[-120.00 100.00 120.00] Dir:[0.66 -0.36 -0.88]

Turning Wireframe on changes the scene objects from solid to wireframe rendering. The
following is the vrpend example with Wireframe on.
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n Inverted Pendulum EI

File View Viewpeoints Mavigation Rendering Simulation Recording Help L

:Pseudo orthographic view V Examine '4J ot | -y 9| d q | . | | 5] | » .

|Pseude orthographic view [T=0.00 |Examine |Pos:[-180.00 100.00 180.00] Dir:[0.66 -0.36 -0.66]

If the Textures option is on, objects have texture in the virtual scene. Here is the
vrplanets example with Textures on:
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If Textures is off, objects do not have texture in the virtual scene. The following is the
vrplanets example with Textures off.
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You can specify the maximum size of a texture used in rendering the vrfigure
object. This option gives you a list of texture sizes to choose from. See the virfigure
MaxTextureSize property for further details.

Turn Off Rendering for Performance

You can use the Rendering property for either a vrfigure or vr.canvas object to turn
off rendering for the object in the Simulink 3D Animation Viewer. For example, if your
code does batch operations on a virtual figure, you can turn off rendering during that
processing and then turn it back on after the processing.

You can also use the new Simulink 3D Animation > World > Default Figure
Rendering preference (DefaultFigureRendering) to specify whether to render a
newly created virtual figure or canvas object.



Specify Rendering Techniques

See Also

Functions
vr.canvas | vrgetpref | vrsetpref | vrworld

Related Examples

“Set Simulink 3D Animation Preferences” on page 2-9

More About
. “Virtual World Viewers” on page 7-2
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Navigate Using the Simulink 3D Animation Viewer

7-22

In this section...

“Basic Navigation” on page 7-22

“Navigation Panel” on page 7-24

“Viewer Keyboard Shortcuts” on page 7-26
“Mouse Navigation” on page 7-27

“Control Menu” on page 7-28

“Change the Navigation Speed” on page 7-28
“Sensors Effect on Navigation” on page 7-29

“Display a Coordinate Axes Triad” on page 7-30

“Pivot Point” on page 7-31

Basic Navigation

You can navigate around a virtual scene using the menu bar, toolbar, navigation panel,
mouse, and keyboard. The vrbounce example illustrates the several key features of the

viewer.

Navigation Panel — The center navigation wheel and two curved buttons on either side
allow you to move about in the scene. Experiment by moving backward and forward and
side to side until you become comfortable with the controls.

Navigation view — You can change the camera position. From the menu bar, select the
Navigation menu Straighten Up option. Alternatively, from the toolbar, you can click

the Straighten Up control, or on the keyboard, you can press F9. This option resets the
camera so that it points straight ahead.
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¥ VR Bouncing Ball =n| Wl <
File View Viewpoints Rendering  Simulation Recording Help L]
Bal v Method vid | M E || E

Speed 3

Straighten Up L\\,

Undo Move

v | Camera Bound to Viewpoint

Navigation methods — Navigation with the mouse depends on the navigation
method that you select and the navigation zone that you are in when you first click
and hold down the mouse button. You can set the navigation method using one of these
approaches:

From the menu bar, select the Navigation menu Method option. This option
provides three choices: Walk, Examine, or Fly. See “Mouse Navigation” on page
7-27.

From the toolbar, select the drop-down list that displays the navigation options Walk,
Examine, and Fly.

=T
File WView Viewpoints Mavigation Rendering Simulation Recording Help L
IBaII ;”Examine;qu P’|$ 9|(f Q_|.||ﬁ| b N

From the navigation panel, click the W, E, or F buttons.
On the keyboard, press Shift+W, Shift+E, Shift+F, or Shift+N.
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Navigation zones — You can view the navigation zones for a scene through the menu
bar or keyboard.

From the menu bar, select the View menu Navigation Zones option. The virtual
scene changes as the navigation zones are toggled on and appear in the virtual scene.
Alternatively, on the keyboard, press the F7 key.

The vrbounce example with Method set to Fly has three navigation zones.

u VR Bouncing Ball EI@
File View Viewpoints Mavigation Rendering Simulation Recording Help L]
Bal | Fy dM s dd | E & > E

Walk
Examine
Fly

Navigation Panel

The Simulink 3D Animation viewer navigation panel has navigation controls for some of
the more commonly used navigation operations available from the menu bar.

7-24



Navigate Using the Simulink 3D Animation Viewer

Navigation
wheel
Slide
right Wireframe
‘ Headlight

Full-screen Slide
mode left

Minimize 4
panel ‘

Previous| Next
Walk /Examine /Fly

Default
viewpoint

If you have multiple viewers open, the navigation panel in the active viewer is blue.

Minimize the Navigation Panel
You can minimize the navigation panel using one of these approaches:

*  Click the red x control on the left side of the navigation panel.
* Select View > Navigation Panel > Minimized

The minimized navigation panel appears as an icon in the lower right corner of the
viewer.

File View Viewpoi Navigati Rendering  Simulati Recording  Help ¥
Mount . Bark oy A |po|dd HE &> E

Pos:[24.00 5.00 69.00] Dir:[-0.93 0.00 -0.36]
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To display the navigation panel again, click the Show Panel left arrow on the minimized
navigation panel icon.

To minimize the navigation panel by default, from the MATLAB Toolstrip, set the
Preferences > Simulink 3D Animation > Canvas > Navigation panel preference to
minimized.

The minimized navigation panel is blue for the active viewer and gray for the inactive
viewers.

Viewer Keyboard Shortcuts

Navigation Function Keyboard Shortcut
Use full-screen mode. Ctrl+f
Undo move. Backspace
Start or stop recording. Ctrl+r
Capture frame. Ctrl+i
Start or stop simulation. Ctrl+t
Straighten up and make the camera stand on the |F9
horizontal plane of its local coordinates.

Zoom in and out. +/-

Toggle the headlight on and off. Fé6

Toggle the navigation zones on and off. F7

Toggle the wireframe option on and off. F5

Toggle the antialiasing option on and off. F8

Go to default viewpoint. Esc

Return to current viewpoint. Home

Go to previous viewpoint. Page Up
Go to next viewpoint. Page Down
Camera is bound/unbound from the viewpoint. F10

Set the navigation method to Walk. Shift+w
Set the navigation method to Examine. Shift+e

Set the navigation method to Fly. Shift+f
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Navigation Function Keyboard Shortcut

Move the camera forward and backward. Shift Up/Down Arrow

Pan the camera up and down. Up/Down Arrow

Pan the camera right and left. Left/Right Arrow, Shift
+Left/Right Arrow

Slide up and down. Alt+Up/Down Arrow

Slide left and right. Alt+Left/Right Arrow

Pressing Ctrl alone acquires the examine lock Ctrl+Left/Right/ Up/Down Arrow

at the point of intersection between the line
perpendicular to the screen, coming through

the center of the viewer window, and the closest
visible surface to the camera. Pressing the arrow
keys without releasing Ctrl rotates the viewpoint
about the acquired center point.

Tilt the camera right and left. Shift+Alt+Left/ Right Arrow

Mouse Navigation

The following table summarizes the behavior associated with the movement modes and
navigation zones when you use your mouse to navigate through a virtual world. Turn
on the navigation zones and experiment by clicking and dragging your mouse in the
different zones of a virtual world.

Simulink 3D Animation Viewer Mouse Navigation

Movement Mode Zone and Description

Walk Outer — Click and drag the mouse up, down, left, or right to
slide the camera in any of these directions in a single plane.

Inner — Click and drag the mouse up and down to move forward
and backward. Drag the mouse left and right to turn left or right.

Examine Outer — Click and drag the mouse up and down to move forward
and backward. Drag the mouse left and right to slide left or right.

Inner — Click and drag the mouse to rotate the viewpoint
around the origin of the scene.
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Movement Mode Zone and Description
Fly Outer — Click and drag the mouse to tilt the view either left or
right.

Inner — Click and drag the mouse to pan the camera up, down,
left, or right within the scene.

Center — Click and drag the mouse up and down to move
forward and backward. Move the mouse left or right to turn in
either of these directions.

If your virtual world contains sensors, these sensors take precedence over mouse
navigation at the sensor location. For more information, see “Sensors Effect on
Navigation” on page 7-29.

Control Menu

Access the control menu by right-clicking in the viewer window. You can use the control
menu to specify a predefined viewpoint or change the appearance of the control panel.
You can also control the navigation method, speed, and rendering of the virtual world.
For more information about navigation methods, see “Navigate Using the Simulink 3D
Animation Viewer” on page 7-22. For more information about rendering, see “Specify
Rendering Techniques” on page 7-13.

Change the Navigation Speed
You can change the speed at which you navigate around the view.

In the menu bar, select the Navigation menu.
Select the Speed option.
Select the specific speed that you want.

B WN —

Navigate the virtual world.

Note Your navigation speed controls the distance that you move with each
keystroke. It does not affect rendering speed.

Consider setting a higher speed for large scenes and a slower speed for more controlled
navigation in smaller scenes.
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To change the default navigation speed for a virtual scene, modify the speed field of the
NavigationlInfo node in the scene virtual world 3D file.

Sensors Effect on Navigation

1

At the MATLAB command prompt, type

vrpend

The Inverted Pendulum example starts, and the viewer displays the following scene.

I Inverted Pendulum = =R

File View Viewpoints MNavigati Renderi Simulati Recording  Help L]

gal
[Pseudoorthographicview vl Examine ']J Ll | B = | addq | . | | o] | » .

Pseudo orthographic view

In the Simulink Editor window, from the Simulation menu, choose Run.

The example starts running.

Click inside and outside the sensor area of the viewer window. The sensor takes
precedence over navigation with the left mouse button. The shape of your pointer
changes when it is located over the sensor area.
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7-30

If the sensor covers the entire navigable area, mouse navigation is effectively disabled.
In this case, use the control panel or the keyboard to move about the scene. For a three-
button mouse or a mouse with a clickable wheel, you can always use the middle button
or the wheel to move about the scene. The middle mouse button and wheel do not trigger
sensors within the virtual world.

Display a Coordinate Axes Triad

To help you visualize changes in the orientation (coordinate axes) of nodes in a virtual
world, display a triad of red, green, and blue arrows. These arrows are always parallel
with global X, y, and z coordinate axes. As you navigate in a virtual world, the triad
display changes to reflect changes in orientation.

E=%ECE 5

File View Viewpeoints Mavigation Rendering Simulation Recording  Help E

v | Fly ~dMm 2 da B o HE

To display a triad in the viewer, or to change the location of the triad, use one of the
following approaches:

+ Right-click in the virtual world. Select the appropriate option from the View > Triad
menu.

* In the viewer menu bar, select the appropriate option from the View > Triad menu.

To change the default location or visibility of the triad:
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1 From the MATLAB Toolstrip, in the Home tab, in the Environment section, select
Preferences.

2 In the Preferences dialog box, select Simulink 3D Animation > Figure > Triad.

Pivot Point

In Examine mode, you can use a pivot point for rotating a virtual world around a point,
using a mouse.

To set the pivot point in a virtual world, hold CRTL and double-click the spot where you
want the pivot point.

Note: On Macintosh platforms, use the command key instead of Ctrl.

See Also

Functions
vrgetpref | vrsetpref

Related Examples
. “Define and Reset Viewpoints” on page 7-33
. “Navigate Through Viewpoints” on page 7-37

More About

. “Virtual World Viewers” on page 7-2

. “Simulink 3D Animation Viewer” on page 7-5
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Viewpoints
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Visitors to your virtual world navigate in an environment that you create for them, using
navigation methods allowed by the viewer (Walk, Examine, Fly). It is useful to set up

in the world several locations, places of interest you want to point the visitors to. These
locations are called viewpoints. Visitors can browse through them, carrying out a guided
tour you prepared for them, gaining the visual information you consider important in
your model.

When entering a world, your are placed at the first Viewpoint node encountered in the
file. It is especially important to define this viewpoint carefully as the most interesting
entry point.

Each virtual world has as many viewpoints as you define for it. You can define
viewpoints in the virtual world through your chosen editor or through the Simulink 3D
Animation viewer.

Defined viewpoints can be:

+ Static — usually created at the top level of the virtual world object hierarchy or as
children of static objects (Transforms).

* Dynamic — created as children of moving objects (objects driven from MATLAB/
Simulink) or linked to them using the VRML ROUTE mechanism.

Dynamic viewpoints allow you to create interesting effects like view at the driving
range from the view of the driver.

Related Examples
. “Define and Reset Viewpoints” on page 7-33
. “Navigate Through Viewpoints” on page 7-37
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Define and Reset Viewpoints

In this section...

“Reset Viewpoints” on page 7-33
“Define Viewpoints” on page 7-33

Reset Viewpoints

You can reset your position in a scene to initial default or current viewpoint position
through the menu bar, toolbar, navigation panel, or keyboard shortcut keys.

*  From the menu bar, use the Viewpoints menu Return to viewpoint option to
return to the initial position of the current viewpoint. Alternatively, from the toolbar,
select Return to viewpoint button to return to the initial position of the current
viewpoint.

*  From the navigation panel, click the Go to default viewpoint control to return
to the default viewpoint of the virtual world. Alternatively, from the menu bar, use
the Viewpoints menu Go to Default Viewpoint option to return to the default
viewpoint of the virtual world.

*  From the keyboard:

* To return to the default viewpoint of the virtual world, press the Esc key.

+ To return to the initial position of the current viewpoint, press the Home key.

Define Viewpoints

You can add new viewpoints to the virtual world through the menu bar or toolbar. You
can start the simulation before creating viewpoints. This topic assumes that the model is
not currently running.

1 Select a Simulink 3D Animation example and type that example name in the
MATLAB Command Window. For example:

vrplanets

The Simulink model is displayed. Also, by default, the Simulink 3D Animation
viewer for that model is loaded and becomes active. If the viewer is not displayed,
double-click the VR Sink block in the Simulink model.
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11

12

In the Simulink 3D Animation viewer, the default viewpoint for this model is View
from top.

From the menu bar, choose the Viewpoints menu.

Choose View on Earth.

In the viewer window, navigate to a random position in the scene.

From the Viewpoints menu, choose Create Viewpoint. Alternatively, click Create

viewpoint on the toolbar.

The Create Viewpoint dialog box is displayed.

Create new viewpoint o || EOjER
Name:
FETEIETE Child of the root -

| Jump to new viewpoint immediatehy

| oK | |Cancel| | Help | | Apohy |

In the Name box, enter a unique and descriptive name for the viewpoint.

The state of the Placement field depends on the current viewpoint. If the current
viewpoint is at the top hierarchy level in the virtual world (one of the children of the
root), the Placement field is grayed out. In this case, it is only meaningful to create
the viewpoint at the same top hierarchy level.

In this example, the Placement field is editable. Select Child of the root as the
viewpoint type. This option makes the viewpoint a static one.

Select the Jump to new viewpoint immediately check box to make the new
viewpoint become the current viewpoint for the viewer. If you do not select this
option, you still create a viewpoint, but you remain bound to the current viewpoint,
not to the new viewpoint.

Click OK.

From the File menu, click Save As to save the file with the new viewpoint. If you do
not save the file, the new viewpoint is lost during simulation.

From the Simulation menu, click Start. Observe the motion of the planets from the
new, static viewpoint.

Stop the simulation.
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13
14

15

16
17

18

Repeat steps 2—6.

In the Placement field, select Sibling of the current viewpoint. This
option creates a viewpoint at the same level in the virtual world object hierarchy
as the child of the parent transform of the current viewpoint. The local coordinate
system of the parent transform defines the new viewpoint coordinates. As a result,
the new viewpoint moves with the parent transform. The new viewpoint also keeps
the position relative to the transform (offset) that you first defined by navigating
somewhere in the space from the current viewpoint (step 4).

Note If the current viewpoint is at the top hierarchy level in the virtual world (one
of the children of the root), the Placement field is grayed out. In this case, it is only
meaningful to create the viewpoint as a static one at the same top hierarchy level.

Select the Jump to new viewpoint immediately check box to make the new
viewpoint become the current viewpoint for the viewer. If you do not select this
option, you still create a viewpoint, but you remain bound to the current viewpoint,
not to the new viewpoint.

Click OK.

From the File menu, choose Save As to save the file with the new viewpoint. If you
do not save the file, the new viewpoint is lost during simulation.

From the Simulation menu, choose Start. Observe that the relative position
between the new viewpoint and Earth remains the same. The new viewpoint moves
together with its parent object Earth transform.
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Related Examples

“Navigate Through Viewpoints” on page 7-37

More About

. “Viewpoints” on page 7-32
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Navigate Through Viewpoints

You can navigate through viewpoints using the menu bar, toolbar, navigation panel,
or keyboard shortcut keys. These navigation methods are inactive if the author has
specified no or only one viewpoint in the virtual world.

*  From the menu bar, use the Viewpoints menu to move between viewpoints. Use the
Previous Viewpoint and Next Viewpoint options to move up and down the list of
existing viewpoints sequentially. To move focus to a particular viewpoint, choose a
viewpoint from the list of viewpoints.

*  From the toolbar, use the drop-down list of viewpoints to select a particular viewpoint.

*  From the navigation panel, use the Previous Viewpoint and Next Viewpoint
controls to move up and down the list of existing viewpoints sequentially.

*  From the keyboard, press Page Up and Page Down.

To reset a camera to the initial position of the current viewpoint, use one of the methods
listed in “Reset Viewpoints” on page 7-33. Resetting the viewpoint is useful to reorient
yourself when you have been moving about the scene.

This topic illustrates viewpoints using the vrplanets example.

1  Select a Simulink 3D Animation example and type that example name in the
MATLAB command window. For example:

vrplanets

The Simulink model is displayed. By default, the Simulink 3D Animation viewer for
that model is loaded and becomes active. If the viewer is not displayed, double-click
the VR Sink block in the Simulink model.

2 From the menu bar, select the Viewpoints menu.

A menu of the viewpoint options is displayed. Included is a list of the existing
viewpoints.
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Previous Viewpaink Pglp
Mext Viewpoink PaDn
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Go ko Default Yiewpaoint Esc

Create Viewpoink., .,
Remowe Current Viewpoink

Perspective view |

3 To see the list of existing viewpoints from the toolbar, select the drop-down list on
the leftmost side of the toolbar. The status bar at the bottom of the viewer displays
the current viewpoint.

List of viewpnints
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View from top *

Perspective view
View on Earth

|View from top |T=0.00 |Fiy |Pos:[0.00 150.00 0.00] Dir:[0.00 -1.00 0.00]

When you add new viewpoints to the world, these lists are updated to reflect the new
viewpoints.

The current viewpoint is also displayed in the left pane of the status bar.

You manage and navigate through viewpoints from the menu bar, toolbar, navigation
panel, and keyboard. In particular, you can

Navigate to a previous or next viewpoint

Return to the initial position of the current viewpoint
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*  Go to the default viewpoint
+ Create and remove viewpoints

* Navigate to an existing viewpoint

Related Examples
. “Define and Reset Viewpoints” on page 7-33

More About

. “Viewpoints” on page 7-32
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Record Offline Animations

In this section...

“Animation Recording” on page 7-41

“Recording Formats” on page 7-41

“File Names” on page 7-42

“Start and Stop Animation Recording” on page 7-43

“Play Animation Files” on page 7-43

“Record 3—D Animation Files” on page 7-44

“Record in Audio Video Interleave (AVI) Format” on page 7-44
“Schedule Files for Recording” on page 7-47

Animation Recording

The Simulink 3D Animation software enables you to record animations of virtual scenes
that the Simulink or MATLAB product controls. You can record simulations using

the Simulink 3D Animation Viewer. You can then play back these animations offline,

in other words, independent of the MATLAB, Simulink, or Simulink 3D Animation
products. You can generate such files for presentations, to distribute simulation results,
or to generate archives.

Note Optimally, use the Simulink 3D Animation Viewer to record animations of virtual
worlds associated with Simulink models. This method ensures that all necessary virtual
world and vrfigure properties are properly set to record simulations. If you are working
with virtual scenes controlled from MATLAB, you can record virtual scenes through the
MATLAB interface. For details, see “Animation Recording” on page 4-11.

You can save a frame snapshot (capture) of the current Simulink 3D Animation viewer
scene. You can save this frame as either a TIF or PNG format file. For details, see
“Capture Frames” on page 7-53.

Recording Formats

You can save the virtual world offline animation data in the following formats:
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3D file — The Simulink 3D Animation software traces object movements and saves
that data into a virtual world 3D file using standard interpolators. You can then
view these files with the Simulink 3D Animation Viewer. 3-D files typically use much
less disk space than Audio Video Interleave (AV]) files. If you make any navigation
movements in the Simulink 3D Animation Viewer while recording the animation, the
Simulink 3D Animation software does not save any of these movements.

Note If you distribute virtual world 3D animation files, distribute all the inlined
object and texture files referenced in the original virtual world 3D file.

2-D Audio Video Interleave (AVI) file — The Simulink 3D Animation software

writes animation data into an .avi file. The Simulink 3D Animation software uses
vrfigure objects to record 2-D animation files. The recorded 2-D animation reflects
exactly what you see in the viewer window. It includes any navigation movements you
make during the recording.

Note While recording 2-D .avi animation data, always ensure that the Simulink
3D Animation Viewer is the topmost window and fully visible. Graphics acceleration
limitations can prevent the proper recording of 2-D animation otherwise.

See the following topics:

“Record 3—D Animation Files” on page 7-44 — Describes how to configure the
record simulation parameters to create 3-D format animation files.

“Record in Audio Video Interleave (AVI) Format” on page 7-44 — Describes how to
configure the record simulation parameters to create 2-D format animation files.

“Schedule Files for Recording” on page 7-47 — Describes how to schedule record
simulation operations to occur automatically.

File Names

By default, the Simulink 3D Animation Viewer records simulations or captures virtual
scene frames in a file named with the following format:

%T_anim_%n.%e

This format creates a unique file name each time you capture a frame or record the
animation. The file name uses the %F, %n, and %e tokens.
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The %F token is replaced with the name of the virtual world associated with the model.
The %n token is a number that increments each time that you record a simulation

for the same virtual world. For example, if the name of the virtual world file is
vrplanets.wrl and you record a simulation for the first time, the animation file is
vrplanets_anim_1._wrl. If you record the simulation a second time, the animation
file name is vrplanets_anim_2._wrl. In the case of frame captures, capturing another
frame of the scene increments the number.

The %e token represents the virtual world 3D file extension (.wrl, .x3d, or .x3dv) as
the extension of the virtual world that drives the animation. By default, the %e token
uses the file extension of the virtual world 3D file that drives the animation. The VR Sink
and VR Source block Source file parameter specifies the file extension of the virtual
world.

You can specify other file name tokens. For details, see “File Name Tokens” on page 4-15.

Start and Stop Animation Recording

You can start or stop recording animations of the virtual world from the Simulink 3D
Animation viewer through the menu bar, toolbar, or keyboard. This section assumes that
you have specified animation files for recording the animation.

*  From the menu bar, choose the Simulation menu, Run option to start recording the
animation (select Stop to stop the recording).

*  From the toolbar, click the Start/stop recording button to start or stop recording
the animation (select Stop to stop the recording). Alternatively, you can use the
Recording menu Start Recording and Stop Recording options. From the
keyboard, press Ctrl+R to toggle between starting or stopping the animation
recording.

* Stop the simulation or let the model simulate until the defined simulation stop time.

Note If you stop the simulation while recording is enabled, the viewer also stops
recording the animation.

Play Animation Files

You can view animation files using the 3D Animation Player or vrplay. For details, see
“Play Animation Files” on page 4-32.
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Record 3-D Animation Files

To create a 3-D animation files from a Simulink model execution, set recording
parameters. You can start the simulation before setting up the recording.

1

5

In the MATLAB Command Window, type the model name. For example:

vrplanets

The Simulink model is displayed. Also, by default, the Simulink 3D Animation
viewer for that model is loaded and becomes active. If the viewer is not displayed,
double-click the VR Sink block in the Simulink model.

From the Recording menu, choose Capture and Recording Parameters.

The Capture and Recording Parameters dialog box is displayed.

Find the Recording section of the dialog. This is located under the Frame Capture
dialog.

Select the Record to 3D file check box.

The File text field becomes active and the default file name, %f_anim_%n.wrl,
appears in the text field.

To save files to other file names, see “File Name Tokens” on page 4-15.
Click OK.

After you define an animation file, you can manually record simulations. See “Start and
Stop Animation Recording” on page 7-43. If you want to record simulations on a
schedule, see “Schedule Files for Recording” on page 7-47.

Record in Audio Video Interleave (AVI) Format

To create a 2-D AVI format file from a Simulink model execution, set recording
parameters. You can start the simulation before setting up the recording.

1

In the MATLAB Command Window, type the model name. For example:

vrplanets

The Simulink model is displayed. Also, by default, the Simulink 3D Animation
viewer for that model is loaded and becomes active. If the viewer is not displayed,
double-click the VR Sink block in the Simulink model.
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2 From the Recording menu, choose Capture and Recording Parameters.

The Capture and Recording Parameters dialog box is displayed.

3 Find the Recording section of the dialog box, located under the Frame Capture
dialog box.

4 Select the Record to AVI file check box.

The File text field and Compression selection area become active, and the default
file name, %f_anim_%n.avi, appears in the text field.

¥ Becodto &l File: |%F_anim_%n.avi

To save files to other file names, see “File Name Tokens” on page 4-15.

5 Set the FPS (Frames Per Second) to an appropriate value.

To use the sample time of the associated VR Sink block to make the file playback
correspond to the model simulation time, set FPS to auto.

For example, to record a Simulink simulation with 25 frames per second (of the
simulation time), in the VR Sink block set Sample time to be 0.04. In that
situation, to create an AVI file where one second of simulation time corresponds to
one second of AVI file playback time, set the FPS parameter to auto. Simulink 3D
Animation saves the value 25 into the AVI file FPS parameter.

Note: An FPS setting of 15 is used, even if you set FPS to auto:
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*  For a virtual world not associated with a Simulink model.

+ If the sample time of the associated VR Sink block cannot be determined at
simulation start time.

6 From the Compression list, select a compression method for the .avi file. Because

-avi files can become large, you can compress the .avi file.

FPS: |15 Compression: |Autoselect 'I Quality: |75 ::l'
f——=

None

4 nsele -
Record mode: IManuaI 'I Lossless Stop time IU

User Defined

_— I

| oK I Cancel | Help |

Choose from

+ Autoselect — Allows the Simulink 3D Animation software to select the most
appropriate compression codec. This option allows you to specify a quality setting
that is a number from 0 through 100. Higher-quality numbers result in higher
video quality and larger file sizes. Lower quality numbers result in lower video
quality and smaller file sizes.

Lossless — Forces the Simulink 3D Animation software to compress the
animation file without loss of data. (Typically, the compression of files sacrifices
some data.)

+ User Defined — Enables you to specify a particular compression codec. This
option allows you to specify a quality setting that is a number from 0 through
100. Higher-quality numbers result in higher video quality and larger file sizes.
Lower quality numbers result in lower video quality and smaller file sizes.
Specify an identification string of a codec that your system supports.

None — Prevents any compression for the animation file.

Disable the navigation panel. The navigation panel appears at the bottom of the
virtual scene view. You can turn off this panel for a cleaner view of the virtual scene.
Choose View > Navigation Panel > None.

You can reenable the Navigation Panel (for example, choose View > Navigation
Panel > Halfbar) after you are finished recording the .avi file.
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8 Click OK.

After you define an animation file, you can record animations. See “Start and Stop
Animation Recording” on page 7-43. If you want to record animations on a schedule,
see “Schedule Files for Recording” on page 7-47.

Schedule Files for Recording

This topic describes how to schedule the recording of an animation using the MATLAB
interface for a virtual world that is associated with a Simulink model. In this case, the
timing in an animation file derives from the simulation time. One second of the recorded
animation time corresponds to one second of Simulink time. To schedule the recording of
an animation file, you preset the simulation time interval during which the animation
recording occurs. This procedure uses the vrplanets example. It assumes that you have
already configured the recording parameters for an animation file.

1 Inthe MATLAB Command Window, type the model name. For example:

vrplanets

The Simulink model is displayed. Also, by default, the Simulink 3D Animation
viewer for that model is loaded and becomes active. If the viewer is not displayed,
double-click the VR Sink block in the Simulink model.

2 From the Recording menu, choose Capture and Recording Parameters.

The Capture and Recording Parameters dialog box is displayed. In the Recording
section, this dialog box contains the Record mode list. The Record mode list is
enabled only if you also select either or both of the Record to 3D and Record to
AVI check boxes.

3 From the Record mode list, choose Scheduled.

The Start time and Stop time text fields are enabled.

4 Enter in Start time and Stop time the start and stop times during which you want
to record the animation. For example, enter O as the start time and 100 as the stop
time.

Ensure that the recording start time value is not earlier than the start time of the
Simulink model; the recording operation cannot start in this instance. If the stop
time exceeds the stop time of the Simulink model, or if it is an out of bounds value
such as a negative number, the recording operation stops when the simulation stops.
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Note: You can also set the stop time before the start time to allow for a scenario
where the simulation starts first and you manually start recording. The recording
then automatically stops at stop time and automatically restarts at start time.

5 Click OK.

After you define the schedule, you can record simulations. See “Start and Stop Animation
Recording” on page 7-43.

Note You can override the recording schedule by starting or stopping the recording
interactively.

See Also

Functions
vrplay

Related Examples

. “Play Animations with Simulink 3D Animation Viewer” on page 7-49
. “Configure Frame Capture Parameters” on page 7-51

. “Capture Frames” on page 7-53

. “Define File Name Tokens” on page 4-13

More About

. “Animation Recording” on page 4-11

. “File Name Tokens” on page 4-15
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Play Animations with Simulink 3D Animation Viewer

To play animation files, you can use a web browser or you can use the Simulink 3D
Animation Viewer using one of these approaches:

At the MATLAB command line, use vrview. For example, enter:

w=vrview("vrplanets_anim_1._wrl*");
set(w, "TimeSource", "freerun®);

The vrview command displays the default Simulink 3D Animation Viewer for the
animation file. Setting the TimeSource property of the set method to "freerun*®
directs the viewer to advance its time independent of the MATLAB software.

To stop the animation, type:

set(w, "TimeSource”, "external ") ;

To close the viewer and delete the world, get the handle of the vrfigure object and close
it:

f=get(w, "Figures™)

close(T);
delete(w);

Or, to close all vrfigure objects and delete the world, type

vrclose
delete(w);

See Also

Functions
vrplay

Related Examples
. “Record Offline Animations” on page 7-41
. “Configure Frame Capture Parameters” on page 7-51

. “Capture Frames” on page 7-53
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. “Define File Name Tokens” on page 4-13

More About

. “Animation Recording” on page 4-11

. “File Name Tokens” on page 4-15
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Configure Frame Capture Parameters

This topic describes how to configure and capture a frame, using the vrplanets example
as the example.

1

7

In the MATLAB Command Window, type

vrplanets

at the MATLAB command prompt. The Planets example starts.

From the Recording menu, choose Capture and Recording Parameters.

The Capture and Recording Parameters dialog box is displayed.
Find the Frame Capture section at the top of the dialog box.

The file name %f_anim_%n.tif appears in the first text field, File.
Leave this file name as is.

In the File Format list, tiT or png specify the graphic file format for the captured
frame. The default is tif. For this procedure, leave this format setting at tif.

Capture and Recording Parameters x|

" Frame Capture

File: IZf_anim_‘Zn.tif File Farmat: Ilif VI Browse... |

You can disable the navigation panel. The navigation panel appears at the bottom
of the virtual scene view. You can turn off this panel for a cleaner view of the virtual
scene. Choose View > Navigation Panel > None.

You can reenable the Navigation Panel (for example, choose View > Navigation
Panel > Halfbar) after you finish recording the . tif file.

Click OK.

With this configuration, each subsequent capture of a scene in the same world
increments the file name number (%n) and saves it in a tif file.

Related Examples

“Record Offline Animations” on page 7-41

7-51



7 Viewing Virtual Worlds

. “Capture Frames” on page 7-53

. “Define File Name Tokens” on page 4-13
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Capture Frames

The Simulink 3D Animation product allows you to save a frame snapshot (capture) of
the current Simulink 3D Animation viewer scene. You can save this frame as either a
TIF or PNG format file. You can later view this scene offline (in other words, without the
Simulink 3D Animation viewer). You can treat this frame capture file like any other TIF
or PNG file, such as print it, include it in other files.

After you complete the steps in “Configure Frame Capture Parameters” on page 7-51, you
can capture frames of a virtual scene.

You can capture frames of the virtual world from the Simulink 3D Animation viewer
through the menu bar, toolbar, or keyboard. This section assumes that you have specified
frame capture file formats.

These actions save the captures in files in the current folder.

*  From the menu bar, choose Recording > Capture Frame to capture a frame.
*  From the toolbar, click the Capture a frame screenshot button to capture a frame.

*  From the keyboard, press Ctrl+I to capture a frame.

You can view the frame capture files using any tool that reads tiF or png files, including
the MATLAB imread function. For example,

image(imread("vrplanets_anim_1_tif"))

Related Examples
. “Record Offline Animations” on page 7-41
. “Configure Frame Capture Parameters” on page 7-51

. “Define File Name Tokens” on page 4-13
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Use the Simulink 3D Animation Web Viewer to access virtual worlds with an HTML5-
enabled web browser. You can open a virtual world in Simulink 3D Animation on a host
computer and then view it remotely in a web browser on another computer. You do not
need to install Simulink 3D Animation on the remote computer.

The Web Viewer supplements the Simulink 3D Animation Viewer. It also supplements
the Orbisnap viewer, which comes with Simulink 3D Animation. Some benefits of the
Web Viewer include:

*  Multiplatform remote viewing of Simulink 3D Animation virtual worlds
*  Support for HTML5-enabled browsers on Microsoft Windows, Macintosh, and
Linux platforms

* No additional software installation required on client computers

*  Access to HTML5 browser features for creating customized pages with virtual reality
visualization

Note: Because the Web Viewer accesses an HTML version of the virtual world, you
cannot use it to modify the virtual world (for example, to create viewpoints).

See Also

Functions
vrview

Related Examples

. “Open the Web Viewer” on page 7-56

. “Navigate Using the Web Viewer” on page 7-58

. “Listen to Sound in a Virtual World” on page 7-61

. “View a Virtual World in Stereoscopic Vision” on page 7-63

More About
. “Virtual World Viewers” on page 7-2
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“Active Stereoscopic Vision Configuration” on page 7-65
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In this section...

“Set up for Remote Viewing” on page 7-56
“Connect the Web Viewer” on page 7-56

Set up for Remote Viewing

To enable a person on a remote computer to use a web browser to view a virtual world
that is connected to a Simulink model:

1

2

In the Simulink 3D Animation Viewer, select Simulation > Block parameters >
Allow viewing from the Internet.

If the Simulink 3D Animation Viewer is the default viewer, you can open that viewer
from the Simulink Editor by double-clicking the VR Sink block.

Enable the Allow viewing from the Internet parameter.

Alternatively, to enable remote computers to view all opened virtual worlds with a web
browser, in the MATLAB Home tab, in the Environment section, use the Preferences
> Simulink 3D Animation > Allow viewing from the Internet preference.

Connect the Web Viewer

1
2

In Simulink 3D Animation, open the virtual world that you want to view.

On the computer from which you want to open the Web Viewer, open an HTML5-
enabled browser (supporting WebGL and WebSocket). The browser must have
Javascript enabled.

Note: For a list of HTML5-enabled browsers, see http://www.x3dom.org/?page_id=9.

Connect to the local host HTTP port. To open the Web Viewer on:

* The same computer on which Simulink 3D Animation runs, enter the following in
your web browser: http://localhost:8123/

* A remote computer that does not have Simulink 3D Animation, in the http://
localhost:8123 URL, replace localhost with the HTTP port of the host
computer.


http://www.x3dom.org/?page_id=9

Open the Web Viewer

Note: To change the HTTP port (for example, if a firewall blocks a port), set a
different port number and restart MATLAB. To change the HTTP port, in the
MATLAB Home tab, in the Environment section, use the Preferences >
Simulink 3D Animation > HTTP Port> preference.

4 Inthe Web Viewer, from the list of open virtual worlds, select the one that you want
to view.

See Also

Functions
vrview

Related Examples
. “Navigate Using the Web Viewer” on page 7-58
. “Listen to Sound in a Virtual World” on page 7-61

. “View a Virtual World in Stereoscopic Vision” on page 7-63

More About

. “Simulink 3D Animation Web Viewer” on page 7-54
. “Virtual World Viewers” on page 7-2

. “Active Stereoscopic Vision Configuration” on page 7-65
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In this section...

“Display and Navigation” on page 7-58
“Keyboard Shortcuts” on page 7-58

“Web Viewer Preferences” on page 7-59

Display and Navigation

Most of the navigation features for the Web Viewer are the same as for the Simulink 3D
Animation Viewer and the 3D World Editor Virtual world display pane. For details
about Simulink 3D Animation Viewer navigation, see “Navigate Using the Simulink 3D
Animation Viewer” on page 7-22.

Some differences between the two viewers include:

*+ The Web Viewer does not include a menu bar.

*  For virtual worlds with undefined background colors, the Web Viewer uses the
default canvas color of the browser; the Simulink 3D Animation Viewer uses a black
background.

The supported navigation features depend on what web browser you use. For example,

when R2013b was released, Firefox” was the only supported web browser that supports
context menu options that are specific to Simulink 3D Animation, such as viewpoints
options.

To determine whether the HTML5-enabled browser that you want to use supports
WebGL (Web Graphics Library), see http://www.x3dom.org/?page_id=9.

Keyboard Shortcuts

Navigation Function Keyboard Shortcut

Straighten up and make the camera stand on the |U
horizontal plane of its local coordinates.

Toggle the headlight on and off. H
Toggle the navigation zones on and off. Z
Go to default viewpoint. Esc



http://www.x3dom.org/?page_id=9

Navigate Using the Web Viewer

Navigation Function Keyboard Shortcut
Return to current viewpoint. R
Go to previous viewpoint. Page Up

Go to next viewpoint.

Page Down

Set the navigation method to Walk. W

Set the navigation method to Examine. E

Set the navigation method to Fly. F

Move the camera forward and backward. Shift Up/Down Arrow

Pan the camera up and down. Up/Down Arrow

Pan the camera right and left. Left/Right Arrow, Shift
+Left/Right Arrow

Tilt the camera right and left. Shift+Alt+Left/ Right Arrow

Slide up and down. Alt+Up/Down Arrow

Slide left and right. Alt+Left/Right Arrow

Set pivot point Double-click

Orbit around selected item (pivot point) Ctrl+Left/Right/Up/Down Arrow
Turn interactive mode on or off I

Set navigation mode to none N

Cycle through navigation speed presets G

Show or hide information panel D

Show or hide status bar S

Show or hide rendering information panel Spacebar

Cycle through navigation panel modes P

Web Viewer Preferences

The following Simulink 3D Animation preferences apply to the Web Viewer, and to the

3D World Editor.

+ Canvas > Navigation panel

+ Figure > Appearance > Status bar
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+ Figure > Appearance > Navigation zones

To access the preferences, from the MATLAB Toolstrip, in the Home tab, in the
Environment section, select Preferences > Simulink 3D Animation.

See Also

Functions
vrgetprefT | vrsetpref | vrview

Related Examples

. “Open the Web Viewer” on page 7-56

. “Set Simulink 3D Animation Preferences” on page 2-9
. “Listen to Sound in a Virtual World” on page 7-61

. “View a Virtual World in Stereoscopic Vision” on page 7-63

More About
. “Simulink 3D Animation Web Viewer” on page 7-54

. “Active Stereoscopic Vision Configuration” on page 7-65
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Listen to Sound in a Virtual World

In this section...

“System Requirements for Sound” on page 7-61

“Listen to Sound” on page 7-61

If a virtual world contains a Sound node and your computer supports sound, then you
can listen to the sound using these Simulink 3D Animation components:

*  Simulink 3D Animation Viewer

* 3D Animation Player

* Vr.canvas on a figure window

System Requirements for Sound

To listen to virtual world sound, use a computer setup that supports sound, including
having:

* A sound card

+  Speakers

*  Operating system support, such as ALSA (Advanced Linux Sound Architecture) on

Linux platforms

For an AudioClip node, use a mono or stereo WAV file in uncompressed PCM format.

Note: A stereo sound source retains its channel separation during playback. Simulink

3D Animation attenuates the sound based on the distance of the viewer from the sound
location. The relative position of the viewer to the sound location and the viewer direction
in the virtual world do not affect Tthe stereo channels. There is no impact even if the
Sound node has the spatialize field set to true.

Listen to Sound
Simulink 3D Animation enables sound by default.

To change the default behavior so that sound is disabled, set the Simulink 3D Animation
Figure > Rendering > Sound preference to off.
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In the Simulink 3D Animation Viewer or 3D Animation Player, to disable sound, right-
click in the virtual world and clear the Rendering > Sound option.

For a vr.canvas object, to disable sound, set the Sound property to "off".

To control volume, use your computer volume controls.

Related Examples
. “Add Sound to a Virtual World” on page 5-31

More About
. “Simulink 3D Animation Web Viewer” on page 7-54
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View a Virtual World in Stereoscopic Vision

In this section...

“Enable Stereoscopic Vision” on page 7-63

“Control Stereoscopic Effects” on page 7-64

You can view a virtual world using 3D effects, so that elements in the virtual world
appear to come forward or back from the plane of the monitor.

You can use stereoscopic vision with these Simulink 3D Animation components:

+ 3D World Editor

*  Simulink 3D Animation Viewer
* 3D Animation Player

* Vr.canvas on a figure window

* Orbisnap

Simulink 3D Animation supports two stereoscopic vision approaches:

* Anaglyph — Use red/cyan 3D glasses. Viewing a virtual world in this mode causes
the colors to appear as almost grayscale. This approach does not require any special
computer hardware or software.

+ Active stereo — Use active shutter 3D glasses. This approach preserves color
effects and produces more powerful 3D effects. Active stereo requires a specially
configured computer and monitor setup. For details, see “Active Stereoscopic Vision
Configuration” on page 7-65.

Enable Stereoscopic Vision

By default, virtual worlds display without stereoscopic vision effects.

1 Right-click in the virtual world.
2 From the Rendering > Stereo 3D menu, select either Anaglyph or Active.

Note: To enable stereoscopic vision by default, set the Simulink 3D Animation Figure >
Rendering > Stereo 3D preference to anaglyph or active.
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Control Stereoscopic Effects

You can control the following stereoscopic effects interactively or using preferences.

of view (cameras) that produce the
3D effect. The higher the offset,
the further apart the cameras are,

increases the
offset.

Stereo 3D Description Keyboard Figure > Rendering
Effect Shortcut Preference
Camera offset | Distance between the two points |Shift+K Stereo 3D Camera

Offset

The default value is

and thus the deeper the 3D effect. |Shift+dJ 0.1
decreases
the offset.
Horizontal The horizontal relationship of the |Shift+O Stereo 3D
image two stereo images. By default, the |increases Horizontal Image
translation background image is at zero and |the distance |Translation
(HIT) the foreground image appears to |back for the
pop out from the monitor toward |background |The default value is O.
the person viewing the virtual image.
world.
Shift+P
You can specify a value from 0 decreases
through 1, inclusive. The larger the distance
the value, the further back the back for the
background appears to be. background
image.

You can also control the camera offset and horizontal image translation
programmatically, using vr.canvas, vrfigure, and vr.utils.stereo3d. If you use
avr.utils.stereo3d object, you can also control the color filters for the left and right

cameras.

See Also

Functions

vr.utils.stereo3d

More About

. “Active Stereoscopic Vision Configuration” on page 7-65
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Active Stereoscopic Vision Configuration

In this section...

“Computer Platforms” on page 7-65

“Graphics Cards” on page 7-65

“Display Devices” on page 7-65

“Graphic Card Connection to Display Devices” on page 7-66

“Examples of Stereoscopic Vision Setups” on page 7-66

This section identifies system requirements for active stereoscopic vision configuration.
For detailed information to determine whether a system meets the Simulink 3D
Animation active stereoscopic vision requirements, consult the documentation for your
systems.

Computer Platforms

You can use stereoscopic vision on properly configured Windows and Linux platforms.
You cannot use active stereoscopic vision on Macintosh platforms.

Graphics Cards

Your computer must have a stereo 3D graphic card that supports OpenGL-based
stereoscopic vision, together with appropriate system driver, such as:

*  AMD" FirePro “W” series of cards (for example, W5000) that support HD3D Pro
technology

* NVIDIA® Quadro cards that support 3D Vision Pro technology

Display Devices

To display the stereoscopic video output of a graphic card, use one of these 3D display
devices.

*  3D-compliant monitor synchronized with active shutter glasses. Depending on the
display technology, enable synchronization using Infrared emitters, cables, or RF
hubs. Some monitors include an infrared (IR) emitter. Other monitors require a
separate IR emitter.
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+ 3D television set that displays 3D content. For stereoscopic vision, you typically use
active shutter glasses or passive polarized glasses.

+ Auto-stereoscopic display (monitor, display containing pair of video projectors, etc.).

Graphic Card Connection to Display Devices

Connect 3D graphic cards to 3D display devices using an interface such as DVI, HDMI, or
DisplayPort.

HDMI 1.4a and DisplayPort display interfaces natively expose the ability to transmit
stereo images using schemes described in their specifications. These interfaces allow
for plug-and-play capability. It is up to the display device to decode the image pairs and
present them according to the presentation technology they implement (active, passive,
auto-stereoscopic).

The DVI interface does not offer native stereoscopic image transfer. To transfer and
identify stereoscopic images correctly, synchronize the graphic card output with the
display device, using synchronization signals transmitted through an additional cable, an
IR emitter, or an RF hub.

Examples of Stereoscopic Vision Setups

Here are two possible configurations for using stereoscopic vision with Simulink 3D
Animation:

+  AMD FirePro “W” series of cards (for example, W5000) connected with an HDMI 1.4
cable to a 3D television set

*  NVIDIA Quadro cards (for example, Quadro K4000), a 3D vision-ready monitor
connected using dual DVI cable, and a 3D Vision Pro kit (an RF hub and active
shutter glasses)

Related Examples

. “View a Virtual World in Stereoscopic Vision” on page 7-63



Simulink 3D Animation Stand-Alone
Viewer

The Simulink 3D Animation stand-alone viewer, Orbisnap, allows you to visualize virtual
worlds or prerecorded animation files without running the MATLAB or Simulink 3D

Animation products.

*  “Orbisnap Viewer” on page 8-2

* “Install Orbisnap” on page 8-3

+  “Start Orbisnap” on page 8-5

*  “Orbisnap Interface” on page 8-7

+ “Navigate Using Orbisnap” on page 8-13

+ “View Animations or Virtual Worlds with Orbisnap” on page 8-16
+ “View Virtual Worlds Remotely with Orbisnap” on page 8-17
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Orbisnap Viewer

What Is Orbisnap?

The Simulink 3D Animation product includes Orbisnap. Orbisnap is a free, optional,
stand-alone virtual world viewer that does not require you to have either the MATLAB or
Simulink 3D Animation products running. You can use Orbisnap to:

* View prerecorded WRL animation files. For example, you can show prerecorded
animation files in a meeting at which you do not have access to the MATLAB or
Simulink 3D Animation products.

+  Remotely view, from a client machine, a virtual world loaded in a current session of
the Simulink 3D Animation product. For example, to visualize a virtual world active
in a Simulink 3D Animation session that is running on a computer in another room,
or across the network. This functionality allows you to view a simulation remotely,
but not control it.

* View and navigate, but not simulate, a virtual world. You can navigate, render, and
otherwise visualize a virtual world without simulating it.

*  View virtual worlds using stereoscopic vision.

Orbisnap is multiplatform. You can run Orbisnap on any of the platforms that the
Simulink 3D Animation product supports. You do not need a MathWorks license to run
Orbisnap.

Related Examples

. “Set the Default Viewer” on page 2-5

. “Install Orbisnap” on page 8-3

. “Start Orbisnap” on page 8-5

. “Navigate Using Orbisnap” on page 8-13

. “View Animations or Virtual Worlds with Orbisnap” on page 8-16
. “View Virtual Worlds Remotely with Orbisnap” on page 8-17

More About

. “Orbisnap Interface” on page 8-7

. “Virtual World Viewers” on page 7-2

8-2



Install Orbisnap

Install Orbisnap

In this section...

“Section Overview” on page 8-3
“System Requirements” on page 8-3

“Copying Orbisnap to Another Location” on page 8-3

“Adding Shortcuts or Symbolic Links” on page 8-4

Section Overview

The collection of Orbisnap files includes the Orbisnap starter file, Orbisnap executable
file, and supporting files. These files are located under the Simulink 3D Animation
orbisnap folder (for example, matlabroot\toolbox\sl3d\orbisnap\bin for the
Windows platform). No further installation is necessary. You can copy the Orbisnap files
to another location or create shortcuts or symbolic links to the Orbisnap starter file for
convenience.

System Requirements

Orbisnap has the same hardware and software requirements as MATLAB. It is a
multiplatform product that can run on PC-compatible computers with Windows or Linux.
See the following page on the MathWorks website:

http://www.mathworks.com/products/matlab/requirements.html

Copying Orbisnap to Another Location

Orbisnap runs independently of the MATLAB and Simulink 3D Animation products.
This independence means that you can copy Orbisnap to another location or even another
machine. The following is a general procedure on how to copy Orbisnap to another
location:

1 From a command line or a graphical interface such as Windows Explorer, create a
folder into which you can copy Orbisnap.

2 Copy all the files in the Orbisnap folder and its subfolders. These files are
likely located in the Simulink 3D Animationorbisnap folder, for example,
matlabroot\toolbox\sl3d\orbisnap for the Windows platform.
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3 Paste the files into the folder you created in step 1.

Adding Shortcuts or Symbolic Links

For convenience, you can create a shortcut (Windows) or symbolic link (UNIX) to the
Orbisnap starter file.

In Windows Explorer, right-click orbisnap.bat and select Properties. You can
start Orbisnap from either the shortcut or the original starter file.

In UNIX, use the In -s command to create a symbolic link to orbisnap.

Related Examples

“Start Orbisnap” on page 8-5

“Navigate Using Orbisnap” on page 8-13

“View Animations or Virtual Worlds with Orbisnap” on page 8-16
“View Virtual Worlds Remotely with Orbisnap” on page 8-17

More About

“Orbisnap Viewer” on page 8-2

“Orbisnap Interface” on page 8-7



Start Orbisnap

Start Orbisnap

You can start Orbisnap from any command line with the following:

orbisnap

orbisnap -f vr_filename

orbisnap -c hostname -w "vrworld" -t http -v vrport -g=end_time
orbisnap -t http -v vrport vr_filename_or_hostname -g=end_time
orbisnap -h

No arguments -- Starts the default Orbisnap. There is no loaded vrworld file and no
connection to a Simulink 3D Animation server.

-f vr_filename — (Optional) Orbisnap starts and loads the vrworld contained in
vr_Filename. If you do not provide vr_filename, Orbisnap prompts you for the file
name.

-c hostname — (Optional) Orbisnap starts and connects to the Simulink 3D Animation
server at hostname. hostname can be a hostname or IP address. If you do not provide
hostname, Orbisnap prompts you for the hostname.

-w vrworld — (Optional) Orbisnap starts, connects to the Simulink 3D Animation
server, and loads the virtual world associated with the title "vrworld". If "vrworld"
is not currently active in the Simulink 3D Animation server, the connection to the server
does not succeed and the default Orbisnap starts.

-t http — (Optional) Orbisnap starts and connects to the Simulink 3D Animation
server at this HTTP port (default 8123).

-t vrport — (Optional) Orbisnap starts and connects to the Simulink 3D Animation
server listening at this port (default 8124).

vr_filename_or_hostname — (Optional) Orbisnap starts and interprets this string
first as a vrwor Id file name (for example, vrbounce.wrl). If the string is not a valid
vrwor ld file name, Orbisnap tries to interpret the string as the name of the host that is
running the Simulink 3D Animation server.

-g=end_time — (Optional) Orbisnap ends when virtual scene time equals end_time.

-h — (Optional) Orbisnap displays the Orbisnap command-line help.

Related Examples
. “Install Orbisnap” on page 8-3
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. “Start Orbisnap” on page 8-5
. “Navigate Using Orbisnap” on page 8-13

More About

. “Orbisnap Viewer” on page 8-2

. “Orbisnap Interface” on page 8-7
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Orbisnap Interface

In this section...

“Menu Bar” on page 8-9
“Toolbar” on page 8-10

“Navigation Panel” on page 8-10

Here is Orbisnap with a virtual world displayed.

«® Orbisnap = || = @
File View Viewpoints Mavigation Rendering Help

| T |lExamine ] J M | & D g

Mo viewpoint Examine Pos:[0.00 0.00 10.00] Dir:[0.00 0.00 -1.00]
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Orbisnap provides much of the functionality of the Simulink 3D Animation Viewer.
Using the menu bar, toolbar, and navigation panel, you can:

8-8



Orbisnap Inferface

*  Customize the Orbisnap window

* Manage virtual world viewpoints

* Manage scene rendering

You cannot

*  Open an editor for the virtual world

*  Open another window for the virtual world

+ Simulate the world (start/stop the model)

*  Record or manage animation files

Menu Bar

The Orbisnap menu bar has the following menus:

* File — General file operation options, including,

Open — Invokes a browser that you can use to browse to the virtual world you
want to visualize.

Connect to server -- Allows you to connect to a Simulink 3D Animation server.
Enter the IP address or hostname of the host computer running the Simulink
3D Animation server (127 .0.0.1 by default) and the port number at which the
Simulink 3D Animation server is listening (8124 by default).

Reload — Reloads the saved virtual world. If you have created any viewpoints in
this session, they are not retained unless you have saved those viewpoints with the
Save As option.

Save As — Allows you to save the virtual world.

Close — Closes the Orbisnap window.

* View — Enables you to customize Orbisnap, including,

Toolbar — Toggles the toolbar display.

Status Bar — Toggles the status bar display at the bottom of Orbisnap. This
display includes the current viewpoint, simulation time, navigation method, and
the camera position and direction.

Navigation Zones — Toggles the navigation zones on/off (see “Navigate Using
Orbisnap” on page 8-13 for a description of how to use navigation zones).
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+ Navigation Panel — Controls the display of the navigation panel, including
toggling it.

Triad — Shows red, green, and blue arrows that are parallel to the orientation of
global x, y,and z coordinate axes.

* Zoom In/Out — Zooms in or out of the world view.

* Normal (100%) — Returns the zoom to normal (initial viewpoint setting).
Fullscreen Mode — Displays the viewer in full-screen mode.

Viewpoints — Manages the virtual world viewpoints.

Navigation — Manages scene navigation.

Rendering — Manages scene rendering.

Help — Displays the Help browser for Orbisnap.

Toolbar

The Orbisnap toolbar has buttons for some of the more commonly used operations
available from the menu bar. These buttons include:

Drop-down list that displays all the viewpoints in the virtual world

Return to viewpoint button d

Create viewpoint button -

=y

Drop-down list that displays the navigation options Walk, Examine, and Fly

Straighten up button

Undo move button =

g
Zoom in/out buttons < , Q

Navigation Panel

The Orbisnap navigation panel has navigation controls for some of the more commonly
used navigation operations available from the menu bar.

The navigation panel controls include from left to right:



Orbisnap Inferface

Hide panel — Toggles the navigation panel.
Full-screen mode— Uses the whole screen for Orbisnap.

Next/previous viewpoint — Left and right arrows toggles through the list of
viewpoints.

Return to default viewpoint — Returns focus to original default viewpoint.

Slide left/right — Buttons to the left and right of the navigation wheel slide the view
left or right.

Navigation wheel — Moves view in one of eight directions.

Navigation method — Manages scene navigation (walk, examine, or fly).
Wireframe toggle — Toggles scene wireframe rendering.

Headlight toggle — Toggles camera headlight.

Help — Invokes the Orbisnap online help.

8-11
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Related Examples

. “Install Orbisnap” on page 8-3
. “Start Orbisnap” on page 8-5
. “Navigate Using Orbisnap” on page 8-13

“View Animations or Virtual Worlds with Orbisnap” on page 8-16

More About

. “Orbisnap Viewer” on page 8-2
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Navigate Using Orbisnap

You can navigate around a virtual world using the menu bar, toolbar, navigation panel,
mouse, and keyboard.

Navigation view — You can change the camera position. From the menu bar, select the
Navigation menu Straighten Up option. This option resets the camera so that it points
straight ahead.

Navigation methods — Navigation with the mouse depends on the navigation method
you select and the navigation zone you are in when you first click and hold down the
mouse button. You can set the navigation method using one of the following:

*  From the menu bar, select the Navigation menu Method option. This option
provides three choices, Walk, Examine, or Fly. See the table Orbisnap Mouse
Navigation.

*  From the toolbar, select the drop-down menu that displays the navigation options
Walk, Examine, and Fly.

*  From the navigation panel, click the W, E, or F buttons.

*  From the keyboard, press Shift+W, Shift+E, or Shift+F.

Navigation zones — You can view the navigation zones for a virtual world through the
menu bar or keyboard.

From the menu bar, select the View menu Navigation Zones option. The virtual
world changes as the navigation zones are toggled on and appear in the virtual world.
Alternatively, from the keyboard, press the F7 key.

The following table summarizes the behavior associated with the movement modes and
navigation zones when you use your mouse to navigate through a virtual world. Turn
on the navigation zones and experiment by clicking and dragging your mouse in the
different zones of a virtual world.

Orbisnap Mouse Navigation

Movement Mode Zone and Description

Walk Outer -- Click and drag the mouse up, down, left, or right to slide
the camera in any of these directions in a single plane.

Inner -- Click and drag the mouse up and down to move forward
and backward. Drag the mouse left and right to turn left or right.
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Movement Mode Zone and Description

Examine Outer -- Click and drag the mouse up and down to move forward
and backward. Drag the mouse left and right to slide left or right.
Inner -- Click and drag the mouse to rotate the viewpoint around
the origin of the scene.

Fly Outer -- Click and drag the mouse to tilt the view either left or

right.

Inner -- Click and drag the mouse to pan the camera up, down,
left, or right within the scene.

Center -- Click and drag the mouse up and down to move forward
and backward. Move the mouse left or right to turn in either of
these directions.

If your virtual world contains sensors, these sensors take precedence over mouse
navigation at the sensor location. In this case, mouse navigation is still possible through
the right or middle mouse buttons.

Keyboard — You can also use the keyboard to navigate through a virtual world. It can
be faster and easier to issue a keyboard command, especially if you want to move the
camera repeatedly in a single direction. The following table summarizes the keyboard
commands and their associated navigation functions. You do not have to capitalize the
letters to perform their intended function.

Orbisnap Keyboard Navigation

Keyboard Command Navigation Function

Backspace Undo move.

F9 Straighten up and make the camera stand on the horizontal
plane of its local coordinates.

+/- Zoom in/out.

Fé6 Toggle the headlight on/off.

F7 Toggle the navigation zones on/off.

F5 Toggle the wireframe option on/off.

F8 Toggle the antialiasing option on/off.




Navigate Using Orbisnap

Keyboard Command Navigation Function
Esc Go to default viewpoint.
Home Return to current viewpoint.

Page Up, Page Down

Move between preset viewpoints.

F10

Toggle camera binding from the viewpoint.

Shift+W Set the navigation method to Walk.

Shift+E Set the navigation method to Examine.

Shift+F Set the navigation method to Fly.

Shift Up/Down Arrow |Move the camera forward and backward.

Up/Down Arrow Pan the camera up and down.

Left/Right Arrow, Shift |Pan the camera right and left.

+Left/Right Arrow

Alt+Up/Down Arrow Slide up and down.

Alt+Left/Right Arrow  [Slide left and right.

Ctrl+Left/Right/Up/ Pressing Ctrl alone acquires the examine lock at the point

Down Arrow

of intersection between the line perpendicular to the screen,
coming through the center of the Orbisnap window, and the
closest visible surface to the camera. Pressing the arrow
keys without releasing Ctrl rotates the viewpoint about the
acquired center point.

Shift+Alt+Left/Right
Arrow

Tilt the camera right and left.

Related Examples

. “Install Orbisnap” on page 8-3

. “Start Orbisnap” on page 8-5

. “View Animations or Virtual Worlds with Orbisnap” on page 8-16

. “View Virtual Worlds Remotely with Orbisnap” on page 8-17

More About

. “Orbisnap Viewer” on page 8-2

. “Orbisnap Interface” on page 8-7
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View Animations or Virtual Worlds with Orbisnap

8-16

This topic assumes that you have a prerecorded WRL animation file or an existing
virtual world file. This procedure uses a file named vr_bounce_anim.wrl.

1  Start Orbisnap. For example, in Windows double-click orbisnap.bat in
matlabroot\toolbox\sl3d\orbisnap\bin.

This file is an Orbisnap starter file that calls the Orbisnap executable. Orbisnap is
displayed.
2 In Orbisnap, select File > Open.

A file browser is displayed.

3 Browse to the folder that contains the prerecorded WRL animation file or virtual
world you want to view.

4  Select the virtual world or prerecorded WRL file you want to view.
5 Click Open.

The file is displayed. If the file is an animation file, the simulation begins.
6 To close Orbisnap, select File > Close.
Using the menus, toolbar, and navigation panel, you can perform many of the same
operations on the virtual world that you can with the Simulink 3D Animation Viewer.

See “Orbisnap Interface” on page 8-7 for an overview of the Orbisnap interface. See
“Start Orbisnap” on page 8-5 for a description of the Orbisnap command-line options.

Related Examples

. “Install Orbisnap” on page 8-3

. “Start Orbisnap” on page 8-5

. “View Virtual Worlds Remotely with Orbisnap” on page 8-17

More About

. “Orbisnap Viewer” on page 8-2

. “Orbisnap Interface” on page 8-7
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View Virtual Worlds Remotely with Orbisnap

To view virtual worlds from the Simulink 3D Animation server in Orbisnap, you must
have

The MATLAB software running a Simulink 3D Animation server session

The version of the Simulink 3D Animation server to which you want to connect must
be compatible with the Orbisnap version you are running. For example, you cannot
connect Orbisnap to Simulink 3D Animation software Version 3.1.

Network access between the client computer (running Orbisnap) and host computer
(running MATLAB and Simulink 3D Animation server)

Note If you expect Orbisnap to access a virtual world on the Simulink 3D Animation
server from a remote computer, make that virtual world available for internet
viewing. In the Simulink 3D Animation Viewer for the virtual world you want to
make available, select Simulation > Block Parameters, select the Allow viewing
from the Internet check box, then click OK.

Note the following when using Orbisnap remotely:

Although you can visualize a virtual world from the Simulink 3D Animation server
in Orbisnap, any navigation or rendering in one viewer is not reflected in the other.
For example, any navigation you do on the virtual world in Orbisnap is not reflected
in the virtual world in the Simulink 3D Animation Viewer.

You cannot start or stop a simulation of the virtual world in Orbisnap. You can see
a simulation on Orbisnap only if the virtual world is simulated in the Simulink 3D
Animation server.

The simulation can be slow when you connect Orbisnap remotely to the Simulink 3D
Animation server.

Start Orbisnap. For example, in Windows, double-click orbisnap.bat in
matlabroot\toolbox\sl3d\orbisnap\bin.

This file is an Orbisnap starter file that calls the Orbisnap executable. Orbisnap is
displayed.

In Orbisnap, select File > Connect to Server.

The Connect to Server dialog box is displayed.
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3 Enter the IP address or hostname of the host computer running the Simulink 3D
Animation server (127.0.0.1 by default). The HTTP port number is 8123 by default
and the port number at which the Simulink 3D Animation server is listening is 8124
by default.

Connect To Server x|

Host name:

Uzing HTTF port 8123 andYE part 8124

ok | Cancel |

The Choose a world dialog box is displayed. This dialog box lists all the virtual
worlds that are currently active on the Simulink 3D Animation server.

Choose a world x|

Chooze a world to connect to

Flanets

|

ak. | Cancel |

If no virtual world has ever been opened in this session of the Simulink 3D
Animation server, Orbisnap displays a message. If you see this message, contact
your counterpart running the Simulink 3D Animation server to better synchronize
your activities. A virtual world must be fully active on the Simulink 3D Animation
server for Orbisnap to access it remotely.

Error connecting to host x|

Errar connecting ko host "127.0.0.1" Mo response Frarm remate host,
Possible reasons are:
- the remote host does nok exisk
- there's no R server running on the remoke hosk
{mo virkual worlds have been open vet)
- the remote host is kemporarily busy
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4  Select a virtual world.

5 Click OK.
Orbisnap displays the selected virtual world of the remote Simulink 3D Animation
server.

6 Navigate and render the virtual world as you want.

7 To close Orbisnap, select File > Close.

Using the menus, toolbar, and navigation panel, you can perform many of the same

operations on the virtual world that you can with the Simulink 3D Animation Viewer.

See “Orbisnap Interface” on page 8-7. See “Start Orbisnap” on page 8-5 for a description
of the Orbisnap command-line options.

Related Examples

. “Install Orbisnap” on page 8-3

. “Start Orbisnap” on page 8-5

. “View Animations or Virtual Worlds with Orbisnap” on page 8-16

More About

. “Orbisnap Viewer” on page 8-2

. “Orbisnap Interface” on page 8-7
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Cross Product

Cross product of two 3-D vectors

b

Cross Product

Library

Simulink 3D Animation

Description

Takes two 3-by-1 vectors as input and returns their cross product.

See Also

* Normalize Vector

* Rotation Between 2 Vectors

* Rotation Matrix to VRML Rotation

* Viewpoint Direction to VRML Orientation
+ “Virtual World Connection to a Model” on page 3-2

Introduced in R2006a



Joystick Input

Joystick Input

Process input from asynchronous joystick device

W fwesp

attans [

Joystick Input

Library

Simulink 3D Animation

Description

The Joystick Input block provides interaction between a Simulink model and the virtual
world associated with a Simulink 3D Animation block.

The Joystick Input block uses axes, buttons, and the point-of-view selector, if present.
You can use this block as you would use any other Simulink source block. Its output ports
reflect the status of the joystick controls for axes and buttons.

The Joystick Input block also supports force-feedback devices.

When building a model using Simulink Desktop Real-Time, use the Simulink Desktop
Real-Time Joystick Input driver instead of the Joystick Input block.

Parameters

Joystick ID — The system ID assigned to the given joystick device. You can find the
properties of the joystick that is connected to the system in the Game Controllers section
of the system Control Panel.

Adjust I/O ports according to joystick capabilities — If you select this check box,
the Simulink 3D Animation software dynamically adjusts the ports to correspond to
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the capabilities of the connected joystick each time that you open the model. If the
connected device does not have force-feedback capability, selecting this check box causes
the removal of the force-feedback input from the block, even if you select the Enable
force-feedback input check box. The block ports do not have the full widths provided
by the Windows Game Controllers interface.

Enable force-feedback input — If you select this check box, the Simulink 3D
Animation software can support force-feedback joystick, steering wheel, and haptic (one
that enables tactile feedback) devices.

Output Ports — Depending on the Adjust I/O ports according to joystick
capabilities check box setting, the output ports change to correspond to the actual
capabilities of the connected joystick. Or, on Windows platforms, the output ports have
fixed maximum width provided by the system Game Controllers interface.

Output Port Value Description
Axes Vector of doubles in the range < |Outputs correspond to the
-1;1> current position of the joystick

in the given axis. Values are
normalized to range from -1 to 1.

Buttons Vector of doubles Outputs correspond to the
0 — Button released current status of joystick buttons.
1 — Button pressed

Point of view -1 — Selector inactive Output corresponds to the
<0; 360> — The angle of the current status of the joystick
POV selector, in degrees point-of-view selector.

Input Port Value Description

Force Vector of doubles Port active only for force-feedback
in the range devices. Inputs correspond to the
<-1;1> force to be applied in the given

axis.

Usually, not all of the device axes
have force-feedback. The size of
the Force vector is then smaller
than the Axes vector size.
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See Also

Space Mouse Input

“Virtual World Connection to a Model” on page 3-2
vrjoystick

vrspacemouse

Introduced before R2006a
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Normalize Vector

Unit vector parallel to input vector

Marmalize [

Marmalize Wectar

Library

Simulink 3D Animation

Description

Takes an input vector of any size and outputs the unit vector parallel to it.

Parameters

Maximum modulus to treat vector as zero — The output is set to zeroes if the
modulus of the input is equal to or lower than this value.

See Also

* Cross Product

* Rotation Between 2 Vectors

* Rotation Matrix to VRML Rotation

* Viewpoint Direction to VRML Orientation
* “Virtual World Connection to a Model” on page 3-2

Introduced in R2006a
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Rotation Between 2 Vectors

Rotation Between 2 Vectors

Virtual world rotation between two 3-D vectors

A
3
WR

Fatation Betuween
2 Wectars

Library

Simulink 3D Animation

Description

Takes input of two 3-by-1 vectors and returns a virtual world rotation (specified as a
four-element vector defining axis and angle) that is needed to transform the first input
vector to the second input vector.

See Also

*+ Cross Product

* Normalize Vector

* Rotation Matrix to VRML Rotation

* Viewpoint Direction to VRML Orientation
+ “Virtual World Connection to a Model” on page 3-2

Introduced in R2006a
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Rotation Matrix to VRML Rotation

Convert rotation matrix into representation used in virtual world

mﬁ’?"ﬁ
WR

Fiotation hdatrix
to WEML Rotation

Library

Simulink 3D Animation

Description

Takes an input of a rotation matrix and outputs the axis/angle rotation representation
used for defining rotations in a virtual world. The rotation matrix can be either a 9-
element column vector or a 3-by-3 matrix defined columnwise.

Note: This block works with VRML and X3D virtual worlds.

Parameters

Maximum value to treat input value as zero — The input is considered to be zero if
it is equal to or lower than this value.

Rotation Matrix

A representation of a three-dimensional spherical rotation as a 3-by-3 real, orthogonal
matrix R: R'R = RR" = I, where I is the 3-by-3 identity and R is the transpose of R.

Ry Rip Riz) [Buw By Be
R=|\Ry; Ryy Ry3 |=|R,, R,, R,
R31 R3y Rg3 R. R, R

2X 4% 2z
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In general, R requires three independent angles to specify the rotation fully. There are
many ways to represent the three independent angles. Here are two:

You can form three independent rotation matrices R;, Ro, Rs3, each representing a
single independent rotation. Then compose the full rotation matrix R with respect to
fixed coordinate axes as a product of these three: R = R3*R,*R;. The three angles are

Euler angles.

You can represent R in terms of an axis-angle rotation n = (ny,ny,n,) and 0 with n*n
= 1. The three independent angles are 6 and the two needed to orient n. Form the

antisymmetric matrix:

0 -n, ny
J = n, 0 -n,
-n n 0

y X

Then Rodrigues' formula simplifies R:

R =exp(0J) =1+ Jsin0+J%(1-cos0)

See Also

Cross Product
Normalize Vector
Rotation Between 2 Vectors

Viewpoint Direction to VRML Orientation
“Virtual World Connection to a Model” on page 3-2

Introduced in R2006a
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Space Mouse Input

Process input from space mouse device

T

Trapslatieni
e
ation b

" Buttonzp

i

Space hMouse Input

Library

Simulink 3D Animation

Description

A space mouse is a device similar to a joystick in purpose, but it also provides movement
control with six degrees of freedom. This block reads the status of the space mouse and
provides some commonly used transformations of the input. The Space Mouse Input
block supports current models of 3—D navigation devices manufactured by 3Dconnexion
(http://www.3dconnexion.com). Contact MathWorks Technical Support (http://
www . mathworks.com/support) for further information on the support of older
3Dconnexion devices.

Data Type Support

The Space Mouse Input block outputs signals of type double.

Parameters

Port — Serial port to which the space mouse is connected. Possible values are
USB1...USB4 and COM1...COM4.

Output Type — This field specifies how the inputs from the device are transformed:

+ Speed — No transformations are done. Outputs are translation and rotation speeds.


http://www.3dconnexion.com
http://www.mathworks.com/support
http://www.mathworks.com/support

Space Mouse Input

* Position — Translations and rotations are integrated. Outputs are position and
orientation in the form of roll/pitch/yaw angles.

* Viewpoint coordinates — Translations and rotations are integrated. Outputs are
position and orientation in the form of an axis and an angle. You can use these values
as viewpoint coordinates in a virtual world.

Dominant mode — If this check box is selected, the mouse accepts only the prevailing
movement and rotation and ignores the others. This mode is very useful for beginners
using space mouse input.

Disable rotation movement — Fixes the positions at the initial values, allowing you to
change rotations only.

Disable position movement — Fixes the rotations at initial values, allowing you to
change positions only.

Normalize output angle — Determines whether the integrated rotation angles should
wrap on a full circle (360°) or not. This is not used when you set the Output Type to
Speed.

Limit position — Determines whether you can limit the upper and lower positions of
the mouse.

Position sensitivity — Mouse sensitivity for translations. Higher values correspond to
higher sensitivity.

Rotation sensitivity — Mouse sensitivity for rotations. Higher values correspond to
higher sensitivity.

Initial position — Initial condition for integrated translations. This is not used when
you set the Output Type to Speed.

Initial rotation — Initial condition for integrated rotations. This is not used when you
set the Output Type to Speed.

Lower position limit — Position coordinates for the lower limit of the mouse.

Upper position limit — Position coordinates for the upper limit of the mouse.

See Also

* Space Mouse Input
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9-12

*  Manipulator with SpaceMouse

+ “Virtual World Connection to a Model” on page 3-2
* vrjoystick

* vrspacemouse

Introduced in R2007b



Viewpoint Direction to VRML Orientation

Viewpoint Direction to VRML Orientation

Convert viewpoint direction to virtual world orientation

W T

“Wiewpaint Direction
to WRML Orientation

Library

Simulink 3D Animation

Description

Takes a viewpoint direction (3-by-1 vector) as input and outputs the corresponding
virtual world viewpoint orientation (four-element rotation vector).

Note: This block works with VRML and X3D virtual worlds.

See Also

*+ Cross Product

* Normalize Vector

* Rotation Between 2 Vectors

* Rotation Matrix to VRML Rotation

+ “Virtual World Connection to a Model” on page 3-2

*  Manipulator with SpaceMouse

Introduced in R2006a
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VR Placeholder

Send unspecified value to Simulink 3D Animation block

WR = F

WR Placehalder

Library

Simulink 3D Animation

Description

The VR Placeholder block sends out a special value that is interpreted as “unspecified”
by the VR Sink block. When this value appears on the VR Sink input, whether as a
single value or as an element of a vector, the appropriate value in the virtual world stays
unchanged. Use this block to change only one value from a larger vector. For example,
use this block to change just one coordinate from a 3-D position.

The value output by the VR Placeholder block should not be modified before being used
in other VR blocks.

Data Type Support

A VR Placeholder block outputs signals of type double.

Parameters

Output Width — Length of the vector containing placeholder signal values.

See Also

VR Signal Expander



VR Placeholder

Introduced before R2006a

9-15



9 Blocks — Alphabetical List

9-16

VR Signal Expander

Expand input vectors into fully qualified virtual world field vectors

e
e

WE Signal Expander

Library

Simulink 3D Animation

Description

The VR Signal Expander block creates a vector of predefined length, using some values
from the input ports and filling the rest with placeholder signal values.

Data Type Support

A VR Signal Expander block accepts and outputs signals of type double.

Parameters

Output width — How long the output vector should be.

Output signal indices — Vector indicating the position at which the input signals
appear at the output. The remaining positions are filled with VR Placeholder signals.

For example, suppose you want an input vector with two signals and an output vector
with four signals, with the first input signal in position 2 and the second input signal in
position 4. In the Output width box, enter 4 and in the Output signal indices box,
enter [2,4]. The first and third output signals are unspecified.



VR Signal Expander

See Also

VR Placeholder

Introduced before R2006a
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VR Sink

Write data from Simulink model to virtual world

R Sink

Library

Simulink 3D Animation

Description

The VR Sink block writes values from its ports to virtual world fields specified in the
Block Parameters dialog box.

For an example of how to use the VR Sink block, see the Foucault Pendulum Model with
Virtual Reality Scene example.

The VR Sink block is equivalent to the VR To Video block, except that the Show video
output port parameter for the VR Sink block is cleared by default.

The VR Sink block cannot be compiled by the Simulink Coder software, but it can be used
as a SimViewing device on the host computer.

Note: The current internal viewer window (vrfigure) properties are saved together
with the Simulink model. The next time you open the model, the internal viewer window
opens with the same parameters that were last saved, such as position, size, and
navigation mode. When closing the viewer window, the Simulink software does not alert
you if these properties have changed.

The VR Sink block is a Sim Viewing Device. You can include it in models that you
compile with Simulink Coder software. If you use External mode to compile, build,



VR Sink

and deploy the model on a target platform, such as Simulink Real-Time™ or Simulink
Desktop Real-Time, some sink blocks and Sim Viewing Device blocks stay in Normal
mode during simulation, receive data from the target, and display that data. For more
information, see “Sim Viewing Devices in External Mode” (Simulink).

Data Type Support

A VR Sink block accepts all meaningful data types on input. The block converts these
data types to natural virtual world types, as necessary. These data types include logicals,
many types of signed and unsigned integers, singles, and doubles. The MATLAB and
Simulink interfaces also accept matrices. For further details, see “Virtual World Data
Types” on page 5-25.

Parameters

Source file — File name specifying the virtual world that connects to this block. By
default, the full path to the associated virtual world 3D file appears in this text box. If
you enter only the file name in this box, the software assumes that the virtual world 3D
file resides in the same folder as the model file. You can specify a VRML file or an X3D
file.

* Click the New to open an empty default virtual world editor. When you either enter a
source file name or use the Browse button, the New button becomes an Edit button.

* Click the Edit button to launch the default virtual world editor with the source file
open.

* Click the View button to view the world in the Simulink 3D Animation Viewer or a
Web browser.

* Click the Reload button reloads the world after you change it.

Open Viewer automatically — If you select this check box, the default virtual world
viewer displays the virtual world after loading the Simulink model.

Allow viewing from the Internet — If you select this check box, the virtual world
1s accessible for viewing on a client computer. If you do not select this check box, then
the world is visible only on the host computer. This parameter is equivalent to the
RemoteView property of a vrwor Id object.
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Description — Description that is displayed in all virtual reality object listings, in the
title bar of the Simulink 3D Animation Viewer, and in the list of virtual worlds on the
Simulink 3D Animation HTML page. This parameter is equivalent to the Description
property of a vrwor Id object.

Sample time — Enter the sample time or -1 for inherited sample time.

To achieve a smooth simulation, MathWorks recommends that you explicitly set the
Sample time parameter. You can change the value of this parameter to achieve the
specific visual experience that you want.

Show video output port — Enables a port to output an RGB video stream for further
2D video processing.

Video output signal dimensions — Dimensions ([vertical horizontal]) of the video
output signal in pixels (default is [200 320]).

Setup and preview video output — Opens a figure window for navigation and
viewing.

Virtual Scene Tree — This box shows the structure of the virtual world 3D file and the
virtual world itself.

Nodes that have names are marked with red arrows. You can access them from the
Simulink 3D Animation interface. Nodes without names, but whose children are named,
are also marked with red arrows. This marking scheme makes it possible for you to find
all accessible nodes by traversing the tree using arrows. Other nodes have a blue dot
before their names.

Fields with values that you set have check boxes. Use these check boxes to select the
fields whose values you want the Simulink software to update. For every field that you
select, an input port is created in the block. Input ports are assigned to the selected nodes
and fields in the order that corresponds to the virtual world 3D file.

Fields whose values cannot be written (because their parent nodes do not have names, or
because they are not of virtual world data class eventln or exposedField) have an X-
shaped icon.

Show node types — If you select this check box, node types are shown in the virtual
scene tree.

Show field types — If you select this check box, field types are shown in the virtual
scene tree.
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See Also

VR To Video

VR Source

“Virtual World Data Types” on page 5-25

Foucault Pendulum Model with Virtual Reality Scene

“Sim Viewing Devices in External Mode” (Simulink)

Introduced before R2006a
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VR Source

Read data from virtual world to Simulink model

VR Source

Library

Simulink 3D Animation

Description

The VR Source provides access to virtual world fields, as chosen in the Block Parameters
dialog box as input signals during simulation.

The VR Source block supports several activities. For example, use the VR Source block
to:

*  Provide interactivity between a user navigating the virtual world and the Simulink
model. The VR Source block can register user interaction with the virtual world. The
block can pass to the model those values which then can affect the simulation of the
model.

* Read into the model events from the virtual world, such as time ticks or outputs from
scripts.

* Read into the model static information about the virtual world (for example, the size
of a box defined in the virtual world 3D file).

+ Access values of 3D object nodes that are not driven by simulation, but whose
monitoring is essential.

For an example of how to use the VR Source block, see the Set the Setpoint
subsystem in the vrcrane_panel example.
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Note: The current internal viewer window (vrfigure) properties are saved together
with the Simulink model. The next time that you open the model, the internal viewer
window opens with the same parameters that were saved, such as position, size, and
navigation mode. When closing the viewer window, the Simulink software does not alert
you if these properties have changed.

You cannot use the Simulink Coder software to compile a model that includes a VR
Source block.

Data Type Support

A VR Source block outputs signals of type double.

Parameters

Source file — Virtual world 3D file name specifying the virtual world that connects to
this block. By default, the full path to the associated virtual world 3D file appears in this
text box. If you enter only the file name in this box, the software assumes that the virtual
world 3D file resides in the same folder as the model file. You can specify a VRML file or
an X3D file.

* Click the New to open an empty default virtual world editor. When you either enter a
source file name or use the Browse button, the New button becomes an Edit button.

* Click the Edit button to launch the default virtual world editor with the source file
open.

* Click the View button to view the world in the Simulink 3D Animation Viewer or a
Web browser.

* Click the Reload button reloads the world after you change it.

Open Viewer automatically — If you select this check box, the default virtual world
viewer displays the virtual world after loading the Simulink model.

Allow viewing from the Internet — If you select this check box, the virtual world is
accessible for viewing on a client computer. If you do not select this check box, the world
is visible only on the host computer. This parameter is equivalent to the RemoteView
property of a vrwor Id object.
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Description — Description that is displayed in all virtual reality object listings, in the
title bar of the Simulink 3D Animation Viewer, and in the list of virtual worlds on the
Simulink 3D Animation HTML page. This parameter is equivalent to the Description
property of a vrwor Id object.

Sample time — Enter the sample time or -1 for inherited sample time.

Note To achieve a smooth simulation, MathWorks recommends that you explicitly set
the Sample time parameter. You can change the value of this parameter to achieve the
specific visual experience you want.

Allow variable-size output signals — Specify the type of signals allowed out of this
port.

By default, the VR Source block does not allow variable-size signals. If you enable this
parameter, then the VR Source block allows variable-size signals for fields that can
change dimensions during simulation. These fields include MFxxx fields that can have a
variable number of elements (typically, MFFloat or MFVec3f). The SFImage is the only
SFxxx field that can map to a variable-size signal. For details about these data types, see
“Field Data Types” on page 5-25.

Note: The signal dimensions of a variable-size output signal of a VR Source block must
be the same size as, or smaller than, the initial state of the signal.

Virtual World Tree — This box shows the structure of the virtual world 3D file and the
virtual world itself.

Nodes that have names are marked with red arrows. You can access them from the
MATLAB interface. Nodes without names, but whose children are named, are also
marked with red arrows. This marking scheme makes it possible for you to find all
accessible nodes by traversing the tree using arrows. Other nodes have a blue dot before
their names.

Fields with readable values have check boxes. Use these check boxes to select the fields
that you want the Simulink software to monitor and to use to input values. For each field
that you select in the Virtual World Tree box, Simulink creates an output port in the
VR Source block. Simulink creates the output ports in the same order as the selected
fields appear in the virtual world 3D file.
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Fields whose values cannot be read (because their parent nodes do not have names, or
because their values cannot be imported to Simulink) have an X-shaped icon.

Show node types — If you select this check box, node types are shown in the virtual
scene tree.

Show field types — If you select this check box, field types are shown in the virtual
scene tree.

See Also

* VR Sink
* VR To Video
+ “Virtual World Data Types” on page 5-25

* vrcrane_panel

Introduced in R2011b
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VR Text Output

Allows display of Simulink signal values as text in virtual reality scene

—= TXT
R

WH Text Output

Library

Simulink 3D Animation

Description

The VR Text Output can display Simulink values of signal as text in a virtual reality
scene.

Text rendering is a demanding task for virtual world viewers, so there is generally

be a decrease in rendering speed when outputting text. This effect increases with the
complexity of the text output. You can improve the performance if you limit the output
from the Simulink model to only the values of signals that change (e.g., modeling
captions) or use more static-text nodes.

Parameters

Associated VRML file — Virtual world 3D file specifying the virtual world to which
text is output.

Associated Text node — Text node within the virtual world to which text is output.

Format string — Format used for output text. This block uses sprintf() to format
the output strings. Like sprintf(), it works in a vectorized fashion, where the format
string is recycled through the components of the input vector. This block does not support
the %c and %s conversion formats, as signals in the Simulink product cannot have both
characters and strings.

Sample time — Enter the sample time or -1 for inherited sample time.
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Ensure that a viewer window is open during simulation — Select this check box to
ensure that the Simulink 3D Animation Viewer is open during simulation.

See Also

* VR Sink

* VR Source

* VR To Video
* VR Tracer

Introduced in R2006b
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VR To Video

Write data from Simulink model to virtual world (video output port enabled)

WR To Wideao

Library

Simulink 3D Animation

Description

This block is equivalent to the VR Sink block, except that its Show video output port
1s selected by default.

See the VR Sink block for details.

See Also

VR Sink

VR To Video

“Virtual World Data Types” on page 5-25
Manipulator with SpaceMouse

“Sim Viewing Devices in External Mode” (Simulink)

Introduced in R2007b
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VR Tracer
Trace trajectory of object in associated virtual scene

Fosition __er_,er/'f

Calar WR
WE Tracer

Library

Simulink 3D Animation

Description
Trace the trajectory of an object in the associated virtual scene.

This block creates marker nodes in regular time steps either as children of the specified
parent node (Parent node parameter), or at the top level of scene hierarchy (root).

You can specify one of three types of markers:

*  General shape
+ Line segments connecting object positions in every time step

+ Axis-aligned triads for orienting the trajectory in the 3—-D space
Also, you can project traced object positions to a plane or to a point.

Object position input must correspond to the placement of the object in the scene
hierarchy. If the traced object resides as a child of a parent object, define the parent
object DEF name in the parent node field. If the traced object resides at the top of the
scene hierarchy (its position is defined in global scene coordinates), leave this field
empty.

The first block input vector determines the position of the marker. The second block

input (if enabled by the Marker color selection parameter) represents the marker
color. The second or third block input vector (depending on whether the marker color
input vector is enabled) specifies the project point coordinates.
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Parameters

Associated VRML file — Virtual world 3D file name specifying the associated virtual
world.

Parent node (leave empty for root) — Specify the location of the traced object in the
scene hierarchy.

Marker shape — From the list, select one shape:

* None

+ Tetrahedron
* Pyramid

* Box

* Octahedron
* Sphere

Connect markers with line segments — Select this check box to connect the traced
object path with lines.

Place a triad at each marker position — Select this check box to place a triad at each
marker position. A triad helps you orient the object trajectory in the x-y-z plane.

Marker scale — Specify a three-component vector that defines the scaling of predefined
marker shapes and triads. This parameter allows accommodation for scenes of various
sizes.

Marker color selection — From the list, select:

* Block input — Disables Marker color parameter and relies on the second block
input to define the marker color. Selecting this option enables the second block input,
to which you can connect a signal for the marker color.

+ Selected in block mask from color list— Enables the Marker color
parameter, for selecting one color from of a list of colors for the marker.

+ Defined in block mask as RGB values — Enables Marker color parameter to
accept RGB values for the marker color.

Marker color — If Marker color selection is Selected in block mask from
color list, select the color from the list: yel low, magenta, cyan, red, green, blue,
white, black
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If Marker color selection is Defined in block mask as RGB values, enter RGB
values for the marker color.

Sample time — Enter the sample time or -1 for inherited sample time.

Ensure that a viewer window is open during simulation — Select this check box to
ensure that the Simulink 3D Animation Viewer is open during simulation.

Project positions on a plane — Specify whether to display line segments from an
object to a plane to approximate the trajectory of the object. If you enable this parameter,
use the Projection plane equation coefficients edit box to specify the plane to which
to project the position of the object. The coefficients are in the form ax+by+cz+d=0.

For example, if you use the default plane equation coefficients to [0 1 O O] for the
vrtkoff trace model, then after you simulate the model, the object positions project to the
y=0 plane.

&% VR Plane Take-Off ol ® ==
File View Viewpeoints Mavigation Rendering Simulation Recording Help N
:Airport V:Fly 'QJP|,$,9|Q+Q_|.||3|}.

Airport J Fly Pos:[69.52 15.52 -20.44] Dir:[-0.73 0.09 0.68]

Project positions to a point— Displays line segments from an object to a point to
approximate the trajectory of the object.

* None — (Default) No projection to a point.
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+ Defined in block mask — If you select this option, enter coordinates in the
Projection point coordinates edit box.

+ Defined in the block input — If you select this option, specify the coordinates
of the point in the output of a block that inputs to the VR Tracer block.

See Also

* VR Sink

* VR Source

* VR To Video

* VR Text Output

Introduced in R2008b
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sti2vrml

Convert STL file to virtual world file

Syntax

stl2vrml (source)
stl2vrml (source,destination)
stl2vrml (source,destination, format)

Description

stl2vrml (source) converts an ASCII or STL file that you specify with source to a
VRML97-compliant, UTF-8 encoded text file.

The converted VRML file has the same name as the source STL file, except that the
extension is .wrl instead of .stl. The st12vrml function places the VRML file in the
current folder.

Tip: You can also use the vrimport function to import STL files. However, to import
Physical Modeling XML files, use the vrimport function instead of vrimport.

stl2vrml (source,destination) creates the converted VRML file in the
destination folder.

stl2vrml (source,destination, format) creates the converted virtual world file in
the specified format.

Examples

Convert STL File to VRML File
This example uses an STL file in the Simscape Multibody product.

Convert the STL file fourbar-Barl-1.STL (in matlab/toolbox/physmod/mech/
mechdemos) to a VRML file and place the resulting file in the current folder.
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stl2vrml (" fourbar-Barl-1_STL")
Is

. fourbar-Barl-1.wrl
% Other files and folders in the current folder appear.

Convert STL File to X3D File
This example uses an STL file in the Simscape Multibody product.

Convert the STL file fourbar-Barl-1._STL (in matlab/toolbox/physmod/mech/
mechdemos) to an XML-encoded virtual world file and place the resulting file in a folder
called virtualworlds.

stl2vrml (" fourbar-Barl1-1_STL", "virtualworlds®, "x3d")
Is

- fourbar-Barl-1.x3d
% Other files and folders in the current folder appear, as well.

. “Import STL and Physical Modeling XML Files” on page 5-34
. “Link to Simulink and Simscape Multibody Models” on page 5-62

Input Arguments

source — STL source file path
string

STL source file path, specified as a string. The STL file can be either ASCII or binary.

If the source file is a Physical Modeling XML file, st12vrml converts all STL files
referenced in the XML file. It also creates a main assembly VRML file that contains
Inline references to all converted individual VRML files. Inlines are wrapped by
Transform nodes with DEF names corresponding to the part names defined in their
respective STL source files.

destination — Path to folder for converted file
string

Path to the destination folder for converted file, specified as a string. If the destination
folder does not exist, the stl2vrml function attempts to create it.
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format — File format for converted virtual world file
"wrl® (VRML) (default) | "x3d" (XML-encoded X3D file) | "x3dv" (Classic VRML-
encoded X3D file)

File format for converted virtual world file, specified as a string.

Tips

+ Use the created assembly virtual world files as templates for creating virtual scenes.
Edit the scenes. For example, add lights, viewpoints, or surrounding objects, modify
part materials, define navigation speeds, and so on.

+ The stl2vrml function places assembly parts in the global coordinate system. If the
source is a physical modeling XML file, the resulting virtual world assembly file
reflects the initial positions of parts defined in the XML file.

* To use the tree structure of the related SolidWorks source file in the assembly virtual
world file, avoid spaces in assembly and component names. To process the assembly
VRML files (but not X3D files), you can use the vrphysmod function to obtain a
Simulink model with VRML visualization.

See Also

See Also

vrcadcleanup | vrimport | vrphysmod

Topics
“Import STL and Physical Modeling XML Files” on page 5-34
“Link to Simulink and Simscape Multibody Models” on page 5-62

Introduced in R2010b
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vrcadcleanup

Clean up virtual world 3D file exported from CAD tools

Syntax

vrcadcleanup("filename™)
vrcadcleanup("“filename®, “hint")

Description

vrcadcleanup("filename™) copies the specified file to a backup file with the

extension bak. It then modifies the virtual world 3D file exported from Pro/ENGINEER"
or SolidWorks. This cleanup enables the Simulink 3D Animation software to use these
files.

vrcadcleanup performs the following modifications to VRML files:

*  Removal of everything except inlines, viewpoints, and transforms

*  Provision of names for inline transforms

Note: You can use vrcadcleanup with VRML files (.wr 1), but not with X3D files (.x3d
or .x3dv).

vrcadcleanup("“filename®, "hint") takes in account the value of "hint" during
conversion. Possible value of "hint" includes:

Argument Description

"solidworks* Assumes that the software is exporting the original set of
virtual world 3D files from SolidWorks. This option adds or
increments the numerical suffix to the node names to match
the part names that exist in the corresponding physical
modeling XML file.

This function expects the input file structure to correspond to the typical output of the
specified CAD tools. The typical input file should contain:
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* A structure of viewpoints and inline nodes (possibly contained in one layer of
transform nodes)

* One inline node for each part of the exported assembly

The function also performs the following:

+  Upon output, discards any additional nodes, including transform nodes, that do not
contain inline nodes.

* Processes hierarchically organized assemblies, where inline files instead of
part geometries contain additional groups of nested node inline nodes. In such
subassembly files, copies all inline references to the main virtual world 3D file. The
function wraps these inline references with a Transform node, using a name that
corresponds to the subassembly name.

Note: If you call this function for a file that is not a product of a CAD export filter, the
output file might be corrupted.

Examples

To clean up the VRML file four_link._wrl:

vrcadcleanup("four_link.wrl®);

See Also

stl2vrml | vrphysmod | “Import STL and Physical Modeling XML Files” on page 5-34
| “Link to Simulink and Simscape Multibody Models” on page 5-62

Introduced in R2009a
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vr.canvas class

Create virtual reality canvas

Description

Create a virtual reality canvas.

Construction

virtualCanvas = vr.canvas(world) creates a virtual reality canvas showing the
specified virtual world.

virtualCanvas = vrfigure(world,parent) creates a virtual reality canvas in

the specified parent figure or panel. A panel arranges user interface components into
groups. By visually grouping related controls, panels can make the user interface easier
to understand. A panel can have a title and various borders.

virtualCanvas = vr.canvas(world,parent,position) creates a virtual reality
canvas in a figure or panel at the specified position.

virtualCanvas = vr.canvas(world,PropertyName,Value, ... ,PropertyName,

Value) sets the values of the vr.canvas properties specified by one or more
PropertyName,Value pair arguments.

Input Arguments

world — Virtual world
vrwor ld object

Virtual world, specified as a virwor 1d object.

Note: Open the virtual world before you create a vr .canvas object using that virtual
world.
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parent — Figure for displaying canvas
figure object | uipanel object

Figure for displaying the canvas, specified as a MATLAB figure or uipanel object

position — Canvas location and size
vector with four elements

Location and size of virtual canvas, specified as the vector, in the form [left bottom
width height]. Specify measurements in pixels.

Note: On Windows systems, figure windows cannot be less than 104 pixels wide,
regardless of the value of the position argument.

Element Description

left Distance from the left edge of the primary display to the
inner left edge of the canvas. This value can be negative on
systems that have more than one monitor.

bottom Distance from the bottom edge of the primary display to
the inner bottom edge of the canvas. This value can be
negative on systems that have more than one monitor.

width Distance between the right and left inner edges of the
canvas.

height Distance between the top and bottom inner edges of the
canvas.

Example: [230 250 570 510]
Data Types: double

PropertyName-Value Pair Arguments

Specify optional comma-separated pairs of PropertyName,Value
arguments. PropertyName is the argument name and Value is the
corresponding value. PropertyName must appear inside single quotes ("
"). You can specify several name and value pair arguments in any order as
PropertyNamel,Valuel, ... ,PropertyNameN,ValueN.
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Example: set(myFigure, "Antialising®, "on", "CameraPosition”,[0 100 100])

"Antialiasing” — Smooth textures using antialiasing
"off" (default) | "on*

Smooth textures using antialising, specified as "on" or "off". Antialiasing smooths
textures by interpolating values between texture points.

"CameraBound” — Camera movement with current viewpoint
"on" (default) | "off"

Camera movement with the current viewpoint, specified as "on" or "off".

"CameraDirection™ — Camera direction in the current viewpoint local coordinates
vector of three doubles

Camera direction in the current viewpoint local coordinates, specified as a vector of
three doubles. The doubles represent the x, y, and z vectors in current viewpoint local
coordinates.

"CameraPosition” — Camera position in the current viewpoint local coordinates
vector of three doubles

Camera position in the current viewpoint local coordinates, specified as a vector of three
doubles. The doubles represent the x, y, and z vectors in the current viewpoint local

coordinates.

"CameraUpVector®™ — Camera up vector
vector of three doubles

Camera up vector, specified as a vector of three doubles. The doubles represent the x, y,
and z vectors in the current viewpoint local coordinates.

"DeleteFcn” — Callback invoked when closing vr . canvas object
string

Callback invoked when closing the vr.canvas object, specified as a string.
"ExaminePivotPoint" — Pivot point about which camera rotates in examine navigation

mode
vector of three doubles
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Pivot point about which camera rotates in examine navigation mode, specified as a
vector of three doubles in world coordinates.

"Headlight" — Headlight from camera
"on" (default) | "off"

Headlight from camera, specified as "on" or "ofFf". If you specify "off", the camera
does not emit light and the scene can appear dark.

"Lighting" — Lighting effect
"on" (default) | "off"

Lighting effect, specified as "on" or "off". If you specify "off", the camera does not
emit light and the scene can appear dark.

"MaxTextureSize" — Maximum pixel size of textures
"auto” (default) | integer in a power of 2

Maximum pixel size of textures, specified as "auto” or integer in a power of 2. The value
of "auto” sets the maximum texture pixel size. Otherwise, specify an integer in a power
of two that is equal to or less than the video card limit (typically 1024 or 2048).

The smaller the size, the faster the texture renders. Increasing the size improves image
quality but decreases performance.

Note: Specifying a value that is unsuitable causes a warning. The Simulink 3D
Animation software then adjusts the property to the next smaller suitable value.

Data Types: int32

"NavMode" — Navigation mode
"Ffly" (default) | "examine® | "walk® | "none”

Navigation mode, specified as "fly", "examine”, "walk", or "none”. See “Mouse
Navigation” on page 7-27.

"NavPanel " — Navigation panel appearance

"none” (default) | "halfbar® | "bar® | "opaque translucent”

Navigation panel appearance, specified as "none”, "halfbar®, "bar”, "opaque”, or
“translucent”.
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"Navspeed™ — Navigation speed
"normal® (default) | "slow” | "veryslow® | "fast” | "veryfast"”

Navigation speed, specified as "normal ®, "slow”, "veryslow", "fast", or
"veryfast”.

"NavZones" — Display navigation zones
"off" (default) | "on*

Navigation zones display, specified as "on" or "off".

"Position” — Canvas location and size
vector with four doubles

Location and size of virtual canvas, specified as the vector in the form [left bottom
width height]. Specify measurements in pixels or normalized, based on the Units
property setting.

Element Description

left Distance from the left edge of the primary display to the
inner left edge of the canvas. You can specify a negative
value on systems that have more than one monitor.

bottom Distance from the bottom edge of the primary display
to the inner bottom edge of the canvas. You can specify
a negative value on systems that have more than one

monitor.

width Distance between the right and left inner edges of the
canvas.

height Distance between the top and bottom inner edges of the
canvas.

Example: [230 250 570 510]

*Sound™ — Sound effects
"on" (default) | "off"

Sound effects, specified as "on" or "off".
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"Stereo3D" — Stereoscopic vision mode
"off" (default) | "anaglyph® | "active” | vr.utils.stereo3d object

Stereoscopic vision mode, specified as "off", "anaglyph®, "active” or a
vr.utils.stereo3d object.

Specifying a vr .utils.stereo3d object sets the Stereo3D, Stereo3DCameraOffset,
and Stereo3DHIT properties. Specifying a vr.utils.stereo3d object also sets color
filters for the left and right cameras.

Data Types: int32

"Stereo3DCameraOffset” — Distance of left and right camera for stereoscopic vision
non-negative floating-point double-precision number

Distance of left and right camera from parallax for stereoscopic vision, specified as a non-
negative floating-point double-precision number.

Specifying a vr .utils.stereo3d object for the Stereo3D property also sets the
Stereo3DCameraOffset and Stereo3DHIT properties and sets color filters for the left
and right cameras.

"Stereo3DHIT" — Horizontal image translation (HIT) of two stereoscopic images
double from O to 1

Horizontal image translation (HIT) of two stereoscopic images, specified as a double from
0 through 1, inclusive. The larger the value, the further back the background appears .

Specifying a vr.utils.stereo3d object for the Stereo3D property also sets the
Stereo3DCameraOffset and Stereo3DHIT properties and sets color filters for the left

and right cameras.

"Textures" — Texture use
"on® (default) | "off"

Texture use, specified as "on" or "off".

"Tooltips™ — Tooltips display
"on" (default) | "ofF"

Tooltips display, specified as "on* or "ofFf".
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"Transparency” — Transparency effect
"on" (default) | "off"

Transparency effect, specified as "on” or "ofFf".
"Triad" — Triad location
"bottomleft” (default) | "bottomright”™ | "center | "topleft” | "topright” |

"none*®

Triad location, specified "bottomleft”®, "bottomright”, "center, "topleft”,
"topright”, or "none”.

"Units" — Units for Position property
"pixels® (default) | "normalized*

Units for Position property, specified as "pixels” or "normalized”.

"Viewpoint" — Active viewpoint of figure
string

Active viewpoint of a figure, specified as a string. If the active viewpoint has no
description, use an empty string.

"Wireframe" — Wireframe display
"off" (default) | "on*

Wireframe display, specified as "on" or "off".

*ZoomFactor®™ — Camera zoom factor
1 (default) | floating-point number

Camera zoom factor, specified as a floating-point number. A zoom factor of 2 makes the
scene look twice as large. A zoom factor of 0.1 makes it look 10 times smaller, and so
forth.

Output Arguments

virtualCanvas — Virtual reality canvas
Vr .canvas object

Virtual reality canvas, represented by a vr.canvas object
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Properties

Antialiasing — Smooth textures using antialiasing
"off" (default) | "on*

Smooth textures using antialising, returned as "on" or "off". Antialiasing smooths
textures by interpolating values between texture points.

CameraBound — Camera movement with current viewpoint
"on” (default) | "ofF"

Camera movement with the current viewpoint, returned as "on" or "off".

CameraDirection — Camera direction in the current viewpoint local coordinates
vector of three doubles

Camera direction in the current viewpoint local coordinates, specified as a vector of
three doubles. The doubles represent the x, y, and z vectors in current viewpoint local
coordinates.

CameraDirectionAbs — Camera direction in world coordinates
vector of three doubles

Camera direction in world coordinates, returned as a vector of three doubles (read-only
property).

CameraPosition — Current camera position in the current viewpoint local coordinates
vector of three doubles

Camera position in the current viewpoint local coordinates, returned as a vector of three
doubles. The doubles represent the x, y, and z vectors in the current viewpoint local
coordinates.

CameraPositionAbs — Camera position in world coordinates
vector of three doubles

Camera direction in world coordinates, represented by a vector of three doubles (read-
only property).

CameraUpVector — Camera up vector
vector of three doubles
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Camera up vector, returned as a vector of three doubles. The doubles represent the x, y,
and z vectors in the current viewpoint local coordinates.

CameraUpVectorAbs — Camera up vector in world coordinates
vector of three doubles

Camera up vector in world coordinates, represented by a vector of three doubles (read-
only property).

DeleteFcn — Callback invoked when closing vr.canvas object
string

Callback invoked when closing the vr.canvas object, returned as a string.

ExaminePivotPoint — Pivot point about which camera rotates in examine navigation
mode
vector of three doubles

Pivot point about which camera rotates in examine navigation mode, returned as a
vector of three doubles in world coordinates.

Headlight — Headlight from camera
“on” (default) | “off*"

Headlight from camera, returned as "on" or "off". If set to "ofF", the camera does not
emit light and the scene can appear dark.

Lighting — Lighting effect
"on” (default) | "ofF"

Lighting effect, returned as "on" or "off". If set to "ofFf", the camera does not emit
light and the scene can appear dark.

MaxTextureSize — Maximum pixel size of textures
"auto” (default) | integer in a power of 2

Maximum pixel size of a texture used. The smaller the size, the faster the texture can
render. A value of "auto” means the texture is set to the maximum pixel size.
Data Types: int32

NavMode — Navigation mode
"fly" (default) | "examine” | "walk

"none*®
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Navigation mode, returned as "fly", "examine”, "walk", or "none"”. See “Mouse
Navigation” on page 7-27.

NavPanel — Navigation panel appearance
"none” (default) | "halfbar® | "bar® | "opaque

" | "translucent*
Navigation panel appearance, returned as "none”, "halfbar"®, "bar”, "opaque”, or
"translucent”.

Navspeed — Navigation speed

"normal * (default) | "slow® | "veryslow® | "fast” | "veryfast”

Navigation speed, returned as "normal *, "slow”, "veryslow", "fast”, or
"veryfast”.

NavZones — Display navigation zones
"off" (default) | "on*

Navigation zones display, returned as "on” or "off".

Parent — Handle of parent of virtual reality canvas object
double

Handle of parent of virtual reality canvas object, represented by a double (read-only
property).

Position — Canvas location and size
vector with four doubles

Location and size of virtual canvas, returned as the vector in the form [left bottom
width height]. Specify measurements in pixels or normalized, based on the Units
property setting.

Note: On Windows systems, figure windows cannot be less than 104 pixels wide,
regardless of the value of the Position property.

Element Description

left Distance from the left edge of the primary display to the
inner left edge of the canvas. You can specify a negative
value on systems that have more than one monitor.
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Element Description

bottom Distance from the bottom edge of the primary display
to the inner bottom edge of the canvas. You can specify
a negative value on systems that have more than one

monitor.

width Distance between the right and left inner edges of the
canvas.

height Distance between the top and bottom inner edges of the
canvas.

Example: [230 250 570 510]

Sound — Sound effects
"on” (default) | "ofF"

Sound effects, returned as "on" or "off".

Stereo3D — Stereoscopic vision mode
"off" (default) | "anaglyph® | "active” | vr.utils.stereo3d object

Stereoscopic vision mode, returned as "off", "anaglyph”, "active” or a
vr.utils.stereo3d object.

Specifying a vr.utils.stereo3d object sets the Stereo3D, Stereo3DCameraOffset,
and Stereo3DHIT properties. Specifying a vr .utils.stereo3d object also sets color
filters for the left and right cameras.

Stereo3DCameraOffset — Distance of left and right camera for stereoscopic vision
non-negative floating-point double-precision number

Distance of left and right camera from parallax for stereoscopic vision, specified as a non-
negative floating-point double-precision number.

Specifying a vr .utils.stereo3d object for the Stereo3D property also sets the
Stereo3DCameraOffset and Stereo3DHIT properties and sets color filters for the left
and right cameras.

Stereo3DHIT — Horizontal image translation (HIT) of two stereoscopic images
double from O to 1
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Horizontal image translation (HIT) of two stereoscopic images, returned as a double from
0 through 1, inclusive. The larger the value, the further back the background appears.
By default, the background image is at zero and the foreground image appears to pop out
from the monitor toward the person viewing the virtual world.

Specifying a vr.utils.stereo3d object for the Stereo3D property also sets the
Stereo3DCameraOffset and Stereo3DHIT properties and sets color filters for the left
and right cameras.

Textures — Texture use
"on" (default) | "off"

Texture use, returned as "on" or "off".

Tooltips — Tooltips display
"on" (default) | "off"

Tooltips display, returned as "on® or "off".

Transparency — Transparency effect
"on" (default) | "ofF"

Transparency effect, returned as "on" or "off".

Triad — Triad location
"bottomleft” (default) | "bottomright®™ | "center | "topleft” | "topright” |
"none*

Triad location, returned as "bottomleft”, "bottomright”, "center, "topleft”,
"topright”®, or "none”.

Units — Units for Position property
"pixels® (default) | "normalized*”

Units for Position property, returned as "pixels”® or "normalized”.

Viewpoint — Active viewpoint of figure
string

Active viewpoint of a figure, returned as a string.

Wireframe — Wireframe display
"off" (default) | "on*
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Wireframe display, returned as "on* or "off".

World — World containing canvas
vrworld object

World containing canvas, represented by a vrwor Id object (read-only property).

ZoomFactor — Camera zoom factor
1 (default) | floating-point number

Camera zoom factor, returned as a floating-point number. A zoom factor of 2 makes the

scene look twice as large. A zoom factor of 0.1 makes it look 10 times smaller, and so
forth.

Methods

capture Capture virtual reality canvas image

Examples

Create a Canvas That Displays in a Figure

Create and open a vrwor ld object.

myWorld = vrworld("vrlights.wrl®);
open(myWorld);

Create a figure to use as the parent of the canvas. Create a canvas. Use a figure as the
parent and specify the position.

fig = figure;

myCanvas = vr.canvas(myWorld, "Parent”,fig, "Units”, ...
“normalized”,"Position®,[0 0 1 1]);
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Create a Virtual World in a Canvas

Create a figure. Create a canvas in the figure and specify a title.

pf = Figure;
ppl = uipanel("Parent”,pf, "Title", "Panel with Title");
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Panel with Title

Create and open a virtual world.

w = vrworld("vrlights.wri®);
open(w);

Create a canvas in the virtual world.

c = vr.canvas(w,ppl);
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Panel with Title

Set Property Values of Canvas
Set the camera direction, navigation mode, and stereoscopic vision properties of a canvas.

Create and open a vrwor Id object.

vrmountWorld = vrworld("vrmount.wrl®);
open(vrmountWorld);
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Create a vr.utils.stereo3d object to use to specify stereoscopic vision properties.

myStereo3D = vr.utils.stereo3d.ANAGLYPH_RED_CYAN;

Create a canvas. Define non-default values for some properties.

myCanvas = vr.canvas(vrmountWorld, "Antialiasing”,"on", ...
"NavPanel ", "opaque*”, "NavZones", "on", "Stereo3D", ...
myStereo3D, "Stereo3DCameraOffset”,0.25, ...
"Stereo3DHIT",0.02)

myCanvas
canvas with properties:

Antialiasing: "on*
CameraBound: "on*
CameraDirection: [0 O -1]
CameraPosition: [0 O O]
CameraUpVector: [0 1 0]

ExaminePivotPoint: [0 O O]
Headlight: “on”
Lighting: "on*
MaxTextureSize: "auto”
NavPanel: "opaque®
NavMode: “examine”
NavSpeed: "normal*®
NavZones: "on*
Position: [0 O 1 1]
Sound: "on
Stereo3D: "anaglyph®
Stereo3DCameraOffset: 0.2500
Stereo3DHIT: 0.0200
Textures: "on*
Tooltips: “on”
Transparency: "on*

Triad: "none*

Units: "normalized*
Viewpoint: "View 1 - Observer®
Wireframe: "off*

ZoomFactor: 1
DeleteFcn: []

CameraDirectionAbs:
CameraPositionAbs:

[0 -0.1987 -0.9801]
[20.2500 8 50]
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CameraUpVectorAbs: [0 0.9801 -0.1987]
Parent: [1x1 Figure]
World: [1x1 vrworld]

Slrgue SIEIE=]

File Edit View Inset Tools Desktop Window Help o
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. “Create vrworld Object for a Virtual World” on page 4-2
. “MATLAB Interaction”
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. “View a Virtual World in Stereoscopic Vision” on page 7-63

See Also

See Also

vr.utils.stereo3d | vrfigure | vrworld | figure

Topics

“Create vrworld Object for a Virtual World” on page 4-2
“MATLAB Interaction”

“View a Virtual World in Stereoscopic Vision” on page 7-63

Introduced before R2006a
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capture

Class: vr.canvas

Capture virtual reality canvas image

Syntax

image_capture = capture(canvas)

Description

image_capture = capture(canvas) captures a virtual reality canvas into a
TrueColor RGB image. You can display this image using the image command.

Input Arguments

canvas — Virtual reality canvas
Vr .canvas object

Virtual reality canvas, specified as a vr.canvas object.

Output Arguments

image_capture — Virtual reality canvas image
array

Virtual reality canvas image, captured as an array. The array is an m-by-n-by-3 data
array that defines red, green, and blue color components for each individual pixel.

Examples

Capture an RGB Image of a Figure in a Canvas

Create and open a vrwor Id object and associate it with the virtual world
vrlights.wrl.



capture

lights_world = vrworld("vrlights.wrl®);
open(lights_world);

Create a vr.canvas object for Iights_world.

f = figure;

c = vr.canvas(lights_world, f, [30 30 300 200]);
vrdrawnow;
Figure 1 (=@ ]=]

File Edit View Insert Tools Desktop ‘Window Help

DEdde M AAODEL- S| 0EH =D
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Capture an image of the canvas.
image_capture = capture(c);
Display an RGB image of the canvas in a MATLAB® figure window.

figure;
image(image_capture);
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“MATLAB Interaction”
“Create vrworld Object for a Virtual World” on page 4-2
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See Also

See Also

vrworld | image

Topics
“MATLAB Interaction”
“Create vrworld Object for a Virtual World” on page 4-2

Introduced before R2006a
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vrclear

Remove all closed virtual worlds from memory

Syntax

vrclear

vrclear("-force")

Description

The vrclear function removes from memory all virtual worlds that are closed and
invalidates all vrworld objects related to them. This function does not affect open virtual
worlds. Open virtual worlds include those loaded from the Simulink interface. You use
this command to

+  Ensure that the maximum amount of memory is freed before a memory-consuming
operation takes place.

*  Perform a general cleanup of memory.

Thevrclear("-force"™) command removes all virtual worlds from memory, including
worlds opened from the Simulink interface.

See Also

vrworld | “Close and Delete a vrworld Object” on page 4-10 | vrworld/delete

Introduced before R2006a
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vrclose

Close virtual reality figure windows

Syntax

vrclose
vrclose all

Description

vrclose and vrclose all close all the open virtual reality figures.

Examples

Open a series of virtual reality figure windows by typing

vrpend
vrbounce
vrlights

Arrange the viewer windows so they are all visible. Type

vrclose

All the virtual reality figure windows disappear from the screen.

See Also

“Close and Delete a vrworld Object” on page 4-10 | vrfigure.close

Introduced before R2006a
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vrdir2ori

Convert viewpoint direction to orientation

Syntax

vrdir2ori(d)
vrdir2ori(d,options)

Description

vrdir2ori(d) converts the viewpoint direction, specified by a vector of three elements,
to an appropriate orientation (virtual world rotation vector).

vrdir2ori(d,options) converts the viewpoint direction with the default algorithm
parameters replaced by values defined in options.

The options structure contains the parameter epsilon that represents the value below
which a number will be treated as zero (default value is 1e-12).

See Also

vrori2dir on page 10-115 | vrrotmat2vec on page 10-128 | vrrotvec on page
10-127 | vrrotvec2mat on page 10-129

Introduced in R2007b
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vrdrawnow

Update virtual world

Syntax

vrdrawnow

Description

vrdrawnow removes from the queue pending changes to the virtual world and makes
these changes to the scene in the viewer.

Changes to the scene are normally queued and the views are updated when

The MATLAB software is idle for some time (no Simulink model is running and no
script is being executed).

A Simulink step is finished.

See Also

vrworld/edit | vrworld/open | “Open a Virtual World with MATLAB” on page 4-4 |
“Interact with a Virtual World with MATLAB” on page 4-6

Introduced before R2006a
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vredit

Open 3D World Editor

Syntax

vredit

w =
w = vredit(filename)

Description

w = vredit opens the 3D World Editor with an empty virtual world.

w = vredit(filename) opens a virtual world file in the 3D World Editor, based on the
specified Filename. It returns the vrwor ld handle of the virtual world.

To open a virtual world file in a third-party editor, do not use the vredit command. For
example, to open a virtual world in the Ligos V-Realm Builder editor:

1 Set the default editor to V-Realm Builder. In MATLAB, enter:

vrsetpref("Editor®, "*VREALM®);

2 Toopen a file in the V-Realm editor, in MATLAB navigate to a virtual world file,
right-click, and select Edit.

Note: The vredit command opens the 3D World Editor, regardless of the default
editor preference setting.

Examples
Open New Virtual World in 3D World Editor

vredit
Open Existing Virtual World in 3D World Editor

Open the membrane virtual world in the 3D World Editor.



vredit

myworld = vredit("membrane.wrl*®)

See Also

vrworld/edit | vrworld/open | “Open a Virtual World with MATLAB” on page 4-4 |
“Interact with a Virtual World with MATLAB” on page 4-6

Introduced in R2012b
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vrfigure class

Create virtual reality figure

Description
Creates a virtual reality figure.

To access vrfigure properties, use the vrfigure/get method. To change properties,
use the vrfigure/set method.

If you create a vrfigure object by specifying a virtual world, the virtual figure displays
in the viewer specified in the vrsetpref DefaultViewer property.

Construction

virtual_figure = vrfigure(world) creates a virtual reality figure showing the
specified virtual world.

virtual_figure = vrfigure(world,position) creates a virtual reality figure at
the specified position.

virtual _figure = vrfigure([]) returns an empty vrfigure object that does not
have a visual representation.

virtual figure = vrfigure returns an empty vector of type vrfigure.

Input Arguments

world — Virtual world
vrwor Id object

Virtual world, specified as a vrwor ld object.

Note: Open the virtual world that you specify before you create a vrfigure object using
that virtual world.
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Position — Figure location and size
vector with four elements

Location and size of virtual figure, specified as the vector in the form [left bottom
width height]. Specify measurements in pixels.

Note: On Windows systems, figure windows cannot be less than 104 pixels wide,
regardless of the value of the Position property.

Element Description

left Distance from the left edge of the primary display to the
inner left edge of the figure window. This value can be
negative on systems that have more than one monitor.

bottom Distance from the bottom edge of the primary display to
the inner bottom edge of the figure window. This value can
be negative on systems that have more than one monitor.

width Distance between the right and left inner edges of the
figure.

height Distance between the top and bottom inner edges of the
figure.

Example: [230 250 570 510]
Data Types: double

Output Arguments

virtual_figure — Virtual redlity figure
vrfigure object | empty vector of type virfigure

If you use a vrworld object as an input argument, virtual_figure is a virtual reality
figure, represented by a vrfigure object.

If you use an empty array as an input argument, the vrfigure constructor returns a
vector of type vrfigure.

If you do not use an input argument, the vrfigure constructor returns an empty vector
of type vrfigure.
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Methods

capture Capture virtual reality figure image
capture Capture virtual reality figure image

close Close virtual reality figure

get Return property value of virfigure object
isvalid Check validity of vrfigure object handles
set Set property values of vrfigure object
set Set property values of vrfigure object
Examples

Create and Display a vrworld Object

Create a vrwor ld object that is associated with the virtual world vrmount.wrl. Open
and view the virtual world.

myworld = vrworld("vrmount.wrl®);
open(myworld);
f = vrfigure(myworld);
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&% VR Car in the Mountains EI@

File  “iew \Viewpoints Mavigation Rendering Simulation Recording Help &

:Viewl-ﬂbsewer v::Examine v4.' e | Y f3'| a Cf| [ ||ﬁ| P m

Viewy 1 - Obzerver T=0.00 Examine Pos:[20.00 5.00 20.00] Dir,[0.00 -0.20 -0.93]

. “Create vrworld Object for a Virtual World” on page 4-2
. “MATLAB Interaction”

. “View a Virtual World in Stereoscopic Vision” on page 7-63
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See Also

See Also

vr.utils.stereo3d | vr.canvas

Topics

“Create vrworld Object for a Virtual World” on page 4-2
“MATLAB Interaction”

“View a Virtual World in Stereoscopic Vision” on page 7-63

Introduced before R2006a
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capture

Class: vrfigure

Capture virtual reality figure image

Syntax

image_capture = capture(figure)

Description

image_capture = capture(figure) captures a virtual reality figure into a
TrueColor RGB image. You can display this image using the image command. You can
then print the figure.

Input Arguments

figure — Virtual reality figure
vrfigure object

Virtual reality figure, specified as a vrfigure object.

Output Arguments

image_capture — Virtual redlity figure image
array

Virtual reality figure image, captured as an array. The array is an m-by-n-by-3 data
array that defines red, green, and blue color components for each individual pixel.

Examples

Capture an RGB Image of a Figure

Create and open a vrwor ld object and associate it with the virtual world virmount._wrl.
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myworld = vrworld("vrmount.wri™);
open(myworld);

View the virtual world in the Simulink® 3D Animation™ Viewer.

T = vrfigure(myworld);

&* VR Car in the Mountains EI@

File  View Viewpaoints Mavigation Rendering Simulation  Recording  Help o

:Viewl-ﬂbsemer v::ExaminE v4.| - | L fl'| a Gf| ] ||i§j| b m

Viewe 1 - Obzerver T=0.00 Examine Pos:[20.00 5.00 50.00] Dir:[0.00 -0.20 -0.95]

Create an RGB image of the figure.

image_capture = capture(f);
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Display the RGB figure image in a MATLAB® figure window.

image(image_capture);
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. “MATLAB Interaction”
. “Create vrworld Object for a Virtual World” on page 4-2

See Also

See Also

vrfigure | vrworld | vrfigure.isvalid | vrnode/isvalid | image
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Topics
“MATLAB Interaction”
“Create vrworld Object for a Virtual World” on page 4-2

Introduced before R2006a
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close

Class: vrfigure

Close virtual reality figure

Syntax

close(figure)

Description

close(figure) closes the virtual reality figure referenced by Figure. If figureis a
vector of virFigure object handles, then the method closes multiple figures.

Input Arguments

figure — Virtual redlity figure
vrfigure object

Virtual reality figure, specified as a vrfigure object.

Examples

Create a Figure
myworld = vrworld("vrpend.wri®);
open(myworld);

f = vrfigure(myworld);
close(T)

“MATLAB Interaction”
“Create vrworld Object for a Virtual World” on page 4-2
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See Also

See Also

vrfigure | vrworld

Topics
“MATLAB Interaction”
“Create vrworld Object for a Virtual World” on page 4-2

Introduced before R2006a
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get
Class: vrfigure

Return property value of virfigure object

Syntax

get(figure)
figureProp = get(figure,propertyName)

Description
get(Figure) lists the values of all the properties of the vrfigure object.

figureProp = get(figure,propertyName) returns the value of the specified
property of the virfigure object.

Input Arguments

figure — Virtual redlity figure
vrfigure object

Virtual reality figure, specified as a vrfigure object.

property_name — Virtual reality figure object property
string

Virtual reality figure property, specified as one of these.

vrfigure Property Meaning

Antialiasing Smooth textures using antialiasing, which
interpolates values between texture points.

CameraBound Camera movement with the current
viewpoint.

CameraDirection Camera direction in the current viewpoint

local coordinates.
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vrfigure Property

Meaning

CameraDirectionAbs

Camera direction in the world coordinates.
(read-only property).

CameraPosition Camera position in the current viewpoint
local coordinates.

CameraPositionAbs Camera position in world coordinates
(read-only property).

CameraUpVector Camera up vector.

CameraUpVectorAbs Camera up vector in world coordinates

(read-only property).

CaptureFileFormat

File format for a captured frame file.

CaptureFileName

Frame capture file name.

DeleteFcn Callback invoked when closing the
vrfigure object.
ExaminePivotPoint Pivot point about which camera is rotated

in examine navigation mode, in world
coordinates.

Fullscreen

Full screen display of figure.

Headlight Headlight from camera.

Lighting Lighting effect.

MaxTextureSize Maximum pixel size of a texture used. The
smaller the size, the faster the texture
can render. A value of "auto” means the
texture is set to the maximum pixel size.

Name Name of figure.

NavMode Navigation mode. See “Mouse Navigation”
on page 7-27.

NavPanel Navigation panel appearance.

NavSpeed Navigation speed.

NavZones Navigation zones display.

Position Screen coordinates of figure.

Record2D 2-D offline animation file recording.
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vrfigure Property Meaning

Record2DCompress Compression method for creating 2-

Method D animation files. See profile in the
MATLAB VideoWriter documentation.

Record2DCompress Quality of 2-D animation file compression.

Quality See the MATLAB VideoWriter

documentation.

Record2DFi leName

Name of 2-D offline animation file. The
string can contain tokens that animation
recording replaces with information. See
“File Name Tokens” on page 4-15.

Record2DFPS

Rate of playback for the 2-D offline
animation video in frames per second (fps).

Rendering

Specifies whether to render a vrfigure
object. Turning off rendering improves
performance. For example, if your code
does batch operations on a virtual figure,
you can turn off rendering during that
processing and then turn it back on after
the processing.

Sound

Sound effects.

StatusBar

Status bar display.

Stereo3D

Stereoscopic vision mode.

Stereo3DCameraOffset

Distance in virtual world units of left and
right camera from parallax for stereoscopic
vision. Parallax is the difference in the
apparent position of an object viewed from
two cameras.

Stereo3DHIT

Horizontal image translation (HIT) of

the two stereo images in stereoscopic
vision, represented by a value from O to 1,
inclusive. The larger the value, the further
back the background appears.

Textures

Texture use.

ToolBar

Toolbar display.
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vrfigure Property Meaning

Tooltips Tooltips display in navigation panel.

Transparency Transparency effect.

Triad Location of the triad.

Viewpoint Active viewpoint of figure.

Wireframe Wireframe display.

World Virtual world that the figure displays
(read-only property).

ZoomFactor Camera zoom factor.

Output Arguments

figureProp — Virtual reality figure property

string | vector

Virtual reality figure property, returned as a string or vector.

Examples

Return All Property Values of a Figure

Create a vrfigure object.

myworld = vrworld("vrmount.wrl®);
open(myworld);
virtual_fig = vrfigure(myworld);
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&% VR Car in the Mountains EI@

File  “iew \Viewpoints Mavigation Rendering Simulation Recording Help &

:Viewl-ﬂbsewer v::Examine v4.' e | Y f3'| a Cf| [ ||ﬁ| P m

Viewy 1 - Obzerver T=0.00 Examine Pos:[20.00 5.00 20.00] Dir,[0.00 -0.20 -0.93]

Return the properties of the virtual figure virtual_fig.
get(virtual_fig)

Antialiasing = “on*

CameraBound = "on*

CameraDirection = [0 0 -1]
CameraDirectionAbs = [0 -0.198669 -0.980067]
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CameraPosition = [0 0 O]
CameraPositionAbs = [20 8 50]
CameraUpVector = [0 1 O]
CameraUpVectorAbs = [0 0.980067 -0.198669]
CaptureFileFormat = "tif"
CaptureFileName = "%f_anim_%n._tif"
DeleteFcn = **

ExaminePivotPoint = [0 0 0]
Fullscreen = "off"

Headlight = "on*

Lighting = "on*

MaxTextureSize = "auto”

Name = *"VR Car in the Mountains®
NavMode = "examine*

NavPanel = "halfbar*®
NavSpeed = “"normal”
NavZones = "off"

Position = [5 92 576 350]
Record2D = "off"

Record2DCompressMethod = "auto”
Record2DCompressQuality = 75
Record2DFPS = "auto”
Record2DFileName = "%Ff_anim_%n.avi”
Rendering = "on*

Sound = "on*

StatusBar = "on*

Stereo3D = "off"
Stereo3DCameraOffset = 0.1
Stereo3DHIT = 0

Textures = "on*

ToolBar = “on
Tooltips = "on
Transparency = “on
Triad = "none*
Viewpoint = "View 1 - Observer*
Wireframe = "off"

World = vrworld object: 1-by-1
ZoomFactor = 1

Return Name of a Figure

Create a vrfigure object.

myworld = vrworld("vrmount.wri™);
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open(myworld);
virtual_fig = vrfigure(myworld);

&% VR Car in the Mountains EI@

File “iew \Viewpoints Mavigation Rendering Simulation Recording Help &

:Viewl-ﬂbsemer v::ExaminE v4.| ot | I fj| a Cf| . ||ﬁ| P =

Viewy 1 - Obzerver T=0.00 Examine Pos:[20.00 5.00 50.00] Dir:[0.00 -0.20 -0.95]

Return the properties of the virtual figure virtual fig.

figure_name = get(virtual_fig, "Name")

figure_name =
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"VR Car in the Mountains*

. “MATLAB Interaction”
. “Create vrworld Object for a Virtual World” on page 4-2

. “View a Virtual World in Stereoscopic Vision” on page 7-63

See Also

See Also

vrfigure | vr.utils._.stereo3d

Topics

“MATLAB Interaction”

“Create vrworld Object for a Virtual World” on page 4-2
“View a Virtual World in Stereoscopic Vision” on page 7-63

Introduced before R2006a
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isvalid

Class: vrfigure

Check validity of vrFfigure object handles

Syntax

valid_handles = isvalid(vrfigure vector)

Description

valid_handles = isvalid(vrfigure_vector) detects whether the vrfigure
handles are valid.

Input Arguments

figure_vector — Virtual redlity figure vector
array of vrfigure object handles

Virtual reality figure vector, specified as a virFigure object.

Output Arguments

valid_handles — Valid vrfigure object handles
logical array

Virtual reality figure image, captured as a logical array. The array that contains a 1
where the vrfigure handles are valid and returns a O where they are not.
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Examples

Check Validity of Figure Handles

Check whether the figure handles of the vrfigure object are valid. The first check
shows that the figure handle is valid, but the second check shows that the handle is
invalid because the figure is closed.

myworld = vrview("vrpend.wrl®);
f = vrfigure(myworld);
firstCheck = isvalid(f)
close(T)

secondCheck = isvalid(f)
firstCheck =

logical

1

secondCheck =
logical

0
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&% Inverted Pendulum

File  “iew Viewpoints

Mavigation

Rendering  Simulation Recording Help &

[(=E@]=]

Pseudo arthographic wview

-

Examine =

dJM L2 dda e 5@ =

|F‘seud|:| orthographic wies

|T=0.00

[Examine |Pos:[-150.00 100.00 180.00] Dir:[0.66 -0.35 -0.65]

. “MATLAB Interaction”
. “Create vrworld Object for a Virtual World” on page 4-2
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See Also

See Also

vrfigure | vrworld

Topics
“MATLAB Interaction”
“Create vrworld Object for a Virtual World” on page 4-2

Introduced before R2006a



set

set

Class: vrfigure

Set property values of vrfigure object

Syntax

set(figure,PropertyName,Value, ... ,PropertyName,Value)

Description

set(figure,PropertyName,Value, ... ,PropertyName,Value) sets the values
of the vrfigure properties specified by one or more PropertyName,Value pair
arguments.

Input Arguments

figure — Virtual redlity figure
vrfigure object

Virtual reality figure, specified as a vrfigure object.

PropertyName-Value Pair Arguments

Specify comma-separated pairs of PropertyName,Value arguments. PropertyName is
the argument name and Value is the corresponding value. PropertyName must appear
inside single quotes (" *). You can specify several name and value pair arguments in any
order as PropertyNamel,Valuel, ... ,PropertyNameN,ValueN.

Example: set(myFigure, "Antialising”, "on", "CameraPosition”,[0 100 100])

"Antialiasing”™ — Smooth textures using antialiasing
"off" (default) | "on”

Smooth textures using antialising, specified as "on" or "off". Antialiasing smooths
textures by interpolating values between texture points.
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"CameraBound” — Camera movement with current viewpoint
"on"” (default) | "off"

Camera movement with the current viewpoint, specified as "on* or "off".

"CameraDirection” — Camera direction in the current viewpoint local coordinates
vector of three doubles

Camera direction in the current viewpoint local coordinates, specified as a vector of three
doubles. The doubles represent the x, y, and z vectors in the current viewpoint local
coordinates.

"CameraPosition™ — Camera position in the current viewpoint local coordinates
vector of three doubles

Camera position in the current viewpoint local coordinates, specified as a vector of three
doubles. The doubles represent the x, y, and z vectors in the current viewpoint local
coordinates.

"CameraUpVector®™ — Camera up vector
vector of three doubles

Camera up vector, specified as a vector of three doubles. The doubles represent the x, y,
and z vectors in the current viewpoint local coordinates.

"CaptureFileFormat” — File format for captured frame file
"tif" (default) | "png”

File format for a captured frame file, specified as "tif" for Tagged Image Format or
"png"” for Portable Network Graphics format.

"CaptureFileName” — Frame capture file name
"%f_anim_%n.ext" (default) | string

Frame capture file name, specified as a string. The string can contain tokens that the
frame capture replaces with the corresponding information. See “Define File Name
Tokens” on page 4-13.

"DeleteFcn” — Callback invoked when closing vrfigure object
string

Callback invoked when closing the vrFigure object, specified as a string.
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"Fullscreen” — Fullscreen display of figure
"off" (default) | "on*

Fullscreen display of figure, specified as "on* or "off".

"Headlight" — Headlight from camera
"on” (default) | "ofF"

Headlight from camera, specified as "on* or "ofFf". If you specify "off", the camera
does not emit light and the scene can appear dark.

"Lighting® — Lighting effect
"on" (default) | "off"

Lighting effect, specified as "on” or "off". If you specify "off", the camera does not
emit light and the scene can appear dark.

"MaxTextureSize" — Maximum pixel size of textures
"auto” (default) | integer in a power of 2

Maximum pixel size of textures, specified as "auto” or integer in a power of 2. The value
of "auto” sets the maximum texture pixel size. Otherwise, specify an integer in a power
of two that is equal to or less than the video card limit (typically 1024 or 2048).

The smaller the size, the faster the texture renders. Increasing the size improves image
quality but decreases performance.

Note: Specifying a value that is unsuitable causes a warning. The Simulink 3D
Animation software then adjusts the property to the next smaller suitable value.

Data Types: int32

"Name" — Name of figure
string

Name of figure, specified as a string.

"NavMode" — Navigation mode

"examine” (default) | "fly" | "walk "none”
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Navigation mode, specified as "examine®, "fly", "walk", or "none”. See “Mouse
Navigation” on page 7-27.

"NavPanel " — Navigation panel appearance
"none” (default) | "halfbar® | "bar® | "opaque® | "translucent”

Navigation panel appearance, specified as "none®, "halfbar®, "bar”, "opaque”, or
"translucent”.

"Navspeed™ — Navigation speed
"normal * (default) | "slow® | "veryslow®" | "fast” | "veryfast”

Navigation speed, specified as "normal ", "slow”, "veryslow", "fast", or
"veryfast-.

"NavZones™ — Navigation zones display
"off" (default) | "on*

Navigation zones display, specified as "on” or "off".

"Position” — Figure location and size
vector with four doubles

Location and size of virtual figure, specified as the vector in the form [left bottom
width height]. Specify measurements in pixels.

Element Description

left Distance from the left edge of the primary display to
the inner left edge of the figure window. You can specify
a negative value on systems that have more than one
monitor.

bottom Distance from the bottom edge of the primary display

to the inner bottom edge of the figure window. You can
specify a negative value on systems that have more than
one monitor.

width Distance between the right and left inner edges of the
figure.

height Distance between the top and bottom inner edges of the
figure.

All measurements are in units specified in pixels.
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Example: [230 250 570 510]
Data Types: double

"Record2D" — 2-D offline animation file recording
"off" (default) | "on*

2-D offline animation file recording, specified as "on" or "off".

"Record2DCompressMethod” — Compression method for creating 2-D animation files
"auto” (default) | " | "lossless” | "none” | string with name of a compression
method

Compression method for creating 2-D animation files, specified as " ", "lossless”,
"none”, or a string specifying the name of a compression method. See profile in the
MATLAB VideoWriter documentation.

"Record2DCompressQuality” — Quality of 2-D animation file compression
75 (default) | floating point number from 0 through 100, inclusive

Quality of 2-D animation file compression, specified as a floating-point number from 0
through 100, inclusive. See the MATLAB VideoWriter documentation.
Data Types: int32

*Record2DFileName® — Name of 2-D offline animation file
string

Name of 2-D offline animation file, specified as a string. The string can contain tokens
that animation recording replaces with the corresponding information. See “File Name
Tokens” on page 4-15.

"Record2DFPS" — Playback rate for 2-D offline animation file
"auto” (default) | scalar

Playback rate for 2-D offline animation file, specified as "auto” or as a scalar. The
"auto” setting aligns simulation time with actual time and uses an appropriate frame
rate.

Data Types: int32

"Rendering” — Render vrfigure object in Simulink 3D Animation Viewer
"on® (default) | "off"
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Render vrfigure object in the Simulink 3D Animation Viewer, by specifying "on* or
"off". Turning off rendering improves performance. For example, if your code does
batch operations on a virtual figure, you can turn off rendering during that processing
and then turn it back on after the processing.

"Sound" — Sound effects
"on" (default) | "off"

Sound effects, specified as "on" or "off".

"StatusBar" — Status bar display
"on” (default) | "off"

Status bar display, specified as "on” or "off".

"Stereo3D" — Stereoscopic vision mode
"off" (default) | "anaglyph® | "active” | vr.utils.stereo3d object

Stereoscopic vision mode, specified as "off", "anaglyph”, "active” or a
vr.utils._stereo3d object.

Specifying a vr.utils.stereo3d object sets the Stereo3D, Stereo3DCamaraOffset,
and Stereo3DHIT properties. Specifying a vr.utils.stereo3d object also sets color
filters for the left and right cameras.

"Stereo3DCameraOffset” — Distance of left and right camera for stereoscopic vision
vector of three doubles

Distance of left and right camera from parallax for stereoscopic vision, specified as a
vector of three doubles representing virtual world units or as a vr.utils.stereo3d
object.

Specifying a vr.utils.stereo3d object sets the Stereo3D, Stereo3DCamaraOffset,
and Stereo3DHIT properties. Specifying a vr.utils.stereo3d object also sets color
filters for the left and right cameras.

"Stereo3DHIT" — Horizontal image translation (HIT) of two stereoscopic images
double from O to 1

Horizontal image translation (HIT) of two stereoscopic images, specified as a double from
0 through 1, inclusive. The larger the value, the further back the background appears.
By default, the background image is at zero and the foreground image appears to pop out
from the monitor toward the person viewing the virtual world.
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Specifying a vr.utils.stereo3d object sets the Stereo3D, Stereo3DCamaraOffset,
and Stereo3DHIT properties. Specifying a vr .utils.stereo3d object also sets color
filters for the left and right cameras.

"Textures" — Texiure use
"on" (default) | "off"

Texture use, specified as "on” or "off".

"Toolbar" — Toolbar display
"on" (default) | "off"

Toolbar display, specified as "on" or "off".

"Tooltips™ — Tooltips display
"on® (default) | "off"

Tooltips display, specified as "on* or "ofFf".

"Transparency” — Transparency effect
"on" (default) | "ofF"

Transparency effect, specified as "on” or "off".

"Viewpoint" — Active viewpoint of figure
string

Active viewpoint of a figure, specified as a string. If the active viewpoint has no
description, use an empty string.

"Wireframe" — Wireframe display
"off" (default) | "on*

Wireframe display, specified as "on" or "off".

"ZoomFactor" — Camera zoom factor
1 (default) | floating-point number

Camera zoom factor, specified as a floating-point number. A zoom factor of 2 makes the

scene look twice as large. A zoom factor of 0.1 makes it look 10 times smaller, and so
forth.
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Examples

Set Property Values of Figure

Set the camera direction, navigation mode, and stereoscopic vision properties of a virtual
figure.

Create a vrfigure object.
myworld = vrworld("vrmount.wrl®);

open(myworld);
virtual_fig = vrfigure(myworld);
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&% VR Car in the Mountains

[(=E@]=]

File View Viewpoints Mavigation Rendering Simulation Recording Help &

:‘l."iewl - Observer

v::EHamine TJP|,I;,§'|QT Q:| L] ||ﬁ| P =

View 1 - Observer

T=0.00 Examine Po=:[20.00 2.00 50.00] Dir:[0.00 -0.20 -0.58]

Create a vr.utils.stereo3d object to use to specify stereoscopic vision properties.

myStereo3D = vr.utils.stereo3d.ANAGLYPH_RED_CYAN;

Set the properties for a figure.

set(virtual_fig, "CameraDirection”,[0 1 0], "NavMode®,"fly", ...
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"Stereo3D" ,myStereo3D);

«* VR Car in the Mountains

File View Viewpoints Mavigation

:‘u"iewl - Observer - ::F|]||'

Rendering

Simulation Recording

rd ML dd

(== |[=]
Help &

o ||| r =

View 1 - Observer

T=0.00 Fly

Pos:[20.00 8.00 50.00] Dir:[0.00 0.38 -0.20]

View the figure properties.

get(virtual_fig)

Antialiasing = "on
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CameraBound = "on
CameraDirection = [0 1 O]
CameraDirectionAbs = [0 0.980067 -0.198669]
CameraPosition = [0 0 O]

CameraPositionAbs = [20 8 50]
CameraUpVector = [0 1 O]

CameraUpVectorAbs = [0 0.980067 -0.198669]
CaptureFileFormat = "tif"

CaptureFileName = "%f_anim_%n._tif"
DeleteFcn = **

ExaminePivotPoint = [0 0 0]

Fullscreen = "off"

Headlight = "on*

Lighting = "on*

MaxTextureSize = "auto”

Name = *"VR Car in the Mountains®

NavMode = "fly*

NavPanel = "halfbar*®
NavSpeed = “"normal”
NavZones = "off"

Position = [5 92 576 380]
Record2D = "off"

Record2DCompressMethod = "auto®
Record2DCompressQuality = 75
Record2DFPS = "auto”
Record2DFileName = "%f_anim_%n.avi”
Sound = "on*

StatusBar = "on*

Stereo3D = "anaglyph*
Stereo3DCameraOffset = 0.1
Stereo3DHIT = 0

Textures = "on*

ToolBar = “on
Tooltips = "on
Transparency = "on*

Triad = "none*

Viewpoint = "View 1 - Observer*
Wireframe = "off"

World = vrworld object: 1-by-1
ZoomFactor = 1

“MATLAB Interaction”
“Create vrworld Object for a Virtual World” on page 4-2
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. “View a Virtual World in Stereoscopic Vision” on page 7-63

See Also

See Also

vrfigure | vrfigure.get | vr.utils.stereo3d

Topics

“MATLAB Interaction”

“Create vrworld Object for a Virtual World” on page 4-2
“View a Virtual World in Stereoscopic Vision” on page 7-63

Introduced before R2006a
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vrgcbf

Current callback vrfigure object

Syntax

f = vrgcbf

Description

T = vrgcbf returns a virfigure object representing the virtual reality figure that
contains the callback currently being executed.

When no virtual reality figure callbacks are executing, vrgcbf returns an empty array of
vrfigure objects.

See Also

vrfigure | “Create vrworld Object for a Virtual World” on page 4-2 | vr.canvas |
“MATLAB Interaction” | “View a Virtual World in Stereoscopic Vision” on page 7-63

Introduced in R2008b
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vrgcf

Handle for active virtual reality figure

Syntax

h = vrgcf

Description

h = vrgcf returns the handle of the current virtual reality figure. The current virtual
reality figure is the currently active virtual reality figure window in which you can get

and set the viewer properties. If no virtual reality figure exists, the MATLAB software

returns an empty vrfigure object.

This method is most useful to query and set virtual reality figure properties.

See Also

vrfigure

Introduced in R2008b
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vrgetpref

Values of Simulink 3D Animation preferences

Syntax

X = vrgetpref

X = vrgetpref(“preference_name")

X = vrgetpref(“preference_name= ,"factory")

X = vrgetpref(~factory®)

Arguments

preference_name Name of the preference to read.

Description

X = vrgetpref returns the values of all the Simulink 3D Animation preferences in a
structure array.

X = vrgetpref(“preference_name®) returns the value of the specified preference.
If preference_name is a cell array of preference names, a cell array of corresponding

preference values is returned.

X = vrgetpref('preference _name®,"factory") returns the default value for the
specified preference.

X = vrgetpref("factory™) returns the default values for all the preferences.
The following preferences are defined. For preferences that begin with the string

DefaultFigure or DefaultWorld, these values are the default values for the
corresponding vrfigure or vrwor ld property:
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Preference

Description

AutoCreateThumbnail

Creates a thumbnail of a virtual world when
you open a virtual world. The default is "ofF".
Setting this preference to "on" can be helpful
if you download multiple virtual worlds from
the Internet, without saving them. Creating
thumbnails on file open provides thumbnails
the next time someone browses through the
downloaded worlds.

DataTypeBool

Specifies the handling of the virtual world Bool
data type for virnode/setfield and vrnode/
getfield. Valid values are "logical ® and
"char”. If set to "logical ", the virtual world
Bool data type is returned as a logical value. If
set to "char™, the Bool data type is returned
"on* or "off". Defaultis "logical .

DataTypelnt32

Specifies handling of the virtual world Int32
data type for vrnode/setfield and vrnode/
getfield. Valid values are "iInt32" and
"double”. If set to "int32", the virtual world
INnt32 data type is returned as int32. If set to
"double”, the Int32 data type is returned as
"double”. Default is "double*

DataTypeFloat

Specifies the handling of the virtual world
float data type for virnode/setfield

and vrnode/getfield. Valid values are
"single” and "double”. If set to "single”,
the virtual world Float and Color data types
are returned as "single”. If set to "double”,
the Float and Color data types are returned
as "double”. Default is "double®.
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Preference

Description

DefaultCanvasNavPanel

Controls the appearance of the control panel in
the vr.canvas object. Values are:

* "none”
Panel is not visible.
* "minimized”

Panel appears as a minimized icon in the
right-hand corner of the viewer.

+ "translucent”

Panel floats half transparently above the
scene.

* "opaque”
Panel floats above the scene.

Default: "none*”

DefaultCanvasUnits

Specifies default units for new vr.canvas
objects. See vr .canvas for detailed description.
Default is "normalized”.

DefaultEditorMouseBehavior

Specifies whether the mouse in the view pane
1s in navigation mode or selection mode (for
highlighting corresponding nodes in the tree
view pane). The default is "navigate”.

DefaultEditorHighlighting

Specifies whether to highlight virtual world
objects selected in the view pane. The default is

on-.

Defaul tFigureAnti Determines whether antialiasing is used
Aliasing by default for new vrfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "off" and "on".
Defaul tFigureCapture Specifies default file name for vr.capture
FileName files. See vrfigure.get for detailed

description. Default is "% _anim_%n.tif".
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Preference

Description

DefaultFigureDeleteFcn

Specifies the default callback invoked when
closing a vrfigure object.

DefaultFigureLighting

Specifies whether the lights are rendered

by default for new vrfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "off" and "on".

Defaul tFigureMax
TextureSize

Specifies the default maximum size of a texture
used in rendering new vrfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "auto” and 32 <=x
<= video card limit, where X is a power of 2.

Defaul tFigureNavPanel

Specifies the default appearance of the control
panel in the viewer. Valid values are "opaque”®,
"translucent”®, "none”, "halfbar”, "bar”,
and "factory"®. Default is "halfbar*®.

Defaul tFigureNavZones

Specifies whether the navigation zone is on

or off by default for new vrfigure objects.
This preference also applies to new vr.canvas
objects. Valid values are "off" and "on".

DefaultFigurePosition

Sets the default initial position and size of the
Simulink 3D Animation Viewer window. Valid
value is a vector of four doubles.

Defaul tFigureRecord2D
CompressMethod

Specifies the default compression method

for creating 2-D animation files for new
vrfigure objects. Valid values are " ", "auto”,
"lossless”®, and "codec_code”.

Defaul tFigureRecord2D
CompressQuality

Specifies the default quality of 2-D animation
file compression for new vrfigure objects.
Valid values are 0-100.

DefaultFigureRecord2D
FileName

Specifies the default 2-D offline animation file
name for new vrfigure objects.
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Preference

Description

Defaul tFigureRecord2DFPS

Specifies the default frames per second
playback speed.

To have the 2D AVI animation play back at
approximately the same playback speed as the
3D virtual world animation, set this preference
to auto.

DefaultFigureRendering

Specifies whether to render a vrfigure or
Vr . canvas object. Turning off rendering
improves performance. For example, if your
code does batch operations on a virtual
figure, you can turn off rendering during that
processing and then turn it back on after the
processing.

Defaul tFigureStatusBar

Specifies whether the status bar appears

by default at the bottom of the Simulink 3D
Animation Viewer for new vrfigure objects.
Valid values are "off" and "on~.

Defaul tFigureTextures

Specifies whether textures should be rendered
by default for new vrfigure objects. This
preference also applies to new vr .canvas
objects. See vrfigure.get for detailed
description. Default is "on*®.

DefaultFigureToolBar

Specifies whether the toolbar appears by
default on the Simulink 3D Animation Viewer
for new vrfigure objects. Valid values are
"off" and "on".

DefaultFigure
Transparency

Specifies whether or not transparency
information is taken into account when
rendering for new vrFfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "off" and "on".
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Preference

Description

DefaultFigureWireframe

Specifies whether objects are drawn as solids

or wireframes by default for new vrfigure
objects. This preference also applies to new

Vr .canvas objects. Valid values are "off" and

on-.

DefaultViewer Specifies which viewer is used to view a virtual
scene.
+ "internal*
Default Simulink 3D Animation Viewer.
+ “web”
Web browser becomes viewer. This is the
current Web browser virtual world plug-in.
DefaultWorldRecord3D Specifies the default 3-D animation file name
FileName for new vrworld objects.

DefaultWorldRecordMode

Specifies the default animation recording mode
for new vrwor ld objects. Valid values are
"manual * and "scheduled®.

DefaultWorldRecord
Interval

Specifies the default start and stop times

for scheduled animation recording for new
vrwor ld objects. Valid value is a vector of two
doubles.

DefaultWorldRemoteView

Specifies whether the virtual world is enabled
by default for remote viewing for new vrworld
objects. Valid values are "off" and "on".

DefaultWorldTimeSource

Specifies the default source of the time for new
vrwor ld objects. Valid values are "external *
and "freerun®.
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Preference

Description

Editor

Specifies which virtual world editor to use. Path
to the virtual world editor. If this path is empty,
the MATLAB editor is used.

The path setting is active only if you select the
Custom option

To open a virtual world file in a third-party
editor, do not use the vredit command. For
example, to open a virtual world in the Ligos V-
Realm Builder editor:

1 Set the default editor to V-Realm Builder.
In MATLAB, enter:

vrsetpref(“Editor®, "*VREALM™);

2 To open a file in the V-Realm editor, in
MATLAB navigate to a virtual world file,
right-click, and select Edit.

Note: The vredit command opens the
3D World Editor, regardless of the default
editor preference setting.

EditorPreservelLayout

Specifies whether the 3D World Editor starts up
with a saved version of the layout of a virtual
world when you exited it or reverts to the
default layout. The layout of the virtual world
display pane includes settings for the view,
viewpoints, navigation, and rendering. Valid
values are "off" and "on". The default is on
(use saved layout).

HttpPort

For remote access, IP port number used to
access the Simulink 3D Animation server
over the Web via HTTP. If you change this
preference, you must restart the MATLAB
software before the change takes effect.
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Preference Description

TransportBuffer For remote access, length of the transport
buffer (network packet overlay) for
communication between the Simulink 3D
Animation server and its clients.

TransportTimeout Amount of time the Simulink 3D Animation
server waits for a reply from the client. If there
is no response from the client, the Simulink 3D
Animation server disconnects from the client.

VrPort For remote access, IP port used for
communication between the Simulink 3D
Animation server and its clients. If you change
this preference, you must restart the MATLAB
software before the change takes effect.

The HttpPort, VrPort, and TransportBuffer preferences affect Web-based remote
viewing of virtual worlds. DefaultFigurePosition and DefaultNavPanel affect the
Simulink 3D Animation Viewer.

Defaul tFigureNavPanel — Controls the appearance of the navigation panel in the
Simulink 3D Animation Viewer. For example, setting this value to "translucent”
causes the navigation panel to appear translucent.

DefaultViewer — Determines whether the virtual scene appears in the default
Simulink 3D Animation Viewer or in your Web browser.

DefaultViewer Setting Description
"internal " Default Simulink 3D Animation Viewer.
“"web*® Viewer is your Web browser.

Editor — Contains a path to the virtual world editor executable file. When you use the
edit command, Simulink 3D Animation runs the virtual world editor executable with all
parameters required to edit the virtual world file.

When you run the editor, Simulink 3D Animation uses the Editor preference value as if
you typed it into a command line. The following tokens are interpreted:

%matlabroot Refers to the MATLAB root folder
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%File Refers to the virtual world file name

For instance, a possible value for the Editor preference is

“ymatlabroot\bin\win64\meditor.exe %file”
If this preference is empty, the MATLAB editor is used.

HttpPort -- Specifies the network port to be used for Web access. The port is given in
the Web URL as follows:

http://server._name:port_number
The default value of this preference is 8123.

TransportBuffer — Defines the size of the message window for client-server
communication. This value determines how many messages, at a maximum, can travel
between the client and the server at one time.

Generally, higher values for this preference make the animation run more smoothly, but
with longer reaction times. (More messages in the line create a buffer that compensates
for the unbalanced delays of the network transfer.)

The default value is 5, which is optimal for most purposes. You should change this value
only if the animation is significantly distorted or the reaction times are very slow. On
fast connections, where delays are introduced more by the client rendering speed, this
value has very little effect. Viewing on a host computer is equivalent to an extremely
fast connection. On slow connections, the correct value can improve the rendering speed
significantly but, of course, the absolute maximum is determined by the maximum
connection throughput.

VrPort — Specifies the network port to use for communication between the Simulink
3D Animation server (host computer) and its clients (client computers). Normally,

this communication is completely invisible to the user. However, if you view a virtual
world from a client computer, you might need to configure the security network system
(firewall) so that it allows connections on this port. The default value of this preference is
8124.

See Also

vrsetpref | “Set Simulink 3D Animation Preferences” on page 2-9
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Introduced before R2006a
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vrifs2patch

Convert virtual world IndexedFaceSet nodes to MATLAB patches

Syntax

vrifs2patch(ifs)

Description

vrifs2patch(ifs) converts the ifs array of existing IndexedFaceSet nodes to
MATLAB patch objects.

Note: This function converts only geometry and color data of the source
IndexedFaceSet node.

Examples

Convert IndexedFaceSet Nodes to MATLAB Patches
This command converts three IndexedFaceSet nodes to MATLAB® patch objects.

Open virtual world containing an IndexedFaceSet node.

wl = vrworld("*sl3dlib/objects/Components/Shapes/Torus_High.wrl®);
open(wl);

View the virtual world as a virtual figure.

vrfigl = vrfigure(wl, "Name”®, ...
"Virtual world containing source IndexedFaceSet node®);
set(vrfigl, "CameraBound” , "off");
set(vrfigl, "CameraPosition”,[0 40 0]);
set(vrfigl, "CameraDirection®,[0 -1 0]);
set(vrfigl, "CameraUpVector®,[0 O -1]);
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&* Virtual world containing source IndexedFaceSet node = | >
File  “iew \Viewpoints Mavigation Rendering Simulation Recording Help &
DefaultViewpaint Fly rd D d q o

D faut e point T=0.00 Fly Pos:[0.00 40,00 0,007 Dir:[0.00 -1.00 0.00]

Convert the IndexedFaceSet a MATLAB patch and show it.
figure("Name”, . ..

"Resulting patch®");
tp = vrifs2patch(wl.torushi.children.geometry);
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1871
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Change the patch color, show the axes grid, rotate the camera, and enable mouse
rotation.

tp.FaceColor = "red”;

axs = gca;
axs.XGrid = "on";
axs.YGrid = "on";
axs.ZGrid = "on";

camorbit(45, -20);

rotate3d on
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Input Arguments

ifs — IndexedFaceSet nodes to convert
array

IndexedFaceSet nodes, specified as an array.
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See Also

See Also
patch | vrpatch2ifs

Topics
“Introduction to Patch Objects” (MATLAB)

Introduced in R2015a
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vrimport

Import 3D file into virtual world or node

Syntax

node = vrimport(source)

node = vrimport(parent,source)
node = vrimport(___ ,format)

[node,virtualWorld] = vrimport( )

Description

node = vrimport(source) creates an empty VRML virtual world and imports the
source 3D file into it. The format of the 3D file is detected automatically. You can
import these file formats:

+ DAE (COLLADA digital asset exchange)
*  SDF (simulation description format)

*  STL (STereoLithography)

+  URDF (unified robot description file)

Tip: To import Physical Modeling XML files, use the stl2vrml function instead of
vrimport.

The function returns a handle to the newly created node.

node = vrimport(parent,source) specifies the existing virtual world or node to
import the 3D source file into.

node = vrimport( , Format) explicitly specifies the file format of the 3D source
file (for example, "urdf"). If the format of the source file does not match the format
specified in the format argument, the function returns an error.

[node,virtualWorld] = vrimport( ) returns the handle of the new node and
the handle of the virtual world that contains that node.
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Examples

Import STL File Into an Empty Virtual World

This example imports an STL file rover_1.stl, a model of a simple wheeled robot. The
example also shows how to add visual appearance and material nodes to the imported
model in the virtual world.

Create a virtual world with the imported model.

[n,w] = vrimport(which("Rover_1.stl"));

View the virtual world with the imported shape.

view(w)

Scale the imported model from mm to dm to see it in the view.

n.scale = [0.01 0.01 0.01]

Rotate the rover around the x-axis.

w.Rover_Transform.rotation = [1 0 0 -pi/2]

Explore the virtual world structure.
get(w, "Nodes™)

STL imported shapes have no visual properties. Add an Appearance and a Materials
node to the shape. The Appearance node is created in the appearance field of the
Shape. The Material node is create in the material field of the Appearance node.

vrnode(w.Rover_Shape, "appearance”, "Rover_App", "Appearance”);
vrnode(w.Rover_App, "material”, "Rover_Mat", "Material");

app
mat

Set the diffuse color to a shade of blue.

w.Rover_Mat.diffuseColor = [0 0.5 1]
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< =0|Eoh =
- |

File View Viewpoints Mavigation Rendering Simulation  Recording Help

No Viewpoint T=0.00 Fly Pos:[0.00 0.00 10.00] Dir:[0.00 0.00 -1.00}

Save the virtual world.

save(w, "Rover_1._wrl")
Import a DAE file
This example imports a .dae format file into a virtual world.

Import the Fox.dae file to a node in a virtual world.
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[n,w] = vrimport(which("fox.dae"))
n =
vrnode object: 1-by-1

COLLADA_ fox_Transform_0001 (Transform) []

W =
vrworld object: 1-by-1

(No Virtual Reality 3D File Associated)
View the imported visual representation.

view(w)
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.

File View Viewpoints Mavigation Rendering Simulation  Recording Help N

+ Fly ~r J P L0 dq "]

/}- WIE' F| B

Po=:[0.00 0.00 10.00] Dir:[0.00 0.00 -1.00]

Mo Viewrpoint T=0.00 Fly

Save the virtual world.

save(w, "fox.wrl™)

“Import STL and Physical Modeling XML Files” on page 5-34

“Import Visual Representations of Robot Models” on page 5-55

“Link to Simulink and Simscape Multibody Models” on page 5-62
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Input Arguments

source — 3D source file
character vector

3D source file path, specified as a character vector. The 3D file can be in DAE, SDF, STL,
or URDF format.

format — File format of source 3D file
"dae” | "sdf" | "stl” | "urdf"

File format of source 3D file, specified as a character vector. Use this argument to specify
explicitly the required format for the source 3D file.

parent — Virtual world or node to import 3D source file to
vrworld object | virnode object

Virtual world or node to import 3D source file into, specified as a virtual world handle or
node handle.

+ If the parent is a virtual world, the imported node is placed at the ROOT node of the
parent.

+ If the parent is a node in a virtual world, the imported node is placed in the
children field of the node.

Output Arguments

node — New node
vrnode object

New node, returned as a vrnode object.

virtualWorld — Virtual world containing new node
vrworld object

Virtual world containing new node, returned as a vrwor Id object.
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See Also

See Also

stl2vrml | vrcadcleanup | vrphysmod

Topics

“Import STL and Physical Modeling XML Files” on page 5-34
“Import Visual Representations of Robot Models” on page 5-55
“Link to Simulink and Simscape Multibody Models” on page 5-62

Introduced in R2016b
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vrinstall

Install and check Simulink 3D Animation components

Syntax
vrinstall("action™)
vrinstall action

X = vrinstall(Taction®)

Arguments

action Type of action for this function. Values are —interactive, -
selftest, -check, -install, and -uninstall.

Description

You use this function to install on Windows platforms the Ligos V-Realm Builder. The
V-Realm Builder is an optional virtual world editor. For details, see “Install V-Realm
Editor on Host Computer” on page 2-20.

Note: The vrinstall command does no perform any action on a Linux platform.

The actions you can perform

Action Value Description

-selftest Checks the integrity of the current installation. If this function
reports an error, you should reinstall the Simulink 3D Animation
software. The function vrinstal l automatically does a self-test
with any other actions.

-interactive Checks for the installed components, and then displays a list of
uninstalled components you can choose to install.
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Action Value Description

-check Checks the installation of optional components. If the given
component is installed, returns 1. If the given component is not
installed, returns 0. If you do not specify a component, displays a
list of components and their status.

-install Installs optional components. This action requires you to specify
the component name.

-uninstall Uninstalls optional components. This option is currently available
for the editor only. Note that this action does not remove the files
for the editor from the installation folder. It removes the editor
registry information.

Examples

Install the virtual world editor. This command associates V-Realm Builder with the Edit
button in the Block Parameters dialog boxes.

vrinstall -install

Introduced before R2006a
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vrjoystick

Create joystick object

Syntax

joy = vrjoystick(id)
joy = vrjoystick(id, "forcefeedback")
Description

Joy = vrjoystick(id) creates a joystick object capable of interfacing with a joystick
device. The 1d parameter is a one-based joystick ID.

jJoy = vrjoystick(id, "forcefeedback™) enables force feedback if the joystick
supports this capability.

Methods

Method Description

axis a = axis(joy, n) reads the status of joystick with
axis number n. Axis status is returned in the range
of -1 to 1. The n parameter may be a vector to return
multiple buttons.

button b = button(joy, n) reads the status of joystick
button number n. Button status is returned as
logical 0 if not pressed and logical 1 if pressed. The
n parameter may be a vector to return multiple
buttons.

caps c = caps(Joy) returns joystick capabilities, such
as the number of axes, buttons, POVs, and force-
feedback axes. The return value is a structure with
fields named Axes, Buttons, POVs, and Forces.
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Method

Description

close

close(joy) closes and invalidates the joystick
object. The object cannot be used once it is closed.

force

force(Joy, n, f) applies force feedback to
joystick axis n. The n parameter can be a vector to
affect multiple axes. F values should be in range of -1
to 1, and the number of elements in ¥ should either
match the number of elements of n, or ¥ can be a
scalar to be applied to all the axes specified by n.

pov

p = pov(oy, n) reads the status of joystick POV
(point of view) of control number n. pov is usually
returned in degrees, with -1 meaning "not selected."
n can be a vector to return multiple POVs.

read

[axes, buttons, povs] = read(joy) reads the
status of axes, buttons, and POVs of the specified
joystick. [axes, buttons, povs] = read(joy,
forces) applies feedback forces, in addition, to a
force-feedback joystick.

where joy is the handle to the joystick object.

See Also

vrsetpref | vrspacemouse | vrlib | “Set Simulink 3D Animation Preferences” on

page 2-9

Introduced in R2007b
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vrlib

Open Simulink block library for Simulink 3D Animation

Syntax

vrlib

Description

The Simulink library for the Simulink 3D Animation product has a number of blocks and
utilities. You can access these blocks in one of the following ways:

In the MATLAB Command Window, type vrlib.

From a Simulink block diagram, select the View menu, click Show Library
Browser.
In the MATLAB Command Window, click the Simulink icon.

Introduced before R2006a
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vrnode

Create node or handle to existing node

Syntax

mynode = vrnode

mynode = vrnode([1)

mynode = vrnode(vrworld_object, "node_name*®)

mynode = vrnode(vrworld_object, "node_name®, "node_type*®)
mynode = vrnode(vrworld_object, "USE", othernode)

mynode = vrnode(parent_node, "parent_field", “node_name-,
"node_type*)

mynode = vrnode(parent_node, "parent_field", “USE",

"othernode®)

Arguments

vrworld_object Name of a vrwor Id object representing a virtual world.
node_name Name of the node.

node_type Type of the node.

parent_node Name of the parent node that is a vrnode object.
parent_field Name of the field of the parent node.

"USE*" Enables a USE reference to another node.

othernode Name of another node for a USE reference.
Description

mynode = vrnode creates an empty vrnode handle that does not reference any node.
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mynode = vrnode([]) creates an empty array of virnode handles.

mynode = vrnode(vrworld object, "node_name”) creates a handle to an existing
named node in the virtual world.

mynode = vrnode(vrworld _object, "node_name-®,"node_type~) creates a new
node called node _name of type node_type on the root of the virtual world. It returns the
handle to the newly created node.

mynode = vrnode(vrworld_object, "USE", othernode) creates a USE reference
to the node othernode on the root of the world vrworld_object. It returns the handle
to the virtual world to the original node.

mynode = vrnode(parent_node, "parent_field", "node_name", "node_type")
creates a new node called node_name of type node_type that is a child of the
parent_node and resides in the field parent_field. It returns the handle to the newly
created node.

mynode = vrnode(parent_node, "parent_field", "USE", "othernode")
creates a USE reference to the node othernode as a child of node parentnode and
resides in the field parentfield. It returns the handle to the original node.

A vrnode object identifies a virtual world node in a way very similar to a handle.

If you apply the vrnode method to a node that does not exist, the method creates a
node, the vrnode object, and returns the handle to the virnode object. If you apply the
vrnode method to an existing node, the method returns the handle to the vrnode object
associated with this node.

Method Summary

Method Description

delete Remove vrnode object

fields Virtual world field summary of node object
get Property value of vrnode object
getfield Field value of vrnode object

isvalid 1 if vrnode object is valid, O if not

set Change property of virtual world node
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Method Description
setfield Change field value of vrnode object
sync Enable or disable synchronization of virtual world fields with client

See Also

vrnode/delete | virnode/get | vrworld | vrnode/getfield | virnode/set |
vrnode/setfield

Introduced before R2006a
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vrnode/delete

Remove vrnode object

Syntax

delete(vrnode_object)

delete(n)

Arguments

vrnode_object Name of a vrnode object.

Description
delete(vrnode_object) deletes the virtual world node.

delete(n) deletes the vrnode object referenced by the vrnode handle n. If n is a vector
of vrnode handles, multiple nodes are deleted.

As soon as a node is deleted, it and all its child objects are removed from all clients
connected to the virtual world.

See Also

vrworld/delete

Introduced before R2006a
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vrnode/fields

virtual world field summary of node object

Syntax

fields(vrnode_object)

x = Fields(vrnode_object)

Arguments

vrnode_object Name of a vrnode object representing the node to be queried.

Description

fields(vrnode_object) displays a list of fields of the node associated with the
vrnode object in the MATLAB Command Window.

x = Fields(vrnode_object) returns the fields of the node associated with the
vrnode object in a structure array. The resulting structure contains a field for every field
with the following subfields:

Type is the name of the field type, for example, "MFString~, "SFColor".

Access is the accessibility description of the data class, for example, "eventiIn®,
"exposedField".

Sync is the synchronization status "on" or "off". See also vrnode/sync.

See Also

vrnode/get | vrnode/set

Introduced before R2006a
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vrnode/get

Property value of vrnode object

Syntax
get(vrnode_object)
X = get(vrnode_object)

X = get(vrnode_object, "property_name")

Arguments

vrnode_object Name of a vrnode object representing the node to be queried.
property name Name of the property to be read.

Description

get(vrnode_object) lists all vrnode properties in the MATLAB Command Window.

X = get(vrnode_object), where virnode_object is a scalar, returns a structure
where each field name is the name of a property and each field contains the value of that
property.

x = get(vrnode_object, "property name®) returns the value of given property.

If vrnode_object is a vector of virnode handles, get returns an M-by-1 cell array of
values, where M is equal to length(vrnode_object).

The vrnode property values are case sensitive. Property names are not case sensitive.

The vrnode object properties allow you to control the behavior and appearance of objects.
The vrnode objects have the following properties. All these properties are read only.

Property Valve Description

Fields Cell array Valid field names for the node.
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Property Value Description

Name String Name of the node.

Type String Type of the node. The value is a string (for example,
"Transform®, "Shape").

World Handle Handle of the parent vrwor ld object. This is a

vrwor Id object that represents the node's parent world.

See Also

vrnode | vrnode/getfield | virnode/set | virnode/setfield

Introduced before R2006a
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vrnode/getfield

Field value of vrnode object

Syntax
getfield(vrnode_object)
x = getfield(vrnode_object)

x = getfield(vrnode_object, "fieldname*®)

Arguments

vrnode_object Name of a virnode object representing the node to be queried.
fieldname Name of the vrnode object field whose values you want to query.
Description

getfield(vrnode_object) displays all the field names and their current values for
the respective node.

x = getfield(vrnode_object), where virnode_object is a scalar, returns a
structure where each field name is the name of a vrnode field and each field contains the
value of that field.

x = getfield(vrnode_object, "fieldname™) returns the value of the specified field
for the node referenced by the virnode_object handle. If vrnode_object is a vector of
vrnode handles, getfield returns an M-by-1 cell array of values, where M is equal to
length(vrnode_object).

If "Fieldname” is a 1-by-N or N-by-1 cell array of strings containing field names,
getfield returns an M-by-N cell array of values.

Note The dot notation is the preferred method for accessing nodes.
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See Also

vrnode | vrnode/get | vrnode/set | vrnode/setfield

Introduced before R2006a
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vrnode/isvalid

1 if vrnode object is valid, O if not

Syntax

x = isvalid(vrnode_object_vector)

Arguments

vrnode_object_vector Name of an array of virnode objects to be queried.

Description

This method returns an array that contains 1 when the elements of
vrnode_object_vector are valid vrnode objects, and O when they are not.

The vrnode object is considered valid if the following conditions are met:

The parent world of the node exists.
The parent world of the node is open.

The node with the given vrnode handle exists in the parent world.

See Also

vrfigure.isvalid | vrworld/isvalid

Introduced before R2006a
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vrnode/set

Change property of virtual world node

Syntax

X = set(vrnode_object, “property_name-,"property_value®)

Arguments

vrnode_object Name of a vrnode object representing a node in the virtual
world.

property name Name of a property.

property value Value of a property.

Description

x = set(vrnode_object, “property _name®,"property_value®) changes the
specified property of the vrnode object to the specified value.

The vrnode property values are case sensitive, while property names are not case
sensitive.

The vrnode property values are case sensitive, while property names are not case
sensitive.

The vrnode objects have the following properties. All these properties are read only.

Property Value Description

Fields Cell array Valid field names for the node. Read only.

Name String Name of the node. Read only.

Type String Type of the node. The value is a string (for example,
"Transform®, "Shape"). Read only.
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Property

Value

Description

World

Handle

Handle of the parent vrwor 1d object. This is a vrwor ld
object that represents the node's parent world. Read only.

Currently, nodes have no settable properties.

See Also

vrnode | vrnode/get | vrnode/getfield | vrnode/setfield

Introduced before R2006a
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vrnode/seffield

Change field value of virnode object

Syntax

x = setfield(vrnode_object, "fieldname®, "fieldvalue®)

Arguments

vrnode_object Name of a vrnode object representing the node to be changed.
fieldname Name of the vrnode object field whose values you want to set.
fieldvalue Value of fieldname.

Description

x = setfield(vrnode object, "fieldname”, "Ffieldvalue™) changes the
specified field of the vrnode object to the specified value. You can specify multiple field
names and field values in one line of code by grouping them in pairs. For example, X =
setfield(vrnode_object, "fieldnamel®, “fieldvaluel®, “fieldname2-,
"fieldvalue2®, ....

Note that field names are case sensitive, while property names are not.

Note The dot notation is the preferred method for accessing nodes. For example:

vrnode_object_fieldname=Ffieldvalue;

See Also

vrnode | vrnode/get | vrnode/getfield | vrnode/set

Introduced before R2006a
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vrnode/sync

Enable or disable synchronization of fields with client

Syntax

sync(vrnode_object, "field_name", "action®)

Arguments
vrnode_object Name of a vrnode object representing the node.
field_name Name of the field to be synchronized.
action The action parameter determines what should be done:
"on" enables synchronization of this field.
"off" disables synchronization of this field.
Description

The sync method controls whether the value of a field is synchronized.

When the field is marked "on*®, the field value is updated every time it is changed on the
client computer. If the field is marked "off", the host computer ignores the changes on
the client computer.

Synchronized fields add more traffic to the network line because the value of the field
must be resent by the client any time it is changed. Because of this, you should mark for
synchronization only the fields you need to scan for changes made on clients (typically
sensors). By default, fields are not synchronized and their values reflect only settings
from MATLAB or the Simulink software.

Synchronization is meaningful only for readable fields. Readable fields are of data class

eventOut and exposedField. You cannot enable synchronization for eventln or
nonexposed fields.
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See Also

vrnode | vrnode/get

Introduced before R2006a
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vrori2dir

Convert viewpoint orientation to direction

Syntax

vrori2dir(r)
vrori2dir(r,options)

Description

vrori2dir(r) converts the viewpoint orientation, specified by a rotation vector, r, to a
direction the viewpoint points to.

vrori2dir(r,options) converts the viewpoint orientation with the default algorithm
parameters replaced by values defined in options.

The options structure contains the parameter epsilon that represents the value below
which a number will be treated as zero (default value is 1e-12).

See Also

vrdir2ori on page 10-32 | vrrotmat2vec on page 10-128 | vrrotvec on page
10-127 | vrrotvec2mat on page 10-129

Introduced in R2007b
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vrpatch2ifs

Convert MATLAB patches to IndexedFaceSet nodes

Syntax

node = vrpatch2ifs(patches,world)
node = vrpatch2ifs(patches,shape)
node = vrpatch2ifs(patches,parent)
vrpatch2ifs(patches, ifs)

Description

node = vrpatch2ifs(patches,world) converts the patches array and saves the
result into the vrnode array node. Each resulting IndexedFaceSet node in node is
wrapped by the created Shape node residing in a root level of the wor ld virtual world.

node = vrpatch2ifs(patches,shape) converts the patches array and saves the
result into the vrnode array node. Each resulting IndexedFaceSet node in node

is a child of the respective Shape node in the shape array. If the Shape node already
contains an IndexedFaceSet node, that IndexedFaceSet is overwritten. The number
of patches must equal the number of Shape nodes.

Note: This function converts only geometry and color data of the patch.

node = vrpatch2ifs(patches,parent) converts the patches array and saves the
result into the vrnode array node. Each resulting IndexedFaceSet node in node is
wrapped by the created Shape node that is a child of the parent node.

vrpatch2ifs(patches, i fs) converts the patches array and saves the result into
i s array of existing IndexedFaceSet nodes, overwriting the IndexedFaceSet nodes.
The number of patches must equal the number of IndexedFaceSet nodes.
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Examples
Convert MATLAB Patches to IndexedFaceSet Nodes
This command converts three MATLAB® patches to IndexedFaceSet nodes.

Create surface using MATLAB peaks function.

fig = figure("Name®, "Source peaks surface®);
s = surf(peaks);

10 ~

10
G0

50
40 40

30
20 20

10

Convert the peaks surface to a patch.

peaksPatch = patch(surf2patch(s));
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delete(s);
shading interp;

10~

Create and open an empty virtual world.

w2 = vrworld("");
open(w2);

Create and bind viewpoint

dv = vrnode(w2, "DefaultViewpoint®, Viewpoint®);
dv._position = [-1 15 30];

dv.orientation = [-0.38 -0.93 0 0.55];
setfield(dv, "set_bind",true); %#ok<STFLD,SFLD>



vrpotch?il:s

Convert the patch to an IndexedFaceSet nodes. The resulting nodes are created in the
root level of supplied vrworld object)

vrpatch2ifs(peaksPatch,w2);

10 -

Show the result.

vrfig2 = vrfigure(w2, "Name”, ...
"Virtual world containing resulting IndexedFaceSet node®);
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&* Virtual world containing resulting IndexedFaceSet nade = | >
File  “iew \Viewpoints Mavigation Rendering Simulation Recording Help &
_untitled_1 v Fly ~d M LD ddq &

/) WE' e B

_untitied_1 T=0.00 Fly Pos:[-1.0015.00 30.00] Dir:[0.48 -0.20 -0.85)

Input Arguments

patches — MATLAB patches to convert

MATLAB patches, specified as an array.
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wor Id — Virtual world that contains Shape nodes
vrwor ld object

Virtual world that contains Shape nodes, specified as a virwor ld object.

parent — Parent grouping node
vrnode object

Parent grouping node, specified as a virnode object.

shape — Shape array
array of Shape nodes

Shape array, specified as an array of Shape nodes.

ifs — IndexedFaceSet nodes
array

IndexedFaceSet nodes, specified as an array.

Output Arguments

node — Conversion result
vrnode array

Conversion result, returned as a vrnode array.

See Also

See Also
patch | vrifs2patch

Topics
“Introduction to Patch Objects” (MATLAB)

Introduced in R2015a
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vrphysmod

Add virtual reality visualization framework to block diagrams

Syntax

vrphysmod(virtualWorldFile,system)

Description

vrphysmod(virtualWorldFile,system) updates the Simulink system (model or
subsystem) that the Simscape Multibody mech_import function generates.

The model must be on the MATLAB path or already open prior to calling the vrphysmod
function.

The .wrl extension is optional for a VRML virtual world file. If the specified system
was created with Simscape Multibody First Generation mech_import function, you can
specify also an .x3d or .x3dv file for the virtualWorldFile.

As necessary, vrphysmod adds additional blocks to visualize the mechanical system in
virtual reality. The association between mechanical system bodies and corresponding
nodes found in the virtual world 3D file is based on the name correspondence.

If your model contains several VR Sink blocks that refer to the same
virtualWorldFile, this function attempts to consolidate the animation signals of that
virtual scene into one VR Sink block.

You can then save, rename, modify, and run the model. When you save the resulting
model, be sure to preserve the relative path between the Simulink system and the virtual
world 3D file.

Note: The SolidWorks VRML export filter does not preserve part instance names and the
part order in the resulting virtual world 3D file. Therefore, the association between such
parts and the corresponding bodies in the block diagram is not always an exact match.

In such cases, the function identifies nodes with partial matches and issues warnings.

To prevent these warnings, ensure that node DEF names in the virtual world 3D file
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are identical to their corresponding bodies in the Simulink model before running this
function.

If you receive this warning and the set of virtual world 3D files does not originate in the
SolidWorks product, ignore the message. Other supported CAD tools also generate part
names with similar names, but preserve them across different export formats.

Examples
To update the model four_link using the file four_link.wrl:
vrphysmod(*four_link.wrl®, "four_link");

To update the subsystem Four_11nk/FOURLINK_ASM using the VRML file
four_link.wrl, ensure that the model that contains the subsystem is open, then:

vrphysmod("four_link.wrl®, "four_link/FOURLINK_ASM®);

To update the current system using the file four_link.wrl:

vrphysmod("four_link.wrl®, gcs);

See Also

stl2vrml | vrcadcleanup | mech_import

Introduced in R2009a
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vrplay

Play VRML animation file

Syntax
vrplay

vrplay(filename)
x=vrplay(filename)

Description

vrplay opens the 3D Animation Player, which you use to open and play virtual world
animation files.

vrplay(Ffilename) opens the 3D Animation Player and loads the virtual world
filename.

x=vrplay(filename) also returns a 3D Animation Player figure handle.

vrplay works only with VRML animation files created using the Simulink 3D
Animation virtual world recording functionality.
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stop play

step forward

step reverse fast forward

rewind
start

last jump 100p

/;19151

B K«wa == p oo

4 | B

Start time: 0  Current time: 0 Stop time: 0

) Simuhink 3D Anitnation Player
File

Stopped

time indicator

When you create additional vrplay windows using the File > New Window command,
the window respects the current setting of the DefaultViewer property. By default,
the File > New Window command creates the new player window implemented as a
MATLAB figure.

Simulink 3D Animation Player App
You can open the Simulink 3D Animation Player from the MATLAB Apps tab. In

the tab, scroll to the Simulation Graphics and Reporting section and click 3D
Animation Player.

Keyboard Support

The playback controls can also be accessed from the keyboard.

Key Function

F, Page Down Fast forward
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Key Function

dJ Jump to time
L Loop

P Play/pause toggle
S Stop

R, Page Up Rewind
Right arrow key Step forward
Left arrow key Step reverse
Up arrow key First

Down arrow key Last
Examples

To play the animation file based on the vr_octavia example, run
vrplay(“octavia_scene_anim.wrl®).

See Also

vrview

Topics
“Record Offline Animations” on page 7-41

Introduced in R2006a
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vrrotvec

Calculate rotation between two vectors

Syntax

r = vrrotvec(a,b)
r = vrrotvec(a,b,options)

Description

r = vrrotvec(a,b) calculates a rotation needed to transform the 3D vector a to the
3D vector b.

r = vrrotvec(a,b,options) calculates the rotation with the default algorithm
parameters replaced by values defined in options.

The options structure contains the parameter epsi lon that represents the value below
which a number will be treated as zero (default value is 1e-12).

The result, r, is a four-element axis-angle rotation row vector. The first three elements
specify the rotation axis, and the last element defines the angle of rotation.

See Also

vrrotmat2vec on page 10-128 | vrrotvec2mat on page 10-129

Introduced in R2007b
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vrrotmat2vec

Convert rotation from matrix to axis-angle representation

Syntax

r = vrrotmat2vec(m)
r = vrrotmat2vec(m,options)

Description

r = vrrotmat2vec(m) returns an axis-angle representation of rotation defined by the
rotation matrix m.

r = vrrotmat2vec(m,options) converts the rotation with the default algorithm
parameters replaced by values defined in options.

The options structure contains the parameter epsi lon that represents the value below
which a number will be treated as zero (default value is 1e-12).

The result r is a four-element axis-angle rotation row vector. The first three elements
specify the rotation axis, and the last element defines the angle of rotation.

See Also

vrrotvec on page 10-127 | vrrotvec2mat on page 10-129

Introduced in R2007b
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vrrotvec2mat

Convert rotation from axis-angle to matrix representation

Syntax

m = vrrotvec2mat(r)
m = vrrotvec2mat(r,options)

Description

m = vrrotvec2mat(r) returns a matrix representation of the rotation defined by the
axis-angle rotation vector, r.

m = vrrotvec2mat(r,options) returns a matrix representation of rotation defined
by the axis-angle rotation vector r, with the default algorithm parameters replaced by
values defined in options.

The options structure contains the parameter epsilon that represents the value below
which a number will be treated as zero (default value is 1e-12).

The rotation vector, r, is a row vector of four elements, where the first three elements
specify the rotation axis, and the last element defines the angle.

To rotate a column vector of three elements, multiply it by the rotation matrix. To rotate
a row vector of three elements, multiply it by the transposed rotation matrix.

See Also

vrrotvec on page 10-127 | vrrotmat2vec on page 10-128

Introduced in R2007b
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vrsetpref

Change Simulink 3D Animation preferences

Syntax

vrsetpref(“preference_name®, “preference_value®)

vrsetpref(~factory”)

Arguments

preference_name Name of the preference.
preference_value New value of the preference.
Description

This function sets the given Simulink 3D Animation preference to a given value.
The following preferences are defined. For preferences that begin with the string
DefaultFigure or DefaultWorld, these values are the default values for the
corresponding Vrfigure or vrwor ld property:

Preference Description

AutoCreateThumbnail Creates a thumbnail of a virtual world when
you open a virtual world. The default is "oFFf".
Setting this preference to "on" can be helpful
if you download multiple virtual worlds from
the Internet, without saving them. Creating
thumbnails on file open provides thumbnails
the next time someone browses through the
downloaded worlds.

DataTypeBool Specifies the handling of the virtual world Bool
data type for virnode/setfield and vrnode/
getfield. Valid values are "logical " and

"char”. If set to "logical ", the virtual world

Bool data type is returned as a logical value. If
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Preference

Description

set to "char”, the Bool data type is returned
"on" or "off". Default is "logical ".

DataTypelnt32

Specifies handling of the virtual world 1nt32
data type for vrnode/setfield and vrnode/
getfield. Valid values are "int32" and
"double”. If set to "int32", the virtual world
Int32 data type is returned as Int32. If set to
"double”, the Int32 data type is returned as
"double”. Default is "double”.

DataTypeFloat

Specifies the handling of the virtual world Float
data type for virnode/setfield and vrnode/
getfield. Valid values are "single” and
"double®. If set to "single”, the virtual world
Float and Color data types are returned as
"single”. If set to "double”, the Float and
Color data types are returned as "double”.
Default is "double®”.

DefaultCanvasNavPanel

Controls the appearance of the control panel in
the vr.canvas object. Values are:

* "none”
Panel is not visible.
* "minimized”

Panel appears as a minimized icon in the
right-hand corner of the viewer.

« "translucent”

Panel floats half transparently above the
scene.

* "opaque*”
Panel floats above the scene.

Default: "none*”
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Preference

Description

DefaultCanvasUnits

Specifies default units for new vr.canvas
objects. See vr.canvas for detailed description.
Default is "normalized”.

Defaul tEditorMouseBehavior

Specifies whether the mouse in the view pane

1s in navigation mode or selection mode (for
highlighting corresponding nodes in the tree
view pane). The default is "havigate”. To make
selection mode the default, set the preference to
"select”.

DefaultEditorHighlighting

Specifies whether to highlight virtual world
objects selected in the view pane. The default
is "on". To avoid highlighting selected virtual
objects by default, set the preference to "off".

Defaul tFigureAnti Determines whether antialiasing is used
Aliasing by default for new vrfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "off" and "on".
DefaultFigureCapture Specifies default file name for capturing
FileName viewer figures. See vrfigure.get for detailed

description. Default is "%f_anim_%n.tif".

DefaultFigureDeleteFcn

Specifies the default callback invoked when
closing a vrfigure object.

DefaultFigureLighting

Specifies whether the lights are rendered

by default for new vrfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "off" and "on".

Defaul tFigureMax
TextureSize

Specifies the default maximum size of a texture
used in rendering new vrfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "auto™ and 32 <=Xx
<= video card limit, where X is a power of 2.

Defaul tFigureNavPanel

Specifies the default appearance of the control
panel in the viewer. Valid values are "opaque”,
"translucent”, "none”, "halfbar", "bar",
and "factory”. Default is "halfbar".
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Preference

Description

Defaul tFigureNavZones

Specifies whether the navigation zone is on or
off by default for new vrfigure objects. This
preference also applies to new vr.canvas
objects. Valid values are "off" and "on".

DefaultFigurePosition

Sets the default initial position and size of the
Simulink 3D Animation Viewer window. Valid
value is a vector of four doubles.

DefaultFigureRecord2D
CompressMethod

Specifies the default compression method

for creating 2-D animation files for new
vrfigure objects. Valid values are ", "auto”,
"lossless”, and "codec_code”.

DefaultFigureRecord2D
CompressQuality

Specifies the default quality of 2-D animation
file compression for new vrfigure objects. Valid
values are 0-100.

DefaultFigureRecord2D
FileName

Specifies the default 2-D offline animation file
name for new vrfigure objects.

Defaul tFigureRecord2DFPS

Specifies the default frames per second playback
speed.

To have the 2D AVI animation play back at
approximately the same playback speed as the
3D virtual world animation, set this preference to
auto.

DefaultFigureRendering

Specifies whether to render a vrfigure or
Vvr.canvas object. Turning off rendering
improves performance. For example, if your code
does batch operations on a virtual figure, you can
turn off rendering during that processing and
then turn it back on after the processing.

Defaul tFigureStatusBar

Specifies whether the status bar appears

by default at the bottom of the Simulink 3D
Animation Viewer for new vrfigure objects.
Valid values are "off" and "on".
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Preference

Description

Defaul tFigureTextures

Specifies whether textures should be rendered
by default for new vrfigure objects. This
preference also applies to new vr.canvas
objects. See vrfigure.get for detailed
description. Default is "on*.

DefaultFigureToolBar

Specifies whether the toolbar appears by default
on the Simulink 3D Animation Viewer for new
vrfigure objects. Valid values are "off" and

on-.

DefaultFigure Transparency

Specifies whether or not transparency
information is taken into account when rendering
for new vrfigure objects. This preference also
applies to new Vr.canvas objects. Valid values
are "off" and "on”".

Defaul tFigureWireframe

Specifies whether objects are drawn as solids or
wireframes by default for new vrfigure objects.
This preference also applies to new vr.canvas
objects. Valid values are "off" and "on".

DefaultViewer Specifies which viewer is used to view a virtual
scene.
* "internal*
Default Simulink 3D Animation Viewer.
*+ “web”
Web browser becomes viewer. This is the
current Web browser virtual world plug-in.
DefaultWorldRecord3D Specifies the default 3-D animation file name for
FileName new vrwor ld objects.

DefaultWor ldRecordMode

Specifies the default animation recording mode
for new vrwor Id objects. Valid values are
"manual " and "scheduled”.
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Preference Description
DefaultWorlldrRecord Specifies the default start and stop times for
Interval scheduled animation recording for new vrworld

objects. Valid value is a vector of two doubles.

DefaultWorldRemoteView

Specifies whether the virtual world is enabled
by default for remote viewing for new vrwor ld
objects. Valid values are "off" and "on".

DefaultWorldTimeSource

Specifies the default source of the time for new
vrwor Id objects. Valid values are "external "
and "freerun®.

Editor

Specifies which virtual world editor to use. Path
to the virtual world editor. If this path is empty,
the MATLAB editor is used.

The path setting is active only if you select the
Custom option.

To open a virtual world file in a third-party
editor, do not use the vredit command. For
example, to open a virtual world in the Ligos V-
Realm Builder editor:

1 Set the default editor to V-Realm Builder. In
MATLAB, enter:

vrsetpref("Editor®, "*VREALM®);

2 To open a file in the V-Realm editor, in
MATLAB navigate to a virtual world file,
right-click, and select Edit.

Note: The vredit command opens the 3D
World Editor, regardless of the default editor
preference setting.
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Preference Description

EditorPreservelLayout Specifies whether the 3D World Editor starts up
with a saved version of the layout of a virtual
world when you exited it or reverts to the default
layout. The layout of the virtual world display
pane includes settings for the view, viewpoints,
navigation, and rendering. Valid values are
"off" and "on". The default is on (use saved
layout).

HttpPort IP port number used to access the Simulink 3D
Animation server over the Web via HTTP. If

you change this preference, you must restart the
MATLAB software before the change takes effect.

TransportBuffer Length of the transport buffer (network packet
overlay) for communication between the Simulink
3D Animation server and its clients.

TransportTimeout Amount of time the Simulink 3D Animation
server waits for a reply from the client. If there
is no response from the client, the Simulink 3D
Animation server disconnects from the client.

VrPort IP port used for communication between the
Simulink 3D Animation server and its clients. If
you change this preference, you must restart the
MATLAB software before the change takes effect.

When you use "factory” as a single argument, all preferences are reset to their default
values. If you use "Ffactory” for a preference value, that single preference is reset to its
default.

The HttpPort, VrPort, and TransportBuffer preferences affect Web-based viewing
of virtual worlds. DefaultFigurePosition and DefaultNavPanel affect the Simulink
3D Animation Viewer. Changes to the HttpPort or VrPort preferences take effect only
after you restart the MATLAB software.

DefaultFigureNavPanel — Controls the appearance of the navigation panel in the

Simulink 3D Animation Viewer. For example, setting this value to "translucent”
causes the navigation panel to appear translucent.
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DefaultViewer — Determines whether the virtual scene appears in the default
Simulink 3D Animation Viewer or in your Web browser.

DefaultViewer Sefting Description

"internal” Default Simulink 3D Animation Viewer.

"web* Viewer is the default Web browser with the virtual
world plug-in.

Editor — Contains a path to the virtual world editor executable file. When you use the
edit command, Simulink 3D Animation runs the virtual world editor executable with all
parameters required to edit the virtual world file.

When you run the editor, Simulink 3D Animation uses the Editor preference value as if
you typed it into a command line. The following tokens are interpreted:

%matlabroot Refers to the MATLAB root folder
%File Refers to the virtual world 3D file name
For instance, a possible value for the Editor preference is
“Ymatlabroot\bin\win64\meditor.exe %file"

If this preference is empty, the MATLAB editor is used.

HttpPort -- Specifies the network port to be used for remote Web access. The port is
given in the Web URL as follows:

http://server _name:port_number
The default value of this preference 1s 8123.

TransportBuffer — Defines the size of the message window for client-server
communication. This value determines how many messages, at a maximum, can travel
between the client and the server at one time.

Generally, higher values for this preference make the animation run more smoothly, but
with longer reaction times. (More messages in the line create a buffer that compensates
for the unbalanced delays of the network transfer.)

The default value is 5, which is optimal for most purposes. You should change this value
only if the animation is significantly distorted or the reaction times are very slow. On

10-137



10  Functions — Alphabetical List

10-138

fast connections, where delays are introduced more by the client rendering speed, this
value has very little effect. Viewing on a host computer is equivalent to an extremely
fast connection. On slow connections, the correct value can improve the rendering speed
significantly but, of course, the absolute maximum is determined by the maximum
connection throughput.

VrPort — Specifies the network port to use for communication between the Simulink
3D Animation server (host computer) and its clients (client computers). Normally,

this communication is completely invisible to the user. However, if you view a virtual
world from a client computer, you might need to configure the security network system
(firewall) so that it allows connections on this port. The default value of this preference is
8124,

See Also

vrgetpref

Introduced before R2006a



vrspacemouse

vrspacemouse

Create space mouse object

Syntax

mouse = vrspacemouse(id)

Description

mouse = vrspacemouse(id) creates a space mouse object capable of interfacing with
a space mouse input device. The id parameter is a string that specifies the space mouse
connection: COM1, COM2, COM3, COM4, USB1, USB2, USB3, or USB4.

The vrspacemouse object has several properties that influence the behavior of the space
mouse input device. The properties can be read or modified using dot notation (e.g.,
mouse.DominantMode = true;).

Properties

Valid properties are (property names are case-sensitive):

Property Description

PositionSensitivity Mouse sensitivity for translations. Higher values

correspond to higher sensitivity.

RotationSensitivity Mouse sensitivity for rotations. Higher values
correspond to higher sensitivity.

DisableRotation Fixes the rotations at initial values, allowing you to
change positions only.

DisableTranslation Fixes the positions at the initial values, allowing you
to change rotations only.

DominantMode If this property is true, the mouse accepts only the
prevailing movement and rotation and ignores the
others. This mode is very useful for beginners using a
space mouse.
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Property Description
UpperPositionLimit Position coordinates for the upper limit of the mouse.
LimitPosition Enables mouse position limits. If false, the
object ignores the UpperPositionLimit and
LowerPositionLimit properties.
LowerPositionLimit Position coordinates for the lower limit of the mouse.

Normal izeOutputAngle

Determines whether the integrated rotation angles
should wrap on a full circle (360°). This is not used
when you read the Output Type as Speed.

InitialPosition Initial condition for integrated translations. This is
not used when you set the Output Type to Speed.
InitialRotation Initial condition for integrated rotations. This is not

used when you set the Output Type to Speed

Methods

Method

Description

button

b = button(mouse, n) reads the status of space
mouse button number n. Button status is returned as
logical 0 if not pressed and logical 1 if pressed. n can
be a vector to return multiple buttons.

close

close(mouse) closes and invalidates the space
mouse object. The object cannot be used once it is
closed.

position

p = position(mouse, n) reads the position of
space mouse axis number N. n can be a vector to
return positions of multiple axes. Translations and
rotations are integrated. Outputs are the position
and orientation in the form of roll/pitch/yaw angles.

speed

s = speed(mouse, n) reads the speed of space
mouse axis number n. n can be a vector to return
the speeds of multiple axes. No transformations
are done. Outputs are the translation and rotation
speeds.
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Method Description

viewpoint p = viewpoint(mouse) reads the space mouse
coordinates in virtual world viewpoint format.
Translations and rotations are integrated. Outputs
are the position and orientation in the form of an axis
and an angle. You can use these values as viewpoint
coordinates in virtual world.

See Also

vrsetpref | vrjoystick | vrlib | “Set Simulink 3D Animation Preferences” on page
2-9

Introduced in R2007b
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vr.utils.stereo3d class

Stereoscopic vision settings for vr.canvas and vr.figure objects

Description

Tip: Use the vr._utils.stereo3d class for advanced tuning of stereoscopic viewer and
canvas properties. You can select and use basic stereoscopic settings from the Viewer
menu.

Specifies these stereoscopic vision properties:

+ Active, anaglyph, or no stereoscopic vision
+  Camera offset

+ Camera angle

+  Color filter for the left and right cameras

* Horizontal image translation (HIT)

Use a vr.utils.stereo3d object to set the Stereo3D, Stereo3DCameraOffset,

and Stereo3DHIT stereoscopic vision properties of virFigure and vr.canvas objects.
Specifying a vr.utils.stereo3d object to set one vrfigure and vr.canvas property
also sets the other stereoscopic vision properties. Using a vr.utils.stereo3d object

also specifies color filters for the left and right cameras. You cannot set camera color
filters directly using the vrfigure/set method or vr.canvas properties.

Construction
stereoVision = vr._utils.stereo3d.OFF disables stereoscopic vision.
stereoVision = vr.utils.stereo3d.ACTIVE enables active stereoscopic vision.

stereoVision = vr.utils.stereo3d.ANAGLYPH enables red-cyan anaglyph
stereoscopic vision.
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stereoVision = vr._utils.stereo3d.RED_CYAN enables red-cyan anaglyph
stereoscopic vision.

stereoVision = vr.utils.stereo3d.ANAGLYPH_GREEN_MAGENTA enables green-
magenta anaglyph stereoscopic vision.

stereoVision = vr.utils.stereo3d.ANAGLYPH_RED_GREEN enables red-green
anaglyph stereoscopic vision.

stereoVision = vr.utils.stereo3d.ANAGLYPH RED BLUE enables red-blue
anaglyph stereoscopic vision.

stereoVision = vr._utils.stereo3d.ANAGLYPH_YELLOW_BLUE enables yellow-blue
anaglyph stereoscopic vision.
Output Arguments

stereoVision — Stereoscopic vision settings for vr.canvas and vrfigure objects
vr.utils.stereo3d object

Stereoscopic vision settings for vr.canvas and vrfigure objects, represented by a
vr.utils.stereo3d object.

Properties

CameraAngle — Camera angle
vr.utils.stereo3D.DEFAULT_ CAMERA_ANGLE | radians

Camera angle, specified using the predefined DEFAULT CAMERA_ANGLE or in radians.
This property is in effect when you enable stereoscopic vision.

This property does not apply to vr.canvas or vrfigure objects.

CameraOffset — Camera offset
0.1 (default) | floating-point number between 0 and 1

Camera offset, specified as a number representing the distance in virtual world units of
left/right camera from parallax. The parallax is the difference in the apparent position of
an object viewed from two cameras.

This property sets the Stereo3DCameraOffset property of a vr.canvas or vrfigure
object.
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HIT — Horizontal image translation
predefined DEFAULT _HIT | floating-point number

Horizontal image translation, specified as either the predefined DEFAULT _HIT or as

a floating-point number from 0 through 1, inclusive. The number of pixels for stereo
3D horizontal image translation (HIT) derives from this number. Horizontal image
translation is the horizontal relationship of the two stereo images. By default, the
background image is at zero and the foreground image appears to pop out from the
monitor toward the person viewing the virtual world. The larger the value, the further
back the background appears to be.

This property sets the Stereo3DHIT property of a vr.canvas or vrfigure object.

LeftCameraFilter — Color filter of left camera
row vector of nine floating-point numbers | predefined filter

Color filter of the left camera, specified as a row vector of nine floating-point numbers or
using a predefined filter.

If you specify a row vector, use floating-point numbers from O through 1. The first three
numbers represent the red value, the second three numbers represent the green value,
and the last three numbers represent the blue value. For example, specifying 1 for the
first three numbers and zeros for the other numbers produces a pure red filter.

The predefined filters are:

+ CAMERA_FILTER_FULL

+ CAMERA_FILTER_RED

+ CAMERA_FILTER_CYAN

+ CAMERA_FILTER_GREEN

+ CAMERA_FILTER_MAGENTA
+ CAMERA_FILTER_YELLOW

+ CAMERA_FILTER_BLUE

This property specifies the left camera filter for vr.canvas or vrfigure objects.

Example: stereo3d_object.LeftCameraFilter = [0.1 0.5 0.5 0.0 0.0 0.0
1.0 0.5 0.5];

Example: stereo3d_object.LeftCameraFilter =
stereo3d_object.CAMERA_FILTER_RED
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Mode — Stereoscopic vision mode
read only

Stereoscopic vision mode. Read only.

* STEREO3D_OFF — No stereoscopic vision.

+ STEREO3D_ACTIVE — Active stereoscopic vision. Stereoscopic vision uses quad-
buffered rendering. You can use a graphics card driver to output stereoscopic vision.
This mode allows active stereoscopic vision via shutter glasses.

* STEREO3D_ANAGLYPH — Anaglyph stereoscopic vision. Stereoscopic vision is enabled
using red-cyan anaglyph. Use appropriate anaglyph 3D glasses to see the effect.
This property sets the Stereo3D property of a vr.canvas or vrfigure object.

RightCameraFilter — Color filter of right camera
row vector of nine floating-point numbers | predefined filter

Color filter of the right camera, specified as a row vector of nine floating-point numbers
or using a predefined filter.

If you specify a row vector, use floating-point numbers from 0 through 1. The first three
numbers represent the red value, the second three numbers represent the green value,
and the last three numbers represent the blue value. For example, specifying 1 for the
first three numbers and zeros for the other numbers produces a pure red filter.

The predefined filters are:

+ CAMERA_FILTER_FULL

+ CAMERA_FILTER_RED

* CAMERA_FILTER_CYAN

+ CAMERA_FILTER_GREEN

+ CAMERA_FILTER_MAGENTA
+ CAMERA_FILTER_YELLOW

+ CAMERA_FILTER_BLUE

This property specifies the right camera filter for vr.canvas or vrfigure objects.

Example: stereo3d_object.RightCameraFilter = [0.1 0.5 0.5 0.0 0.0 0.0
1.0 0.5 0.5];
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Example: stereo3d_object.RightCameraFilter =
stereo3d_object.CAMERA FILTER_RED

Examples

Define and Apply Stereoscopic Vision Settings

Create a virtual world.
w = vrworld(“octavia_scene®);

open(w);
c = vr.canvas(w);
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Specify stereoscopic vision settings.

s3d = vr.utils.stereo3d.ANAGLYPH_RED_CYAN;
s3d.CameraOffset = 0.05;
s3d.CameraAngle = pi/128;

Modify the red component of filter for the left camera.
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s3d.LeftCameraFilter(1:3) = s3d.LeftCameraFilter(1:3)...
+ [0.1 -0.05 -0.05];

Apply stereoscopic vision settings of vr.utils.stereo3d object s3d to vr.canvas
object C.

set(c, "Stereo3D",s3d)

. “View a Virtual World in Stereoscopic Vision” on page 7-63

See Also

See Also

vr.canvas | vrfigure

Topics
“View a Virtual World in Stereoscopic Vision” on page 7-63

Introduced in R2015a
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vrview

View virtual world using Simulink 3D Animation viewer or Web browser

Syntax

vrview

vrview("filename®)

X

x = vrview("filename", "-internal ")

vrview("filename®, "-web")

X

Description

vrview opens the default Web browser and loads the Simulink 3D Animation software
Web page containing a list of virtual worlds available for viewing.

X = vrview("filename") creates a virtual world associated with the .wrl file, opens
the virtual world, and displays it in the Simulink 3D Animation Viewer or the Web
browser depending on the value of the DefaultViewer preference. The handle to the
virtual world is returned.

x = vrview("filename", "-internal ") creates a virtual world associated with the
wrl file, opens the virtual world, and displays it in the Simulink 3D Animation Viewer.

x = vrview("filename", "-web") creates a virtual world associated with the .wrl
file, opens the virtual world, and displays it in your Web browser.

vrview( " filename#viewpointname®) specifies a default viewpoint.

See Also

vrplay | vrworld | vrworld/open | vrworld/view

Introduced before R2006a
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vrwho

List virtual worlds in memory

Syntax

vrwho

X = vrwho

Description

If you do not specify an output parameter, vrwho displays a list of virtual worlds in
memory in the MATLAB Command Window.

If you specify an output parameter, virwho returns a vector of handles to existing
vrwor Id objects, including those opened from the Simulink interface.

See Also

vrclear | vrwhos | vrworld

Introduced before R2006a
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vrwhos

List details about virtual worlds in memory

Syntax

vrwhos

Description

vrwhos displays a list of virtual worlds currently in memory, with a description, in the
MATLAB Command Window. The relation between vrwho and vrwhos is similar to the

relation between who and whos.

See Also

vrclear | vrwho

Introduced before R2006a
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vrworld

Create new vrwor ld object associated with virtual world

Syntax

myworld = vrworld(filename)

myworld = vrworld(Filename, "reuse”)
myworld = vrworld(filename, “new")
myworld = vrworld

myworld = vrworld("")

myworld = vrworld([])

Arguments

filename String containing the name of the virtual world 3D file from which
the virtual world is loaded. You can specify .wrl, .x3d, or .x3dv).
If no file extension is specified, the file extension .wrl is assumed.

"new" Argument to create a virtual world associated with Fi lename.

Description

myworld = vrworld(Ffilename) creates a virtual world associated with the virtual
world 3D file Fi lename and returns its handle. If the virtual world already exists, a
handle to the existing virtual world is returned. Specify the file name as a string.

myworlld = vrworld(filename, "reuse”) has the same functionality as myworld =
vrwor ld(filename).

myworld = vrworld("filename®, "new") creates a virtual world associated with
the virtual world 3D file fi lename and returns its handle. It always creates a new
virtual world object, even if another vrworld object associated with the same file already
exists.
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myworld = vrworld creates an invalid vrwor 1d handle

myworlld = vrworld(" ") creates an empty vrworld object that is not associated with
any virtual world 3D file

myworlld = vrworld([]) returns an empty array of returns an empty array of
vrwor ld handles.

A vrworld object identifies a virtual world in a way very similar to a handle. All
functions that affect virtual worlds accept a vrworld object as an argument to identify
the virtual world.

If the given virtual world already exists in memory, the handle to the existing virtual
world is returned. A second virtual world is not loaded into memory. If the virtual world
does not exist in memory, it is loaded from the associated virtual world 3D file. The
newly loaded virtual world is closed and must be opened before you can use it.

The vrworld object associated with a virtual world remains valid until you use either
delete or vrclear.

Examples

myworld = vrworld("vrpend.wrl®)

Method Summary

Method Description

addexternproto Add externproto declaration to virtual world.
close Close virtual world

delete Remove virtual world from memory

edit Open virtual world file in external virtual world editor
get Property value of virwor 1d object

isvalid 1 if vrwor I d object is valid, O if not

nodes List nodes available in virtual world

open Open virtual world
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Method Description

reload Reload virtual world from virtual world 3D file
save Write virtual world to virtual world 3D file
set Change property values of virworld object
view View virtual world

See Also

vrworld/close | vrworld/delete | vrworld/open | “Create vrworld Object for a
Virtual World” on page 4-2 | “Open a Virtual World with MATLAB” on page 4-4

Introduced before R2006a
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vrworld/addexternproto

Add externproto declaration to virtual world

Syntax

addexternproto(vrworld_object, protofile, protoname)

addexternproto(vrworld_object, protofile, protoname, protodef)

Arguments

vrworld_object A vrworld object representing the virtual world.

protofile String containing the name of the prototype file from which the
EXTERNPROTO declaration is added.

protoname String containing the name of the EXTERNPROTO declaration.

protodef String containing a new name for the EXTERNPROTO declaration.

Description

addexternproto(vrworld_object, protofile, protoname) adds an
EXTERNPROTO declaration from file protofile to the virtual world. The handle

vrwor ld_object refers to the virtual world. The EXTERNPROTO declaration is identified
as protoname. If protoname is a cell array of identifiers, the function adds multiple
EXTERNPROTOs from one file to the virtual world.

addexternproto(vrworld_object, protofile, protoname, protodef) adds
an EXTERNPROTO declaration from file protofi le to the virtual world. The handle
vrworld_object refers to the virtual world. The EXTERNPROTO declaration is identified
as protoname. If protoname is a cell array of identifiers, the function adds multiple
EXTERNPROTOs from one file to the virtual world. This command then renames the new
EXTERNPROTO declaration to protodef.

In both cases, the EXTERNPROTO declaration becomes equivalent to the PROTO
declaration. In other words, protoname or protodef becomes an internal PROTO type
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in the virtual scene associated with virworld_object. After you save the virtual world,
these PROTO declarations no longer require a reference to the original file, protofile,
that contains the EXTERNPROTO declarations.

See Also

vrworld/close | vrworld/delete | virworld/open | “Create vrworld Object for a
Virtual World” on page 4-2 | “Open a Virtual World with MATLAB” on page 4-4

Introduced in R2008b
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vrworld/close

Close virtual world

Syntax

close(vrworld_object)

Arguments

vrworld_object A vrworld object representing the virtual world.

Description

This method changes the virtual world from an opened to a closed state:

+ If the world was opened more than once, you must use an appropriate number of
close calls before the virtual world closes.

+ Ifvrworld_object is a vector of vrwor 1d objects, all associated virtual worlds close.

+ If the virtual world is already closed, close does nothing.

Opening and closing virtual worlds is a mechanism of memory management. When the

system needs more memory and the virtual world is closed, you can discard its contents
at any time.

Generally, you should close a virtual world when you no longer need it. This allows you
to reuse the memory it occupied. The vrwor ld objects associated with this virtual world
stay valid after it is closed, so the virtual world can be opened again without creating a
new vrwor ld object.

Examples

myworld = vrworld("vrpend.wrl®)
open(myworld)
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close(myworld)

See Also

vrworld | “Close and Delete a vrworld Object” on page 4-10 | vrworld/delete |
vrworld/open

Introduced before R2006a
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vrworld/delete

Remove virtual world from memory

Syntax

delete(vrworld_object)

Arguments

vrworld_object A vrworld object representing a virtual world.

Description

The delete method removes from memory the virtual world associated with a vrworld
object. The virtual world must be closed before you can delete it.

Deleting a virtual world frees the virtual world from memory and invalidates all existing
vrwor ld objects associated with the virtual world.

If vrworld_object is a vector of virwor ld objects, all associated virtual worlds are
deleted.

You do not commonly use this method. One of the possible reasons to use this method

is to ensure that a large virtual world is removed from memory before another memory-
consuming operation starts.

See Also

vrworld | vrclear | “Close and Delete a vrworld Object” on page 4-10 | vrworld/
delete | vrworld/open

Introduced before R2006a
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vrworld/edit

Open virtual world file in virtual world editor

Syntax

edit(vrworld_object)

Arguments

vrworld_object A vrworld object representing a virtual world.

Description

The edit method opens the virtual world 3D file associated with the vrworld object in
a virtual world editor. The Editor preference specifies the editor to use. See vrsetpref
for details on setting preferences.

The editor saves any changes you make directly to a virtual world file. If the virtual
world is open,

* Use the save command in the virtual world editor to save the changes to a virtual
world file. In the MATLAB interface, the changes appear after you reload the virtual
world.

* Use the save method in the MATLAB software to replace the modified virtual world
3D file. Any changes you made in the editor are lost.

See Also

vrworld/reload | vrworld/save | “Close and Delete a vrworld Object” on page 4-10
| vrworld/delete | vrworld/open | “Create vrworld Object for a Virtual World” on
page 4-2

Introduced before R2006a
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vrworld/get

Property value of vrwor ld object

Syntax

get(vrworld_object)

x = get(vrworld_object)

X = get(vrworld_object, “property_name*")

Arguments

vrworld_object A vrworld object representing a virtual world.
property name Name of the property.

Description

get(vrworld_object) displays all the virtual world properties and their values.

x = get(vrworld_object) returns an M-by-1 structure where the field names are the
names of the virtual world properties. Each field contains the associated property value.
M is equal to length(vrworld_object).

x = get(vrworld_object, "property name®) returns the value of the specified
property.

+ Ifvrworld_object is a vector of vrwor 1d handles, the get method returns an M-
by-1 cell array of values where M is equal to length(vrworld_object).

+ Ifproperty_name is a 1-by-N or N-by-1 cell array of strings containing field names,
the get method returns an M-by-N cell array of values.

The following are properties of virwor Id objects. Names are not case sensitive.

Property

Value Description

Clients

Scalar Number of clients currently viewing the
virtual world. Read only.
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Property

Value

Description

ClientUpdates

"off" | "on*

Default: "on*

Client cannot or can update the virtual
scene. Read/write.

Description String. Description of the virtual world as it
appears on the main Web page. Read/write.
Default: automatically taken
from the virtual world 3D file
property title
Figures Vector of virfigure objects | Vector of handles to Simulink 3D
Animation Viewer windows currently
viewing the virtual world. Read only.
FileName String Name of the associated virtual world 3D
file. Read only.
Nodes Vector of vrnode objects Vector of vrnode objects for all named
nodes in the virtual world. Read only.
Open “off" | “on- Indicates a closed or open virtual world.
Read only.
Default: "off"
Record3D "off" | "on" Enables 3-D animation recording. Read/

Default: "off"

write.

Record3DFi leName

String.

Default: "%Ff_anim %n.wrl*

3-D animation file name. The string can
contain tokens that are replaced by the
corresponding information when the
animation recording takes place. For
details, see “File Name Tokens” on page
4-15. Read/write.

Recording "off" | “on* Animation recording toggle. This property
acts as the master recording switch. Read/
Default: "off*" write.
RecordMode "manual® | “scheduled® |Animation recording mode. Read/write.

Default: "manual ®
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Property

Value

Description

RecordInterval

Vector of two doubles

Default: [0 0]

Start and stop times for scheduled
animation recording. Corresponds to the
virtual world object Time property. Read/
write.

RemoteView

“off" | “on-

Default: "off"

Remote access flag. If the virtual world
is enabled for remote viewing, it is set to
"on"; otherwise, it is set to "off". Read/
write.

Rendering

"off" | “on"

Default: "on*

Render vrworld object in the Simulink
3D Animation Viewer, specifying "on" or
"off". Turning off rendering improves
performance. For example, if your code
does batch operations on a virtual world,
you can turn off rendering during that
processing and then turn it back on after
the processing.

Time

Double

Current time in the virtual world. Read/
write.

TimeSource

"external® | “freerun-

Default: "external *

Source of the time for the virtual world.

If set to "external *, time in the scene is
controlled from the MATLAB interface (by
setting the Time property) or the MATLAB
interface (simulation time).

If set to "freerun”, time in the scene
advances independently based on the
system timer. Read/write.

"off" | "on"

Default: "on*

Indicates an unviewable or viewable virtual
world. Read/write.

The ClientUpdates property is set to "on” by default and can be set by the user. When
it is set to "OFF", the viewers looking at this virtual world should not update the view
according to the virtual world changes. That is, the view is frozen until this property is
changed to "on". This is useful for preventing tearing effec